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To Alexandra, Charlotte, Maximilian, and Johannes
– Marko Sarstedt –
To Irma
– Erik Mooi –

About this Book
In the digital economy, data have become a valuable commodity, much in the way that oil is in the rest of the economy (Wedel and Kannan 2016). Data enable market researchers to obtain valuable and novel insights. There are many new sources of data, such as web traffic, social networks, sensors that track suppliers, customers and shipments, online surveys, and others. A Forbes (2015a) survey of senior executives reveals that 96 % of the respondents consider data-driven marketing crucial to success. Not surprisingly, data are valuable to companies who spend over $44 billion a year on obtaining insights (Statista.com 2017). So valuable are these insights that companies go to great lengths to conceal the findings. Apple, for example, is known to carefully hide that it conducts a great deal of research, as the insights from this enable the company to gain a competitive advantage (Heisler 2012).

                This book is about being able to supply such insights. It is a valuable skill for which there are abundant jobs. Forbes (2015b) shows that IBM, Cisco, and Oracle alone have more than 25,000 unfilled data analysis positions. Davenport and Patil (2012) label data scientists
                The Sexiest Job of the 21st Century
                .
              

                This book introduces market research, using commonly used quantitative techniques such as regression analysis, factor analysis, and cluster analysis. These statistical methods have generated findings that have significantly shaped the way we see the world today. If you search for market(ing) research books on Google or Amazon, you will find that there is no shortage of such books. However, this book differs in many important ways:
                	
                      This book is a bridge between the theory of conducting quantitative research and its execution, using the market research process as a framework. We discuss market research, starting off by identifying the research question, designing the data collection process, collecting, and describing data. We also introduce essential data analysis techniques and the basics of communicating the results, including a discussion on ethics. Each chapter on quantitative methods describes key theoretical choices and how these are executed in SPSS. Unlike most other books, we do not discuss theory
                      or
                      application, but link the two.
                    

	This is a book for non-technical readers! All chapters are written in an accessible and comprehensive way so that readers without a profound background in statistics can also understand the introduced data analysis methods. Each chapter on research methods includes examples to help the reader gain a hands-on feeling for the technique. Each chapter concludes with an illustrated case that demonstrates the application of a quantitative method.

	To facilitate learning, we use a single case study throughout the book. This case deals with a customer survey of a fictitious company called Oddjob Airways (familiar to those who have seen the James Bond movie Goldfinger). We also provide additional end-of-chapter cases, including different datasets, thus allowing the readers to practice what they have learnt. Other pedagogical features, such as keywords, examples, and end-of-chapter questions, support the contents.

	This book is concise, focusing on the most important aspects that a market researcher, or manager interpreting market research, should know.

	Many chapters provide links to videos, further readings, and other websites. We also include a comprehensive Web Appendix with information on additional analysis techniques and datasets.

	
                      The book makes use of the Springer Nature More Media App (
                      http://​www.​springer.​com/​gp/​marketing/​springer-multimedia-app
                      ), which allows you to scan an image tagged with the Play Button and stream videos directly to your mobile device. The App allows saving the documents on your device and keeps track of your 50 most recently accessed media. This unique merger of offline and online content offers readers a broad spectrum of additional and readily accessible information. You can download the Springer Nature More Media App from the Apple App Store or from Google Play.
                    

	
                      Lastly, we have set up a Facebook page called
                      Market Research: The Process, Data, and Methods
                      . This page provides a platform for discussions and the exchange of market research ideas.
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How to Use this Book

                  The following will help you read this book:
                  	
                        Variable and file names in the main text appear in
                        italics
                        to distinguish them from the descriptions.
                      

	
                        Items from SPSS’s interface are shown in
                        bold
                        , with successive menu options separated. For example, the text could read: “Go to ► Analyze ► Descriptive Statistics ► Frequencies and enter the variables
                        s1, s2
                        , and
                        s3
                        into the
                        Variable(s)
                        box.” This means that the word
                        Variable(s)
                        appears in the SPSS interface.
                      

	
                        Keywords also appear in
                        bold
                        when they first appear in the main text. We have used many keywords to help you find everything quickly and define them in the glossary at the end of the book. Secondary keywords that are only in the index list appear in
                        italics
                        .
                      

	
                        If you see “► Web Appendix → Downloads” in the book, please go to
                        https://​www.​guide-market-research.​com
                        and click on Downloads.
                      

	All chapters include different types of boxes and text elements that highlight important aspects, contain tips (e.g., on using SPSS more efficiently), or offer further information for the interested reader.




                
For Instructors

                  Besides the benefits described above, this book is also designed to make teaching as easy as possible when using this book. Each chapter comes with a set of detailed and professionally designed PowerPoint slides for educators, tailored for this book, which can be easily adapted to fit a specific course’s needs. These are available on the website’s instructor resources page at
                  http://​www.​guide-market-research.​com
                  . You can gain access to the instructor’s page by requesting login information under Instructor Resources.
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The book’s web appendices are freely available on the accompanying website and provide supplementary information on analysis techniques not covered in the book and datasets. Moreover, at the end of each chapter, there is a set of questions that can be used for in-class discussions.

                  We also designed a separate website at
                  http://​www.​oddjobairways.​com
                  , which includes background information on the company and videos for teaching and learning (e.g., on experiments and different interviews techniques). We plan on further extending the website, so visit the site regularly.
                
If you have any remarks, suggestions, or ideas about this book, please drop us a line at erik.mooi@unimelb.edu.au (Erik Mooi) or at marko.sarstedt@ovgu.de (Marko Sarstedt). We appreciate any feedback on the book’s concept and contents!

Marko Sarstedt
Erik A. Mooi
Magdeburg, GermanyParkville, VIC, Australia

What’s New in the Third Edition?

                We’ve revised the third edition thoroughly. Some of the major changes compared to the second edition are:
                	
                      The third edition comes in a new design template, which allowed us to implement further
                      pedagogical elements
                      , such as excurses, tips, case studies, and review questions. We also organized chapters in a more reader-friendly way, with more sections to facilitate navigation.
                    

	
                      Learning market research vocabulary is essential for understanding the topic. We therefore added a
                      glossary
                      in which we define each keyword. Descriptions offer further information on selected topics.
                    

	
                      To facilitate learning, the third edition uses a
                      single case study
                      throughout the book. This case deals with a customer survey of a fictitious company called Oddjob Airways. All illustrations of statistical methods draw on this one example. We also designed a separate website at
                      http://​www.​oddjobairways.​com
                      , which includes background information on the company and videos for teaching and learning.
                    

	
                      We fully revised the sections on
                      survey design
                      , which now covers the latest research on survey administration (e.g., smartphones and tablets), item generation (e.g., item content and wording), and the properties of different scale types.
                    

	
                      The third edition contains substantial
                      new material
                      to reflect the
                      latest research
                      on each topic. There is additional content in the context of regression analysis (e.g., model selection via information criteria), factor analysis (e.g., further details on the similarities and differences between principal component analysis and principal axis factoring), cluster analysis (e.g., sample size recommendations), results communication (e.g., how to present statistical data), and many more.
                    

	
                      All the examples have been updated and now use
                      SPSS 25
                      . All the material reflects this new version of the program.
                    




              


Acknowledgments
Thanks to all the students who have inspired us with their feedback and constantly reinforce our choice to stay in academia. We have many people to thank for making this book possible. First, we would like to thank Springer, and particularly Barbara Fess and Ruth Milewski for all their help and for their willingness to publish this book. Ilse Evertse has done a wonderful job (again!) proofreading the chapters. She is a great proofreader and we cannot recommend her enough! Drop her a line atstpubus@gmail.com if you need proofreading help. In addition, we would like to thank the team of current and former doctoral students and research fellows at the Otto-von-Guericke-University, namely Kati Barth, Janine Dankert, Frauke Kühn, Sebastian Lehmann, Marcel Lichters, Doreen Neubert, Mandy Pick, Victor Schliwa, and Fiorella Vera. Finally, we would like to acknowledge the many insights and suggestions provided by many our colleagues and students. We would like to thank the following:

                Ralf Aigner
                of Wishbird, Mexico City, Mexico
              

                Carolin Bock
                of Technische Universität Darmstadt, Darmstadt, Germany
              

                Cees J. P. M. de Bont
                of Hong Kong Polytechnic, Hung Hom, Hong Kong
              

                Bernd Erichson
                of Otto-von-Guericke-Universität Magdeburg, Magdeburg, Germany
              

                Andrew M. Farrell
                of Southhampton University, Southampton, UK
              

                Sebastian Fuchs
                of BMW Group, München, Germany
              

                David I. Gilliland
                of Colorado State University, Fort Collins, CO, USA
              

                Joe F. Hair Jr.
                of University of South Alabama, Mobile, AL, USA
              

                Jörg Henseler
                of University of Twente, Enschede, The Netherlands
              

                Alok Kumar
                of University of Nebraska–Lincoln, Lincoln, NE, USA
              

                Emile F. J. Lancée
                of Vrije Universiteit Amsterdam, Amsterdam, The Netherlands
              

                Peter S.H. Leeflang
                of University of Groningen, Groningen, The Netherlands
              

                Tim F. Liao
                of University of Illinois Urbana-Champaign, USA
              

                Marcel Lichters
                of Otto-von-Guericke-Universität Magdeburg, Magdeburg, Germany
              

                Arjen van Lin
                of Vrije Universiteit Amsterdam, Amsterdam, The Netherlands
              

                Leonard J. Paas
                of Massey University, Albany, New Zealand
              

                Sascha Raithel
                of FU Berlin, Berlin, Germany
              

                Edward E. Rigdon
                of Georgia State University, Atlanta, GA, USA
              

                Christian M. Ringle
                of Technische Universität Hamburg-Harburg, Hamburg, Germany
              

                John Rudd
                of Warwick University, Coventry, UK
              

                Sebastian Scharf
                of Campus M21, München, Germany
              

                Tobias Schütz
                of ESB Business School Reutlingen, Reutlingen, Germany
              

                Philip Sugai
                of International University of Japan, Minami-Uonuma, Niigata, Japan
              

                Charles R. Taylor
                of Villanova University, Philadelphia, PA, USA
              

                Andrés Trujillo-Barrera
                of Wageningen University & Research
              

                Stefan Wagner
                of European School of Management and Technology, Berlin, Germany
              

                Eelke Wiersma
                of Vrije Universiteit Amsterdam, Amsterdam, The Netherlands
              

                Caroline Wiertz
                of Cass Business School, London, UK
              

                Michael Zyphur
                of University of Melbourne, Parkville, Australia
              
References

                  Davenport, T. H., & Patil, D. J. (2012). Data scientist. The sexiest job of the 21st century.
                  Harvard Business Review, 90
                  (October), 70–76.
                

                  Forbes (2015a). Data driven and customer centric: Marketers turning insights into impact.
                  http://​www.​forbes.​com/​forbesinsights/​data-driven_​and_​customer-centric/​
                  . Accessed 03 May 2018.
                

                  Forbes (2015b). Where big data jobs will be in 2016.
                  http://​www.​forbes.​com/​sites/​louiscolumbus/​2015/​11/​16/​where-big-data-jobs-will-be-in-2016/​#68fece3ff7f1/​
                  . Accessed 03 May 2018.
                

                  Heisler, Y. (2012). How Apple conducts market research and keeps iOS source code locked down.
                  Networkworld
                  .
                  http://​www.​networkworld.​com/​article/​2222892/​wireless/​how-apple-conducts-market-research-and-keeps-ios-source-code-locked-down.​html
                  . Accessed 03 May 2018.
                

                  Statista.com. (2017). Market research industry/market – Statistics & facts.
                  https://​www.​statista.​com/​topics/​1293/​market-research/​
                  . Accessed 03 May 2018.
                

                  Wedel, M., & Kannan, P. K. (2016). Marketing analytics for data-rich environments.
                  Journal of Marketing, 80
                  (6), 97–121.
                


About the Authors
Marko Sarstedt

                  [image: ../images/210704_3_En_BookFrontmatter_Fig3_HTML.jpg]

                  is chaired professor of Marketing at the Otto-von-Guericke-University Magdeburg (Germany). His main research is in the application and advancement of structural equation modeling methods to further the understanding of consumer behavior and to improve marketing decision-making. His research has been published in journals such as Journal of Marketing Research, Journal of the Academy of Marketing Science, Organizational Research Methods, MIS Quarterly, and International Journal of Research in Marketing. Marko has co-edited several special issues of leading journals and co-authored several widely adopted textbooks, including “A Primer on Partial Least Squares Structural Equation Modeling (PLS-SEM)” (together with Joe F. Hair, G. Tomas M. Hult, and Christian M. Ringle).
                
Erik Mooi

                  [image: ../images/210704_3_En_BookFrontmatter_Fig4_HTML.jpg]

                  Is senior lecturer at the University of Melbourne (Australia). His main interest is in business-to-business marketing and works on topics such as outsourcing, inter-firm contracting, innovation, technology licensing, and franchising using advanced econometrics. His research has been published in journals such as Journal of Marketing, the Journal of Marketing Research, the International Journal of Research in Marketing, and the Journal of Business Research. He is also program director at the Centre for Workplace Leadership, a fellow at the EU centre for shared complex challenges, as well as a fellow at the Centre for Business Analytics at Melbourne Business School.
                


Contents


                1 Introduction to Market Research
              1


                2 The Market Research Process
              11


                3 Data
              25


                4 Getting Data
              47


                5 Descriptive Statistics
              91


                6 Hypothesis Testing and ANOVA
              151


                7 Regression Analysis
              209


                8 Principal Component and Factor Analysis
              257


                9 Cluster Analysis
              301


                10 Communicating the Results
              355

Supplementary Information
Glossary378
Index392

              [image: ../images/210704_3_En_BookFrontmatter_Fig5_HTML.jpg]
            



© Springer-Verlag GmbH Germany, part of Springer Nature 2019
Marko Sarstedt and Erik MooiA Concise Guide to Market ResearchSpringer Texts in Business and Economicshttps://doi.org/10.1007/978-3-662-56707-4_1

1. Introduction to Market Research

Marko Sarstedt1  and Erik Mooi2
(1)Faculty of Economics and Management, Otto-von-Guericke- University Magdeburg, Magdeburg, Germany

(2)Department of Management and Marketing, The University of Melbourne, Parkville, VIC, Australia

 


1.1 Introduction
1.2 What Is Market and Marketing Research?
1.3 Market Research by Practitioners and Academics
1.4 When Should Market Research (Not) Be Conducted?
1.5 Who Provides Market Research?
1.6 Review Questions
References

Electronic supplementary material
The online version of this chapter (https://​doi.​org/​10.​1007/​978-3-662-56707-4_​1) contains additional material that is available to authorized users. You can also download the “Springer Nature More Media App” from the iOS or Android App Store to stream the videos and scan the image containing the “Play button”.
Learning Objectives
After reading this chapter, you should understand:	What market and marketing research are and how they differ.

	How practitioner and academic market(ing) research differ.

	When market research should be conducted.

	Who provides market research and the importance of the market research industry.
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1.1 Introduction
When Toyota developed the Prius—a highly fuel-efficient car using a hybrid petrol/electric engine—it took a gamble on a grand scale. Honda and General Motors’ previous attempts to develop frugal (electric) cars had not worked well. Just like Honda and General Motors, Toyota had also been working on developing a frugal car but focused on a system integrating a petrol and electric engine. These development efforts led Toyota to start the G21 project, which aimed at developing a car with a fuel economy that was at least 50 % better than similar-sized cars. This project nearly came to a halt in 1995 when Toyota encountered substantial technological problems. The company solved these problems, using nearly a thousand engineers, and launched the car, called the Prius, in Japan in 1997. Internal Toyota predictions suggested that the car was either going to be an instant hit, or that the product’s acceptance would be slow, as it takes time to teach dealers and consumers about the technology. In 1999, Toyota decided to start working on launching the Prius in the US. Initial market research showed that it was going to be a difficult task. Some consumers thought it was too small for the US and some thought the positioning of the controls was poor for US drivers. There were other issues too, such as the design, which many thought was too strongly geared towards Japanese drivers.
While preparing for the launch, Toyota conducted further market research, which could, however, not reveal who the potential car buyers would be. Initially, Toyota thought the car might be tempting for people concerned with the environment, but market research dispelled this belief. Environmentalists dislike technology in general and money is a big issue for this group. A technologically complex and expensive car such as the Prius was therefore unlikely to appeal to them. Additional market research did little to identify any other good market segment. Despite the lack of conclusive findings, Toyota decided to sell the car anyway and to await the public’s reaction. Before the launch, Toyota put a market research system in place to track the initial sales and identify where customers bought the car. After the formal launch in 2000, this system quickly found that celebrities were buying the car to demonstrate their concern for the environment. Somewhat later, Toyota noticed substantially increased sales figures when ordinary consumers became aware of the car’s appeal to celebrities. It appeared that consumers were willing to purchase cars that celebrities endorse.
CNW Market Research, a market research company specializing in the automotive industry, attributed part of the Prius’s success to its unique design, which clearly demonstrated that Prius owners were driving a different car. After substantial increases in the petrol price and changes to the car (based on extensive market research) to increase its appeal, Toyota’s total Prius sales reached about four million and the company is now the market leader in hybrid petrol/electric cars.
This example shows that while market research occasionally helps, sometimes it contributes little, or even fails. There are many reasons for market research’s success varying. These reasons include the budget available for research, the support for market research in the organization, the implementation, and the market researchers’ research skills. In this book, we will guide you step by step through the practicalities of the basic market research process. These discussions, explanations, facts, and methods will help you carry out successful market research.
1.2 What Is Market and Marketing Research?
Market research can mean several things. It can be the process by which we gain insight into how markets work. Market research is also a function in an organization, or it can refer to the outcomes of research, such as a database of customer purchases, or a report that offers recommendations. In this book, we focus on the market research process, starting by identifying and formulating the problem, continuing by determining the research design, determining the sample and method of data collection, collecting the data, analyzing the data, interpreting, discussing, and presenting the findings, and ending with the follow-up.
Some people consider marketing research and market research to be synonymous, whereas others regard these as different concepts. The American Marketing Association (AMA)
                
              , the largest marketing association in North America, defines marketing research as follows:
The function that links the consumer, customer, and public to the marketer through information—information used to identify and define marketing opportunities and problems; generate, refine, and evaluate marketing actions; monitor marketing performance; and improve understanding of marketing as a process. Marketing research specifies the information required to address these issues, designs the method for collecting information, manages and implements the data collection process, analyzes the results, and communicates the findings and their implications (American Marketing Association 2004).
On the other hand, ESOMAR
                
              , the world organization for market, consumer and societal research, defines market research as:
The systematic gathering and interpretation of information about individuals and organisations. It uses the statistical and analytical methods and techniques of the applied social, behavioural and data sciences to generate insights and support decision-making by providers of goods and services, governments, non-profit organisations and the general public. (ICC/ESOMAR 2016).
Both definitions overlap substantially, but the AMA definition focuses on marketing research as a function (e.g., a department in an organization), whereas the ESOMAR definition focuses on the process. In this book, we focus on the process and, thus, on market research.
1.3 Market Research by Practitioners and Academics
Practitioners and academics are both involved in marketing and market research. Academic and practitioner views of market(ing) research differ in many ways, but also have many communalities.
There is, however, a key difference in their target groups. Academics almost exclusively undertake research with the goal of publishing in academic journals. Highly esteemed journals include the Journal of Marketing, Journal of Marketing Research, Journal of the Academy of Marketing Science, and the International Journal of Research in Marketing. Such Journals emphasize methodological rigor and consistency. Academic journals are often difficult to read and understand, while practitioner reports should be easy to read. Moreover, practitioners’ target group is the client, whose needs and standards include relevance, practicality, generalizability, and timeliness of insights.
Academics and practitioners differ greatly in their use of and focus on methods. Practitioners have adapted and refined some of the methods, such as cluster analysis and factor analysis, which academics developed originally.1 Developing methods is often a goal in itself for academics. Practitioners are more concerned about the value of applying specific methods. Standards also differ. Clear principles and professional conduct as advocated by ESOMAR and the AMSRS (for examples, see https://​www.​esomar.​org/​uploads/​public/​knowledge-and-standards/​codes-and-guidelines/​ICCESOMAR-International-Code_​English.​pdf and https://​www.​amsrs.​com.​au/​professionalstan​dards/​code-of-professional-behaviour) mostly guide practitioners’ methods. Universities and schools sometimes impose data collection and analysis standards on academics, but these tend not to have the level of detail advocated by ESOMAR or the AMSRS. Interestingly, many practitioners claim that their methods meet academic standards, but academics never claim that their methods are based on practitioner standards.
Besides these differences, there are also many similarities. For example, good measurement is paramount for academics and practitioners. Furthermore, academics and practitioners should be interested in each other’s work; academics can learn much from the practical issues that practitioners faced, while practitioners can gain much from understanding the tools, techniques, and concepts that academics develop. Reibstein et al. (2009), who issued an urgent call for the academic marketing community to focus on relevant business problems, underlined the need to learn from each other. Several other researchers, such as Lee and Greenley (2010), Homburg et al. (2015), and Tellis (2017), have echoed this call.
1.4 When Should Market Research (Not) Be Conducted?
Market research serves several useful roles in organizations. Most importantly, market research can help organizations by providing answers to questions firms may have about their customers and competitors; answers that could help such firms improve their performance. Specific questions related to this include identifying market opportunities, measuring customer satisfaction, and assessing market shares. Some of these questions arise ad hoc, perhaps due to issues that the top management, or one of the departments or divisions, has identified. Much market research is, however, programmatic; it arises because firms systematically evaluate market elements. Subway, the restaurant chain, systematically measures customer satisfaction, which is an example of programmatic research. This type of research does not usually have a distinct beginning and end (contrary to ad hoc research), but is executed continuously over time and leads to daily, weekly, or monthly reports.
The decision to conduct market research may be made when managers face an uncertain situation and when the costs of undertaking good research are (much) lower than good decisions’ expected benefits. Researching trivial issues or issues that cannot be changed is not helpful.
Other issues to consider are the politics within the organization because if the decision to go ahead has already been made (as in the Prius example in the introduction), market research is unnecessary. If market research is conducted and supports the decision, it is of little value—and those undertaking the research may have been biased in favor of the decision. On the other hand, market research is ignored if it rejects the decision.
Moreover, organizations often need to make very quick decisions, for example, when responding to competitive price changes, unexpected changes in regulation, or to the economic climate. In such situations, however, market research may only be included after decisions have already been made. Consequently, research should typically not be undertaken for urgent decisions.
1.5 Who Provides Market Research?
Many organizations have people, departments, or other companies working for them to provide market research. In Fig. 1.1, we show who these providers of market research are.[image: ../images/210704_3_En_1_Chapter/210704_3_En_1_Fig1_HTML.png]
Fig. 1.1The providers of market research



Most market research is provided internally by specialized market research departments, or people tasked with this function. It appears that about 75 % of organizations have at least one person tasked with carrying out market research. This percentage is similar in most industries, although it is much less in government sectors and, particularly, in health care (Churchill and Iacobucci 2015).
In larger organizations, a sub-department of the marketing department usually undertakes internally provided market research. Sometimes this sub-department is not connected to a marketing department, but to other organizational functions, such as corporate planning or sales (Rouziès and Hulland 2014). Many large organizations even have a separate market research department. This system of having a separate market research department, or merging it with other departments, seems to become more widespread, with the marketing function devolving increasingly into other functions within organizations (Sheth and Sisodia 2006).
The external providers of market research are a powerful economic force. In 2015, the Top 50 external providers had a collective turnover of about $21.78 billion (Honomichl 2016). The market research industry has also become a global field with companies such as The Nielsen Company (USA), Kantar (UK), GfK (Germany), and Ipsos (France), playing major roles outside their home markets. External providers of market research are either full-service providers or limited-service providers.
Full-service providers
                
               are large market research companies such as The Nielsen Company (http://​www.​nielsen.​com), Kantar (http://​www.​kantar.​com), and GfK (http://​www.​gfk.​com). These large companies provide syndicated data and customized services. Syndicated data
                
               are data collected in a standard format and not specifically collected for a single client. These data, or analyses based on the data, are then sold to multiple clients. Large marketing research firms mostly collect syndicated data, as they have the resources to collect large amounts of data and can spread the costs of doing so over a number of clients. For example, The Nielsen Company collects syndicated data in several forms: Nielsen’s Netratings, which collects information on digital media; Nielsen Ratings, which details the type of consumer who listens to the radio, watches TV, or reads print media; and Nielsen Homescan, which collects panel information on the purchases consumers make. These large firms also offer customized services by conducting studies for a specific client. These customized services can be very specific, such as helping a client carry out specific analyses.
Nielsen’s Total Audience Measurement
In today’s media environment, consumers have endless options for consuming their favorite content, and it's fundamentally changing the business of TV, advertising, and measurement. The need for fair comparisons between digital and TV is greater than ever. Nielsen’s Total Audience Measurement provides metrics that enable comparability between traditional viewing on a television set and media consumption that occurs on other devices and platforms. These metrics allow marketers to compare their options to put their ads in front of the right consumer, on the right platform, at the right time.
In the following video, Jessica Hogue, Senior Vice President of Product Leadership at Nielsen discusses the company’s Total Audience Measurement approach.[image: ../images/210704_3_En_1_Chapter/210704_3_En_1_Figa_HTML.png]
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Contrary to full-service providers, which undertake nearly all market research activities, limited-service providers
                
               specialize in one or more services and tend to be smaller companies. In fact, many of the specialized market research companies are one-man businesses and the owner—after (or beside) a practitioner or academic career—offers specialized services. Although there are many different types of limited-service firms, we only discuss three of them: those focused on segmentation, field service, and specialized services.
Segment specialists
                
               concentrate on specific market segments. Skytrax (http://​www.​airlinequality.​com/​), which focuses on market research in the airline and airport sector, is an example of such specialists. Other segment specialists do not focus on a particular industry, but on a type of customer; for example, Ethnic Focus (http://​www.​ethnicfocus.​com/​), a UK-based market research firm, focuses on understanding ethnic minorities.
Field service firms
                
              , such as Research Now SSI (http://​www.​surveysampling.​com/​), focus on executing surveys, determining samples, sample sizes, and collecting data. Some of these firms also translate surveys or provide addresses and contact details.
Specialized service firms
                
               are a catch-all term for those companies with specific technical skills, thus only focusing on specific products, or aspects of products, such as market research on taste and smell. Specialized firms may also concentrate on a few highly specific market research techniques, or may focus on one or more highly specialized analysis techniques, such as time series analysis, panel data analysis, or quantitative text analysis. Envirosell (http://​www.​envirosell.​com), a research and consultancy firm that analyzes consumer behavior in commercial environments, is a well-known example of a specialized service firm.
A choice between these full-service and limited-service market research firms boils down to a tradeoff between what they can provide (if this is highly specialized, you may not have much choice) and the price of doing so. In addition, if you have to combine several studies to gain further insight, full-service firms may be better than multiple limited-service firms. The fit and feel with the provider are obviously also highly important!
1.6 Review Questions

              	1.What is market research? Try to explain what market research is in your own words.

 

	2.Imagine you are the head of a division of Procter & Gamble. You are just about ready to launch a new shampoo but are uncertain about who might buy it. Is it useful to conduct a market research study? Should you delay the launch of the product?

 

	3.Please read the press excerpt Taco Bell issued on https://​www.​tacobell.​com/​news/​american-consumers-would-rather-pay-less. Do you feel retrospectively that, keeping the findings in mind, market research should have been conducted?

 

	4.Try to find the websites of a few market research firms. Look, for example, at the services provided by GfK and the Nielsen Company, and compare the extent of their offerings to those of specialized firms such as those listed on, for example, http://​www.​greenbook.​org


 

	5.If you have a specialized research question, such as what market opportunities there are for selling music to ethnic minorities, would you use a full-service or limited-service firm (or both)? Please discuss the benefits and drawbacks.
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© Springer-Verlag GmbH Germany, part of Springer Nature 2019
Marko Sarstedt and Erik MooiA Concise Guide to Market ResearchSpringer Texts in Business and Economicshttps://doi.org/10.1007/978-3-662-56707-4_2

2. The Market Research Process

Marko Sarstedt1  and Erik Mooi2
(1)Faculty of Economics and Management, Otto-von-Guericke- University Magdeburg, Magdeburg, Germany

(2)Department of Management and Marketing, The University of Melbourne, Parkville, VIC, Australia

 


2.1 Introduction
2.2 Identify and Formulate the Problem
2.3 Determine the Research Design
2.3.1 Exploratory Research
2.3.2 Uses of Exploratory Research
2.3.3 Descriptive Research
2.3.4 Uses of Descriptive Research
2.3.5 Causal Research
2.3.6 Uses of Causal Research
2.4 Design the Sample and Method of Data Collection
2.5 Collect the Data
2.6 Analyze the Data
2.7 Interpret, Discuss, and Present the Findings
2.8 Follow-Up
2.9 Review Questions
References

Electronic supplementary material
The online version of this chapter (https://​doi.​org/​10.​1007/​978-3-662-56707-4_​2) contains additional material that is available to authorized users. You can also download the “Springer Nature More Media App” from the iOS or Android App Store to stream the videos and scan the image containing the “Play button”.
Learning Objectives
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	The differences between exploratory research, descriptive research, and causal research.

	What causality is.

	The market research process.






Keywords
Causal research • Descriptive research • Ethnographies • Exploratory research • Field experiments • Focus groups • Hypotheses • In-depth interviews • Lab experiments • Market segments • Observational studies • Projective techniques • Research design • Scanner data • Test markets

2.1 Introduction
How do organizations plan for market research processes? In this chapter, we explore the market research process and various types of research. We introduce the planning of market research projects, starting with identifying and formulating the problem and ending with presenting the findings and the follow-up (see Fig. 2.1). This chapter is also an outline of the chapters to come.[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig1_HTML.png]
Fig. 2.1The market research process



2.2 Identify and Formulate the Problem
The first step in setting up a market research process involves identifying and formulating the research problem
                
              . Identifying the research problem is valuable, but also difficult. To identify the “right” research problem, we should first identify the marketing symptoms
                
               or marketing opportunities
                
              . The marketing symptom is a problem that an organization faces. Examples of marketing symptoms include declining market shares, increasing numbers of complaints, or new products that consumers do not adopt. In some cases, there is no real problem, but instead a marketing opportunity, such as the potential benefits that new channels and products offer, or emerging market opportunities that need to be explored. Exploring marketing symptoms and marketing opportunities require asking questions such as:	Why is our market share declining?

	Why is the number of complaints increasing?

	Why are our new products not successful?

	How can we enter the market for 3D printers?

	How can we increase our online sales?





The research problems that result from such questions can come in different forms. Generally, we distinguish three types of research problems
                
              :	Ambiguous problems,

	somewhat defined problems, and

	clearly defined problems.





Ambiguous problems occur when we know very little about the issues that need to be solved. For example, ambiguity often surrounds (if not clouds) the introduction of radically new technologies or products. When Toyota planned to launch the Prius many years ago, critical, but little understood, issues arose, such as the features that were essential and even who the potential buyers of such a car were.
When we face somewhat defined problems, we know the issues (and variables) that are important for solving the problem, but not how they are related. For example, when an organization wants to export products, it is relatively easy to obtain all sorts of information on market sizes, economic development, and the political and legal system. However, how these variables impact the exporting success may be very uncertain.
When we face clearly defined problems, the important issues and variables, as well as their relationships, are clear. However, we do not know how to make the best possible choice. We therefore face the problem of how the situation should be optimized. A clearly defined problem may arise when organizations want to change their prices. While organizations know that increasing (or decreasing) prices generally leads to decreased (increased) demand, the precise relationship (i.e., how many units do we sell less when the price is increased by $1?) is unknown.
2.3 Determine the Research Design
The research design
                
               is related to the identification and formulation of the problem. Research problems and research designs are interrelated. If we start working on an issue that has never been researched before, we seem to enter a funnel where we initially ask exploratory questions, because we as yet know little about the issues we face. These exploratory questions are best answered using an exploratory research design. Once we have a clearer picture of the research issue after our exploratory research, we move further into the funnel. Generally, we want to learn more by describing the research problem in terms of descriptive research. Once we have a reasonably complete picture of all the issues, it may be time to determine exactly how key variables are linked. We then move to the narrowest part of the funnel. We do this through causal (not casual!) research (see Fig. 2.2).[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig2_HTML.png]
Fig. 2.2The relationship between the marketing problem and the research design



Each research design has different uses and requires the application of different analysis techniques. For example, whereas exploratory research can help formulate problems exactly or structure them, causal research provides exact insights into how variables relate. In Fig. 2.3, we provide several examples of different types of research, which we will discuss in the following paragraphs.[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig3_HTML.png]
Fig. 2.3Uses of exploratory, descriptive, and causal research



2.3.1 Exploratory Research
As its name suggests, the objective of exploratory research
                  
                 is to explore a problem or situation. As such, exploratory research has several key uses regarding the solving of ambiguous problems. It can help organizations formulate their problems exactly. Through initial research, such as interviewing potential customers, the opportunities and pitfalls may be identified that help determine or refine the research problem. It is crucial to discuss this information with the client to ensure that your findings are helpful. Such initial research also helps establish priorities (what is nice to know and what is important to know?) and eliminate impractical ideas. For example, market research helped Toyota dispel the belief that people concerned with the environment would buy the Prius, as this target group has an aversion to high technology and lacks spending power.
2.3.2 Uses of Exploratory Research
Exploratory research can be used to formulate problems precisely. For example, focus groups, in-depth interviews, projective techniques, observational studies, and ethnographies are often used to achieve this. In the following, we briefly introduce each technique and provide more detailed descriptions in Chap.​ 4.
Focus groups
                  
                 usually have between 6 and 10 participants, who discuss a defined topic under the leadership of a moderator. The key difference between a depth interview and focus group is that focus group participants can interact with one another (e.g., “What do you mean by … ?,” “How does this differ from … .”), thereby providing insight into group dynamics.
In-depth interviews
                  
                 consist of an interviewer asking an interviewee several questions. In-depth interviews allow probing on a one-to-one basis, which fosters interaction between the interviewer and the respondent. In-depth interviews are required when the topic needs to be adjusted for each interviewee, for sensitive topics, and/or when the person interviewed has high status.
Projective techniques
                  
                 present people with pictures, words, or other stimuli to which they respond. For example, a researcher could ask what people think of BMW owners (“A BMW owner is someone who … .”) or could show them a picture of a BMW and ask them what they associate the picture with. Moreover, when designing new products, market researchers can use different pictures and words to create analogies to existing products and product categories, thus making the adoption of new products more attractive (Feiereisen et al. 2008).
Observational studies
                  
                 are frequently used to refine research questions and clarify issues. Observational studies require an observer to monitor and interpret participants’ behavior. For example, someone could monitor how consumers spend their time in shops or how they walk through the aisles of a supermarket. These studies require a person, a camera or other tracking devices, such as radio frequency identification (RFID) chips, to monitor behavior. Other observational studies may comprise click stream data that track information on the web pages people have visited. Observational studies can also be useful to understand how people consume and/or use products. New technology is being developed in this area, for example, market research company Almax (also see Chap.​ 4) has developed the EyeSee Mannequin, which helps observe who is attracted by store windows and reveals important details about customers, such as their age range, gender, ethnicity, and dwell time.
In the award-winning paper “An Exploratory Look at Supermarket Shopping Paths,” Larson et al. (2005) analyze the paths individual shoppers take in a grocery store, which the RFID tags located on their shopping carts provide. The results provide new perspectives on many long-standing perceptions of shopper travel behavior within a supermarket, including ideas related to aisle traffic, special promotional displays, and perimeter shopping patterns (Fig. 2.4). Before this study, most retailers believed that customers walked through the aisles systematically. Larson et al.’s (2005) research reveals this rarely happens.[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig4_HTML.jpg]
Fig. 2.4Supermarket shopping paths



Ethnographies
                  
                 (or ethnographic studies) originate from anthropology. In ethnographic research, a researcher interacts with consumers over a period to observe and ask questions. Such studies can consist of, for example, a researcher living with a family to observe how they buy, consume, and use products. For example, the market research company BBDO used ethnographies to understand consumers’ rituals. The company found that many consumer rituals are ingrained in consumers in certain countries, but not in others. For example, women in Colombia, Brazil, and Japan are more than twice as likely to apply make-up when in their cars, than women in other countries. Miele, a German whitegoods producer, used ethnographies to understand how people with allergies do their washing and developed washing machines based on the insights gathered (Burrows 2014).
Exploratory research can also help establish research priorities. What is important to know and what is less important? For example, a literature search may reveal that there are useful previous studies and that new market research is not necessary. Exploratory research may also lead to the elimination of impractical ideas. Literature searches, just like interviews, may again help eliminate impractical ideas.
Another helpful aspect of exploratory research is the generation of hypotheses
                  
                . A hypothesis is a claim made about a population, which can be tested by using sample results. For example, one could hypothesize that at least 10 % of people in France are aware of a certain product. Marketers frequently suggest hypotheses, because they help them structure and make decisions. In Chap.​ 6, we discuss hypotheses and how they can be tested in greater detail.
Another use of exploratory research is to develop measurement scales. For example, what questions can we use to measure customer satisfaction? What questions work best in our context? Do potential respondents understand the wording, or do we need to make changes? Exploratory research can help us answer such questions. For example, an exploratory literature search may use measurement scales that tell us how to measure important concepts such as corporate reputation and service quality.
2.3.3 Descriptive Research
As its name implies, descriptive research
                  
                 is all about describing certain phenomena, characteristics, or functions. It can focus on one variable (e.g., profitability) or on two or more variables at the same time (“what is the relationship between market share and profitability?” and “how does temperature relate to the sale of ice cream?”). Descriptive research often builds on previous exploratory research. After all, to describe something, we must have a good idea of what we need to measure and how we should measure it. Key ways in which descriptive research can help us include describing customers, competitors, market segments, and measuring performance.
2.3.4 Uses of Descriptive Research
Market researchers conduct descriptive research for many purposes. These include, for example, describing customers or competitors. For instance, how large is the UK market for pre-packed cookies? How large is the worldwide market for cruises priced $10,000 and more? How many new products did our competitors launch last year? Descriptive research helps us answer such questions. Much data are available for descriptive purposes, particularly on durable goods and fast moving consumer goods. One source of such data are scanner data
                  
                , which are collected at the checkout of a supermarket where details about each product sold are entered into a vast database. By using scanner data, it is, for example, possible to describe the market for pre-packed cookies in the UK.
Descriptive research is frequently used to define market segments
                  
                , or simply segments. Since companies can seldom connect with all their (potential) customers individually, they divide markets into groups of (potential) customers with similar needs and wants. Firms can then target each of these segments by positioning themselves in a unique segment (such as Ferrari in the high-end sports car market). Many market research companies specialize in market segmentation; an example is Claritas, which developed a segmentation scheme for the US market called Claritas MyBestSegments. This segments consumers along a multitude of attitudinal, behavioral, and demographic characteristics; companies can use these segments to better target their customers. Segments have names, such as Young Digerati (tech-savvy singles and couples living in fashionable urban fringe neighborhoods) and Heartlanders (older couples with working-class jobs living in unpretentious homes who prefer a rustic lifestyle).
Another important function of descriptive market research is to measure performance. Nearly all companies regularly track their sales across specific product categories to evaluate the performance of the firm, the managers, or specific employees. Such descriptive work overlaps with the finance or accounting departments’ responsibilities. However, market researchers also frequently measure performance using measures that are quite specific to marketing, such as share of wallet (i.e., how much do people spend on a certain brand or company in a product category?) and brand awareness (i.e., do you know brand/company X?), or the Net Promotor Score, a customer loyalty metric for brands or firms (see Chap.​ 3 for more information).
2.3.5 Causal Research
Causal research
                  
                 is used to understand the relationships between two or more variables. For example, we may wish to estimate how changes in the wording of an advertisement impact recall. Causal research provides exact insights into how variables relate and may be useful as a test run to try out changes in the marketing mix. Market researchers undertake causal research less frequently than exploratory or descriptive research. Nevertheless, it is important to understand the delicate relationships between important marketing variables and the outcomes they help create. The key usage of causal research is to uncover causality
                  
                . Causality is the relationship between an event (the cause) and a second event (the effect) when the second event is a consequence of the first. To claim causality, we need to meet the following four requirements:	Relationship between cause and effect,

	time order,

	controlling for other factors, and

	an explanatory theory.





First, the cause needs to be related to the effect. For example, if we want to determine whether price increases cause sales to drop, there should be a negative relationship or correlation between price increases and sales decreases (see Chap.​ 5). Note that people often confuse correlation and causality. Just because there is some type of relationship between two variables does not mean that the one caused the other (see Box 2.1).
Second, the cause needs to come before the effect. This is the requirement of time order. A price increase can obviously only have a causal effect on the sales if it occurred before the sales decrease.
Third, we need to control for other factors. If we increase the price, sales may go up, because competitors increase their prices even more. Controlling for other factors is difficult, but not impossible. In experiments, we design studies so that external factors’ effect is nil, or as close to nil as possible. This is achieved by, for example, conducting experiments in labs where environmental factors, such as the conditions, are constant (controlled for). We can also use statistical tools that account for external influences to control for other factors. These statistical tools include an analysis of variance (see Chap.​ 6), regression analysis (see Chap.​ 7), and structural equation modeling (see the end of Chap.​ 8).
Fourth, the need for a good explanatory theory is an important criterion. Without a theory, our effects may be due to chance and no “real” effect may be present. For example, we may observe that when we advertise, sales decrease. Without a good explanation of this effect (such as people disliking the advertisement), we cannot claim that there is a causal relationship.
Box 2.1 Correlation does not automatically imply causation
Correlation does not automatically imply causality. For example, Fig. 2.5 plots US fatal motor vehicle crashes (per 100,000 people) against the harvested area of melons (in 1000 acres) between 2000 and 2015.[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig5_HTML.png]
Fig. 2.5Correlation and causation (the data were taken from the NHTSA Traffic Safety Facts, DOT HS 810 780, and the United States Department of Agriculture, National Agricultural Statistics Service)



Clearly, the picture shows a trend. If the harvested area of melons increases, the number of US fatal motor vehicle crashes increases. The resulting correlation of 0.839 is very high (we discuss how to interpret correlations in Chap.​ 5). While this correlation is the first requirement to determine causality, the story falls short when it comes to explanatory theory. What possible mechanism could explain the findings? This is likely a case of a spurious correlation
                    
                  , which is simply due to coincidence.
In the above situation, most people would be highly skeptical and would not interpret the correlation as describing a causal mechanism; in other instances, the situation is much less clear-cut. Think of claims that are part of everyday market research, such as “the new advertisement campaign caused a sharp increase in sales,” “our company’s sponsorship activities helped improve our company’s reputation,” or “declining sales figures are caused by competitors’ aggressive price policies.” Even if there is a correlation, the other requirements for causality may not be met. Causal research helps us determine if causality can be claimed.
Some of these and other examples can be found in Huff (1993) or on Wikipedia (https://​en.​wikipedia.​org/​wiki/​Correlation_​does_​not_​imply_​causation). Furthermore, check http://​www.​tylervigen.​com/​spurious-correlations for more entertaining examples of spurious correlations—see also Vigen (2015).[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Figa_HTML.png]
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2.3.6 Uses of Causal Research
Experiments are a key type of causal research and come in the form of either lab or field experiments.
Lab experiments
                  
                 are performed in controlled environments (usually in a company or academic lab) to isolate the effects of one or more variables on a certain outcome. To do so, researchers impose a treatment (e.g., a new advertisement) that induces changes in one variable (e.g., the type of advertising appeal) and evaluate its impact on an outcome variable (e.g., product choice). Field experiments
                  
                 are like lab experiments in that they examine the impact of one or more variables on a certain outcome. However, field experiments are conducted in real-life settings (not set up in controlled environments), thus reducing (or even eliminating) plausible claims of causality (Gneezy 2017). On the plus side, their realism makes them attractive for market research purposes, as the observed effects can probably be generalized to similar settings. For example, isi (https://​www.​isi-goettingen.​de/​en), a German sensory market research company, regularly runs product acceptance tests in which consumers sequentially evaluate different products, interrupted by short breaks to neutralize their senses. These tests are traditionally run in sensory labs under controlled conditions. However, isi also runs field experiments in actual consumption environments. Fig. 2.6 shows a photo of a field experiment the company ran in a coffeehouse to evaluate consumer ratings of different cappuccino products. We discuss experimental set-ups in more detail in Chap.​ 4.[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig6_HTML.jpg]
Fig. 2.6Field experiment (© isi GmbH)



Field experiments are not always a good idea. In the city of Rotterdam, the local council tried to reduce bike accidents by turning the traffic lights at bike crossings at a very busy intersection green at the same time. While the idea was that bicyclists would pay more attention, it took less than a minute for two accidents to happen. Needless to say, the experiment was canceled. (see https://​www.​youtube.​com/​watch?​v=​QIsLSmbfaiQ, in Dutch only).
Test markets
                  
                 are a form of field experiment in which organizations in a geographically defined area introduce new products and services, or change the marketing mix to gauge consumer reactions. Test markets help marketers learn about consumer response, thus reducing the risks of a nationwide rollout of new products/services or changes in the marketing mix. For example, gps dataservice (http://​www.​gps-dataservice.​de/​en) runs several test markets for a series of major European retailers to evaluate the effect of treatments, such as new product launches, price changes, promotions, or product placements, on purchasing behavior. The company uses data from scanners, customer cards, and other sources (e.g., surveys, observations) to investigate their effects on sales. For example, shelf tests
                  
                 involve placing dummy packages in the usual shelves in selected stores, and determining the reactions to these new packages by means of shopper observations (e.g., eye or physical contact with the product; Fig. 2.7), surveys, and scanner data. In Chap.​ 4, we discuss test markets in more depth.[image: ../images/210704_3_En_2_Chapter/210704_3_En_2_Fig7_HTML.jpg]
Fig. 2.7Shelf test (© IWD market research GmbH)



2.4 Design the Sample and Method of Data Collection
Having determined the research design, we need to design a sampling plan and choose a data-collecting method. This involves deciding whether to use existing (secondary) data or to conduct primary research. We discuss this in more detail in Chap.​ 3.
2.5 Collect the Data
Collecting data is a practical, but sometimes difficult, part of the market research process. How do we design a survey? How do we measure attitudes toward a product, brand, or company if we cannot observe these attitudes directly? How do we get CEOs to respond? Dealing with such issues requires careful planning and knowledge of the marketing process. We discuss related key issues in Chap.​ 4.
2.6 Analyze the Data
Analyzing data requires technical skills. We discuss how to enter, clean, and describe data in Chap.​ 5. After this, we introduce key techniques, such as hypothesis testing and analysis of variance (ANOVA), regression analysis, principal component analysis, factor analysis, and cluster analysis in Chap.​ 6–9. In each of these chapters, we discuss the key theoretical choices and issues that market researchers face when using these techniques. We also illustrate how researchers can practically deal with these theoretical choices and issues by means of SPSS.
2.7 Interpret, Discuss, and Present the Findings
When executing the market research process, researchers’ immediate goals are interpreting, discussing, and presenting the findings. Consequently, researchers should provide detailed answers and actionable suggestions based on data and analysis techniques. The last step is to clearly communicate the findings and recommendations to help decision making and implementation. This is further discussed in Chap.​ 10.
2.8 Follow-Up
Market researchers often stop when the results have been interpreted, discussed, and presented. However, following up on the research findings is important too. Implementing market research findings sometimes requires further research, because suggestions or recommendations may not be feasible or practical and market conditions may have changed. From a market research firm’s perspective, follow-up research on previously conducted research can be a good way of entering new deals for further research. Some market research never ends, for example, many firms track customer satisfaction continuously, but such research can also have specific follow-ups, for example, because the management may wish to know the causes of drops in customer satisfaction.
2.9 Review Questions

              	1.Why do we follow a structured process when conducting market research? Are there any shortcuts you can take? Compare, for example, Qualtrics’ market research process (http://​www.​qualtrics.​com/​blog/​marketing-research-process) with the process discussed above. What are the similarities and differences?

 

	2.Describe what exploratory, descriptive, and causal research is and how they are related to one another. Provide an example of each type of research.

 

	3.What are the four requirements for claiming causality? Do we meet these requirements in the following situations?	Good user design led to Google’s Android becoming the market leader.

	When Rolex charges a higher price, this increases sales.

	More advertising causes greater sales.
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3.1 Introduction
Data are at the heart of market research. By data we mean a collection of facts that can be used as a basis for analysis, reasoning, or discussions. Think, for example, of people’s answers to surveys, existing company records, or observations of shoppers’ behaviors. “Good” data are vital because they form the basis of useful market research. In this chapter, we discuss different types of data. This discussion will help you explain the data you use and why you do so. Subsequently, we introduce strategies for collecting data in Chap.​ 4.
3.2 Types of Data
Before we start discussing data, it is a good idea to introduce the terminology we will use. In the next sections, we will discuss the following four concepts:	Variables,

	constants,

	cases, and

	constructs.





A variable
                
               is an attribute whose value can change. For example, the price of a product is an attribute of that product and generally varies over time. If the price does not change, it is a constant
                
              . A case
                
               (or observation
                
              ) consists of all the variables that belong to an object such as a customer, a company, or a country.
The relationship between variables and cases is that within one case we usually find multiple variables. Table 3.1 includes five variables: car type, age, as well as brand_1, brand_2, and brand_3, which capture statements related to brand trust. In the lower rows, you see four observations.Table 3.1Quantitative data


	Variable name
	
                          Car type
                        
	
                          Customer’s age
                        
	
                          brand_1
                        
	
                          brand_2
                        
	
                          brand_3
                        

	Description
	Type of car bought
	Customer’s age in years
	This brand’s product claims are believable
	This brand delivers what it promises
	This brand has a name that you can trust

	Customer 1
	BMW 328i
	29
	6
	5
	7

	Customer 2
	Mercedes C180K
	45
	6
	6
	6

	Customer 3
	VW Passat 2.0 TFSI
	35
	7
	5
	5

	Customer 4
	BMW 525ix
	61
	5
	4
	5


Coding for brand_1, brand_2, and brand_3: 1 = fully disagree, 7 = fully agree




Another important and frequently used term in market research is construct, which refers to a variable that is not directly observable (i.e., a latent variable
                
              ). More precisely, a construct is used to represent latent concepts in statistical analyses. Latent concepts
                
               represent broad ideas or thoughts about certain phenomena that researchers have established and want to measure in their research (e.g., Bollen 2002). However, constructs cannot be measured directly, as respondents cannot articulate a single response that will completely and perfectly provide a measure of that concept. For example, constructs such as satisfaction, loyalty, and brand trust cannot be measured directly. However, we can measure satisfaction, loyalty, and brand trust by means of several items
                
              . The term items (or indicators
                
              ) is normally used to indicate posed survey questions. Measuring constructs requires combining items to form a multi-item scale
                
              , an example of which appears in Table 3.1 in the form of three items brand_1 (This brand’s product claims are believable), brand_2 (This brand delivers what it promises), and brand_3 (This brand has a name that you can trust). Bear in mind that not all items relate to constructs; for example, the variables car type and age in Table 3.1 are not constructs, as these are observable and a single response can measure it accurately and fully.
Like constructs, an index
                
               also consists of sets of variables. The difference is that an index is created by the variable’s “causes.” For example, we can create an index of information search activities, which is the sum of the information that customers acquire from dealers, the promotional materials, the Internet, and other sources. This measure of information search activities is also referred to as a composite measure
                
              , but, unlike a construct, the items in an index define what we want to measure. For example, the Retail Price Index consists of a “shopping” bag of common retail products multiplied by their price. Unlike a construct, each item in a scale captures a part of the index perfectly.
The procedure of combining several items is called scale development
                
              , operationalization
                
              , or, in the case of an index, index construction
                
              . These procedures involve a combination of theory and statistical analysis, such as factor analysis (discussed in Chap.​ 8) aimed at developing an appropriate construct measure. For example, in Table 3.1, brand_1, brand_2, and brand_3 are items that belong to a construct called brand trust (as defined by Erdem and Swait 2004). The construct is not an individual item that you see in the list, but it is captured by calculating the average of several related items. Thus, in terms of brand trust, the score of customer 1 is (6 + 5 + 7)/3 = 6.
But how do we decide which and how many items to use when measuring specific constructs? To answer these questions, market researchers make use of scale development procedures. These procedures follow an iterative process with several steps and feedback loops. For example, DeVellis (2017) provides a thorough introduction to scale development. Unfortunately, scale development requires much (technical) expertise. Describing each step is therefore beyond this book’s scope. However, many scales do not require this procedure, as existing scales can be found in scale handbooks, such as the Handbook of Marketing Scales by Bearden et al. (2011). Furthermore, marketing and management journals frequently publish research articles that introduce new scales or indices, such as for measuring the reputation of non-profit organizations (e.g., Sarstedt and Schloderer 2010) or for refining existing scales (e.g., Kuppelwieser and Sarstedt 2014). In Box 3.1, we introduce two distinctions that are often used to discuss constructs.
Box 3.1 Types of constructs
In reflective constructs
                  
                , the items are considered to be manifestations of an underlying construct (i.e., the items reflect the construct). Our brand trust example suggests a reflective construct, as the items reflect trust. Thus, if a respondent changes his assessment of brand trust (e.g., due to a negative brand experience), this is reflected in the answers to the three items. Reflective constructs typically use multiple items (3 or more) to increase the measurement stability and accuracy. If we have multiple items, we can use analysis techniques to inform us about the measurement quality, such as factor analysis and reliability analysis (discussed in Chap.​ 8). Formative constructs
                  
                 consist of several items that define a construct. A typical example is socioeconomic status, which is formed by a combination of education, income, occupation, and residence. If any of these measures increases, the socioeconomic status would increase (even if the other items did not change). Conversely, if a person’s socioeconomic status increases, this would not necessarily go hand in hand with an increase in all four measures. The distinction between reflective and formative constructs is that they require different approaches to decide on the type and number of items. For example, reliability analyses (discussed in Chap.​ 8) should not be run on formative measures (Diamantopoulos 2006). For an overview of this distinction, see Bollen and Diamantopoulos (2017), Diamantopoulos et al. (2008), or Sarstedt et al. (2016c).
Instead of using multiple items to measure constructs (i.e., multi-item constructs
                  
                ), researchers and practitioners frequently use single items (i.e., single-item constructs
                  
                ). For example, we may only use “This brand has a name that you can trust” to measure brand trust, instead of using three items. A popular single-item measure is the Net Promoter Score (NPS)
                  
                , which aims to measure loyalty by using the single question: “How likely are you to recommend our company/product/service to a friend or colleague?” (Reichheld 2003). While this is a good way of making the questionnaire shorter, it also reduces the quality of your measures (e.g., Diamantopoulos et al. 2012; Sarstedt et al. 2016a, b). You should therefore avoid using single items to measure constructs unless you only need a rough proxy measure of a latent concept.[image: ../images/210704_3_En_3_Chapter/210704_3_En_3_Figa_HTML.png]
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3.2.1 Primary and Secondary Data
Generally, we can distinguish between primary data and secondary data. While primary data are data that a researcher has collected for a specific purpose, another researcher collected the secondary data for another purpose.
The US Consumer Expenditure Survey (www.​bls.​gov/​cex), which makes data available on what people in the US buy, such as insurance, personal care items, and food, is an example of secondary data. It also includes the prices people pay for these products and services. Since these data have already been collected, they are secondary data. If a researcher sends out a survey with various questions to find an answer to a specific issue, the collected data are primary data. If primary data are re-used to answer another research question, they become secondary data.
Secondary and primary data have their own specific advantages and disadvantages, which we illustrate in Table 3.2. The most important reasons for using secondary data are that they tend to be cheaper and quick to obtain access to (although lengthy processes may be involved). For example, if you want to have access to the US Consumer Expenditure Survey, all you have to do is to use your web browser to go to www.​bls.​gov/​cex and to download the required files. However, the authority and competence of some research organizations could be a factor. For example, the claim that Europeans spend 9 % of their annual income on health may be more believable if it comes from Eurostat (the statistical office of the European Community) rather than from a single, primary research survey.Table 3.2The advantages and disadvantages of secondary and primary data


	 	Secondary data
	Primary data

	Advantages
	– Tend to be cheaper
– Sample sizes tend to be greater
– Tend to have more authority
– Are usually quick to access
– Are easier to compare to other research using the same data
– Are sometimes more accurate (e.g., data on competitors)
	– Are recent
– Are specific for the purpose
– Are proprietary

	Disadvantages
	– May be outdated
– May not fully fit the problem
– There may be hidden errors in the data – difficult to assess the data quality
– Usually contain only factual data
– No control over data collection
– May not be reported in the required form (e.g., different units of measurement, definitions, aggregation levels of the data)
	– Are usually more expensive
– Take longer to collect





However, important secondary data drawbacks are that they may not answer your research question. If you are, for example, interested in the sales of a specific product (and not in a product or service category), the US Consumer Expenditure Survey may not help much. In addition, if you are interested in the reasons for people buying products, this type of data may not help answer your question. Lastly, as you did not control the data collection, there may be errors in the data.
In contrast, primary data tend to be highly specific, because the researcher (you!) can influence what the research comprises. In addition, research to collect primary data can be carried out when and where required and competitors cannot access it. However, gathering primary data often requires much time and effort and is therefore usually expensive compared to secondary data.
As a rule, start looking for secondary data first. If they are available, and of acceptable quality, use them! We will discuss ways to gather primary and secondary data in Chap.​ 4.
3.2.2 Quantitative and Qualitative Data
Data can be quantitative or qualitative. Quantitative data
                  
                 are presented in values, whereas qualitative data are not. Qualitative data
                  
                 can take many forms, such as words, stories, observations, pictures, and audio. The distinction between qualitative and quantitative data is not as black-and-white as it seems. Quantitative data may be the result of quantifying qualitative data. For example, Twitter feeds or Facebook posts, produce qualitative data. Market researchers can code attributes of the data, which describe a particular characteristic, thereby turning it into quantitative data. Think, for example, of how people respond to a new product in an interview. We can code the data by setting neutral responses to 0, somewhat positive responses to 1, positive responses to 2, and very positive responses to 3. We have therefore turned qualitative data into quantitative data. Box 3.2 shows an example of how to code qualitative data. Also see Chap.​ 5 for more information on qualitative coding.
Qualitative data’s biggest strength is their richness, as they have the potential to offer detailed insights into respondents’ perceptions, attitudes, and intentions. However, their downside is that qualitative data can be interpreted in many ways. Thus, the process of interpreting qualitative data is subjective. To reduce subjectivity, (multiple) trained researchers should code qualitative data. The distinction between quantitative and qualitative data is closely related to that between quantitative and qualitative research, which we discuss in Box 3.3. Most people think of quantitative data as being more factual and precise than qualitative data, but this is not necessarily true. Rather, how well qualitative data have been collected and/or coded into quantitative data is important.
Box 3.2 Coding qualitative data
In 2016 Toyota launched new Prius, the Prius Prime (www.​toyota.​com/​priusprime/​) and Facebook reactions were divided. Here are some examples of Facebook posts:	“Love it! But why only 2 seats at the back? Is there any technical reason for that?”

	“Wondering if leather seats are offered? The shape of the seats looks super comfy!”

	“Here’s that big black grill on yet another Toyota. Will be very glad when this ‘fashion faze’ is over.”





One way of structuring these responses is to consider the attributes mentioned in the posts. After reading them, you may find that, for example, the seat and styling are attributes. You can then categorize in respect of each post whether the response was negative, neutral, or positive. If you add the actual response, this can later help identify the aspect the posts liked (or disliked). As you can see, we have now turned qualitative data into quantitative data!	Attribute
	Negative
	Neutral
	Positive

	Seats
	1-why only two seats?
	2-are leather seats offered?
	2-shape looks super comfy!

	Styling
	3-big black grill
	 	1-love it!





Box 3.3 Quantitative research
                    
                   and qualitative research
                    
                  

Market researchers often label themselves as either quantitative or qualitative researchers. The two types of researchers use different methodologies, different types of data, and focus on different research questions. Most people regard the difference between qualitative and quantitative as the difference between numbers and words, with quantitative researchers focusing on numbers and qualitative researchers on words. This distinction is not accurate, as many qualitative researchers use numbers in their analyses. The distinction should instead depend on when the information is quantified. If we know the values that may occur in the data even before the research starts, we conduct quantitative research. If we only know this after the data have been collected, we conduct qualitative research. Think of it in this way: If we ask survey questions and use a few closed questions, such as “Is this product of good quality?,” and the respondents can either choose “Completely disagree,” “Somewhat disagree,” “Neutral,” “Somewhat agree,” and “Completely agree,” we know that the data we will obtain from this will—at most—contain five different values. Because we know all possible values beforehand, the data are quantified beforehand. If, on the other hand, we ask someone “Is this product of good quality?,” he or she could give many different answers, such as “Yes,” “No,” “Perhaps,” “Last time yes, but lately … ”. This means we have no idea what the possible answer values are. Therefore, these data are qualitative. We can, however, recode these qualitative data, for example, as described in Box 3.2, and assign values to each response. Thus, we quantify the data, allowing further statistical analysis.
Qualitative research accounts for 15 % of money spent in the market research industry, with quantitative research making up the rest (ESOMAR 2017). Practically, market research is often hard to categorize as qualitative or quantitative, as it may include elements of both. Research that includes both elements is sometimes called hybrid market research
                    
                  , fused market research
                    
                  , or simply mixed methodology
                    
                  .
3.3 Unit of Analysis
The unit of analysis
                
               is the level at which a variable is measured. Researchers often ignore this aspect, but it is crucial because it determines what we can learn from the data. Typical measurement levels include that of the respondents, customers, stores, companies, or countries. It is best to use data at the lowest possible level, because this provides more detail. If we need these data at another level, we can aggregate them. Aggregating data
                
               means that we sum up a variable at a lower level to create a variable at a higher level. For example, if we know how many cars all car dealers in a country sell, we can take the sum of all the dealer sales, to create a variable measuring countrywide car sales. Aggregation is not possible if we have incomplete or missing data at the lower levels.
3.4 Dependence of Observations
A key issue for any data is the degree to which observations are related, or the dependence of observations. If we have exactly one observation from each individual, store, company, or country, we label the observations independent. That is, the observations are unrelated. If we have multiple observations of each individual, store, company, or country, we label them dependent. For example, we could ask respondents to rate a type of Cola, then show them an advertisement, and again ask them to rate the same type of Cola. Although the advertisement may influence the respondents, it is likely that the first response and second response will be related. That is, if the respondents first rated the Cola negatively, the chance is higher that they will continue to rate the Cola negative rather than positive after the advertisement. If the observations are dependent, this often impacts the type of analysis we should use. For example, in Chap.​ 6, we discuss the difference between the independent samples t-test (for independent observations
                
              ) and the paired samples t-test (for dependent observations).
3.5 Dependent and Independent Variables
Dependent variables represent the outcome that market researchers study, while independent variables
                
               are those used to explain the dependent variable(s). For example, if we use the amount of advertising to explain sales, then advertising is the independent variable and sales the dependent.
This distinction is artificial, as all variables depend on other variables. For example, the amount of advertising depends on how important the product is for a company, the company’s strategy, and other factors. However, this distinction is frequently used in the application of statistical methods. When researching relationships between variables, we, on the basis of theory and practical considerations, need to distinguish between the dependent and the independent variables beforehand.
3.6 Measurement Scaling
Not all data are equal! For example, we can calculate the respondents’ average age in Table 3.1. However, if we would have coded the color of a car as black = 1, blue = 2, silver = 3 it would not make any sense to calculate the average. Why is this? The values that we have assigned 1, 2, and 3 are arbitrary; we could just as well have changed these value for any other. Therefore, choosing a different coding would lead to different results, which is meaningless. Measurement scaling
                
               refers to two things: the variables we use for measuring a certain construct (see discussion above) and the level at which a variable is measured, which we discuss in this section. This can be highly confusing! There are four levels of measurement


                
              :	Nominal scale,

	ordinal scale,

	interval scale, and

	ratio scale.





These scales relate to how we quantify what we measure. It is vital to know the scale on which something is measured, because, as the gender example above illustrates, the measurement scale determines the analysis techniques we can, or cannot, use. For example, if the consumer preference for the color of an airline seat is coded as blue = 0, black = 1, brown = 2, it makes no sense to calculate respondents’ average preference. We will return to this issue in Chap.​ 5 and beyond. However, even when we know the scale, be aware that, as Fig. 3.1 shows, meaningful calculations are not always possible![image: ../images/210704_3_En_3_Chapter/210704_3_En_3_Fig1_HTML.jpg]
Fig. 3.1Meaningless! (Picture by MikeGogulski)



The nominal scale
                
               is the most basic level at which we can measure something. Essentially, if we use a nominal scale, we substitute a word for a numerical value. For example, we could code the color of each Prius sold: black = 1, blue = 2, silver = 3. In this example, the numerical values represent nothing more than a label.
The ordinal scale
                
               provides more information. If a variable is measured on an ordinal scale, increases or decreases in values give meaningful information. For example, if we code the Prius version people bought as the first generation = 1, second generation = 2, third generation = 3, and fourth generation = 4, we know whether the model is more recent. The ordinal scale provides information about the order of our observations. However, we do not know if the differences in the order are equally spaced. That is, we do not know if the difference between first generation and second generation is the same as between second and third generation, even though the difference in values (1–2 and 2–3) is equal.
If something is measured on an interval scale
                
              , we have precise information on the rank order at which something is measured and we can interpret the magnitude of the differences in values directly. For example, if the temperature in a car showroom is 23°C, we know that if it drops to 20°C, the difference is exactly 3°C. This difference of 3°C is the same as the increase from 23 to 26°C. This exact “spacing” is called equidistance
                
              . Equidistant scales are necessary for some analysis techniques, such as factor analysis (discussed in Chap.​ 8). What the interval scale does not give us, is an absolute zero point. If the temperature is 0°C it may feel cold, but the temperature can drop further. The value of 0 does not therefore mean that there is no temperature at all.
The ratio scale
                
               provides the most information. If something is measured on a ratio scale, we know that a value of 0 means that that the attribute of that particular variable is not present. For example, if a dealer sells zero Prius cars (value = 0) then he or she really sells none. Or, if we spend no money on advertising a Prius (value = 0), we really spend no money. Therefore, the origin of the variable is equal to 0.
While it is relatively easy to distinguish between the nominal and the interval scales, it is sometimes hard to see the difference between the interval and the ratio scales. The difference between the interval and the ratio scales can be ignored in most statistical methods. Table 3.3 shows the differences between the four scales we just discussed.Table 3.3Measurement Scaling


	 	Label
	Order
	Differences
	Origin is 0

	Nominal scale
	✓
	 	 	 
	Ordinal scale
	✓
	✓
	 	 
	Interval scale
	✓
	✓
	✓
	 
	Ratio scale
	✓
	✓
	✓
	✓





3.7 Validity and Reliability
In any market research process, it is paramount to use “good” measures. Good measures are those that measure what they are supposed to measure and do so consistently. For example, if we are interested in knowing whether customers like a new TV commercial, we could show a commercial and ask the following two questions afterwards:	1.“Did you enjoy watching the commercial?,” and

 

	2.“Did the commercial provide the essential information required for a purchase decision?”

 





How do we know if these questions really measure whether or not the viewers liked the commercial? We can think of this as a measurement problem through which we relate what we want to measure—whether existing customers like a new TV commercial—with what we actually measure in terms of the questions we ask. If these relate perfectly, our actual measurement is equal to what we intend to measure and we have no measurement error. If these do not relate perfectly, we have measurement error
                
              .
This measurement error can be divided into a systematic error
                
               and a random error
                
              . We can express this as follows, where XO stands for the observed score (i.e., what the customers indicated), XT for the true score (i.e., what the customers’ true liking of the commercial is), ES for the systematic error, and ER for the random error.[image: 
$${X_O} = {X_T} + {E_S} + {E_R}$$
]





The systematic error is a measurement error through which we consistently measure higher or lower than we want to measure. If we were to ask customers, for example, to evaluate a TV commercial and offer them remuneration in return, they may provide more favorable information than they would otherwise have. This may cause us to think that the TV commercial is systematically more enjoyable than it is in reality. There may also be random errors. Some customers may be having a good day and indicate that they like a commercial, whereas others, who are having a bad day, may do the opposite.
Systematic errors cause the actual measurement to be consistently higher or lower than what it should be. On the other hand, random error causes (random) variation between what we actually measure and what we want to measure.
The systematic and random error concepts are important because they relate to a measure’s validity and reliability. Validity
                
               refers to whether we are measuring what we want to measure and, therefore, to a situation where the systematic error ES is small. Reliability
                
               is the degree to which what we measure is free from random error and therefore relates to a situation where the ER is zero. In Fig. 3.2, we illustrate the difference between reliability and validity by means of a target comparison. In this analogy, different measurements (e.g., of a customer’s satisfaction with a specific service) are compared to arrows shot at a target. To measure each score, we have five measurements (indicated by the black circles), which correspond to, for example, questions asked in a survey. The cross indicates their average. Validity describes the cross’s proximity to the bull’s eye at the target center. The closer the average to the true score, the higher the validity. If several arrows are fired, reliability is the degree to which the arrows are apart. If all the arrows are close together, the measure is reliable, even though it is not necessarily near the bull’s eye. This corresponds to the upper left box where we have a scenario in which the measure is reliable, but not valid. In the upper right box, both reliability and validity are given. In the lower left box, though, we have a situation in which the measure is neither reliable nor valid. This is obviously because the repeated measurements are scattered around and the average does not match the true score. However, even if the latter were the case (i.e., if the cross were in the bull’s eye), we would still not consider the measure valid. An unreliable measure can never be valid. If we repeated the measurement, say, five more times, the random error would probably shift the cross to a different position. Reliability is, therefore, a necessary condition for validity. This is also why the scenario that is not reliable/valid (lower right box) is not included, as it is not possible for a measure to be valid but not reliable.[image: ../images/210704_3_En_3_Chapter/210704_3_En_3_Fig2_HTML.png]
Fig. 3.2Validity and reliability



3.7.1 Types of Validity
For some variables, such as length or income, we can objectively verify what the true score is. For constructs, such as satisfaction, loyalty and brand trust, this is impossible. From a philosophical point of view, one could even argue that there is no “true” score for a construct. So how do we know if a measure is valid? Because there is no objective way of verifying what we are measuring, several forms of validity have been developed, including face, content, predictive, criterion, and discriminant validity (Netemeyer et al. 2003). Researchers frequently summarize these validity types under the umbrella term construct validity
                  
                , which relates to the correspondence between a measure at the conceptual level and a purported measure. The different types of validity help us understand the association between what we should measure and what we actually measure, thereby increasing the likelihood of adequately measuring the latent concept under consideration.	Face validity
                        
                       is an absolute minimum requirement for a variable to be valid and refers to whether a variable reflects what you want to measure. Essentially, face validity subjectively assesses if a measure makes sense. For example, if you want to measure trust, using items such as “this company is honest and truthful” makes a lot of sense, whereas “this company is not well known” makes little sense. Researchers should agree on face validity before starting the actual measurement. Face validity is usually determined by using a sample of experts who discuss and agree on the degree of face validity (this is also referred to as expert validity
                        
                      ).

	Content validity
                        
                       is strongly related to face validity but is more formalized. To assess content validity, researchers need to first define what they want to measure and discuss what is included in the definition and what not. For example, trust between businesses is often defined as the extent to which a firm believes that its exchange partner is honest and/or benevolent (Geyskens et al. 1998). This definition clearly indicates what should be mentioned in the questions used to measure trust (honesty and benevolence). After researchers have defined what they want to measure, items have to be developed that relate closely to the definition. Consequently, content validity is mostly achieved prior to the actual measurement.

	Predictive validity
                        
                       requires a measure to be highly correlated (see Chap.​ 5 for an introduction to correlations) with an outcome variable, measured at a later point in time, to which it is conceptually strongly related. For example, loyalty should lead to people purchasing a product in the future. Similarly, a measure of satisfaction should be predictive future purchases. Assessing predictive validity requires collecting data at two points in time and therefore requires a greater effort. If both measures (i.e., the one to be evaluated and the outcome variable) are measured at the same point in time, we call this criterion validity
                        
                      .

	Discriminant validity
                        
                       ensures that a measure is empirically unique and represents phenomena of interest that other measures in a model do not capture (e.g., Henseler et al. 2015). For example, customer satisfaction and customer loyalty are two distinct latent concepts. Discriminant validity requires the constructs used to measure these two concepts to also be empirically distinct (i.e., they should not correlate too highly).

	Nomological validity
                        
                       is the degree to which a construct behaves as it should in a system of related constructs. For example, customer expectations, perceived quality, and value have a significant influence on customer satisfaction. Similarly, satisfaction generally relates positively to customer loyalty. As such, you would expect the measure of satisfaction that you are evaluating to correlate with this measure.





3.7.2 Types of Reliability
How do we know if a measure is reliable? Three key factors are used to assess reliability: test-retest reliability, internal consistency reliability, and inter-rater reliability (Mitchell and Jolley 2013).
Test–retest reliability
                  
                 means that if we measure something twice (also called the stability of the measurement
                  
                ), we expect similar outcomes. The stability of measurement requires a market researcher to have collected two data samples, is therefore costly, and could prolong the research process. Operationally, researchers administer the same test to the same sample on two different occasions and evaluate how strongly the measurements are correlated. We would expect the two measurements to correlate highly if a measure is reliable. This approach is not without problems, as it is often hard, if not impossible, to survey the same people twice. Furthermore, respondents may learn from past surveys, leading to practice effects
                  
                . In addition, it may be easier to recall events the second time a survey is administered. Moreover, test–retest approaches do not work if a survey concentrates on specific time points. If we ask respondents to provide information on their last restaurant experience, the second test might relate to a different restaurant experience. Thus, test–retest reliability can only be assessed in terms of variables that are stable over time.
Internal consistency reliability
                  
                 is by far the most common way of assessing reliability. Internal consistency reliability requires researchers to simultaneously use multiple items to measure the same concept. Think, for example, of the set of questions commonly used to measure brand trust (i.e., “This brand’s product claims are believable,” “This brand delivers what it promises,” and “This brand has a name that you can trust”). If these items relate strongly, there is a considerable degree of internal consistency. There are several ways to calculate indices of internal consistency, including split-half reliability and Cronbach’s α (pronounced as alpha), which we discuss in Chap.​ 8.
Inter-rater reliability
                  
                 is used to assess the reliability of secondary data or qualitative data. If you want to identify, for example, the most ethical organizations in an industry, you could ask several experts to provide a rating and then calculate the degree to which their answers relate.
3.8 Population and Sampling
A population
                
               is the group of units about which we want to make judgments. These units can be groups of individuals, customers, companies, products, or just about any subject in which you are interested. Populations can be defined very broadly, such as the people living in Canada, or very narrowly, such as the directors of large hospitals in Belgium. Both the conducted research and the research goal determine the population’s structure.
Sampling
                
               is the process by which we select cases from a population. The most important aspect of sampling is that the selected sample is representative of the population. Representative means that the characteristics of the sample closely match those of the population. In Box 3.4, we discuss how to determine whether a sample is representative of the population. When we develop a sampling strategy, we have three key choices:

              	Census,

	probability sampling, and

	non-probability sampling.




            
If we are lucky and somehow manage to include every unit of the population in our study, we have conducted a census
                
              . Thus, strictly speaking, this is not a sampling strategy. Census studies are rare, because they are very costly and because missing just a small part of the population can have dramatic consequences. For example, if we were to conduct a census study of directors of Luxemburg banks, we may miss a few because they were too busy to participate. If these busy directors happen to be those of the very largest companies, any information we collect would underestimate the effects of variables that are more important at large banks. Census studies work best if the population is small, well-defined, and accessible. Sometimes census studies are also conducted for specific reasons. For example, the US Census Bureau is required to hold a census of all people resident in the US every 10 years. Check out the US Census Bureau’s YouTube channel (Box 3.5) to find out more about the US Census Bureau.
If we select part of the population, we can distinguish two types of approaches: probability sampling and non-probability sampling. Fig. 3.3 provides an overview of the different sampling procedures, which we will discuss in the following sections.[image: ../images/210704_3_En_3_Chapter/210704_3_En_3_Fig3_HTML.png]
Fig. 3.3Sampling procedures



Box 3.4 Do I have a representative sample
                  
                ?
It is important for market researchers that their sample is representative of the population. How can we determine whether this is so?	The best way to test whether the sample relates to the population is to use a database with information on the population (or to draw the sample from such databases). For example, the Amadeus database (https://​www.​bvdinfo.​com/​) provides information on public and private companies around the world at the population level. We can (statistically) compare the information from these databases to the selected sample. However, this approach can only support the tested variables’ representativeness; that is, the specific representativeness
                        
                      . Conversely, global representativeness
                        
                      —that is, matching the distribution of all the characteristics of interest to the research question, but which lie outside their scope—cannot be achieved without a census (Kaplan 1964).

	You can use (industry) experts to judge the quality of your sample. They may look at issues such as the type and proportion of organizations in your sample and population.

	To check whether the responses of people included in your research differ significantly from those of non-respondents (which would lead to your sample not being representative), you can use the Armstrong and Overton procedure
                        
                      . This procedure calls for comparing the first 50 % of respondents to the last 50 % in respect of key demographic variables. The idea behind this procedure is that later respondents more closely match the characteristics of non-respondents. If these differences are not significant (e.g., through hypothesis tests, discussed in Chap.​ 6), we find some support for there being no significant response bias (see Armstrong and Overton 1977). When the survey design includes multiple waves (e.g., the first wave of the survey is web-based and the second wave is by phone), this procedure is generally amended by comparing the last wave of respondents in a survey design to the earlier waves. There is some evidence that this procedure is better than Armstrong and Overton’s original procedure (Lindner et al. 2001).

	Using follow-up procedures, a small sample of randomly chosen non-respondents can again be contacted to request their cooperation. This small sample can be compared against the responses obtained earlier to test for differences.





Box 3.5 The US census

                [image: ../images/210704_3_En_3_Chapter/210704_3_En_3_Figb_HTML.png]
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3.8.1 Probability Sampling
Probability sampling
                  
                 approaches provide every individual in the population with a chance (not equal to zero) of being included in the sample (Levy and Lemeshow 2013). This is often achieved by using an accurate sampling frame
                  
                , which is a list of individuals in the population. There are various sampling frames, such as Dun & Bradstreet’s Selectory database (includes executives and companies), the Mint databases (includes companies in North and South America, Italy, Korea, the Netherlands, and the UK), and telephone directories. These sampling frames rarely cover the population of interest completely and often include outdated information, but are frequently used due to their ease of use and availability. If the sampling frame and population are very similar, we have little sampling error
                  
                , which is the degree to which sample frames represent the population. Starting with a good-quality sampling frame, we can use several methods to select units from it (Sarstedt et al. 2018).
The easiest way is to use simple random sampling
                  
                , which is achieved by randomly selecting the number of cases required. This can be achieved by using specialized software.
Systematic sampling
                  
                 uses a different procedure. We first randomize the order of all the observations, number them and, finally, select every nth observation. For example, if our sampling frame consists of 1000 firms and we wish to select just 100 firms, we could select the 1st observation, the 11th, the 21st, etc. until we reach the end of the sampling frame and have our 100 observations.
Stratified sampling and cluster sampling are more elaborate techniques of probability sampling requiring us to divide the sampling frame into different groups. When we use stratified sampling
                  
                , we divide the population into several homogeneous groups called strata
                  
                . These strata are based on key sample characteristics, such as different departments in organizations, or the areas in which consumers live. Subsequently, we draw a random number of observations from each stratum. While stratified sampling is more complex and requires accurate knowledge of the sampling frame and population, it also helps ensure that the sampling frame’s characteristics are similar to those of the sample.
Cluster sampling
                  
                 requires dividing the population into different heterogeneous groups, with each group’s characteristics similar to those of the population. For example, we can divide a country’s consumers into different provinces, counties, and councils. Several of these groups could have key characteristics (e.g., income, political preference, household composition) in common, which are very similar (representative of) to those of the population. We can select one or more of these representative groups and use random sampling to select observations that represent this group. This technique requires knowledge of the sampling frame and population, but is convenient because gathering data from one group is cheaper and less time-consuming.
Generally, all probability sampling methods allow for drawing representative samples from the target population. However, simple random sampling and stratified sampling are considered superior in terms of drawing representative samples. For a detailed discussion, see Sarstedt et al. (2018).
3.8.2 Non-probability Sampling
Non-probability sampling
                  
                 procedures do not give every individual in the population an equal chance of being included in the sample (Levy and Lemeshow 2013). This is a drawback because the resulting sample is most certainly not representative of the population, which may bias the subsequent analyses’ results. Nevertheless, non-probability sampling procedures are frequently used as they are easily executed, and are normally less costly than probability sampling methods. Popular non-probability sampling procedures include judgmental sampling, snowball sampling, and quota sampling (Sarstedt et al. 2018).
Judgmental sampling
                  
                 is based on researchers taking an informed guess regarding which individuals should be included. For example, research companies often have panels of respondents who are continuously used in research. Asking these people to participate in a new study may provide useful information if we know, from experience, that the panel has little sampling frame error.
Snowball sampling
                  
                 involves existing study participants to recruit other individuals from among their acquaintances. Snowball sampling is predominantly used if access to individuals is difficult. People such as directors, doctors, and high-level managers often have little time and are, consequently, difficult to involve. If we can ask just a few of them to provide the names and the details of others in a similar position, we can expand our sample quickly and then access them. Similarly, if you post a link to an online questionnaire on your LinkedIn or Facebook page (or send out a link via email) and ask your friends to share it with others, this is snowball sampling.
Quota sampling
                  
                 occurs when we select observations for the sample that are based on pre-specified characteristics, resulting in the total sample having the same distribution of characteristics assumed to exist in the population being studied. In other words, the researcher aims to represent the major characteristics of the population by sampling a proportional amount of each (which makes the approach similar to stratified sampling). Let’s say, for example, that you want to obtain a quota sample of 100 people based on gender. First, you need to find what proportion of the population is men and what women. If you find that the larger population is 40 % women and 60 % men, you need a sample of 40 women and 60 men for a total of 100 respondents. You then start sampling and continue until you have reached exactly the same proportions and then stop. Consequently, if you already have 40 women in your sample, but not yet 60 men, you continue to sample men and discard any female respondents that come along. However, since the selection of the observations does not occur randomly, this makes quota sampling a non-probability technique. That is, once the quota has been fulfilled for a certain characteristic (e.g., females), you no longer allow any observations with this specific characteristic in the sample. This systematic component of the sampling approach can introduce a sampling error. Nevertheless, quota sampling is very effective and inexpensive, making it the most important sampling procedure in practitioner market research.
Convenience sampling
                  
                 is a catch-all term for methods (including the three non-probability sampling techniques just described) in which the researcher draws a sample from that part of the population that is close at hand. For example, we can use mall intercepts
                  
                 to ask people in a shopping mall if they want to fill out a survey. The researcher’s control over who ends up in the sample is limited and influenced by situational factors.
3.8.3 Probability or Non-probability Sampling?
Probability sampling methods are recommended, as they result in representative samples. Nevertheless, judgmental and, especially, quota sampling might also lead to (specific) representativeness (e.g., Moser and Stuart 1953; Stephenson 1979). However, both methods’ ability to be representative depends strongly on the researcher’s knowledge (Kukull and Ganguli 2012). Only when the researcher considers all the factors that have a significant bearing on the effect under study, will these methods lead to a representative sample. However, snowball sampling never leads to a representative sample, as the entire process depends on the participants’ referrals. Likewise, convenience sampling will almost never yield a representative sample, because observations are only selected if they can be accessed easily and conveniently. See Sarstedt et al. (2018) for further details.
3.9 Sample Sizes
After determining the sampling procedure, we have to determine the sample size
                
              . Larger sample sizes increase the precision of the research but are also much more expensive to collect. The gains in precision decrease as the sample size increases (in Box 6.3 we discuss the question whether a sample size can be too large in the context of significance testing). It may seem surprising that relatively small sample sizes are precise, but the strength of samples comes from selecting samples accurately, rather their size. Furthermore, the required sample size has very little relation to the population size. That is, a sample of 100 employees from a company with 100,000 employees can be nearly as accurate as selecting 100 employees from a company with 1000 employees.
There are some problems with selecting sample sizes. The first is that market research companies often push their clients to accept large sample sizes. Since the fee for market research services, such as those offered by Qualtrics or Toluna, is often directly dependent on the sample size, increasing the sample size benefits the market research company. Second, if we want to compare different groups, we need to multiply the required sample by the number of groups included. That is, if 150 observations are sufficient to measure how much people spend on organic food, 2 times 150 observations are necessary to compare singles and couples’ expenditure on organic food.
The figures mentioned above are net sample sizes; that is, these are the actual (usable) number of observations we should have. Owing to non-response (discussed in Chaps.​ 4 and 5), a multiple of the initial sample size is normally necessary to obtain the desired sample size. Before collecting data, we should have an idea of the percentage of respondents we are likely to reach (often high), a percentage estimate of the respondents willing to help (often low), as well as a percentage estimate of the respondents likely to fill out the survey correctly (often high). For example, if we expect to reach 80 % of the identifiable respondents, and if 25 % are likely to help, and 75 % of those who help are likely to fully fill out the questionnaire, only 15 % (0.80 · 0.25 · 0.75) of identifiable respondents are likely to provide a usable response. Thus, if we wish to obtain a net sample size of 100, we need to send out[image: 
$\;\left( {\frac{{desired\;sample\;size}}{{likely\;usable\;responses}}} \right)\,\, = \,\,100/0.15 = 667{\kern 1pt} {\kern 1pt} {\kern 1pt} $
]surveys. In Chap.​ 4, we will discuss how we can increase response rates (the percentage of people willing to help).
3.10 Review Questions

              	1.Explain the difference between items and constructs.

 

	2.What is the difference between reflective and formative constructs?

 

	3.Explain the difference between quantitative and qualitative data and give examples of each type.

 

	4.What is the scale on which the following variables are measured?	The amount of money a customer spends on shoes.

	A product’s country-of-origin.

	The number of times an individual makes a complaint.

	A test’s grades.

	The color of a mobile phone.






 

	5.Try to find two websites offering secondary data and discuss the kind of data described. Are these qualitative or quantitative data? What is the unit of analysis and how are the data measured?

 

	6.What are “good data”?

 

	7.Discuss the concepts reliability and validity. How do they relate to each other?

 

	8.Please comment on the following statement: “Face and content validity are essentially the same.”

 

	9.What is the difference between predictive and criterion validity?

 

	10.Imagine you have just been asked to execute a market research study to estimate the market for notebooks priced $300 or less. What sampling approach would you propose to the client?

 

	11.Imagine that a university decides to evaluate their students’ satisfaction. To do so, employees issue every 10th student at the student cafeteria on one weekday with a questionnaire. Which type of sampling is conducted in this situation? Can the resulting sample be representative of the student population?

 




            
References
	Armstrong, J. S., & Overton, T. S. (1977). Estimating nonresponse bias in mail surveys. Journal of Marketing Research, 14(3), 396–403.Crossref

	Bearden, W. O., Netemeyer, R. G., & Haws, K. L. (2011). Handbook of marketing scales. Multi-item measures for marketing and consumer behavior research (3rd ed.). Thousand Oaks, CA: Sage.Crossref

	Bollen, K. A. (2002). Latent variables in psychology and the social sciences. Annual Review of Psychology, 53(1), 605–634.Crossref

	Bollen, K. A., & Diamantopoulos, A. (2017). In defense of causal-formative indicators: A minority report. Psychological Methods, 22(3), 581–596.Crossref

	DeVellis, R. F. (2017). Scale development: Theory and applications (4th ed.). Thousand Oaks, CA: Sage.

	Diamantopoulos, A. (2006). The error term in formative measurement models: Interpretation and modeling implications. Journal of Modelling in Management, 1(1), 7–17.Crossref

	Diamantopoulos, A., Riefler, P., & Roth, K. P. (2008). Advancing formative measurement models. Journal of Business Research, 61(12), 1203–1218.Crossref

	Diamantopoulos, A., Sarstedt, M., Fuchs, C., Wilczynski, P., & Kaiser, S. (2012). Guidelines for choosing between multi-item and single-item scales for construct measurement: A predictive validity perspective. Journal of the Academy of Marketing Science, 40(3), 434–449.Crossref

	Erdem, T., & Swait, J. (2004). Brand credibility, brand consideration, and choice. Journal of Consumer Research, 31(1), 191–198.Crossref

	ESOMAR (2017). Global market research report. Available at: https://​www.​esomar.​org/​knowledge-center/​library?​publication=​2892.​Accessed 03 May 2018.

	Geyskens, I., Steenkamp, J.-B. E. M., & Kumar, N. (1998). Generalizations about trust in marketing channel relationships using meta-analysis. International Journal of Research in Marketing, 15(3), 223–248.Crossref

	Henseler, J., Ringle, C. M., & Sarstedt, M. (2015). A new criterion for assessing discriminant validity in variance-based structural equation modeling. Journal of the Academy of Marketing Science, 43(1), 115–135.Crossref

	Kaplan, A. (1964). The conduct of inquiry: San Francisco, CA: Chandler.

	Kukull, W. A., & Ganguli, M. (2012). Generalizability. The trees, the forest, and the low-hanging fruit. Neurology, 78(23), 1886–1891.Crossref

	Kuppelwieser, V., & Sarstedt, M. (2014). Confusion about the dimensionality and measurement specification of the future time perspective scale. International Journal of Advertising, 33(1), 113–136.Crossref

	Levy, P. S., & Lemeshow, S. (2013). Sampling of populations: Methods and applications (5th ed.). Hoboken, NJ: John Wiley & Sons.

	Lindner, J. R., Murphy, T. H., & Briers, G. E. (2001). Handling nonresponse in social science research. Journal of Agricultural Education, 42(4), 43–53.Crossref

	Mitchell, M. L., & Jolley, J. M. (2013). Research design explained (8th ed.). Belmont, CA: Wadsworth.

	Moser, C. A., & Stuart, A. (1953). An experimental study of quota sampling. Journal of the Royal Statistical Society. Series A General, 116(4), 349–405.Crossref

	Netemeyer, R. G., Bearden, W. O., & Sharma, S. (2003). Scaling procedures: Issues and applications. Thousand Oaks, CA: Sage.Crossref

	Reichheld, F. F. (2003). The one number you need to grow. Harvard Business Review, 81(12), 46–55.

	Sarstedt, M., & Schloderer, M. P. (2010). Developing a measurement approach for reputation of nonprofit organizations. International Journal of Nonprofit and Voluntary Sector Marketing, 15(3), 276–299.

	Sarstedt, M., Diamantopoulos, A., Salzberger, T., & Baumgartner, P. (2016a). Selecting single items to measure doubly-concrete constructs: A cautionary tale. Journal of Business Research, 69(8), 3159–3167.Crossref

	Sarstedt, M., Diamantopoulos, A., & Salzberger, T. (2016b). Should we use single items? Better not. Journal of Business Research, 69(8), 3199–3203.Crossref

	Sarstedt, M., Hair, J. F., Ringle, C. M., Thiele, K. O., & Gudergan, S. P. (2016c). Estimation issues with PLS and CBSEM: Where the bias lies! Journal of Business Research, 69(10), 3998–4010.Crossref

	Sarstedt, M., Bengart, P., Shaltoni, A. M., & Lehmann, S. (2018). The use of sampling methods in advertising research: A gap between theory and practice. International Journal of Advertising, 37(4), 650–663.Crossref

	Stephenson, C. B. (1979). Probability sampling with quotas: An experiment. Public Opinion Quarterly, 43(4), 477–496.Crossref


Further Reading
	Churchill, G. A. (1979). A paradigm for developing better measures for marketing constructs. Journal of Marketing Research, 16(1), 64–73.Crossref

	Cochran, W. G. (1977). Sampling techniques (3rd ed.). New York, NY: John Wiley and Sons.

	Diamantopoulos, A., & Winklhofer, H. M. (2001). Index construction with formative indicators: an alternative to scale development. Journal of Marketing Research, 38(2), 269–277.Crossref

	DeVellis, R. F. (2017). Scale development: Theory and applications (4th ed.). Thousand Oaks, CA: Sage.

	Marketing Scales Database at www.​marketingscales.​com/​search/​search.​php


	Mitchell, M. L., & Jolley, J. M. (2013). Research design explained (8th ed.). Belmont, CA: Wadsworth.

	Netemeyer, R. G., Bearden, W. O., & Sharma, S. (2003). Scaling procedures: Issues and applications. Thousand Oaks, CA: Sage.Crossref

	Paas, L.J., & Morren, M. (2018). Please do not answer if you are reading this: Respondent attention in online panels. Marketing Letters, 29(1), 13–21.Crossref

	Revilla, M., & Ochoa, C. (2018). Alternative methods for selecting web survey samples. International Journal of Maret Research, 60(4), 352-265.




© Springer-Verlag GmbH Germany, part of Springer Nature 2019
Marko Sarstedt and Erik MooiA Concise Guide to Market ResearchSpringer Texts in Business and Economicshttps://doi.org/10.1007/978-3-662-56707-4_4

4. Getting Data

Marko Sarstedt1  and Erik Mooi2
(1)Faculty of Economics and Management, Otto-von-Guericke- University Magdeburg, Magdeburg, Germany

(2)Department of Management and Marketing, The University of Melbourne, Parkville, VIC, Australia

 


4.1 Introduction
4.2 Secondary Data
4.2.1 Internal Secondary Data
4.2.2 External Secondary Data
4.3 Conducting Secondary Data Research
4.3.1 Assess Availability of Secondary Data
4.3.2 Assess Inclusion of Key Variables
4.3.3 Assess Construct Validity
4.3.4 Assess Sampling
4.4 Conducting Primary Data Research
4.4.1 Collecting Primary Data Through Observations
4.4.2 Collecting Quantitative Data: Designing Surveys
4.5 Basic Qualitative Research
4.5.1 In-depth Interviews
4.5.2 Projective Techniques
4.5.3 Focus Groups
4.6 Collecting Primary Data through Experimental Research
4.6.1 Principles of Experimental Research
4.6.2 Experimental Designs
4.7 Oddjob Airways (Case Study)
4.8 Review Questions
References

Electronic supplementary material
The online version of this chapter (https://​doi.​org/​10.​1007/​978-3-662-56707-4_​4) contains additional material that is available to authorized users. You can also download the “Springer Nature More Media App” from the iOS or Android App Store to stream the videos and scan the image containing the “Play button”.
Learning Objectives
After reading this chapter, you should understand:	How to find secondary data and decide on their suitability

	How to collect primary data

	How to design a basic questionnaire

	How to design basic experiments

	How to design basic qualitative research






Keywords
Back-translation • Balanced scale • Big data • Closed-ended questions • Constant sum scale • Customer relationship management • Double-barreled questions • Equidistant scale • Ethnography • Experiments • Experimental design • External secondary data • External validity • Face-to-face interviews • Focus groups • Forced-choice scale • Free-choice scale • In-depth interviews • Internal secondary data • Internal validity • Laddering • Likert scale • Mail surveys • Manipulation checks • Means-end approach • Mixed mode • Mystery shopping • Observational studies • Open-ended questions • Personal interviews • Primary data • Projective techniques • Qualitative research • Rank order scales • Reverse-scaled items • Secondary data • Semantic differential scales • Sentence completion • Social desirability bias • Social media analytics • Social networking data • Surveys • Syndicated data • Telephone interviews • Test markets • Treatments • Unbalanced scale • Verbatim items • Visual analogue scale • Web surveys

4.1 Introduction
In the previous chapter, we discussed some of the key theoretical concepts and choices associated with collecting data. These concepts and choices include validity, reliability, sampling, and sample sizes. We also discussed different types of data. Building on Chap.​ 3, this chapter discusses the practicalities of collecting data. First, we discuss how to work with secondary data. Before collecting primary data, market researchers should always consider secondary data, which are often available and do not depend on respondents’ willingness to participate. Although secondary data have already been collected, you usually need to spend considerable effort preparing them for analysis, which we discuss first. If you find that the required secondary data are unavailable, outdated, or very costly, you may have to collect primary data. In the sections that follow, we discuss how to collect primary data through observations, surveys, and experiments. In Fig. 4.1, we provide an overview of some types of secondary and primary data.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig1_HTML.png]
Fig. 4.1Types of primary and secondary data sources



4.2 Secondary Data
Secondary data
                
               are data that have already been gathered, often for a different research purpose and some time ago. Secondary data comprise internal secondary data, external secondary data, or a mix of both.
4.2.1 Internal Secondary Data
Internal secondary data
                  
                 are data that companies compiled for various reporting and analysis purposes. Much of these data have been collected and stored because “you can’t manage what you don’t measure.”1 Large companies have systems in place, such as Enterprise Resource Planning
                  
                 systems (usually abbreviated as ERP systems), in which vast amounts of customer, transaction, and performance data are stored. In general, internal secondary data comprise the following:	Company records,

	sales reports, and

	existing research studies.





Company records
                  
                 are a firm’s repository of information. They may contain data from different business functions, such as finance, or Customer Relationship Management (CRM)
                  
                . The finance function may provide internal reviews of an organization’s financial well-being and strategic advice, as it has access to the organization’s financial and operational data. The term CRM refers to a system of databases and analysis software that tracks and predicts customer behavior. Firms such as IBM, Microsoft, and Oracle market the database systems that the analysis software utilizes. These database management systems often include information on, for example, purchasing behavior, (geo-)demographic customer data, and the after-sales service. This information is compiled to allow marketers to track individual customers over different sales channels and types of products in order to tailor their offerings to these customers’ needs. Several information technology companies, such as SAP, Oracle, and Salesforce.com sell the analysis software that utilizes these databases. Companies use this software to, for example, identify customer trends, calculate their profitability per customer, or identify opportunities to sell new or different products. The CRM market is substantial, generating about $37 billion in 2017.
Sales reports
                  
                 are created when products and services are sold to business-to-business clients. Many of these reports detail discussions held with clients, as well as the products and services sold. The reports therefore provide insights into customers’ needs. Sales reports are also a means of retaining customers’ suggestions regarding products and services, and can be a productive source of information. For example, DeMonaco et al. (2005) found that 59 % of existing drugs had uses other than those that the producing company described. Because it is important to be aware of a drug’s uses, sales discussions with doctors, hospitals, and research institutes can help this company market these drugs. When sales reports are available, they are often part of a CRM system.
Existing research studies
                  
                 are a good source of secondary data. You should, however, carefully consider whether existing research studies are still useful and what you can learn from them. Even if you believe their findings are outdated, their measures may be very useful. Consequently, if you wish to use existing research studies, it is important that you ascertain that enough of their details are available to make them useful.
4.2.2 External Secondary Data
External secondary data
                  
                 have been compiled outside a company for a variety of purposes. Important sources of secondary data, which we discuss next, include:	Governments,

	trade associations,

	market research firms,

	consulting firms,

	(literature) databases, and

	Internet & social networks.





Governments
                  
                 often provide data that can be used for market research purposes. For example, The CIA World Fact Book provides information on the economy, politics, and other issues of nearly every country in the world. Eurostat (the statistics office of the European Union) provides detailed information on the economy and different market sectors of the European Union. Much of this information is free of charge and is an easy starting point for market research studies.
Trade associations
                  
                 are organizations representing different companies whose purpose is to promote their common interests. For example, the Auto Alliance—which consists of US automakers—provides information on the sector and lists the key issues it faces. The European Federation of Pharmaceutical Industries and Associations represents 1900 pharmaceutical companies operating in Europe. The federation provides a detailed list of key figures and facts, and regularly offers statistics on the industry. Most of the other trade associations also provide lists of their members’ names and addresses. These can be used, for example, as a sampling frame (see Chap.​ 3). Most trade associations regard ascertaining their members’ opinions a key task and therefore collect data regularly. These data are often included in reports that researchers can download from the organization’s website. Such reports can be a short-cut to identifying key issues and challenges in specific industries. Sometimes, these reports are free of charge, but non-members usually need to pay a (mostly substantial) fee.
Market research firms
                  
                 are another source of secondary data. Especially large market research firms provide syndicated data that different clients can use (see Chap.​ 1). Syndicated data
                  
                 are standardized, processed information made available to multiple (potential) clients, usually for a substantial fee. Syndicated data often allow the client’s key measures (such as satisfaction or market share) to be compared against the rest of the market. Examples of syndicated data include the J.D. Power Initial Quality Study, which provides insights into the initial quality of cars in the US, and the J.D. Power Vehicle Ownership Satisfaction Study, which contains similar data on other markets, such as New Zealand and Germany. GfK’s Spex, which we introduce in Box 4.1, is another important example of syndicated data.
Consulting firms
                  
                 are a rich source of secondary data. Most firms publish full reports or summaries of reports on their website. For example, McKinsey & Company publish the McKinsey Quarterly, a business journal that includes articles on current business trends, issues, problems, and solutions. Oliver Wyman publishes regular reports on trends and issues across many different industries. Other consulting firms, such as Gartner and Forrester, provide data on various topics. These data can be purchased and used for secondary analysis. For example, Forrester maintains databases on market segmentation, the allocation of budgets across firms, and the degree to which consumers adopt various innovations. Consulting firms provide general advice, information, and knowledge, while market research firms only focus on marketing-related applications. In practice, there is some overlap in the activities that consulting and market research firms undertake.
(Literature) databases
                  
                 comprise professional and academic journals, newspapers, and books. Two important literature databases are ProQuest (http://​www.​proquest.​com) and JSTOR (https://​www.​jstor.​org). ProQuest contains over 9000 trade journals, business publications, and leading academic journals, including highly regarded publications such as the Journal of Marketing and the Journal of Marketing Research. A subscription is needed to gain access, although some papers are published as open access. Academic institutions often allow their students and, sometimes, their alumni to access these journals. JSTOR is like ProQuest, but is mostly aimed at academics. Consequently, it provides access to nearly all leading academic journals. A helpful feature of JSTOR is that the first page of academic articles (which contains the abstract) can be read free of charge. In addition, JSTOR’s information is searchable via Google Scholar (discussed in Box 4.2). Certain database firms provide firm-level data, such as names and addresses. For example, Bureau van Dijk (https://​www.​bvdinfo.​com/​en-gb), as well as Dun and Bradstreet (http://​www.​dnb.​com), publish extensive lists of firm names, the industry in which they operate, their profitability, key activities, and address information. This information is often used as a sampling frame for surveys.
Internet data
                  
                 is a catch-all term that refers to data stored to track peoples’ behavior on the Internet. Such data consist of page requests
                  
                 and sessions
                  
                . A page request refers to people clicking on a link or entering a specific Internet address. A session is a series of these requests and is often identified by the IP number, a specific address that uniquely identifies the receiver for a period of time, or by means of a tracking cookie
                  
                . With this information, researchers can calculate when and why people move from one page to another. The conversion rate
                  
                 is a specific type of information, namely the ratio of the number of purchases made on a website relative to the number of unique visitors, which often interests researchers. Facebook, Instagram, and LinkedIn, provide valuable information in the form of social networking profiles, which include personal details and information. These social networking data
                  
                 reflect how people would like others to perceive them and, thus, indicate consumers’ intentions. Product or company-related user groups are of specific interest to market researchers. Take, for example, comments posted on a Facebook group site such as that of BMW or Heineken. An analysis of the postings helps provide an understanding of how people perceive these brands. Interpretations of such postings usually include analyzing five elements: the agent (who is posting?), the act (what happened, i.e., what aspect does the posting refer to?), the agency (what media is used to perform the action?), the scene (what is the background situation?), and the purpose (why do the agents act?). By analyzing this qualitative information, market researchers can gain insight into consumers’ motives and actions. Casteleyn et al. (2009), for example, show that the Heineken Facebook posts reveal that the brand has a negative image in Belgium. The task of collecting, processing, analyzing, and storing social networking data is very challenging, due to the data’s complexity and richness. To enable these tasks, researchers have combined theories and methods from a variety of disciplines (e.g., computer science, linguistics, statistics) in the emerging research field of social media analytics
                  
                 to develop new approaches to and method for analyzing social networking data. These include (1) text mining
                  
                 to derive high-quality information from text, (2) social network analysis
                  
                 to study the structure of the relationships between persons, organizations, or institutions in social networks, and (3) trend analysis
                  
                 to predict emerging topics in, for example, Twitter tweets or Facebook posts (Stieglitz et al. 2014). Several companies, such as Talkwalker (www.​talkwalker.​com), aggregate data from different websites including blogs and social media platforms, such as Twitter, Facebook, and Instagram, which they then analyze. These sites also provide statistics, such as the number of mentions or complaints, thereby providing insight into people, brands, and products rated on various dimensions. Talkwalker, for example, uses AI to power it’s sentiment detection and conducted a sentiment analysis of a major product recall by Toyota. Toyota found that its social media mentions increased sharply and were far more negative in the US and Europe than in Indonesia and Japan (see https://​www.​talkwalker.​com/​blog/​navigate-the-automotive-recall-storm-with-social-media-monitoring). Fig. 4.2 shows a snapshop of a sentiment analysis via Talkwater.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig2_HTML.jpg]
Fig. 4.2Snapshot of sentiment analysis via www.​talkwalker.​com




Social websites also provide quantitative information. For example, Facebook’s Ad Manager provides information on the effectiveness of advertising on Facebook, including on measures, such as the click-through-rate, and on demographics, such as gender or location.
Big data
                  
                 is an important term in the context of Internet and social networking data. The term big data describes very large datasets, generally a mix of quantitative and qualitative data in very large volumes, which are automatically analyzed, often with the aim of making predictions. There is no commonly accepted definition of the term, but the use of big data has become very important very quickly. Big data’s use is not unique to market research, but spans boundaries and often includes IT, operations, and other parts of organizations. Netflix, a provider of videos and movies, relies on big data. Netflix faces the challenge that it pays upfront for the videos and the movies it purchases, and therefore needs to understand which, and how many, of its customers will watch them. Netflix analyzes 2 billion hours of video each month in an endeavor to understand its customers’ viewing behavior and to determine which videos and movies will become hits. Walmart, the largest retailer in the world, also uses big data. One of Walmart’s challenges is to proactively suggest products and services to its customers. Using big data, Walmart connects information from many sources, including their location, and uses a product database to find related products. This helps Walmart make online recommendations.
Box 4.1 GfK Spex Retail
GfK is a large market research company. One of its databases, Spex Retail, provides resellers, distributors, manufacturers, and website portals with product data. In 20 languages, it offers aggregated data on more than 7 million products from 20,000 manufacturers in 30 countries. This database provides details on IT, consumer electronics, household appliances, and other products. Spex Retail also provides insight into new products being launched by providing 70,000 new information sheets that describe new products or product changes every month. The data can also be used to map product categories. Such information helps its clients understand the market structure, or identify cross-selling or up-selling possibilities. See http://​www.​etilize.​com/​retailers/​#product-content for more details, including a demo of its products.
                    
                  

4.3 Conducting Secondary Data Research
In Chap.​ 2, we discussed the market research process, starting with identifying and formulating the research question, followed by determining the research design. Once these two have been done, your attention should turn to designing the sample and the method of data collection. In respect of secondary data, this task involves the steps shown in Fig. 4.3.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig3_HTML.png]
Fig. 4.3Assessing secondary data



4.3.1 Assess Availability of Secondary Data
Search engines
                  
                 (such as Google or Bing) provide easy access to many sources of the secondary data we have just discussed. Furthermore, many (specialist) databases also provide access to secondary data.
Search engines crawl through the Internet, regularly updating their contents. Algorithms, which include how websites are linked, and other peoples’ searches evaluate this content and present a set of results. Undertaking searches by means of search engines requires careful thought. For example, the word order is important (put keywords first) and operators (such as +, −, and ~) may have to be added to restrict searches. In Box 4.2, we discuss the basics of using Google to search the Internet.
Databases contain existing data that can be used for market research purposes, which we discussed in the Sect. 4.2.2. Lightspeed Research (http://​www.​lightspeedresear​ch.​com), for example, maintains several databases, such as a B2B and Millenial Panel, providing details on selected market segments. GfK provides several databases that track retail sales. Nielsen maintains a large consumer panel of some 250,000 households in 27 countries. It is clearly not possible to provide an exhaustive list of the databases available, but an online search, a market research agency, or an expert should help you identify the options quickly.
Once a potential secondary data source has been located, the next task is to evaluate the available data. It is important to critically assess the (potential) data’s fit with your needs. Fig. 4.3 provides a set of criteria to help evaluate this fit.
Box 4.2 Using Google to searching for secondary data
Most people use Google daily, so why not use it for market research purposes too? Google has an easy interface, but if you use the standard search box, you may not find the data you are looking for. What must you then do to find useful data?	You could use Google Scholar (https://​scholar.​google.​com) if you are looking for scholarly information such as that found in academic journals. While you can search for any information, specific search items can usually only be accessed if you have an organizational, university, or library password.

	By using Google Books (https://​books.​google.​com/​books), you can enter several keywords to easily search through a very large catalogue of books. Google clearly indicates the books in which the search results are found and the pages on which the keywords occur. The Ngram Viewer (https://​books.​google.​com/​ngrams/​) shows the relative frequency with which words are used and is a cool Google books tool.

	If you cannot find what you are looking for, Google allows you to refine your search. After you have searched you can typically select All, Images, Videos, News, Maps, and More to select the type of result you are interested in. Under Tools, you can select the country and time range from which results are to be shown.

	Google Public Data Explorer (https://​www.​google.​com/​publicdata/​directory) facilitates exploration of a variety of public-interest datasets. These include the US Census Bureau, Eurostat, and the OECD datasets. This site is particularly useful if you want to obtain visualized data on economic indicators.

	Try using operators, which are signs that you use to restrict your research. For example, putting a minus symbol (−) (without a space) before a search word excludes this word from your findings. Putting a sequence of words, or an entire sentence in quotation marks (e.g., “a concise guide to market research”) indicates that Google should only search for exact matches.





4.3.2 Assess Inclusion of Key Variables
Measurement is the first element to assess. It consists of a set of criteria. You should first check whether the desired variables are included in the source. The key variables in which you are interested, or could use, should obviously be part of the data. Also check if these variables are included at the required level of analysis, which is called the aggregation level (see Chap.​ 3). For example, the American Customer Satisfaction Index (ACSI)
                  
                 satisfaction dataset reports on satisfaction at the company level;2 therefore, if researchers need the measurement of satisfaction at a product, service, or store level, these data are inappropriate.
4.3.3 Assess Construct Validity
After checking that the desired variables are included in the source, the construct validity should be assessed (see Chap.​ 3 for a discussion of validity). Validity relates to whether variables measure what they should measure (see Chap.​ 3). Construct validity
                  
                 is a general term relating to how a variable is defined conceptually and its suggested (empirical) measure. Houston (2002) establishes a three-step method to assess the construct validity of secondary data measures.	First, specify the theoretical definition of the construct in which you are interested. Satisfaction is, for example, often defined as the degree to which an experience conforms to expectations and the ideal.

	Second, compare your intended measure against this theoretical definition (or another acceptable definition of satisfaction). Conceptually, the items should fit closely.

	Third, assess if these items have nomological validity
                        
                       (see Chap.​ 3). For example, customer expectations, perceived quality, and value have a significant influence on customer satisfaction. Similarly, satisfaction generally relates positively to customer loyalty. As such, you would expect the measure of satisfaction that you are evaluating to correlate with these measures (if included in the database).





Taking these three steps is important, as the construct validity is often poor when secondary data are used.3 See Raithel et al. (2012) for an application of this three-step process.
If there are multiple sources of secondary data, identical measures can be correlated to assess the construct validity. For example, the Thomson Reuter SDC Platinum and the Bioscan database of the American Health Consultants both include key descriptors of firms and financial information; they therefore have a considerable overlap regarding the measures included. This may raise questions regarding which databases are the most suitable, particularly if the measures do not correlate highly. Fortunately, databases have been compared; for example, Schilling (2009) compares several databases, including SDC Platinum.
4.3.4 Assess Sampling
Next, the sampling process of the collected secondary data should be assessed. First assess the population and the representativeness of the sample drawn from it. For example, the sampling process of Nielsen Homescan’s data collection effort is based on probability sampling, which can lead to representative samples (see Chap.​ 3). Sellers of secondary data often emphasize the size of the data collected, but good sampling is more important than sample size! When sampling issues arise, these can be difficult to detect in secondary data, because the documents explaining the methodology behind secondary data (bases) rarely discuss the data collection’s weaknesses. For example, in many commercial mailing lists 25% (or more) of the firms included routinely have outdated contact information, are bankrupt, or otherwise not accurately recorded. This means that the number of contactable firms is much lower than the number of firms listed in the database. In addition, many firms may not be listed in the database. Whether these issues are problematic depends on the research purpose. For example, descriptive statistics may be inaccurate if data are missing.
The recency of the data, the time period over which the data were collected, and future intentions to collect data should be assessed next. The data should be recent enough to allow decisions to be based on them. The data collection’s timespan and the intervals at which the data were collected (in years, months, weeks, or in even more detail) should match the research question. For example, when introducing new products, market competitors’ market share is an important variable, therefore such data must be recent. Also consider whether the data will be updated in the future and the frequency with which such updates will done. Spending considerable time on getting to know data that will not be refreshed can be frustrating! Other measurement issues include definitions that change over time. For example, many firms changed their definitions of loyalty from behavioral (actual purchases) to attitudinal (commitment or intentions). Such changes make comparisons over time difficult, as measures can only be compared if the definitions are consistent.
4.4 Conducting Primary Data Research
Primary data
                
               are gathered for a specific research project or task. There are two ways of gathering primary data. You can observe consumers’ behavior, for example, by means of observational studies, or test markets. Alternatively, you can ask consumers directly by means of surveys, in-depth interviews, predictive techniques, or focus groups. Experiments are a special type of research, which is normally a combination of observing and asking. We provide an overview of the various types of primary data collection methods in Fig. 4.1.
Next, we briefly introduce observing as a method of collecting primary data. We proceed by discussing how to conduct surveys. Since surveys are the main means of collecting primary data by asking, we discuss the process of undertaking survey research in enough detail to allow you to set up your own survey-based research project. We then discuss in-depth interviews, including a special type of test used in these interviews (projective techniques). Last, we discuss combinations of observing and asking—the basics of conducting experimental research.
4.4.1 Collecting Primary Data Through Observations
Observational studies
                  
                 can provide important insights that other market research techniques do not. Observational techniques shed light on consumers’ and employees’ behavior and can help answer questions such as: How do consumers walk through supermarkets?; how do they consume and dispose of products?; and how do employees spend their working day? Observational techniques are normally used to understand what people are doing rather than why they are doing it. They work well when people find it difficult to put what they are doing into words, such as shoppers from different ethnic backgrounds.
Most observational studies use video recording equipment, or trained researchers, who unobtrusively observe what people do (e.g., through one-way mirrors or by using recording equipment). Another example is the use of eyetracking
                  
                 equipment that measure what catches customers’ eyes and how long their gaze remains (see Box 4.3 for a video on how market researchers use eyetracking for studies in supermarkets).
Recently, researchers started using computer chips (called RFIDs) as observational equipment to trace consumers’ shopping paths within a supermarket Chap.​ 2. Almax, an Italian company, has developed a special type of observational equipment. Their EyeSee product is an in-store mannequin equipped with a camera and audio recording equipment. The product also comprises software that analyze the camera recordings and provides statistical and contextual information, such as the shoppers’ demographics. Such information is useful for developing targeted marketing strategies. For example, a retail company found that Chinese visitors prefer to shop in Spanish stores after 4 p.m., prompting these stores to increase their Chinese-speaking staff at these hours. Fig. shows what the EyeSee Mannequin looks like.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig4_HTML.png]
Fig. 4.4The EyeSee mannequin. (© almax)

                        https://​www.​youtube.​com/​watch?​v=​NA-fFv1uB-c
                      



Mystery shopping,
                  
                 when a trained researcher is asked to visit a store or restaurant and consume the products or services, is a specific type of observational study. For example, McDonalds and Selfridges, a UK retail chain, both use mystery shoppers to ensure the quality of their services and products (see Box 4.4 for an MSNBC video on mystery shopping).
Sometimes observational studies are conducted in households, with researchers participating in them to see how the inhabitants buy, consume, and dispose of products or services. The type of study in which the researcher is a participant is called an ethnography
                  
                . An example of an ethnography is Volkswagen’s Moonraker project, in which several Volkswagen employees followed American drivers to gain an understanding of how their usage of and preferences for automobiles differ from those of European drivers (Kurylko 2005).
Test markets
                  
                 are a useful, but costly, type of market research in which a company introduces a new product or service to a specific geographic market. Test markets are sometimes also used to understand how consumers react to different marketing mix instruments, such as changes in pricing, distribution, or advertising and communication. Test marketing is therefore about changing a product or service offering in a real market and gauging consumers’ reactions. While the results from such studies provide important insights into consumer behavior in a real-world setting, they are expensive and difficult to conduct. Some frequently used test markets include Hassloch in Germany, as well as Indianapolis and Nashville in the US.
Box 4.3 Eyetracking study in a supermarket

                  [image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Figa_HTML.png]
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                          https://​www.​youtube.​com/​watch?​v=​Hatmm84sqm0&​index=​3&​list=​PLMM7ZjFcpspWOBn​q-rdg7P1fBXcJY7tWL​
                        


                
Box 4.4 Using mystery shopping to improve customer service

                  [image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Figb_HTML.png]
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4.4.2 Collecting Quantitative Data: Designing Surveys
There is little doubt that surveys
                  
                 are the mainstay of primary market research. While it may seem easy to conduct a survey (just ask what you want to know, right?), there are many issues that could turn good intentions into bad results. In this section, we discuss the key design choices for good surveys. Designing a good survey requires several steps. First, determine the survey goal. Next, determine the type of questionnaire required and the administration method. Thereafter, decide on the questions and the scale, as well as the design of the questionnaire. Conclude by pretesting and administering the questionnaire. We show these steps in Fig. 4.5.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig5_HTML.png]
Fig. 4.5Steps in designing surveys



4.4.2.1 Set the Survey Goal
Before you start designing the questionnaire, it is vital to consider the survey goal. Is it to collect quantitative data on customers’ background, to assess customer satisfaction, or do you want to understand why and how customers complain? These different goals influence the type of questions asked (such as open-ended or closed-ended questions), the method of administration (e.g., by mail or on the Web), and other design issues discussed below. Two aspects are particularly relevant when designing surveys:
First, consider the information or advice you want to emerge from the study for which the survey is required. Say you are asked to help understand check-in waiting times at an airport. If the specific study question is to gain an understanding of how many minutes travelers are willing to wait before becoming dissatisfied, you should be able to provide an answer to the question: How much does travelers’ satisfaction decrease with increased waiting time? If, on the other hand, the specific question is to understand how people perceive waiting time (short or long), your questions should focus on how travelers perceive this time and, perhaps, what influences their perception. Thus, the information or advice you want to provide influences the questions that you should pose in a survey.
Second, consider the method required for the study early in the design process. For example, if a study’s goal is to determine market segments, you should probably use cluster analysis (see Chap.​ 9). Similarly, if the study’s goal is to develop a way to systematically measure customer satisfaction, you are likely to use factor analysis (see Chap.​ 8). This approach is crucial, as each method requires different types of data. Cluster analysis, for example, generally requires variables that are not too highly correlated, meaning that researchers need to use a type of questionnaire that can produce these data. On the other hand, factor analysis requires data that include different, but highly correlated, variables. If you use factor analysis to distinguish between the different aspects of consumer satisfaction, you need to design a survey that will produce data allowing you to conduct factor analysis.
4.4.2.2 Determine the Type of Questionnaire and Method of Administration
After determining the survey goal, you need to decide on the type of questionnaire you should use and how it should be administered. There are four key ways of administering a survey:	Personal interviews,

	telephone interviews,

	web surveys, and

	mail surveys.





In some cases, researchers combine different ways of administering surveys. This is called a mixed mode.
Personal Interviews
Personal interviews
                      
                     (or face-to-face interviews
                      
                    ) can obtain high response rates, since engagement with the respondents are maximized, allowing rich information (visual expressions, etc.) to be collected. Moreover, since people find it hard to walk away from interviews, it is possible to collect answers to a reasonably lengthy set of questions. Consequently, personal interviews can support long surveys. It is also the best type of data collection for open-ended responses. In situations where the respondent is initially unknown, this may be the only feasible data collection type. Consequently, in-depth interviews may be highly preferable, but they are also the costliest per respondent. This is less of a concern if only small samples are required (in which case personal interviewing could be the most efficient). Other issues with personal interviews include the possibility of interviewer bias
                      
                     (i.e., a bias resulting from the interviewer’s behavior, e.g., in terms of his/her reactions or presentation of the questions), respondent bias
                      
                     to sensitive items, and the data collection usually takes more time. Researchers normally use personal interviewing when they require an in-depth exploration of opinions. Such interviewing may also help if drop out is a key concern. For example, if researchers collect data from executives around the globe, using methods other than face-to-face interviewing may lead to excessive non-response in countries such as Russia or China where face-to-face interviews are a sign of respect for and appreciation of the time taken. CAPI, which is the abbreviation of computer-assisted personal interviews
                      
                    , is a frequently used term in the context of in-depth interviewing. CAPI involve using computers during the interviewing process to, for example, route the interviewer through a series of questions, or to enter responses directly. Similarly, in CASI (computer-assisted self-interviews
                      
                    ), the respondent uses a computer to complete the survey questionnaire without an interviewer administering it.
Telephone Interviews
Telephone interviews
                      
                     allow researchers to collect data quickly. These interviews also support open-ended responses, although not as well as personal interviews. Moreover, interviewer bias can only be controlled moderately, since the interviewers follow predetermined protocols, and the respondent’s interactions with others during the interview is strongly controlled. Telephone interviewing can be a good compromise between mailed interviews’ low cost and the richness of in-depth interviews. CATI refers to computer-assisted telephone interviews
                      
                    , which are an important method of administering surveys. Until the 1990s, telephone interviews were generally conducted via landlines, but mobile phone usage has soared in the meantime. In many countries, mobile phone adoption rates are higher than landline adoption. This holds especially for African countries, India, and many European countries if younger consumers are the targeted interviewees (Vincente and Reis 2010). Consequently, mobile phone surveys
                      
                     have become dominant in market research.
A decade ago, the differences between landline and mobile phone surveys could be large, with younger and richer individuals being overrepresented in mobile phone surveys (Vincente et al. 2008). As the adoption of mobile phones increased, the use of landlines decreased, which introduced new problems in terms of sampling errors (Stern et al. 2014). For example, younger people are now less likely to have landlines. An additional issue is that landlines are fixed to a geographical area whereas mobile phones are not. As people move or travel, mobile phones are far less likely to give useful information about geographic areas. While recent research has shown that differences in response accuracy between mobile phone and landline surveys are small (e.g., with regard to social desirability bias), especially for questions that are not cognitively demanding (e.g., Kennedy and Everett 2011; Lynn and Kaminska 2013), the samples from which they are drawn can be very different in practice. There are some other differences as well. For example, the likelihood of full completion of surveys is higher for mobile calling, even though completion takes around 10–15 % longer (Lynn and Kaminska 2013).
Web Surveys
Web surveys
                      
                     (sometimes referred to as CAWI, or computer-assisted web interviews
                      
                    ) are often the least expensive to administer and can be set up very quickly. Researchers can administer web surveys to very large populations, even internationally, because, besides the fixed costs of setting up a survey, the marginal costs of administering additional web surveys are relatively low.
Many firms specializing in web surveys will ask $0.30 (or more) for each respondent, which is substantially lower than the costs of personal interviews, telephone interviews, and mail surveys. It is also easy to obtain precise quotes quickly. Qualtrics (http://​www.​qualtrics.​com) is a leading web service provider that allows a specific type of respondent and a desired sample size to be chosen. For example, using Qualtrics’s sample to survey 500 current owners of cars to measure their satisfaction costs $2500 for a 10-minute survey. This cost increases sharply if samples are hard to access and/or require compensation for their time. For example, surveying 500 purchasing managers by means of a 10-minute survey costs approximately $19,500.
Web surveys also support complex survey designs with elaborate branching and skip patterns that depend on the response. For example, web surveys allow different surveys to be created for different types of products. Further, since web surveys reveal the questions progressively to the respondents, there is an option to channel them to the next question based on their earlier responses. This procedure is called adaptive questioning
                      
                    . In addition, web surveys can be created that allow respondents to automatically skip questions if they do not apply. For example, if a respondent has no experience with an iPad, researchers can create surveys that do not ask questions about this product. However, web surveys impose similar burdens on the respondents as mail surveys do (see below), which they may experience as an issue. This makes administering long web surveys difficult. Moreover, open-ended questions tend to be problematic, because few respondents are likely to provide answers, leading to a low item response. There is evidence that properly conducted web surveys lead to data as good as those obtained from mail surveys; in addition, the lack an interviewer, which can result in interviewer bias,
                      
                     means they can provide better results than personal interviews (Bronner and Ton 2007; Deutskens et al. 2006). In web surveys, the respondents are also less exposed to evaluation apprehension and less inclined to respond with socially desirable behavior.4

To complete web surveys, most respondents still use their personal computers, but the popularity of mobile devices (i.e., smartphones and tablets) has risen significantly in recent years. Brosnan et al. (2017) have found that survey completion rates vary across devices with personal computers yielding the highest rate (83 %), followed by tablets (66 %) and smartphones (63 %). In addition, since device use is significantly associated with specific socio-demographic characteristics, you should not limit respondents to use a specific device for completing a survey as this may negatively affect representativity.
It is important to distinguish between true web-based surveys used for collecting information on which marketing decisions will be based and polls, or very short surveys, on websites used to increase interactivity. These polls/short surveys are used to attract and keep people interested in websites and are not part of market research. For example, USA Today (http://​www.​usatoday.​com), an American newspaper, regularly publishes short polls on their main website.
Mail Surveys
Mail surveys
                      
                     are paper-based surveys sent out to respondents. They are a more expensive type of survey research and are best used for sensitive items. Since no interviewer is present, there is no interviewer bias. However, mail surveys are a poor choice for complex survey designs, such as when respondents need to skip a large number of questions depending on previously asked questions, as this means that the respondent needs to correctly interpret the survey structure. Open-ended items are also problematic, because few people are likely to provide answers to such questions if the survey is administered on paper. Other problems include a lack of control over the environment in which the respondent fills out the survey and that mail surveys take longer than telephone or web surveys. However, in some situations, mail surveys are the only way to gather data. For example, while executives rarely respond to web-based surveys, they are more likely to respond to paper-based surveys. Moreover, if the participants cannot easily access the web (such as employees working in supermarkets, cashiers, etc.), handing out paper surveys is likely to be more successful.
Tip
The method of administration also has a significant bearing on a survey’s maximum duration (Vesta Research 2016). As a rule of thumb, telephone interviews should be no longer than 20 minutes. When calling a on a mobile phone, however, the survey should not exceed 5 minutes. The maximum survey duration of web surveys is 20 minutes—10 minutes for social media-based surveys. Personal interviews and mail surveys can be much longer, depending on the context. For example, surveys comprising personal interviews on topics that respondents find important, could take up to 2 hours. However, when topics are less important, mail surveys and personal interviews need to be considerably shorter.

Market researchers are increasingly using mixed mode
                      
                     approaches. An example of a mixed mode survey is when potential respondents are first approached by phone, asked to participate and confirm their email addresses, after which they are given access to a web survey. Mixed mode approaches are also used when people are first sent a paper survey and then called if they fail to respond.
Mixed mode approaches may help, because they signal that the survey is important. They may also help improve response rates, as people who are more visually oriented prefer mail and web surveys, whereas those who are aurally oriented prefer telephone surveys. However, there is only evidence of increased response rates when modes are offered sequentially and of mixed modes reducing response rates when offered simultaneously (Stern et al. 2014). By providing different modes, people can use the mode they most prefer. A downside of mixed mode surveys is that they are expensive and require a detailed address list (including a telephone number and matching email address). However, systematic (non)response is the most serious mixed mode survey issue. For example, when filling out mail surveys, the respondents have more time than when providing answers by telephone. If respondents need this time to think about their answers, the responses obtained from mail surveys may differ systematically from those obtained from telephone surveys.
4.4.2.3 Design the Items
Designing the items, whether for a personal interview, web survey, or mail survey, requires a great deal of thought. Take, for example, the survey item shown in Fig. 4.6:[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig6_HTML.jpg]
Fig. 4.6Example of a bad survey item



It is unlikely that people can give meaningful answers to such an item. First, using a negation (“not”) in sentences makes questions hard to understand. Second, the reader may not have an iPhone, or may not have experience using it. Third, the answer categories are unequally distributed. That is, there is one category above neutral while there are two below. These issues are likely to create difficulties with understanding and answering questions, which may, in turn, cause validity and reliability issues. While the last aspect relates to the properties of the scale (see Sect. 4.4.2.4), the first two issues refer to the item content and wording, which we will discuss next (see Table 4.1 for a summary).
Table 4.1A summary of some of the key choices when designing survey items


	Aspect
	Recommendation

	
                              Item content
                            

	Can all the respondents answer the question asked?
	Ensure that all potential respondents can answer all items. If they cannot, ask screener questions to direct them. If the respondents cannot answer questions, they should be able to skip them.

	Can the respondents construct or recall the answers?
	If the answer is no, you should use other methods to obtain information (e.g., secondary data or observations).

	Moreover, you should ask the respondents about major aspects before zooming in on details to help them recall answers.

	Do the respondents want to answer each question?
	If the questions concern “sensitive” subjects, check whether they can be omitted. If not, stress the confidentiality of the answers and mention why these answers are useful for the researcher, the respondent, or society before introducing them.

	Open-ended or closed-ended questions?
	Keep the subsequent coding in mind. If easy coding is possible beforehand, design a set of exhaustive answer categories. Further, remember that open-ended scale items have a much lower response rate than closed-ended items.

	
                              Item wording
                            

	Grammar and sentences
	Use simple wording and grammar. Keep sentences short. Avoid negations, vague quantifiers, and double-barreled questions. Employ reverse-scaled items sparingly. Use back-translation if necessary.

	
                              Type of scale
                            

	Number of response categories
	Use visual analogue scales. If not available, use 5-point or 7-point scales.

	Forced-choice or free-choice scale?
	Use a free-choice scale by including a neutral category.

	Design of the response categories
	Ensure that the response categories are exclusive and that each category has approximately the same percentage of responses.

	What scaling categories should you use (closed-ended questions only)?
	Use visual analogue scales if possible, otherwise Likert scales. If the question requires this, use semantic differential scales, or rank order scales.

	Labeling of response categories
	Label endpoints only. When using the items for prediction-type analyses, label all categories.

	Inclusion of a “Don’t know” option
	Include a “Don’t know” option only for items that the respondent might genuinely not know. If included, place this at the end of the scale.

	Balanced or unbalanced scale?
	Always use a balanced scale. There should be an exact number of positive and negative wordings in the scale items. The words at the ends of the scale should be exact opposites.





Item content
When deciding on the item content
                      
                    , there are at least three essential rules you should keep in mind.
As a first rule, ask yourself whether everyone will be able to answer each item. If the item is, for example, about the quality of train transport and the respondent always travels by car, his or her answers will be meaningless. However, the framing of items is important, since, for example, questions about why the specific respondent does not use the train can yield important insights.
As a second rule, you should check whether respondents can construct or recall an answer. If you require details that possibly occurred a long time ago (e.g., what information did the real estate agent provide when you bought/rented your current house?), the respondents may have to “make up” an answer, which leads to validity and reliability issues.
As a third rule, assess whether the respondents are willing to answer an item. If contents are considered sensitive (e.g., referring to sexuality, money, etc.), respondents may provide more socially desirable answers (e.g., by reporting higher or lower incomes than are actually true). Most notably, respondents might choose to select a position that they believe society favors (e.g., not to smoke or drink, or to exercise), inducing a social desirability bias
                      
                    . They may also not answer such questions at all. You should determine whether these items are necessary to attain the research objective. If they are not, omit them from the survey. The content that respondents may regard as sensitive is subjective and differs across cultures, age categories, and other variables. Use your common sense and, if necessary, use experts to decide whether the items are appropriate. In addition, make sure you pretest the survey and ask the pretest participants whether they were reluctant to provide certain answers. To reduce respondents’ propensity to give socially desirable answers, use indirect questioning (e.g., “What do you believe other people think about … ?”), frame questions as neutrally as possible, and suggest that many people exhibit behavior different from the norm (e.g., Brace 2004). Adjusting the response categories also helps when probing sensitive topics. For example, instead of directly asking about respondents’ disposable income, you can provide various answering categories, which will probably increase their willingness to answer this question.
Designing the items also requires deciding whether to use open-ended or closed-ended questions. Open-ended questions
                      
                     (also called verbatim items
                      
                    ) provide little or no structure for respondents’ answers. Generally, the researcher asks a question and the respondent writes down his or her answer in a box. Open-ended questions are flexible and allow for explanation, making them particularly suitable for exploratory research. However, the drawback is that the respondents may be reluctant to provide detailed information. Furthermore, answering open-ended questions is more difficult and time consuming. In addition, their interpretation requires substantial coding. Coding issues arise when respondents provide many different answers (such as “sometimes,” “maybe,” “occasionally,” or “once in a while”) and the researcher has to divide these into categories (such as very infrequently, infrequently, frequently, and very frequently) for further statistical analysis. This coding is very time-consuming, subjective, and difficult. Closed-ended questions
                      
                     provide respondents with only a few categories from which to choose, which drastically reduces their burden, thereby inducing much higher response rates compared to open-ended questions. Closed-ended questions also facilitate immediate statistical analysis of the responses as no ex post coding is necessary. However, researchers need to identify answer categories in advance and limit this number to a manageable amount. Closed-ended questions are dominant in research and practice.
Item wording
The golden rule of item wording
                      
                     is to keep it short and simple. That is, use simple words and avoid using jargon or slang as some respondents may misunderstand these. Similarly, keep grammatical complexities to a minimum by using active rather than passive voice, repeat the nouns instead of using pronouns, and avoiding possessive forms (Lietz 2010). Use short sentences (20 words max; Oppenheim 1992) to minimize the cognitive demands required from the respondents (Holbrook et al. 2006) and to avoid the risk of double-barreled questions
                      
                    , causing respondents to agree with one part of the question but not the other, or which they cannot answer without accepting a particular assumption. An example of such a double-barreled question is: “In general, are you satisfied with the products and services of the company?” A more subtle example is: “Do you have the time to read the newspaper every day?” This question also contains two aspects, namely “having time” and “reading the paper every day.” The question “Do you read the newspaper every day?” followed by another about the reasons for a negative or a positive answer would be clearer (Lietz 2010).
Moreover, avoid using the word not or no where possible. This is particularly important when other words in the same sentence are negative, such as “unable,” or “unhelpful,” because sentences with two negatives (called a double negative) are hard to understand. For example, a question such as “I do not use the email function on my iPhone because it is unintuitive” is quite hard to follow and takes longer to process (Peng and Finn 2016). Also, avoid using vague quantifiers
                      
                    , such as “frequent” or “occasionally” (Dillman et al. 2014), which make it difficult for respondents to answer questions (what exactly is meant by “occasionally”?). They also make comparing responses difficult. After all, what one person considers “occasionally,” may be “frequent” for another.5 Instead, it is better to use frames that are precise (“once a week”).
Never suggest an answer. For example, a question like “Company X has done very well, how do you rate it?” is highly suggestive and would shift the mean response to the positive end of the scale.
Many researchers recommend including reverse-scaled items
                      
                     in surveys. Reverse-scaled means the question, statement (if a Likert scale is used), or word pair (if a semantic differential scale is used) are reversed compared to the other items in the set. Box 4.5 shows an example of a five-item scale for measuring consumers’ attitude toward the brand (e.g., Sarstedt et al. 2016) with one reverse-scaled item printed in bold. Reverse-scaled items act as cognitive “speed bumps” that alert inattentive respondents that the content varies (Weijters and Baumgartner 2012) and help reduce the effect of acquiescence
                      
                    , which relates to a respondent’s tendency to agree with items regardless of the item content (Baumgartner and Steenkamp 2001; see also Chap.​ 5). Furthermore, reverse-scaled items help identify straight-lining, which occurs when a respondent marks the same response in almost all the items (Chap.​ 5). However, numerous researchers have shown that reverse-scaled items create problems, for example, by generating artificial factors, as respondents have greater difficulty verifying the item. This creates misresponse rates
                      
                     of 20 % and higher (e.g., Swain et al. 2008; Weijters et al. 2013). Given these results, we suggest employing reverse-scaled items sparingly (Weijters and Baumgartner 2012), for example, only to identify straight-lining. If used, reverse-scaled items should not contain a particle negation such as “not” or “no.”
Finally, when you undertake a survey in different countries (or adapt a scale from a different language), use professional translators, because translation is a complex process. Functionally, translating one language into another seems quite easy, as there are many websites, such as Google translate (translate.​google.​com), that do this. However, translating surveys requires preserving the conceptual equivalence of whole sentences and paragraphs; current software applications and websites cannot ensure this. In addition, cultural differences normally require changes to the instrument format or procedure. Back-translation is a technique to establish conceptual equivalence across languages. Back-translation
                      
                     requires translating a survey instrument into another language, after which another translator takes the translated survey instrument and translates it back into the original language (Brislin 1970). After the back-translation, the original and back-translated instruments are compared and points of divergence are noted. The translation is then corrected to more accurately reflect the intent of the wording in the original language.
Box 4.5 An example of a scale with reverse-scaled items (in bold).
Please rate the brand in the advertisement on the following dimensions:	Dislike
	1
	2
	3
	4
	5
	6
	7
	Like

	Unpleasant
	1
	2
	3
	4
	5
	6
	7
	Pleasant

	Good
	1
	2
	3
	4
	5
	6
	7
	Bad

	Expensive
	1
	2
	3
	4
	5
	6
	7
	Inexpensive

	Useless
	1
	2
	3
	4
	5
	6
	7
	Useful





4.4.2.4 Set the Scale
When deciding on scales, two separate decisions need to be made. First, you need to decide on the type of scale. Second, you need to set the properties of the scale you choose.
Type of Scale
Marketing research and practice have provided a variety of scale types
                      
                    . In the following, we discuss the most important (and useful) ones:	Likert scales,

	semantic differential scales, and

	rank order scales.





The most popular scale type used in questionnaires is the Likert scale
                      
                     (Liu et al. 2016). Likert scales are used to establish the degree of agreement with a specific statement. Such a statement could be “I am very committed to Oddjob Airways.” The degree of agreement is usually set by scale endpoints ranging from strongly disagree to strongly agree. Likert scales are used very frequently and are relatively easy to administer. Bear in mind that if the statement is too positive or negative, it is unlikely that the endings of the scale will be used, thereby reducing the number of answer categories actually used. We show an example of three Likert-scale-type items in Fig. 4.7, in which respondents assess the personality of the Oddjob Airways brand.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig7_HTML.jpg]
Fig. 4.7Example of a 7-point Likert scale



The semantic differential scale is another scale type that features prominently in market research. Semantic differential scales
                      
                     use an opposing pair of words, normally adjectives (e.g., young/old, masculine/feminine) constituting the endpoint of the scale. Respondents then indicate how well one of the word in each pair describes how he or she feels about the object to be rated (e.g., a company or brand). These scales are widely used in market research. As with Likert scales, 5 or 7 answer categories are commonly used (see the next section on the number of answer categories you should use). We provide an example of the semantic differential scale in Fig. 4.8, in which respondents provide their view of Oddjob Airways.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig8_HTML.jpg]
Fig. 4.8Example of a 7-point semantic differential scale



Rank order scales
                      
                     are a unique type of scale, as they force respondents to compare alternatives. In its basic form, a rank order scale allows respondents to indicate which alternative they rank highest, which alternative they rank second highest, etc. Fig. 4.9 shows an example. The respondents therefore need to balance their answers instead of merely stating that everything is important. In a more complicated form, rank order scales ask respondents to allocate a certain total number of points (often 100) to a number of alternatives. This is called the constant sum scale
                      
                    . Constant sum scales work well when a small number of answer categories are used (normally up to 5). Generally, respondents find constant scales that have 6 or 7 answer categories somewhat challenging, while constant scales that have 8 or more categories are very difficult to answer. The latter are thus best avoided.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig9_HTML.jpg]
Fig. 4.9Example of a rank order scale



In addition to these types of scaling, there are other types, such as graphic rating scales, which use pictures to indicate categories, and the MaxDiff scale
                      
                    , in which respondents indicate the most and least important items. We introduce the MaxDiff scale in the [image: $\underline {\downarrow}$] Web Appendix (→ Downloads). The MaxDiff scale is a form of Best-Worst scaling
                      
                    .[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Figc_HTML.png]
© EtiAmmos/Getty Images/iStock

                            https://​www.​guide-market-research.​com/​app/​download/​13488664327/​SPSS+3rd_​Chapter+4_​MaxDiff+scales.​pdf?​t=​1516713250
                          



Properties of the Scale
After selecting the type of scale, we need to set the scale properties
                      
                    , which involves making several decisions:	Decide on the number of response categories,

	choose between forced-choice scale and free-choice scales,

	design the response categories,

	label the response categories,

	decide whether to use a “don’t know” option, and

	choose between a balanced and unbalanced scale.





Decide on the number of response categories
                      
                    : When using closed-ended questions, the number of answer categories needs to be determined. In its simplest form, a survey could use just two answer categories (yes/no). Multiple categories (such as, “completely disagree,” “disagree,” “neutral,” “agree,” “completely agree”) are used more frequently to allow for more nuances. When determining how many scale categories to use, we face a trade-off between having more variation and differentiation in the responses versus burdening the respondents too much, which can trigger different types of response biases (e.g., Weijters et al. 2010). Because 5-point scales and 7-point scales are assumed to achieve this trade-off well, their use has become common in marketing research (e.g., Fink 2003; Peterson 1997). Research on these two scale types in terms of their reliability and validity is inconclusive, but the differences between them are generally not very pronounced (e.g., Lietz 2010; Peng and Finn 2016; Weijters et al. 2010). Ten-point scales are often used in market research practice. However, scales with many answer categories often confuse respondents, because the wording differences between the scale points become trivial. For example, the difference between “tend to agree” and “somewhat agree” are subtle and respondents may not be able to differentiate between them. In such a case, respondents tend to choose categories in the middle of the scale (Rammstedt and Krebs 2007). Given this background, we recommend using 5-point or 7-point scales.
Finally, many web surveys now use levers that allow scaling on a continuum without providing response categories. This scale type is called a visual analogue scale
                      
                     and is especially recommended if small differences in response behavior need to be detected. Visual analogue scales are well known in paper-and-pencil-based research (especially in the medical sector) and have become increasingly popular in web surveys. A visual analogue scale consists of a line and two anchors, one at each end. The anchors often consist of verbal materials that mark opposite ends of a semantic dimension (e.g., good and bad). However, the anchors may also be pictures, or even sound files. Visual anchors, such as smileys, are often used with participants who may not fully grasp the meaning of verbal materials—for example, preschool children (Reips and Funke 2008). Compared to ordinal scales, measurement by means of visual analogue scales is more exact, leading to more narrow confidence intervals, and higher power statistical tests. This exactness helps detect smaller effects that may be unobservable with ordinal scales (Reips and Funke 2008). However, although not all web survey platforms offer visual analogue scales, you should use them if possible. Fig. 4.10 shows an example of a visual analogue scale that measures customers’ expectations of Oddjob Airways.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fig10_HTML.jpg]
Fig. 4.10Example of a visual analogue scale



Choose between a forced-choice scale and a free-choice scale: Sometimes, researchers and practitioners use 4-point or 6-point scales that omit the neutral category, thereby forcing the respondents to be positive or negative. Using such a forced-choice scale
                      
                     could bias the answers, leading to validity issues.6 By providing a neutral category choice (i.e., a free-choice scale
                      
                    ), the respondents are not forced to give a positive or negative answer. Many respondents feel more comfortable about participating in a survey using a free-choice scale (Nowlis et al. 2002). Furthermore, research has shown that including a neutral category minimizes response bias (Weijters et al. 2010). Therefore, we strongly suggest using free-choice scales and including a neutral category.
Design the response categories
                      
                    : When designing response categories for categorical variables, use response categories that are exclusive, so that answers do not overlap (e.g., age categories 0–4, 5–10, etc.). The question here is: How do we decide on the spacing between the categories? For example, should we divide US household income in the categories 0–$9999, $10,000–$19,999, $20,000-higher, or use another way to set the categories? One suggestion is to use narrower categories if the respondent can recall the variable easily. A second suggestion is to space the categories so that we, as researchers, expect an approximately equal number of observations per category. In the example above, we may find that most households have an income of $20,000 or higher and that categories 0–$9999 and $10,000–$19,999 are infrequently used. It is best to choose categories where equal percentages are expected such as 0–$24,999, $25,000–$44,999, $45,000–$69,999, $70,000–$109,999, $110,000–and higher. Although the range in each category differs, we can reasonably expect each category to hold about 20 % of the responses if we sample US households randomly (https://​en.​wikipedia.​org/​wiki/​Household_​income_​in_​the_​United_​States#Household_​income_​over_​time). Box 4.6 shows a real-life example of oddly chosen response categories (and there are a few other issues too!).
Note that the response categories also give the respondents the range of acceptable answers. Respondents generally view the middle of the scale as normal, or most common, and position themselves in relation to this (e.g., Revilla 2015). For example, Tourangeau and Smith (1996) found that the reported number of sexual partners in an open-ended question is more than twice as high when the answer category labels used in a previously asked closed-ended question on the same topic shifted to indicate higher numbers (from 0, 1, 2, 3, 4, 5 or more to 0, 1–4, 5–9, 10–49, 50–99, 100 or more).
Label the response categories
                      
                    : A common way of labeling response categories is to use endpoint labels only, omitting intermediary labels. For example, instead of labeling all five points of a Likert scale (e.g., “completely disagree,” “disagree,” “neutral,” “agree,” and “completely agree”), we only label the endpoints (e.g., “completely disagree” and “completely agree”). While this approach makes response category labeling easy, it also amplifies acquiescence Chap.​ 5, because the endpoints reinforce the respondents’ agreement (Weijters et al. 2010). Conversely, if all the categories are labeled, this helps the respondents interpret and differentiate, making the midpoint more salient and accessible. Labeling the response categories fully also increases the scale reliability (Weng 2004), but reduces criterion validity. Drawing on Weijters et al. (2010), we generally recommend only labeling the endpoints. However, when using the items for prediction-type analyses, such as in correlation and regression analyses, it is beneficial to label all the categories.7

Decide whether or not to use a “don’t know” option: Another important choice to make is whether or not to include a “don’t know” option
                      
                     in the scaling (Lietz 2010). Using a “don’t know” option allows the researcher to distinguish between those respondents who have a clear opinion and those who do not. Moreover, the respondents may find that answering the survey is slightly easier. While these are good reasons for including this category, the drawback is that there will then be missing observations. If many respondents choose not to answer, this will substantially reduce the number of surveys that can be used for analysis. Generally, when designing surveys, you should only include a “don’t know” (or “undecided”) option as an answer to questions that the respondents might genuinely not know, for example, when requiring answers to factual questions. If included, the option should appear at the end of the scale. The “don’t know” option should not be included in other types of questions (such as on attitudes or preferences), as researchers are interested in the respondents’ perceptions regardless of their knowledge of the subject matter.
Choose between a balanced and unbalanced scale: A balanced scale
                      
                     has an equal number of positive and negative scale categories. For example, in a 5-point Likert scale, we may have two negative categories (completely disagree and disagree), a neutral option, and two positive categories (agree and completely agree). Besides this, the wording in a balanced scale should reflect equal distances between the scale items. This is called an equidistant scale
                      
                    , which is a requirement for analysis techniques such as factor analysis (Chap.​ 8). Consequently, we strongly recommend using a balanced scale instead of an unbalanced scale
                      
                    . A caveat of balanced scales is that many constructs cannot have negative values. For example, one can have some trust in a company or very little trust, but negative trust is highly unlikely. If a scale item cannot be negative, you will have to resort to an unbalanced scale in which the endpoints of the scales are unlikely to be exact opposites. Table 4.1 summarizes the key choices we have to make when designing survey items.
Box 4.6 Oddly chosen response categories

                      [image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Figd_HTML.jpg]

                    
4.4.2.5 Design the Questionnaire
After determining the individual questions, you have to integrate these, together with other elements, to create the questionnaire. Questionnaire design
                    
                   involves the following elements:	Designing the starting pages of the questionnaire,

	choosing the order of the questions, and

	designing the layout and format.





Starting pages of the questionnaire: At the beginning of each questionnaire, the importance and goal are usually described to stress that the results will be treated confidentially, and to mention what they will be used for. This is usually followed by an example question (and answer), to demonstrate how the survey should be filled out. Keep this page very short when using mobile surveys.
If questions relate to a specific issue, moment, or transaction, you should indicate this clearly at the very beginning. For example, “Please provide answers to the following questions, keeping the purchase of product X in mind.” If applicable, you should also point out that your survey is conducted in collaboration with a university, a recognized research institute, or a known charity, as this generally increases respondents’ willingness to participate. Moreover, do not forget to provide a name and contact details for those participants who have questions, or if technical problems should arise. Consider including a photo of the research team, as this increases response rates. Lastly, you should thank the respondents for their time and describe how the questionnaire should be returned (for mail surveys).
Order of the questions: Choosing an appropriate question order
                    
                   is crucial, because it determines the questionnaire’s logical flow and therefore contributes to high response rates. The order of questions is usually as follows:	1.Screening questions
                            
                           (typically simply referred to as screeners
                            
                          ) come first. These questions determine what parts of the survey a respondent should fill out.

 

	2.Next, ask questions relating to the study’s key variables. This includes the dependent variables, followed by the independent variables.

 

	3.Use a funnel approach
                            
                          . That is, ask questions that are more general first and then move on to details. This makes answering the questions easier as the order helps the respondents recall. Make sure that sensitive questions are put at the very end of this section.

 

	4.Questions related to demographics are placed last if they are not part of the screening questions. If you ask demographic questions, always check whether they are relevant to the research goal and if they are not already known.8 In addition, check if these demographics are likely to lead to non-response. Asking about demographics, like income, educational attainment, or health, may result in a substantial number of respondents refusing to answer. If such sensitive demographics are not necessary, omit them from the survey. Note that in certain countries asking about a respondent’s demographic characteristics means you must adhere to specific laws, such as the Data Protection Act 1998 in the UK.

 





If your questionnaire comprises several sections (e.g., in the first section, you ask about the respondents’ buying attitudes and, in the following section, about their satisfaction with the company’s services), you should make the changing context clear to the respondents.
Layout
                    
                   and format
                    
                   of the survey: The layout of both mail and web-based surveys should be concise and should conserve space where possible, particularly in respect of mobile surveys. Avoid using small and colored fonts, which reduce readability. Booklets work well for mail-based surveys, since postage is often cheaper if surveys fit in standard envelopes. If this is not possible, single-sided stapled paper can also work. When using web-based surveys, it is good to have a counter that tells the respondents what percentage of the questions they have already filled out. This gives them some indication of how much time they are likely to need to complete the survey. Make sure the layout is simple and compatible with mobile devices and tablets. Qualtrics and other survey tools offer mobile-friendly display options, which should always be ticked.
4.4.2.6 Pretest the Questionnaire and Execution
We have already mentioned the importance of pretesting
                    
                   the survey several times. Before any survey is sent out, you should pretest the questionnaire to enhance its clarity and to ensure the client’s acceptance of the survey. Once the questionnaire is in the field, there is no way back! You can pretest questionnaires in two ways. In its simplest form, you can use a few experts (say 3–6) to read the survey, fill it out, and comment on it. Many web-based survey tools allow researchers to create a pretested version of their survey, in which there is a text box for comments behind every question. Experienced market researchers can spot most issues right away and should be employed to pretest surveys. If you aim for a very high quality survey, you should also send out a set of preliminary (but proofread) questionnaires to a small sample of 50–100 respondents. The responses (or lack thereof) usually indicate possible problems and the preliminary data can be analyzed to determine the potential results. Never skip pretesting due to time issues, since you are likely to run into problems later!
Motivating potential respondents to participate is an increasingly important aspect of survey research. In addition to Dillman et al.’s (2014) recommendations on how to increase response rates
                    
                   (Box 4.7), incentives are used. A simple example of such an incentive is to provide potential respondents with a cash reward. In the US, one-dollar bills are often used for this purpose. Respondents who participate in (online) research panels often receive points that can be exchanged for products and services. For example, Research Now, a market research company, gives its Canadian panel members AirMiles that can be exchanged for, amongst others, free flights. A special type of incentive is to indicate that some money will be donated to a charity for every returned survey. ESOMAR, the world organization for market and social research (see Chap.​ 10), suggests that incentives for interviews or surveys should “be kept to a minimum level proportionate to the amount of their time involved, and should not be more than the normal hourly fee charged by that person for their professional consultancy or advice.”
Another incentive is to give the participants a chance to win a product or service. For example, you could randomly give a number of participants gifts. The participants then need to disclose their name and address in exchange for a chance to win a gift so that they can be reached. While this is not part of the research itself, some respondents may feel uncomfortable providing their contact details, which could potentially reduce the response rate.
Finally, reporting the findings to the participants is an incentive that may help participation (particularly in professional settings). This can be done by providing a general report of the study and its findings, or by providing a customized report detailing the participant’s responses and comparing them with all the other responses (Winkler et al. 2015). Obviously, anonymity needs to be assured so that the participants cannot compare their answers to those of other individual responses.
Box 4.7 Dillman et al.’s (2014) recommendations on how to increase response rates
It is becoming increasingly difficult to get people to fill out surveys. This may be due to over-surveying, dishonest firms that disguise sales as research, and a lack of time. Dillman et al. (2014) discuss four steps to increase response rates:	1.Send out a pre-notice letter indicating the importance of the study and announcing that a survey will be sent out shortly.

 

	2.Send out the survey with a sponsor letter, again indicating the importance of the study.

 

	3.Follow up after 3–4 weeks with a thank you note (for those who responded) and the same survey, plus a reminder (for those who did not respond).

 

	4.Call or email those who have still not responded and send out a thank you note to those who replied during the second round.

 





4.5 Basic Qualitative Research
Qualitative research
                
               is mostly used to gain an understanding of why certain things happen. It can be used in an exploratory context by defining problems in more detail, or by developing hypotheses to be tested in subsequent research. Qualitative research also allows researchers to learn about consumers’ perspectives and vocabulary, especially if they are not familiar with the context (e.g., the industry). As such, qualitative research offers importance guidance when little is known about consumers’ attitudes and perceptions, or the market (Barnham 2015).
As discussed in Chap.​ 3, qualitative research leads to the collection of qualitative data. One can collect qualitative data by explicitly informing the participants that you are doing research (directly observed qualitative data), or you can simple observe the participants’ behavior without them being explicitly aware of the research goals (indirectly observed qualitative data). There are ethical issues associated with conducting research if the participants are not aware of the research purpose. Always check the regulations regarding what is allowed in your context and what not. It is, in any case, good practice to brief the participants on their role and the goal of the research once the data have been collected.
The two key forms of directly observed qualitative data are in-depth interviews and focus groups. Together, they comprise most of the conducted qualitative market research. First, we will discuss in-depth interviews, which are—as the terms suggests—interviews conducted with one participant at a time, allowing for high levels of personal interaction between the interviewer and respondent. Next, we will discuss projective techniques, a frequently used type of testing procedure in in-depth interviews. Lastly, we will introduce focus group discussions, which are conducted with multiple participants.
4.5.1 In-depth Interviews
In-depth interviews
                  
                 are qualitative conversations with participants on a specific topic. These participants are often consumers, but, in a market research study, they may also be the decision-makers, who are interviewed to gain an understanding of their clients’ needs. They may also be government or company representatives. The structure levels of interviews vary. In their simplest form, interviews are unstructured and the participants talk about a topic in general. This works well if you want to obtain insight into a topic, or as an initial step in a research process. Interviews can also be fully structured, meaning all the questions and possible answer categories are decided beforehand. This way allows you to collect quantitative data. However, most in-depth interviews for gathering qualitative data are semi-structured and contain a series of questions that need to be addressed, but have no specific format regarding what the answers should look like. The person interviewed can make additional remarks, or discuss somewhat related issues, but is not allowed to wander off too far. In these types of interviews, the interviewer often asks questions like “that’s interesting, could you explain?,” or “how come … ?” to gain more insight into the issue. In highly structured interviews, the interviewer has a fixed set of questions and often a fixed amount of time for each person’s response. The goal of structured interviews is to maximize the comparability of the answers. Consequently, the set-up of the questions and the structure of the answers need to be similar.
In-depth interviews are unique in that they allow probing on a one-to-one basis, thus fostering an interaction between the interviewer and interviewee. In-depth interviews also work well when those being interviewed have very little time and when they do not want the information to be shared with the other study participants. This is, for example, probably the case when you discuss marketing strategy decisions with CEOs. The drawbacks of in-depth interviews include the amount of time the researcher needs to spend on the interview itself and on traveling (if the interview is conducted face-to-face and not via the telephone), as well as on transcribing the interview.
When conducting in-depth interviews, a set format is usually followed. First, the interview details are discussed, such as confidentiality issues, the interview topic, the structure, and the duration. Moreover, the interviewer should disclose whether the interview is being recorded and inform the interviewee that there is no right or wrong answer, just opinions on the subject. The interviewer should also try to be open and maintain eye contact with the interviewee. Interviewers can end an interview by informing their respondents that they have reached the last question and thanking them for their time.
Interviews are often used to investigate means-end issues, in which researchers try to understand what ends consumers aim to satisfy and which means (consumption) they use to do so. A means-end approach
                  
                 involves first determining a product’s attributes. These are the functional product features, such as the speed a car can reach or its acceleration. Subsequently, researchers look at the functional consequences that follow from the product benefits. This could be driving fast. The psychosocial consequences, or personal benefits, are derived from the functional benefits and, in this example, could include an enhanced status, or being regarded as successful. Finally, the psychosocial benefits are linked to people’s personal values or life goals, such as a desire for success or acceptance. Analyzing and identifying the relationships between these steps is called laddering
                  
                .
4.5.2 Projective Techniques
Projective techniques
                  
                 describe a special type of testing procedure, usually used as part of in-depth interviews. These techniques provide the participants with a stimulus and then gauge their responses. Although participants in projective techniques know that they are participating in a market research study, they may not be aware of the research’s specific purpose. The stimuli that the projective techniques provide are ambiguous and require a response from the participants. Sentence completion
                  
                 is a key form of projective techniques.

                	An iPhone user is someone who:
	...................................................................

	The Apple brand makes me think of:
	...................................................................

	iPhones are most liked by:
	...................................................................




              
In this example, the respondents are asked to express their feelings, ideas, and opinions in a free format.
Projective techniques’ advantage is that they allow for responses when people are unlikely to respond if they were to know the study’s exact purpose. Thus, projective techniques can overcome self-censoring and allow expression and fantasy. In addition, they can change a participant’s perspective. Think of the previous example. If the participants are iPhone users, the sentence completion example asks them how they think other people regard them, not what they think of the iPhone. A drawback is that projective techniques require the responses to be interpreted and coded, which can be difficult.
4.5.3 Focus Groups
Focus groups
                  
                 are interviews conducted with a number of respondents at the same time and led by a moderator. This moderator leads the interview, structures it, and often plays a central role in transcribing the interview later. Focus groups are usually semi or highly structured. The group usually comprises between 6 and 10 people to allow for interaction between the participants and to ensure that all the participants have a say. The duration of a focus group interview varies, but is often between 30 and 90 minutes for company employee focus groups and between 60 to 120 minutes for consumers. When focus groups are held with company employees, moderators usually travel to the company and conduct their focus group in a room. When consumers are involved, moderators often travel to a market research company, or hotel, where the focus group meets in a conference room. Market research companies often have specially equipped conference rooms with, for example, one-way mirrors, built-in microphones, and video recording devices.
How are focus groups structured? They usually start with the moderator introducing the topic and discussing the background. Everyone in the group is introduced to all the others to establish rapport. Subsequently, the moderator encourages the members of the focus group to speak to one another, instead of asking the moderator for confirmation. Once the focus group members start discussing topics with one another, the moderator tries to stay in the background, merely ensuring that the discussions stay on-topic. Afterwards, the participants are briefed and the discussions are transcribed for further analysis.
Focus groups have distinct advantages: they are relatively cheap compared to in-depth interviews, work well with issues that are socially important, or which require spontaneity. They are also useful for developing new ideas. On the downside, focus groups do not offer the same opportunity for probing as interviews do, and also run a greater risk of going off-topic. Moreover, a few focus group members may dominate the discussion and, especially in larger focus groups, “voting” behavior may occur, hindering real discussions and the development of new ideas. Table 4.2 summarizes the key differences between focus groups and in-depth interviews.Table 4.2Comparing focus groups and in-depth interviews


	 	Focus groups
	In-depth interviews

	Group interactions
	Group interaction, which may stimulate the respondents to produce new thoughts.
	There is no group interaction. The interviewer is responsible for stimulating the respondents to produce new ideas.

	Group/peer pressure
	Group pressure and stimulation may clarify and challenge thinking.
	In the absence of group pressure, the respondents’ thinking is not challenged.

	Peer pressure and role playing.
	With just one respondent, role playing is minimized and there is no peer pressure.

	Respondent competition
	Respondents compete with one another for time to talk. There is less time to obtain in-depth details from each participant.
	Individuals are alone with the interviewer and can express their thoughts in a non-competitive environment. There is more time to obtain detailed information.

	Peer influence
	Responses in a group may be biased by other group members’ opinions.
	With one respondent, there is no potential of other respondents influencing this person.

	Subject sensitivity
	If the subject is sensitive, respondents may be hesitant to talk freely in the presence of other people.
	If the subject is sensitive, respondents may be more likely to talk.

	Stimuli
	The volume of stimulus materials that can be used is somewhat limited.
	A fairly large amount of stimulus material can be used.

	Interviewer schedule
	It may be difficult to assemble between 6 and 10 respondents if they are a difficult type to recruit (such as busy executives).
	Individual interviews are easier to schedule.





Learn more about focus groups in this TED-Ed video.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Fige_HTML.png]
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4.6 Collecting Primary Data through Experimental Research
In Chap.​ 2, we discussed causal research
                
               and briefly introduced experiments as a means of conducting research
                
              . The goal of experiments is to avoid unintended influences through the use of randomization. Experiments are typically conducted by manipulating one variable, or a few, at a time. For example, we can change the price of a product, the type of product, or the package size to determine whether these changes affect important outcomes such as attitudes, satisfaction, or intentions. Simple field observations are often unable to establish these relationships, as inferring causality is problematic. Imagine a company that wants to introduce a new type of soft drink aimed at health-conscious consumers. If the product were to fail, the managers would probably conclude that the consumers did not like the product. However, many (usually unobserved) variables, such as competitors’ price cuts, changing health concerns, and a lack of availability, can also influence new products’ success.
4.6.1 Principles of Experimental Research
Experiments
                  
                 deliberately impose one or more treatments
                  
                 and then observe the outcome of a specific treatment (Mitchell and Jolley 2013). This way, experiments attempt to isolate how one change affects an outcome. The outcome(s) is (are) the dependent variable(s) and the independent variable(s) (also referred to as factors) are used to explain the outcomes. To examine the influence of the independent variable(s) on the dependent variable(s), the participants are subjected to treatments. These are supposed to manipulate the participants by putting them in different situations. A simple form of treatment could be an advertisement with and without humor. In this case, the humor is the independent variable, which can take two levels (i.e., with or without humor). If we manipulate, for example, the price between low, medium, and high, we have three levels. When selecting independent variables, we normally include those that marketers care about and which are related to the marketing and design of the products and services. To assure that the participants do indeed perceive differences, manipulation checks
                  
                 are conducted. For example, if two different messages with and without humor are used as stimuli, we could ask the respondents which of the two is more humorous. Such manipulation checks help establish an experiment’s validity.
Care should be taken not to include too many of these variables in order to keep the experiment manageable. An experiment that includes four independent variables, each of which has three levels and includes every possible combination (called a full factorial design
                  
                ) requires 43 = 64 treatments. Large numbers of levels (5 or more) will dramatically increase the complexity and cost of the research. Finally, extraneous variables
                  
                , such as the age or income of the experiment participant, are not changed as part of the experiment. However, it might be important to control for their influence when setting up the experimental design.
Experiments can run in either a lab or field environment. Lab experiments
                  
                 are performed in controlled environments (usually in a company or academic lab), thereby allowing for isolating the effects of one or more variables on a certain outcome. Extraneous variables’ influence can also be controlled for. Lab experiments stand out in terms of internal validity
                  
                , which is the extent to which we can make causal claims based on the study. However, as they take place in controlled experimental settings, which typically ignore real-world business conditions, they therefore usually lack external validity
                  
                , which is the extent to which the study results can be generalized to similar settings. Field experiments
                  
                , on the other hand, are performed in natural environments (e.g., in a supermarket or in home) and, as such, generally exhibit high degrees of external validity. However, since controlling for extraneous variables’ impact is difficult in natural environments, field experiments usually lack internal validity (Gneezy 2017).
Experiments can be incredibly useful but conducting experiments without user consent can result in a consumer backlash, ethics concerns, or may even be illegal as Facebook found out.[image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Figf_HTML.png]
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4.6.2 Experimental Designs
Experimental design
                  
                 refers to an experiment’s structure. There are various types of experimental designs. To clearly separate the different experimental designs, researchers have developed the following notation:	O:
	A formal observation or measurement of the dependent variable. Subscripts below an observation O such as 1 or 2, indicate measurements at different points in time.

	X:
	The test participants’ exposure to an experimental treatment.

	R:
	The random assignment of participants. Randomization ensures control over extraneous variables and increases the experiment’s reliability and validity.





In the following, we will discuss the most prominent experimental designs:	One-shot case study,

	before-after design,

	before-after design with a control group, and

	Solomon four-group design.





The simplest form of experiment is the one-shot case study
                  
                . This type of experiment is structured as follows:9
	X
	O1






This means we have one treatment (indicated by X), such as a new advertising campaign. After the treatment, we await reactions to it and then measure the outcome of the manipulation (indicated by O1), such as the participants’ willingness to purchase the advertised product. This type of experimental set-up is common, but does not tell us if the effect is causal. One reason for this is that we did not measure anything before the treatment and therefore cannot assess what the relationship between the treatment and outcome is. The participants’ willingness to purchase the product was perhaps higher before they were shown the advertisement, but since we did not measure their willingness to purchase before the treatment, this cannot be ruled out. Consequently, this design does not allow us to establish causality.
The simplest type of experiment that allows us to make causal inferences—within certain limits—is the before-after design
                  
                 used for one group. The notation for this design is:	O1

	X
	O2






We have one measurement before (O1) and one after a treatment (O2). Thus, this type of design can be used to determine whether an advertisement has a positive, negative, or no effect on the participants’ willingness to purchase a product.
A problem with this type of design is that we do not have a standard of comparison with which to contrast the change between O1 and O2. While the advertisement may have increased the participants’ willingness to purchase, this might have been even higher if they had not seen the advertisement. The reason for this is that the before-after-design does not control for influences occurring between the two measurements. For example, negative publicity after the initial measurement could influence the subsequent measurement. These issues make the “real” effect of the advertisement hard to assess.
If we want to have a much better chance of identifying the “real” effect of a treatment, we need a more complex setup, called the before-after design with a control group
                  
                . In this design, we add a control group who is not subjected to the treatment X. The notation of this type of experiment is:	Experimental group (R)
	O1

	X
	O2


	Control group (R)
	O3

	 	O4






The effect attributed to the experiment is the difference between O1 and O2 minus the difference between O3 and O4. For example, if the participants’ willingness to purchase increases much stronger in the experimental group (i.e., O2 is much higher than O1) than in the control group (i.e., O4 is slightly higher than or equal to O3), the advertisement has had an impact on the participants.
The random
                  
                 assignment of the participants to the experimental and the control groups (indicated by R), is an important element of this experimental design. This means that, for any given treatment, every participant has an equal probability of being chosen for one of the two groups. This ensures that participants with different characteristics are spread randomly (and, it is hoped, equally) between the treatment(s), which will neutralize self-selection
                  
                . Self-selection occurs when participants can select themselves into either the experimental or the control group. For example, if participants who like sweets participate in a cookie tasting test, they will certainly try to give the treatment (cookie) a try! See Mooi and Gilliland (2013) for an example of self-selection and an analysis method.
However, the before-after experiment with a control group does have limitations. The initial measurement O1 may alert the participants that they are being studied, which may bias the post measurement O2. This effect is also referred to as the before measurement effect
                  
                , or the testing effect
                  
                 (Campbell and Stanley 1966). Likewise, the initial measurement O1 may incite the participants to drop out of the experiment, leading to no recorded response for O2. If there is a systematic reason for the participants to drop out, this will threaten the experiment’s validity.
The Solomon four-group design
                  
                 is an experimental design accounting for before measurement effects and is structured as follows (Campbell and Stanley 1966):	Experimental group 1 (R)
	O1

	X
	O2


	Control group 1 (R)
	O3

	 	O4


	Experimental group 2 (R)
	 	X
	O5


	Control group 2 (R)
	 	 	O6






The design is much more complex, because we need to measure the effects six times and administer two treatments. This method provides an opportunity to control for the before measurement effect of O1 on O2. The design also provides several measures of the treatment’s effect (i.e., (O2–O4), (O2–O1)–(O4–O3), and (O6–O5)). If these measures agree, the inferences about the treatment’s effect are much stronger.
In Chap.​ 6, we discuss how to analyze experimental data using ANOVA and various other tests.
4.7 Oddjob Airways (Case Study)
Case Study

                [image: ../images/210704_3_En_4_Chapter/210704_3_En_4_Figg_HTML.png]

                        Oddjob Airways
                      


              
Founded in 1962 by the Korean businessman Toshiyuki Sakata, Oddjob Airways is a small premium airline, mainly operating in Europe, but also offering flights to the US.10 The company regularly conducts market research in order to monitor its service quality and to improve customer satisfaction. The market research department has uploaded a series of videos on https://​www.​oddjobairways.​com/​market-research/​, which document some of the recent projects. Please help the department by answering the following questions:	1.Go to https://​www.​oddjobairways.​com/​market-research/​interviews/​ and watch the three videos. Try to identify all errors that the interviewer made. You can find the solutions under „Corrections.“

 

	2.Under https://​www.​oddjobairways.​com/​market-research/​experiments/​, you will find two videos, which show safety videos with male and female voice-overs. Carry out an experiment, which contrasts viewers’ perceptions of the safety video (e.g., in terms of satisfaction) when the voice-over is male vs. female. Compute the mean values (Chap.​ 5) for each group. In a further step, carry out independent samples t-tests (Chap.​ 6) to check for significant differences between the two groups.

 

	3.Go to https://​www.​oddjobairways.​com/​market-research/​focus-group/​ and watch the video on focus groups. Would you have spotted all errors?

 





4.8 Review Questions

              	1.What is the difference between primary and secondary data? Can primary data become secondary data?

 

	2.Please search for and download two examples of secondary data sources found on the Internet. Discuss two potential market research questions that each dataset can answer.

 

	3.Imagine you are asked to understand what consumer characteristics make these consumers likely to buy a BMW i3 (http://​www.​bmw.​com). How would you collect the data? Would you start with secondary data, or would you start collecting primary data directly? Do you think it is appropriate to collect qualitative data? If so, at what stage of the process should you do so?

 

	4.What are the different reasons for choosing interviews rather than focus groups? What choice would you make if you want to understand CEOs’ perceptions of the economy, and what would seem appropriate when you want to understand how consumers feel about a newly introduced TV program?

 

	5.Consider the following examples of survey items relating to how satisfied iPhone users are with their performance, reliability, and after-sales service. Please assess their adequacy and make suggestions on how to revise the items, if necessary.

 




            

              	 	Strongly disagree
	Somewhat disagree
	Somewhat agree
	Agree
	Completely agree

	I am satisfied with the performance and reliability of my iPhone
	□
	□
	□
	□
	□




              	 	Strongly disagree
	Somewhat disagree
	Neutral
	Somewhat agree
	Completely agree

	I am satisfied with the after-sales service of my iPhone
	□
	□
	□
	□
	□




              	Which of the following iPhone features do you find most important?
	Not at all important
	Not important
	Neutral
	Important
	Very important

	Camera
	□
	□
	□
	□
	□

	Music player
	□
	□
	□
	□
	□

	App store
	□
	□
	□
	□
	□

	Web browser
	□
	□
	□
	□
	□

	Mail
	□
	□
	□
	□
	□




            

              	6.Make recommendations regarding the following aspects of scale design: the number of response categories, the design and labeling of response categories, and the inclusion of a “don’t know” option.

 

	7.Describe the Solomon four-group design and explain which of the simpler experimental design problems it controls for.

 

	8.If you were to set up an experiment to ascertain what type of product package (new or existing) customers prefer, what type of experiment would you choose? Please discuss.

 




            
References
	Barnham, C. (2015). Quantitative and qualitative research: Perceptual foundations. International Journal of Market Research, 57(6), 837–854.Crossref

	Baumgartner, H., & Steenkamp, J. B. E. M. (2001). Response styles in marketing research: A cross-national investigation. Journal of Marketing Research, 38(2), 143−156.Crossref

	Brace, I. (2004). Questionnaire design. How to plan, structure and write survey material for effective market research. London: Kogan Page.

	Brislin, R. W. (1970). Back-translation for cross-cultural research. Journal of Cross-Cultural Psychology, 1(3), 185–216.Crossref

	Bronner, F., & Ton, K. (2007). The live or digital interviewer. A comparison between CASI, CAPI and CATI with respect to differences in response behaviour. International Journal of Market Research, 49(2), 167–190.Crossref

	Brosnan, K., Grpn, B., & Dolnicar, S. (2017). PC, phone or tablet? Use, preference and completion rates for web surveys. International Journal of Market Research, 59(1), 35–55.

	Cabooter, E., Weijters, B., Geuens, M., & Vermeir, E. (2016). Scale format effects on response option interpretation and use. Journal of Business Research, 69(7), 2574–2584.Crossref

	Casteleyn, J., André, M., & Kris, R. (2009). How to use facebook in your market research. International Journal of Market Research, 51(4), 439–447.Crossref

	DeMonaco, H. J., Ayfer, A., & Hippel, E. V. (2005). The major role of clinicians in the discovery of off-label drug therapies. Pharmacotherapy, 26(3), 323–332.Crossref

	Deutskens, E., De Jong, A., De Ruyter, K., & Martin, W. (2006). Comparing the generalizability of online and mail surveys in cross-national service quality research. Marketing Letters, 17(2), 119–136.Crossref

	Dillman, D. A., Smyth, J. D., & Christian, L. M. (2014). Internet, phone, mail, and mixed-mode surveys: The tailored design method (4th ed.). Hoboken, NJ: John Wiley & Sons.

	Fink, A. (2003) How to ask survey questions. Thousand Oaks, CA: Sage.Crossref

	Foddy, W. (1993). Constructing questions for interviews and questionnaires. Theory and practice in social science research. Cambridge: Cambridge University Press.Crossref

	Gneezy, A. (2017). Field experimentation in marketing research. Journal of Marketing Research, 54(1), 140–143.Crossref

	Holbrook, A., Cho, Y. I. K., & Johnson, T. (2006). The impact of question and respondent characteristics on comprehension and mapping difficulties. Public Opinion Quarterly, 70(4), 565–595.Crossref

	Houston, M. B. (2002). Assessing the validity of secondary data proxies for marketing constructs. Journal of Business Research, 57(2), 154–161.Crossref

	Kennedy, C., & Everett, S. E. (2011). Use of cognitive shortcuts in landline and cell phone surveys. Public Opinion Quarterly, 75(2), 336–348.Crossref

	Kurylko, D. T. (2005). Moonraker project seeks marketing savvy for VW. Automotive News Europe, 10(17), 22.

	Lietz, P. (2010). Research into questionnaire design. A summary of the literature. International Journal of Market Research, 52(2), 249–272.Crossref

	Liu, M., Lee, S., & Conrad, F. G. (2016). Comparing extreme response styles between agree-disagree and item-specific scales. Public Opinion Quarterly, 79(4), 952–975.Crossref

	Lynn, P., & Kaminska, O. (2013). The impact of mobile phones on survey measurement error. Public Opinion Quarterly, 77(2), 586–605.Crossref

	Mooi, E., & Gilliland, D. I. (2013). How contracts and enforcement explain transaction outcomes. International Journal of Research in Marketing, 30(4), 395–405.Crossref

	Mitchell, M. L., & Jolley, J. M. (2013). Research design explained (8th ed.). Belmont, CA: Wadsworth.

	Nowlis, S. M., Kahn, B. E., & Dhar, R. (2002). Coping with ambivalence: The effect of removing a neutral option on consumer attitude and preference judgments. Journal of Consumer Research, 29(3), 319–334.Crossref

	Oppenheim, A. N. (1992). Questionnaire design, Interviewing and attitude measurement. London: Pinter.

	Peng, L., & Finn, A. (2016). Assessing response format effects on the scaling of marketing stimuli. International Journal of Market Research, 58(4), 595–619.

	Peterson, R. A. (1997). A quantitative analysis of rating-scale response variability. Marketing Letters, 8(1), 9–21.Crossref

	Raithel, S., Sarstedt, M., Scharf, S., & Schwaiger, M. (2012). On the value relevance of customer satisfaction. Multiple drivers in multiple markets. Journal of the Academy of Marketing Science, 40(4), 509–525.Crossref

	Rammstedt, B., & Krebs, D. (2007) Does response scale format affect the answering of personality scales? European Journal of Psychological Assessment, 23(1), 32–38.Crossref

	Reips, U.-D., & Funke, F. (2008). Interval-level measurement with visual analogue scales in Internet-based research: VAS generator. Behavior Research Methods, 40(3), 699–704.Crossref

	Revilla, M. (2015). Effect of using different labels for the scales in a web survey. International Journal of Market Research, 57(2), 225–238.Crossref

	Rindfleisch, A., & Heide, J. B. (1997). Transaction cost analysis: Past, present, and future applications. Journal of Marketing, 61(4), 30–54.Crossref

	Sarstedt, M., Diamantopoulos, A., Salzberger, T., & Baumgartner, P. (2016). Selecting single items to measure doubly concrete constructs: A cautionary tale. Journal of Business Research, 69(8), 3159-3167.Crossref

	Schilling, M. A. (2009). Understanding the alliance data. Strategic Management Journal, 30(3), 233–260.Crossref

	Stern, M. J., Bilgen, I., & Dillman, D. A. (2014). The state of survey methodology challenges, dilemmas, and new frontiers in the era of the tailored design, Field Methods, 26(3), 284–301.Crossref

	Stieglitz, S., Dang-Xuan, L., Bruns, A., & Neuberger, C. (2014). Social media analytics, An interdisciplinary approach and its implications for information systems. Business & Information Systems Engineering, 6(2), 89−96.Crossref

	Swain, S. D., Weathers, D., & Niedrich, R. W. (2008). Assessing three sources of misresponse to reversed Likert items. Journal of Marketing Research, 45(1), 116−131.Crossref

	Tourangeau, R., & Smith, T. W. (1996). Asking sensitive questions: the impact of data collection mode, question format, and question context. Public Opinion Quarterly, 60(2), 275–304.Crossref

	Vesta Research. (2016). Rules of thumb for survey length. Vesta Research Blog. Available at: http://​www.​verstaresearch.​com/​blog/​rules-of-thumb-for-survey-length/​


	Vicente, P., & Reis, E. (2010). Marketing research with telephone surveys: Is it time to change? Journal of Global Marketing, 23(4), 321−332.Crossref

	Vincente, P., Reis, E., & Santos, M. (2008). Using mobile phones for survey research. International Journal of Market Research, 51(5), 613–633.

	Weijters, B., & Baumgartner, H. (2012). Misresponse to reversed and negated items in surveys: A review. Journal of Marketing Research, 49(5), 737–747.Crossref

	Weijters, B., Cabooter, E., & Schillewaert, N. (2010). The effect of rating scale format on response styles: The number of response categories and response category labels. International Journal of Research in Marketing, 27(3), 236–247.Crossref

	Weijters, B., Baumgartner, H., & Schillewaert, N. (2013). Reversed item bias: An integrative model. Psychological Methods, 18(3), 320–334.Crossref

	Weng, L.-J. (2004). Impact of the number of response categories and anchor labels on coefficient alpha and test-retest reliability. Educational and Psychological Measurement, 64(6), 956–972.Crossref

	Winkler, T. J., Sarstedt, M., Keil, M., & Rost, P. (2015). Selfsurvey.org: A platform for prediction-based benchmarking and feedback-enabled survey research. Proceedings of the European Conference on Information Systems, Paper 204, Münster, Germany.


Further Reading
	Barnham, C. (2015). Quantitative and qualitative research: Perceptual foundations. International Journal of Market Research, 57(6), 837–854.Crossref

	Campbell, D. T., & Stanley, J. C. (1966). Experimental and quasi-experimental designs for research. Chicago: Wadsworth Publishing.

	Cook, T. D., & Campbell, D. T. (1979). Quasi-experimentation: Design and analysis issues for field settings. Chicago, IL: Wadsworth Publishing.

	Dillman, D. A., Smyth, J. D., & Christian, L. M. (2014). Internet, phone, mail, and mixed-mode surveys: The tailored design method (4th ed.). Hoboken, NJ: John Wiley & Sons.

	FocusGroupTips.com.

	Gideon, L. (2012). The art of questionnaire phrasing. In: L. Gideon (Ed.), Handbook of survey methodology for the social sciences (pp. 91–108). New York, NJ: Springer.Crossref

	Hulland, J., Baumgartner, H., & Smith, K.M. (2018). Marketing survey research best practices: Evidence and recommendations from a review of JAMS articles. Journal of the Academy of Marketing Science, 46(1), 92–108.Crossref

	Lichters, M., Sarstedt, M., & Vogt, B. (2015). On the practical relevance of the attraction effect: a cautionary note and guidelines for context effect experiments. AMS Review, 5(1-2), 1–19.Crossref

	Lietz, P. (2010). Current state of the art in questionnaire design: a review of the literature. International Journal of Market Research, 52(2), 249–272.Crossref

	Morales, A. C., Amir, O., & Lee, L. (2017). Keeping it real in experimental research. Understanding when, where, and how to enhance realism and measure consumer behavior. Journal of Consumer Research, 44(2), 465–476.Crossref

	Mystery Shopping Providers Association (www.​mysteryshop.​org).

	Norman, G. (2010). Likert scales, levels of measurement and the “laws” of statistics. Advances in Health Sciences Education, 15(5), 625–632.Crossref

	Smyth, J.D., Olson, K., & Burke, A. (2018). Comparing survey ranking question formats in mail surveys. International Journal of Market Research, forthcoming.

	Veludo-de-Oliveira, T. M., Ikeda, A. A., & Campomar, M. C. (2006). Laddering in the practice of marketing research: Barriers and solutions. Qualitative Market Research: An International Journal, 9(3), 297–306.Crossref



Footnotes
1This quote has been attributed to Peter F. Drucker.

 

2See https://​www.​theacsi.​org for a detailed description of how ACSI data are collected.

 

3Issues related to construct validity in business marketing are discussed by, for example, Rindfleisch and Heide (1997). A more general discussion follows in Houston (2002).

 

4For a comparison of response behavior between CASI, CAPI, and CATI, see Bronner and Ton (2007).

 

5Foddy (1993) reported 445 interpretations of the word “usually,” with the meaning assigned to the word varying, depending on, for example, the type of activity or who was asked about the activity.

 

6Forced-choice scales can, of course, also be used for uneven response categories such as 5-point or 7-point Likert scales.

 

7Sometimes, researchers number the response options. For example, when numbering the response options of a 7-point scale you can use only positive numbers (1 to 7), or positive and negative numbers (-3 to +3). For recommendations, see Cabooter et al. (2016).

 

8The demographics of panels (see Sect. 4.4.2.2) are usually known.

 

9If one symbol precedes another, it means that the first symbol precedes the next one in time.

 

10All chapters dealing with research methods (i.e., Chapters 5-9) also draw on the Oddjob Airways case study. We introduce the case study in greater detail in section 5.​8.
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After reading this chapter, you should understand:	The workflow involved in a market research study.

	Univariate and bivariate descriptive graphs and statistics.
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	How to identify and deal with outliers.

	What a codebook is.
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5.1 The Workflow of Data
Market research projects involving data become more efficient and effective if they have a proper workflow
                
              , which is a strategy to keep track of entering, cleaning, describing, and transforming data. These data may have been collected through surveys or may be secondary data (Chap.​ 3). Entering, cleaning, and analyzing bits of data haphazardly is not a (good) strategy, since it increases the likelihood of making mistakes and makes it hard to replicate results. Moreover, without a good data workflow, it becomes hard to document the research process and to cooperate on projects. For example, how can you outsource the data analysis if you cannot indicate what the data are about or what specific values mean? Finally, a lack of a good workflow increases the risk of duplicating work or even losing data. In Fig. 5.1, we show the steps required to create and describe a dataset after the data have been collected. We subsequently discuss each step in greater detail.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig1_HTML.png]
Fig. 5.1The workflow of data



5.2 Create Structure
The basic idea of setting up a good workflow is that good planning saves the researcher time, allows researchers to share the analysis, and/or allows replicating the research. After the data collection phase, the first step is to save the available data. We recommend keeping track of the dataset by providing data and data-related files in separate directories. This directory should have subdirectories for at least: (1) the data files, (2) commands, (3) a temporary directory, and (4) related files; that is, a directory with files that are directly related to a project, such as the survey used to collect the data.1

In Table 5.1, we show an example of a directory structure. Within the main directory, there are four subdirectories, each with distinct files. Notice that in the Data files subdirectory, we have the original dataset, two modified datasets (one without missing data and one which includes several transformations of the data), as well as a zip file that contains the original dataset. If the data file is contained in a zip or other archive file, it is stored and unlikely to be modified, but can be easily opened if the working file is accidentally overwritten or deleted. In the Data files subdirectories, we distinguish between two files with the suffix rev1 and rev2. We use rev (abbreviation of revision), but you however, choose another file name as long as it clearly indicates the revision on which you are working. In the Syntax files subdirectory, we store all syntax code that were used to manage and analyze our data. These commands may relate to different project phases, including a missing data analysis, descriptives, factor analysis, and other methods used over the course of the project. The Output files subdirectory includes a series of files with results from different statistical analyses. As the name indicates, Temporary files serve as intermediary files that are kept until the final data or command files are established, after which they are removed. Finally, in the Related Files subdirectory, we have a codebook (more on this later), the survey, two presentations, and two documents containing recommendations.Table 5.1Example of a directory structure for saving market-research-related files


	Directory name
	Subdirectory name
	Example file names

	Oddjob
	Data files
	oddjob.sav

	oddjob.zip

	oddjob rev1.sav

	oddjob rev2.sav

	Syntax files
	Missing data analysis.sps

	Descriptives.sps

	Factor analysis.sps

	Regression analysis.sps

	Output files
	Missing data analysis.spv

	Descriptives.spv

	Factor analysis.spv

	Regression analysis.spv

	Temporary files
	Missing data analysis rev1.spv

	Descriptives rev1.spv

	Factor analysis rev1.spv

	Regression analysis rev1.spv

	Related files
	Codebook.docx

	Survey.pdf

	Initial findings–presentation to client.pptx

	Findings–presentation to client.pptx

	Recommendations rev1.docx

	Recommendations rev2.docx





Another aspect of creating a structure is setting up the variables for your study properly. This involves making decisions on the following elements:	Variable names,

	variable labels,

	data type, and

	coding of variables.





The variable names
                
               should be clear and short so that they can be read in the dialog boxes. For example, if you have three questions on product satisfaction, three on loyalty, and several descriptors (age and gender), you could code these variables as satisfaction1, satisfaction2, satisfaction3, loyalty1, loyalty2, loyalty3, age, and gender.
In SPSS, and most other statistical software programs, you can include variable labels that describe what each variable denotes. The description generally includes the original question if the data were collected using surveys. Another point to consider is variable coding
                
              . Coding means assigning values to a variable. When collecting quantitative data, the task is relatively easy; we use values that correspond with the answers for Likert and semantic differential scales. For example, when using a 7-point Likert scale, responses can be coded as 1–7 or as 0–6 (with 0 being the most negative and 6 being the most positive response). Open-ended questions (qualitative data
                
              ) require more effort, usually involving a three-step process. First, we collect all the responses. In the second step, we group these responses. Determining the number of groups and the group to which a response belongs is the major challenge in this step. Two or three market researchers usually code the responses independently to prevent the process from becoming too subjective and thereafter discuss the differences that may arise. The third step is providing a value for each group. Please see Krippendorff (2012) for more details about coding qualitative variables.
Once a system has been set up to keep track of your progress, you need to consider safeguarding your files. Large companies usually have systems for creating backups (extra copies as a safeguard). If you are working alone or for a small company, you are probably responsible for this. You should save your most recent and second most recent version of your file on a separate drive and have multiple copies of your entire drive! Always keep at least two copies and never keep both backups in the same place, because you could still lose all your work through theft, fire, or an accident! You can use cloud storage services, such as Amazon’s storage services, or Dropbox, Google Drive, or Microsoft’s OneDrive for small projects to prevent loss. Always read the terms of the cloud storage services carefully to determine whether your data’s privacy is guaranteed.
The following video gives a brief introduction into qualitative coding.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figa_HTML.png]
© vgajic/Getty Images/iStock
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5.3 Enter Data
How do we enter survey or experimental data into a dataset? Specialized software is often used for large datasets, or datasets created by professional firms. For example, Epidata (http://​www.​epidata.​dk, freely downloadable) is frequently used to enter data from paper-based surveys, Confirmit’s mobile survey (http://​www.​confirmit.​com) to enter data from personal intercepts or face-to-face interviewing, and Voxco’s Interviewer CATI for telephone interviewing. The SPSS Data Collection Family (http://​www.​spss.​com.​hk/​software/​data-collection/​) is a suite of different software packages specifically designed to collect and (automatically) enter data collected from online, telephone, and paper-based surveys.
Such software may not be available for smaller projects, in which case data should be entered directly into SPSS. A significant drawback of direct data entry is the risk of typing errors, for which SPSS cannot check. Professional software, such as Epidata, can directly check if values are admissible. For example, if a survey question has only two answer categories, such as gender (coded 0/1), Epidata (and other packages) can directly check if the value entered is 0 or 1, and not any other value. The software also allows for using multiple typists when very large amounts of data need to be entered simultaneously.
5.4 Clean Data
Cleaning data is the next step in the workflow. It requires checking for:	Interviewer fraud,

	suspicious response patterns,

	data entry errors,

	outliers, and

	missing data.





These issues require researchers to make decisions very carefully. In the following, we discuss each issue in greater detail. Table 5.3 summarizes the key recommendations discussed in the following sections.
5.4.1 Interviewer Fraud
Interviewer fraud
                  
                 is a difficult and serious issue. It ranges from interviewers “helping” respondents provide answers to entire surveys being falsified. Interviewer fraud often leads to incorrect results. Fortunately, we can avoid and detect interviewer fraud in various ways. First, never base interviewers’ compensation on the number of completed responses they submit. Second, check and control for discrepancies in respondent selection and responses. If multiple interviewers were used, each of whom collected a reasonably large number of responses (n > 100), a selection of the respondents should be similar. This means that the average responses obtained should also be similar. In Chap.​ 6 we will discuss techniques to test this. Third, if possible, contact a random number of respondents afterwards for their feedback on the survey. If a substantial number of people claim they were not interviewed, interviewer fraud is likely. Furthermore, if people were previously interviewed on a similar subject, the factual variables collected, such as their gender, should not change (or no more than a trivial percentage), while variables such as a respondent’s age and highest education level should only move up. We can check this using descriptive statistics. If substantial interviewer fraud is suspected, the data should be discarded. You should check for interviewer fraud during the data collection process to safeguard the quality of data collection and minimize the risk of having to discard the data in the end.
5.4.2 Suspicious Response Patterns
Before analyzing data, we need to identify suspicious response patterns
                  
                . There are two types of response patterns we need to look for:	Straight-lining, and

	inconsistent answers.





Straight-lining
                  
                 occurs when a respondent marks the same response in almost all the items. For example, if a 7-point scale is used to obtain answers and the response pattern is 4 (the middle response), or if the respondent selects only 1s, or only 7s in all the items. A common way of identifying straight-lining is by including one or more reverse-scaled items
                  
                 in a survey (see Chap.​ 4). By evaluating the response patterns, we can differentiate between those respondents who are not consistent for the sake of consistency and those who are merely mindlessly consistent. Note, however, that this only applies if respondents do not tick the middle option. Straight-lining is very common, especially in web surveys where respondents generally pay less attention to the answers. Likewise, long surveys and those with many similarly worded items trigger straight-lining (Drolet and Morrison 2001). An alternative is to note potential straight-lined responses and include this as a separate category in the subsequent statistical analyses. This step avoids the need to reduce the sample and indicates the size and direction of any bias.
However, straight-lining can also be the result of culture-specific response styles
                  
                . For example, respondents from different cultures have different tendencies regarding selecting the mid points (middle response styles
                  
                ) or the end points of a response scale (extreme response styles
                  
                ). Similarly, respondents from different cultures have different tendencies regarding agreeing with statements, regardless of the item content; this tendency is also referred to as acquiescence
                  
                 (Baumgartner and Steenkamp 2001). For example, respondents from Spanish-speaking countries tend to show higher extreme response styles and high acquiescence, while East Asian (Japanese and Chinese) respondents show a relatively high level of middle response style. Within Europe, the Greeks stand out as having the highest level of acquiescence and a tendency towards an extreme response style. Harzing (2005) and Johnson et al. (2005) provide reviews of culture effects on response behavior.
Inconsistent answers
                  
                 also need to be addressed before analyzing your data. Many surveys start with one or more screening questions. The purpose of a screening question is to ensure that only individuals who meet the prescribed criteria complete the survey. For example, a survey of mobile phone users may screen for individuals who own an iPhone. If an individual indicates that he/she does not have an iPhone, this respondent should be removed from the dataset.
Surveys often ask the same question with slight variations, especially when reflective measures (see Box 3.1 in Chap.​ 3) are used. If a respondent gives a different answer to very similar questions, this may raise a red flag and could suggest that the respondent did not read the questions closely, or simply marked answers randomly to complete the survey as quickly as possible.
5.4.3 Data Entry Errors
When data are entered manually, data entry errors
                  
                 occur routinely. Fortunately, such errors are easy to spot if they happen outside the variable’s range. That is, if an item is measured using a 7-point scale, the lowest value should be 1 (or 0) and the highest 7 (or 6). We can check if this is true by using descriptive statistics (minimum, maximum, and range; see next section). Data entry errors should always be corrected by going back to the original survey. If we cannot go back (e.g., because the data were collected using face-to-face interviews), we need to delete this specific observation for this specific variable.
More subtle errors—for example, incorrectly entering a score of 4 as 3—are difficult to detect using statistics. One way to check for these data entry errors is to randomly select observations and compare the entered responses with the original survey. We do, of course, expect a small number of errors (below 1 %). If many data entry errors occur, the dataset should be entered again.
Manual double data entry is another method to detect data entry errors. That is, once the data has been entered manually, a second data checker enters the same data a second time and the two separate entries are compared to ensure they match. Entries that deviate from one another or values that fall outside the expected range of the scales (e.g., 7-point Likert scales should have values that fall within this range) are then indicative of data entry errors (Barchard and Verenikina 2013). Various studies reveal that—although double data entry is more laborious and expensive—it detects errors better than single data entry (Barchard and Pace 2011; Paulsen et al. 2012).
5.4.4 Outliers
Data often contain outliers
                  
                , which are values situated far from all the other observations that may influence results substantially. For example, if we compare the average income of 20 households, we may find that the incomes range between $20,000 and $100,000, with the average being $45,000. If we considered an additional household with an income of, say, $1 million, this would increase the average substantially.
Tip
Malcolm Gladwell’s (2008) book “Outliers: The Story of Success” is an entertaining study of how some people became exceptionally successful (outliers).

5.4.4.1 Types of Outliers
Outliers must be interpreted in the context of the study and this interpretation should be based on the types of information they provide. Depending on the source of their uniqueness, outliers can be classified into three categories:	The first type of outlier is produced by data collection or entry errors. For example, if we ask people to indicate their household income in thousands of US dollars, some respondents may just indicate theirs in US dollars (not thousands). Obviously, there is a substantial difference between $30 and $30,000! Moreover, (as discussed before) data entry errors occur frequently. Outliers produced by data collection or entry errors should be deleted, or we need to determine the correct values by, for example, returning to the respondents.

	A second type of outlier occurs because exceptionally high or low values are a part of reality. While such observations can influence results significantly, they are sometimes highly important for researchers, because the characteristics of outliers can be insightful. Think, for example, of extremely successful companies, or users with specific needs long before most of the relevant marketplace also needs them (i.e., lead users). Deleting such outliers is not appropriate, but the impact that they have on the results must be discussed.

	A third type of outlier occurs when combinations of values are exceptionally rare. For example, if we look at income and expenditure on holidays, we may find someone who earns $1,000,000 and spends $500,000 of his/her income on holidays. Such combinations are unique and have a very strong impact on the results (particularly the correlations that we discuss later in this chapter). In such situations, the outlier should be retained, unless specific evidence suggests that it is not a valid member of the population under study. It is very useful to flag such outliers and discuss their impact on the results.





5.4.4.2 Detecting Outliers
In a simple form, outliers can be detected using univariate or bivariate graphs and statistics.2 When searching for outliers, we need to use multiple approaches to ensure that we detect all the observations that can be classified as outliers. In the following, we discuss both routes to outlier detection:
Univariate Detection
The univariate detection of outliers examines the distribution of observations of each variable with the aim of identifying those cases falling outside the range of the “usual” values. In other words, finding outliers means finding observations with very low or very high variable values. This can be achieved by calculating the minimum and maximum value of each variable, as well as the range. Another useful option for detecting outliers is through box plots, which visualize the distribution of a variable and pinpoint those observations that fall outside the range of the “usual” values. We introduce the above statistics and box plots in greater detail in the Describe Data section.
Bivariate Detection
We can also examine pairs of variables to identify observations whose combinations of variables are exceptionally rare. This is done by using a scatter plot
                      
                    , which plots all observations in a graph where the x-axis represents the first variable and the y-axis the second (usually dependent) variable (see Sec. 5.5). Observations that fall markedly outside the range of the other observations will show as isolated points in the scatter plot.
A drawback of this approach is the number of scatter plots that we need to draw. For example, with 10 variables, we need to draw 45 scatter plots to map all possible combinations of variables! Consequently, we should limit the analysis to only a few relationships, such as those between a dependent and independent variable in a regression. Scatterplots with large numbers of observations are often problematic when we wish to detect outliers, as there is usually not just one dot, or a few isolated dots, just a cloud of observations where it is difficult to determine a cutoff point.
5.4.4.3 Dealing with Outliers
In a final step, we need to decide whether to delete or retain outliers, which should be based on whether we have an explanation for their occurrence. If there is an explanation (e.g., because some exceptionally wealthy people were included in the sample), outliers are typically retained, because they are part of the population. However, their impact on the analysis results should be carefully evaluated. That is, one should run an analysis with and without the outliers to assess if they influence the results. If the outliers are due to a data collection or entry error, they should be deleted. If there is no clear explanation, outliers should be retained.
5.4.5 Missing Data
Market researchers often have to deal with missing data
                  
                . There are two levels at which missing data occur:	Entire surveys are missing (survey non-response), and

	Respondents have not answered all the items (item non-response)





Survey non-response
                  
                 (also referred to as unit non-response
                  
                ) occurs when entire surveys are missing. Survey non-response is very common and regularly 75–95%, suggesting only 5%–25% of surveys are filled out. Issues such as inaccurate address lists, a lack of interest and time, people confusing market research with selling, privacy issues, and respondent fatigue also lead to dropping response rates. The issue of survey response is best solved by designing proper surveys and survey procedures (see Box 4.​7 in Chap.​ 4 for suggestions).
Item non-response
                  
                 occurs when respondents do not provide answers to certain questions. There are different forms of missingness, including people not filling out or refusing to answer questions. Item non-response is common and 2–10 % of questions usually remain unanswered. However, this number greatly depends on factors, such as the subject matter, the length of the questionnaire, and the method of administration. Non-response can be much higher in respect of questions that people consider sensitive and varies from country to country. In some countries, for instance, reporting incomes is a sensitive issue.
The key issue with item non-response is the type of pattern that the missing data follow. Do the missing values occur randomly, or is there some type of underlying system?3 Fig. 5.2 illustrates the process of missing data treatment, which we will discuss next.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig2_HTML.png]
Fig. 5.2Guideline for treating missing data



5.4.5.1 The Three Types of Missing Data: Paradise, Purgatory, and Hell
We generally distinguish between three types of missing data:	Missing completely at random (“paradise”),

	missing at random (“purgatory”), and

	non-random missing (“hell”).





Data are missing completely at random (MCAR)
                    
                   when the probability of data being missing is unrelated to any other measured variable and is unrelated to the variable with missing values. MCAR data occur when there is no systematic reason for certain data points being missing. For example, MCAR may happen if the Internet server hosting the web survey broke down temporarily. Why is MCAR paradise? When data are MCAR, observations with missing data are indistinguishable from those with complete data. If this is the case and little data are missing (typically less than 10 % in each variable) listwise deletion can be used. Listwise deletion means that we only analyze complete cases; in most statistical software, such as SPSS, this is a default option. Note that this default option in SPSS only works when estimating models and only applies to the variables included in the model. When more than 10 % of the data are missing, we can use multiple imputation (Eekhout et al. 2014), a more complex approach to missing data treatment that we discuss in the section Dealing with Missing Data.
Unfortunately, data are rarely MCAR. If the missingness of a variable’s observation depends on one or more other variable(s) for which we have complete information (i.e., there are no missing observations for these variables), we consider the data missing at random (MAR).
                    
                   In this case, the probability that a data point is missing depends on the respondents’ traits (e.g., age, gender, or income) or their answering behavior regarding other variables in the dataset. An example of MAR is when women are less likely to reveal their income. That is, the probability of missing data depends on the gender and not on the actual level of the respondent’s income.
The term MAR is quite confusing. Many researchers confuse MAR with MCAR but the label has stuck.
Why is MAR purgatory? When data are MAR, the missing value pattern is not random, but this can be handled by more sophisticated missing data techniques such as multiple imputation, which use information in other variables in the dataset to impute the missing data points. On the downside, however, the missingness can typically not be fully accounted for by other variables in the dataset. Hence, we must also rely on its substantive reasonableness to verify whether or not the data are MAR.
Finally, data are missing not at random (MNAR)
                    
                   when the probability that a data point (e.g., xi) is missing depends on the variable x. For example, very affluent and poor people are generally less likely to indicate their income even when having the exact same observed values of race, education, and other observed background variables. That is, the missing income values depend on the income variable itself! This is the most severe type of missing data (“hell”). Even sophisticated missing data techniques do not provide satisfactory solutions as it is impossible to estimate the missing observations from other known observations in the dataset. Thus, any result based on MNAR data should be considered with caution. MNAR data can best be prevented by extensive pretesting and consultations with experts to avoid surveys that cause problematic response behavior. For example, we could use income categories instead of querying the respondents’ income directly, or we could simply omit the income variable.
The following website offers a nice visualization of these three typed of missing data.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figb_HTML.png]
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5.4.5.2 Testing for the Type of Missing Data
When dealing with missing data, we must ascertain the missing data’s type. If the dataset is small, we can browse through the data for obvious nonresponse patterns. However, missing data patterns become more difficult to identify with an increasing sample size and number of variables. Similarly, when we have few observations, patterns should be difficult to spot. In these cases, we should use one (or both) of the following diagnostic tests to identify missing data patterns:	Little’s MCAR test, and

	mean difference tests.





Little’s MCAR test
                    
                   (Little 1998) analyzes the pattern of the missing data by comparing the observed data with the pattern expected if the data were randomly missing. If the test indicates no significant differences between the two patterns, the missing data can be classified as MCAR. Put differently, the null hypothesis is that the data are MCAR. Thus,	if we do not reject the null hypothesis, we assume that the data are MCAR, and

	if we reject the null hypothesis, the data are either MAR or MNAR.





If the data cannot be assumed to be MCAR, we need to test whether the missing pattern is caused by another variable in the dataset by using the procedures discussed in Chap.​ 6. For example, we can run a two independent samples t-test to explore whether there is a significant difference in the mean of a continuous variable (e.g., income) between the group with missing values and the group without missing values. If we find a significant difference between these two groups, we would conclude that the data are MAR. For nominal or ordinal variables, we would tabulate the occurrence of non-responses against different groups’ responses. If we put the (categorical) variable about which we have concerns in one column of a table (e.g., income category), and the number of (non-)responses in another, we obtain a table similar to Table 5.2.Table 5.2Example of response issues


	 	Low income
	Medium income
	High income

	Response
	65
	95
	70

	Non-response
	35
	5
	30


N = 300




We can use the χ
2-test
                    
                   (pronounced as chi-square), discussed in the ⤓ Web Appendix (→ Downloads → Chap.​ 6), to test if there is a significant relationship between the respondents’ (non-)responses of a certain variable and their income. In this example, the test yields a χ
2 value of 28.88, indicating that there is a significant relationship between the respondents’ income and the (non-)response behavior, supporting the assumption that the data are MAR.
In the ⤓ Web Appendix (→ Downloads), we illustrate details of Little’s MCAR test, together with missing data analysis and imputation procedures.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figc_HTML.png]
© MicroStockHub/Getty Images/iStock
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5.4.5.3 Dealing with Missing Data
Research has suggested a broad range of approaches for dealing with missing data. We discuss the listwise deletion and the multiple imputation method.
Listwise deletion
                    
                   uses only those cases with complete responses in respect of all the variables considered in the analysis. If any of the variables used have missing values, the observation is omitted from the computation. If many observations have some missing responses, this decreases the usable sample size substantially and hypotheses are tested with less power (the power of a statistical test is discussed in Chap.​ 6).
Multiple imputation
                    
                   is a more complex approach to missing data treatment (Rubin 1987; Carpenter and Kenward 2013). It is a simulation-based statistical technique that facilitates inference by replacing missing observations with a set of possible values (as opposed to a single value) representing the uncertainty about the missing data’s true value (Schafer 1997). The missing values are replaced by a set of plausible values not once, but m times (e.g., 5 times). This procedure yields m imputed datasets, each of which reflects the uncertainty about the missing data’s correct value (Schafer 1997). Using these m datasets as input, SPSS then analyzes each dataset separately. Depending on the type of statistical analysis, the program additionally analyzes a pooled dataset that combines the m datasets into one. According to the literature, deciding on the number of imputations, m, can be very challenging, especially when the patterns of the missing data are unclear. As a rule of thumb, an m of at least 5 should be sufficient to obtain valid inferences (Rubin, 1987; White et al. 2011).
Now that we have briefly reviewed the most common approaches for handling missing data, there is still one unanswered question: Which one should you use? As shown in Fig. 5.2, if the data are MCAR, listwise deletion is recommended (Graham 2012) when the missingness is less than 10 % and multiple imputation when this is greater than 10 %. When the data are not MCAR but MAR, listwise deletion yields biased results. You should therefore use the multiple imputation method with an m of 5 (White et al. 2011). Finally, when the data are MNAR, the multiple imputation method provides inaccurate results. Consequently, you should choose listwise deletion and acknowledge the limitations arising from the missing data. Table 5.3 summarizes the data cleaning issues discussed in this section.Table 5.3Data cleaning issues and how to deal with them


	Problem
	Action

	Interviewer fraud
	– Check with respondents whether they were interviewed and correlate with previous data if available.

	Suspicious response patterns
	– Check for straight lining.
– Include reverse-scaled items.
– Consider removing the cases with straight-lined responses.
– Consider cultural differences in response behavior (middle and extreme response styles, acquiescence).
– Check for inconsistencies in response behavior.

	Data entry errors
	– Use descriptive statistics (minimum, maximum, range) to check for obvious data entry errors.
– Compare a subset of surveys to the dataset to check for inconsistencies.

	Outliers
	– Identify outliers using univariate descriptive statistics (minimum, maximum, range), box plots, and scatter plots.
– Outliers are usually retained unless they …
     - … Are a result of data entry errors,
     - … do not fit the objective of the research, or
     - … influence the results severely (but report results with and without outliers for transparency).

	Missing data
	– Check the type of missing data by running Little’s MCAR test and, if necessary, mean differences tests.
– When the data are MCAR, use either listwise deletion or the multiple imputation method with an m of 5.
– When the data are MAR, use the multiple imputation method with an m of 5.
– When the data are MNAR, use listwise deletion and acknowledge the limitations arising from the missing data.





5.5 Describe Data
Once we have performed the previous steps, we can turn to the task of describing
                
               the data. Data can be described one variable at a time (univariate descriptives
                
              ) or in terms of the relationship between two variables (bivariate descriptives
                
              ). We further divide univariate and bivariate descriptives into graphs and tables, as well as statistics.
The choice between the two depends on the information we want to convey. Graphs and tables can often tell a non-technical person a great deal. On the other hand, statistics require some background knowledge, but have the advantage that they take up little space and are exact. We summarize the different types of descriptive statistics in Fig. 5.3.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig3_HTML.png]
Fig. 5.3The different types of descriptive statistics



5.5.1 Univariate Graphs and Tables
In this section, we discuss the most common univariate graphs
                  
                 and univariate tables
                  
                :	Bar chart,

	histogram,

	box plot,

	pie chart, and the

	frequency table.





Figure 5.4 draws on these different types of charts and tables to provide information on the characteristics of travelers taken from the Oddjob Airways dataset that we use throughout this book.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig4_HTML.png]
Fig. 5.4From top left to bottom right; the bar chart, histogram, box plot, pie chart, and frequency table



A bar chart
                  
                 (Fig. 5.4 top left) is a graphical representation of a single categorical variable indicating each category’s frequency of occurrence. However, each bar’s height can also represent other indices, such as centrality measures or the dispersion of different data groups (see next section). Bar charts are primarily useful for describing nominal or ordinal variables. Histograms should be used for interval or ratio-scaled variables.
A histogram
                  
                 (Fig. 5.4 top middle) is a graph that shows how frequently categories made from a continuous variable occur. Differing from the bar chart, the variable categories on the x-axis are divided into (non-overlapping) classes of equal width. For example, if you create a histogram for the variable age, you can use classes of 21–30, 31–40, etc. A histogram is commonly used to examine the distribution of a variable. For this purpose, a curve following a specific distribution (e.g., normal) is typically superimposed on the bars to assess the correspondence of the actual distribution to the desired (e.g., normal) distribution. Given that overlaying a normal curve makes most symmetric distributions look more normal then they are, you should be cautious when assessing normality using histograms. In Chap.​ 6 we will discuss several options for checking the normality of data.
Histograms plot continuous variables with ranges of the variables grouped into intervals (bins), while bar charts plot nominal and ordinal variables.
Another way of displaying the distribution of a (continuous) variable is the box plot
                  
                 (Fig. 5.4 top right) (also referred to as a box-and-whisker plot
                  
                ). The box plot is a graph representing a variable’s distribution and consists of elements expressing the dispersion of the data. Note that several elements refer to terminologies discussed in the Univariate Statistics section (Sect. 5.5.2). Fig. 5.5 shows a box plot for the variable age based on the Oddjob Airways dataset.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig5_HTML.png]
Fig. 5.5Elements of the box plot




                	The bottom and top of the box describe the first and third quartiles. That is, the box contains the middle 50 % of the data, which is equivalent to the interquartile range
                        
                       (see Sect. 5.5.2).

	The solid line inside the box represents the median
                        
                      .

	The upper line extending the box (whisker
                        
                      ) represents the distance to the largest observation that is within the following range: 3rd quartile + interquartile range. If there are no observations within this range, the line is equal to the maximum value.

	The lower line extending the box (whisker) represents the distance to the smallest observation that is within the following range: 1st quartile—interquartile range. If there are no obervations within this range, the line is equal to the minimum value.

	Outliers
                        
                       (observations that range between 1.0 and 3.0 interquartile ranges away from the box) and extreme values
                        
                       (observations that range more than 3.0 interquartile ranges away from the box) are depicted by symbols outside the whiskers.




              
We can make statements about the dispersion of the data with a box plot. The larger the box, the greater the observations’ variability. Furthermore, the box plot helps us identify outliers in the data.
The pie chart
                  
                 (i.e., Fig. 5.4 bottom left) visualizes how a variable’s different values are distributed. Pie charts are particularly useful for displaying percentages of variables, because people interpret the entire pie as being 100 %, and can easily see how often values occur. The limitation of the pie chart is, however, that it is difficult to determine the size of segments that are very similar.
A frequency table
                  
                 (i.e., Fig. 5.4 bottom right) is a table that includes all possible values of a variable in absolute terms (i.e., frequency), how often they occur relatively (i.e., percentage), and the percentage of the cumulative frequency, which is the sum of all the frequencies from the minimum value to the category’s upper bound (i.e., cumulative frequency). It is similar to the histogram and pie chart in that it shows the distribution of a variable’s possible values. However, in a frequency table, all values are indicated exactly. Like pie charts, frequency tables are primarily useful if variables are measured on a nominal or ordinal scale.
5.5.2 Univariate Statistics
Univariate statistics
                  
                 fall into two groups: those describing centrality and those describing the dispersion of variables. Box 5.2 at the end of this section shows sample calculation of the statistics used on a small set of values.
5.5.2.1 Measures of Centrality
Measures of centrality
                    
                   (also referred to as measures of central tendency
                    
                  ) are statistical indices of a “typical” or “average” score. There are two main types of measures of centrality, the median and the mean.4

The median
                    
                   is the value that occurs in the middle of the set of scores if they are ranked from the smallest to the largest, and it therefore separates the lowest 50 % of cases from the highest 50 % of cases. For example, if 50 % of the products in a market cost less than $1000, then this is the median price. Identifying the median requires at least ordinal data (i.e., it cannot be used with nominal data).
The most commonly used measure of centrality is the mean
                    
                   (also called the arithmetic mean
                    
                   or, simply, the average
                    
                  ). The mean (abbreviated as [image: 
${{\bar x}}$
]) is the sum of each observation’s value divided by the number of observations:[image: 
$$\bar x = \frac{{Sum\left( x \right)}}{n} = \frac{1}{n}\mathop \sum \limits_{i = 1}^n {x_i}$$
]





In the above formula, xi refers to the value of observation i of variable x and n refers to the total number of observations. The mean is only useful for interval or ratio-scaled variables. SPSS also allows computing the 5 % trimmed mean
                    
                  , which is the mean that would be obtained if the lower and upper 5 % of values of the variable were deleted.
Tip
Each measure of centrality has its own use. The mean is most frequently used, but is sensitive to very small or large values. Conversely, the median is not sensitive to outliers. Consequently, the relationship between the mean and the median provides us with valuable information about a variable’s distribution. If the mean and the median are about the same, the variable is likely to be symmetrically distributed (i.e., the left side of the distribution mirrors the right side). If the mean differs from the median, this suggests that the variable is asymmetrically distributed and/or contains outliers. This is the case when we examine the prices of a set of products valued $500, $530, $530, and $10,000; the median is $530, while the mean is $2890. This example illustrates why a single measure of centrality can be misleading. We also need to consider the variable’s dispersion to gain a more complete picture.

5.5.2.2 Measures of Dispersion
Measures of dispersion
                    
                   provide researchers with information about the variability of the data; that is, how far the values are spread out. We differentiate between four types of measures of dispersion:	Range,

	interquartile range,

	variance, and

	standard deviation.





The range
                    
                   is the simplest measure of dispersion. It is the difference between the highest and the lowest value in a dataset and can be used on data measured at least on an ordinal scale. The range is of limited use as a measure of dispersion, because it provides information about extreme values and not necessarily about “typical” values. However, the range is valuable when screening data, as it allows for identifying data entry errors. For example, a range of more than 6 on a 7-point Likert scale would indicate an incorrect data entry.
The interquartile range
                    
                   is the difference between the 3rd and 1st quartile. The 1st quartile
                    
                   corresponds to the value separating the 25 % lowest values from the 75 % largest values if the values are ordered sequentially. Correspondingly, the 3rd quartile separates the 75 % lowest from the 25 % highest values. The interquartile range is particularly important for drawing box plots.
The variance
                    
                   (generally abbreviated as s
2) is a common measure of dispersion. The variance is the sum of the squared differences of each value and a variable’s mean, divided by the sample size minus 1. The variance is only useful if the data are interval or ratio-scaled:[image: 
$${s^2} = \frac{{\mathop \sum \nolimits_{i = 1}^n {{({x_i} - \bar x)}^2}}}{{n - 1}}$$
]





The variance tells us how strongly observations vary around the mean. A low variance indicates that the observations tend to be very close to the mean; a high variance indicates that the observations are spread out. Values far from the mean increase the variance more than those close to the mean.
The most commonly used measure of dispersion is the standard deviation
                    
                   (usually abbreviated as s). It is the square root of—and, therefore, a variant of—the variance:[image: 
$$s = \sqrt {{s^2}} = \sqrt {\frac{{\mathop \sum \nolimits_{i = 1}^n {{({x_i} - \bar x)}^2}}}{{n - 1}}} $$
]





The variance and standard deviation provide similar information, but while the variance is expressed on the same scale as the original variable, the standard deviation is standardized. Consequently, the following holds for normally distributed variables (this will be discussed in the following chapters in more detail):	66 % of all observations are between plus and minus one standard deviation units from the mean,

	95 % of all observations are between plus and minus two standard deviation units from the mean, and

	99 % of all observations are between plus and minus three standard deviation units from the mean.





Thus, if the mean price is $1000 and the standard deviation is $150, then 66 % of all the prices fall between $850 and $1150, 95 % fall between $700 and $1300, and 99 % of all the observations fall between $550 and $1450.
5.5.3 Bivariate Graphs and Tables
There are several bivariate graphs
                  
                 and bivariate tables
                  
                , of which the scatter plot and the crosstab are the most important. Furthermore, several of the graphs, charts, and tables discussed in the context of univariate analysis can be used for bivariate analysis. For example, box plots can be used to display the distribution of a variable in each group (category) of nominal variables.
A scatter plot
                  
                 (see Fig. 5.6) uses both the y and x-axis to show how two variables relate to each other. If the observations almost form a straight diagonal line in a scatter plot, the two variables are strongly related.5 Sometimes, a third variable is included, adding another dimension to the plot. Corresponding variants of the scatter plot include the bubble plot
                  
                 or 3-D scatter plot
                  
                .[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig6_HTML.png]
Fig. 5.6Scatter plots and correlations



Crosstabs
                  
                 (also referred to as contingency tables
                  
                ) are tables in a matrix format that show the frequency distribution of nominal or ordinal variables. They are the equivalent of a scatter plot used to analyze the relationship between two variables. While crosstabs are generally used to show the relationship between two variables, they can also be used for three or more variables, which, however, makes them difficult to grasp.
Crosstabs are also part of the χ
2-test
                  
                , which we discuss in the ⤓ Web Appendix (→ Downloads → Chap.​ 6).[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figd_HTML.png]
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5.5.4 Bivariate Statistics
Bivariate statistics
                  
                 involve the analysis of two variables to determine the empirical relationship between them. There are two key measures that indicate (linear) associations between two variables; we illustrate their computation in Box 5.2:	covariance, and

	correlation.





The covariance
                  
                 is the degree to which two variables vary together. If the covariance is zero, then two variables do not vary together. The covariance is the sum of the multiplication of the differences between each value of the xi and yi variables and their means, divided by the sample size minus 1:[image: 
$$Cov\left( {{x_i},{y_i}} \right) = \frac{1}{{n - 1}}\mathop \sum \limits_{i = 1}^n \left( {{x_i} - \bar x} \right) \cdot \left( {{y_i} - \bar y} \right)$$
]





The correlation
                  
                 (typically abbreviated as r) is a common measure of how strongly two variables relate to each other. The most common type of correlation, the Pearson’s correlation coefficient
                  
                , is calculated as follows:[image: 
$$r = \frac{{Cov\left( {{x_i},{y_i}} \right)}}{{{s_x} \cdot {s_y}}} = \frac{{\sum_{i = 1}^n({x_i} - \bar x) \cdot \left( {{y_i} - \bar y} \right)}}{{\sqrt {\sum_{i = 1}^n{{\left( {{x_i} - \bar x} \right)}^2}} \cdot \,\sqrt {\sum_{i = 1}^n{{\left( {{y_i} - \bar y} \right)}^2}} }}$$
]





The numerator contains the covariance of xi and yi [image: 
$\left( {Cov\left( {{x_i},{y_i}} \right)} \right)$
], while the denominator contains the product of the standard deviations of xi and yi.6 Thus, the correlation is the covariance divided by the product of the standard deviations. As a result, the correlation is standardized and, unlike the covariance, is no longer dependent on the variables’ original measurement. More precisely, the correlation coefficient ranges from −1 to 1, where −1 indicates a perfect negative relationship and 1 indicates the contrary. A correlation coefficient of 0 indicates that there is no relationship, also implying that their covariance is zero.
Tip
As a rule of thumb (Cohen 1988), an absolute correlation …	… below 0.30 indicates a weak relationship,

	… between 0.30 and 0.49 indicates a moderate relationship, and

	… above 0.49 indicates a strong relationship.






Strong relationships are not necessarily better than weak relationships. Strong relationships are typically well-established which means they lack novelty. Furthermore, strong relationships may not be actionable. For example, knowing that high net worth is a predictor of sports car sales does not help if we do not have good information on high net worth for targeting purposes.
The scatter plots in Fig. 5.6 illustrate several correlations between two variables x and y. If the observations almost form a straight diagonal line in the scatter plot (upper left and right in Fig. 5.6), the two variables have a high (absolute) correlation. If the observations are uniformly distributed in the scatter plot (lower right in Fig. 5.6), or one variable is a constant (lower left in Fig. 5.6), the correlation is zero.
Pearson’s correlation coefficient is the most common and is generally simply referred to as the correlation (Agresti and Finlay 2014). Pearson’s correlation is appropriate for calculating correlations between two variables that are both interval or ratio-scaled. However, it can also be used when one variable is interval or ratio-scale and the other is, for example, binary. There are other correlation coefficients for variables measured on lower scale levels. Some examples are:	Spearman’s correlation coefficient
                        
                       and Kendall’s tau
                        
                       when at least one variable for determining the correlation is measured on an ordinal scale.

	Contingency coefficient
                        
                      , Cramer’s V
                        
                      , and Phi
                        
                       for variables measured on a nominal scale. These statistical measures are used with crosstabs; we discuss these in the context of the χ
2-test
                        
                       in the ⤓ Web Appendix (→ Downloads → Chap.​ 6).





In Table 5.4, we indicate which descriptive statistics are useful for differently scaled variables. The brackets X indicate that the use of a graph, table, or statistic is potentially useful while (X) indicates that use is possible, but less likely useful, because this typically requires collapsing data into categories, resulting in a loss of information.Table 5.4Types of descriptive statistics for differently scaled variables


	 	Nominal
	Ordinal
	Interval & ratio

	
                            Univariate graphs & tables
                          

	
                            Bar chart
                          
	X
	X
	 
	
                            Histogram
                          
	 	 	X

	
                            Box plot
                          
	 	 	X

	
                            Pie chart
                          
	X
	X
	(X)

	
                            Frequency table
                          
	X
	X
	(X)

	
                            Univariate statistics: Measures of centrality
                          

	
                            Median
                          
	 	X
	X

	
                            Mean
                          
	 	 	X

	
                            Univariate statistics: Measures of dispersion
                          

	
                            Range
                          
	 	(X)
	X

	
                            Interquartile range
                          
	 	(X)
	X

	
                            Variance
                          
	 	 	X

	
                            Standard deviation
                          
	 	 	X

	
                            Bivariate graphs/tables
                          

	
                            Scatter plot
                          
	 	 	X

	
                            Crosstab
                          
	X
	X
	(X)

	
                            Bivariate statistics
                          

	
                            Contingency coefficient
                          
	X
	 	 
	
                            Cramer’s V
                          
	X
	 	 
	
                            Phi
                          
	X
	 	 
	
                            Spearman’s correlation
                          
	 	X
	 
	
                            Kendall’s tau
                          
	 	X
	 
	
                            Pearson’s correlation
                          
	 	 	X





Box 5.2 Sample calculation of univariate and bivariate statistics
Consider the following list of values for variables x and y, which we treat as ratio-scaled:	
                              x
                            
	6
	6
	7
	8
	8
	8
	12
	14
	14

	
                              y
                            
	7
	6
	6
	9
	8
	5
	10
	9
	9






                  Measures of centrality for x:
                
Median = 8
Mean [image: 
$\bar x = \:\frac{1}{9}\:\left( {6 + 6 + \ldots + 14 + 14} \right) = \:\frac{{83}}{9} \approx 9.22$
]


                  Measures of dispersion for x:
                
Minimum = 6
Maximum = 14
Range = 14 – 6 = 8
Interquartile range = 6.5
Variance [image: 
$({s^2}) = \frac{{\left[ {{{(6 - 9.22)}^2} + \ldots + {{(14 - 9.22)}^2}} \right.\left. {} \right]}}{{9 - 1}} = \frac{{83.56}}{8} \approx 10.44$
]

Standard deviation (s) = [image: 
$\sqrt {{s^2}} = \sqrt {10.44} \approx 3.23$
]


                  Measures of association between x and y:
                
Covariance [image: 
$\begin{gathered} (cov(x,\:y)) = \frac{1}{{9 - 1\:}}[\left( {6 - 9.22} \right) \cdot \left( {7 - 7.67} \right) + \ldots + \hfill \\ \;\;\;\;\;\;\;\;\;\;\;\;\;\;\;\left( {14 - 9.22} \right) \cdot \left( {9 - 7.67} \right)] = \frac{{31.67}}{8} \approx 3.9 \hfill \\ \end{gathered} $
]

Correlation [image: 
$\left( r \right) = \frac{{3.96}}{{3.23 \cdot 1.73}} \approx 0.71$
]

5.6 Transform Data (Optional)
Transforming data
                
               is an optional step in the workflow. Researchers transform data as certain analysis techniques require this: it might help interpretation or might help meet the assumptions of techniques that will be discussed in subsequent chapters. We distinguish two types of data transformation:	variable respecification, and

	scale transformation.





5.6.1 Variable Respecification
Variable respecification
                  
                 involves transforming data to create new variables or to modify existing ones. The purpose of respecification is to create variables that are consistent with the study’s objective. Recoding
                  
                 a continuous variable into a categorical variable is an example of a simple respecification. For example, if we have a variable that measures a respondent’s number of flights per year, we could code those flights below 5 as low (=1), between 5 and 10 flights as medium (=2), and everything above 11 as high (=3). Recoding a variable in such a way always results in a loss of information, since the newly created variable contains less detail than the original. While there are situations that require recoding (e.g., we might be asked to give advice based on different income groups where income is continuous), we should generally avoid recoding.
Another example of respecification is swapping the polarity of a question. If you have a variable measured on a 5-point Likert-scale where: 1 = strongly agree; 2 = agree; 3 = undecided; 4 = disagree; 5 = strongly disagree and you wish to switch the polarity of the values so that value 1 reverses to 5, value 2 becomes 4, and so on.
Creating a dummy variable is a special way of recoding data. Dummy variables
                  
                 (or simply dummies
                  
                ) are binary variables that indicate if a certain trait is present or not. For example, we can use a dummy variable to indicate that advertising was used during a period (value of the dummy is 1) or not (value of the dummy is 0). We can also use multiple dummies to capture categorical variables’ effects. For example, three levels of flight intensity (low, medium, and high) can be represented by two dummy variables: The first takes a value of 1 if the intensity is high (0 else), the second also takes a value of 1 if the intensity is medium (0 else). If both dummies take the value 0, this indicates low flight intensity. We always construct one dummy less than the number of categories. We show how to create dummy variables in SPSS in the example illustrating the use of regression analysis in Sect.​ 7.​4.
The creation of constructs
                  
                 is a frequently used type of variable respecification. As described in Chap.​ 3, a construct is a concept that cannot be observed, but can be measured by using multiple items, none of which relate perfectly to the construct. To compute a construct measure, we need to calculate the average (or the sum) of several related items. For example, a traveler’s commitment to fly with an airline can be measured by using the following three items:	I am very committed to Oddjob Airways.

	My relationship with Oddjob Airways means a lot to me.

	If Oddjob Airways would no longer exist, it would be a true loss for me.





By calculating the average of these three items, we can form a composite of commitment. If one respondent indicated 4, 3, and 4 on the three items’ scale, we calculate a construct score
                  
                 (also referred to as a composite score) for this person as follows: (4 + 3 + 4)/3 = 3.67. Note that we should take the average over the number of nonmissing responses. In Chap.​ 8 we discuss more advanced methods of doing this by, for example, creating factor scores.
Similar to creating constructs, we can create an index
                  
                 of sets of variables. For example, we can create an index of information search activities, which is the sum of the information that customers require from promotional materials, the Internet, and other sources. This measure of information search activities is also referred to as a composite measure, but, unlike a construct, the items in an index define the trait to be measured.
5.6.2 Scale Transformation
Scale transformation
                  
                 involves changing the variable values to ensure comparability with other variables or to make the data suitable for analysis. Different scales are often used to measure different variables. For example, we may use a 5-point Likert scale for one set of variables and a 7-point Likert scale for a different set of variables in our survey. Owing to the differences in scaling, it would not be meaningful to make comparisons across any respondent’s measurement scales. These differences can be corrected by standardizing variables
                  
                .
A popular way of standardizing data is by rescaling these to have a mean of 0 and a variance of 1. This type of standardization is called the z-standardization
                  
                . Mathematically, standardized scores zi (also called z-scores
                  
                ) can be obtained by subtracting the mean [image: 
$\bar x$
] of every observation xi and dividing it by the standard deviation s. That is:[image: 
$${z_i} = \frac{{\left( {{x_i} - \bar x} \right)}}{s}$$
]





Range standardization
                  
                
[image: 
$\left( {{r_i}} \right)$
] is another standardization technique which scales the data in a specific range. For example, standardizing a set of values to a range of 0 to 1 requires subtracting the minimum value of every observation xi and then dividing it by the range (i.e., the difference between the maximum and minimum value).[image: 
$${r_i} = \frac{{\left( {{x_i} - {x_{min}}} \right)}}{{\left( {{x_{max}} - {x_{min}}} \right)}}$$
]





The range standardization is particularly useful if the mean, variance, and ranges of different variables vary strongly and are used for some forms of cluster analysis (see Chap.​ 9.)
A log transformation
                  
                —another type of transformation—is commonly used if we have skewed data. Skewed data
                  
                 occur if we have a variable that is asymmetrically distributed and can be positive or negative. A positive skew
                  
                 (also called right-skewed data
                  
                 or skewed to the right) occurs when many observations are concentrated on the left side of the distribution, producing a long right tail. When data are right-skewed, the mean will be higher than the median. A negative skew
                  
                 (also called left-skewed data
                  
                 or skewed to the left) is the opposite, meaning that many observations are concentrated on the right of the distribution, producing a long left tail. When data are negatively skewed, the mean will be lower than the median. A histogram will quickly show whether data are skewed. Skewed data can be undesirable in analyses. Log transformations are commonly used to transform data closer to a normal distribution when the data are right-skewed (i.e., the data are non-negative). Taking a natural logarithm will influence the size of the coefficient related to the transformed variable, but will not influence the value of its outcome.7

Finally, aggregation
                  
                 is a special type of transformation. Aggregation means that we take variables measured at a lower level to a higher level. For example, if we know the average customer’s satisfaction with an airline and the distribution channels from which they buy (i.e., the Internet or a travel agent), we can calculate the average satisfaction at the channel level. Aggregation only works from lower to higher levels and is useful if we want to compare groups at a higher level.
While transforming data is often necessary to ensure comparability between variables or to make the data suitable for analysis, there are also drawbacks to this procedure. Most notably, we may lose information during most transformations. For example, recoding the ticket price (measured at the ratio scale) as a “low,” “medium,” and “high” ticket price will result in an ordinal variable. In the transformation process, we have therefore lost information by going from a ratio to an ordinal scale. Another drawback is that transformed data are often more difficult to interpret. For example, the log (ticket price) is far more difficult to interpret and less intuitive than simply using the ticket price.
5.7 Create a Codebook
After all the variables have been organized and cleaned, and some initial descriptive statistics have been calculated, we can create a codebook
                
              , containing essential details of the data collection and data files, to facilitate sharing. Codebooks usually have the following structure:	Introduction: The introduction discusses the goal of the data collection, why the data are useful, who participated, and how the data collection effort was conducted (mail, Internet, etc.).

	Questionnaire(s): It is common practice to include copies of all the types of questionnaires used. Thus, if different questionnaires were used for different respondents (e.g., for French and Chinese respondents), a copy of each original questionnaire should be included. Differences in wording may afterwards explain the results of the study, particularly those of cross-national studies, even if a back-translation was used (see Chap.​ 4). These are not the questionnaires received from the respondents themselves, but blank copies of each type of questionnaire used. Most codebooks include details of each variable as comments close to the actual items used. If a dataset was compiled using secondary measures (or a combination of primary and secondary data), the secondary datasets are often briefly discussed (the version that was used, when it was accessed, etc.).

	Description of the variables: This section includes a verbal description of each variable used. It is useful to provide the variable name as used in the data file, a description of what the variable is supposed to measure, and whether the measure has previously been used. You should also describe the measurement level (see Chap.​ 3).

	Summary statistics: This section includes descriptive statistics of each variable. The average (only for interval and ratio-scaled data), minimum, and maximum are often shown. In addition, the number of observations and usable observations (excluding observations with missing values) are included, just like a histogram (if applicable).

	Datasets: This last section includes the names of the datasets and sometimes the names of all the revisions of the used datasets. Codebooks sometimes include the file date or a data signature, to ensure that the right files are used.





In the Web Appendix (⤓ Web Appendix → Downloads), we briefly discuss how to create a codebook using SPSS.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fige_HTML.png]
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5.8 The Oddjob Airways Case Study
The most effective way of learning statistical methods is to apply them to a set of data. Before introducing SPSS and how to use it, we present the dataset from a fictitious company called Oddjob Airways (but with a real website, http://​www.​oddjobairways.​com) that will guide the examples throughout this book. The dataset Oddjob.sav (⤓ Web Appendix → Downloads) stems from a customer survey of Oddjob Airways. Founded in 1962 by the Korean businessman Toshiyuki Sakata, Oddjob Airways positions itself as a low-cost carrier, targeting young customers who prefer late or overnight flights. However, the actual customer base is very diverse with many older customers appreciating the offbeat onboard services, high-speed Wi-Fi, and tablet computers on every seat. In an effort to improve its customers’ satisfaction, the company’s marketing department contacted all the customers who had flown with the airline during the last 12 months and were registered on the company website. A total of 1065 customers who had received an email with an invitation letter completed the survey online.
The survey resulted in a rich dataset with information about travelers’ demographic characteristics, flight behavior, as well as their price/product satisfaction with and expectations in respect of Oddjob Airways. Table 5.5 describes the variables in detail.Table 5.5Variable description and label names of the Oddjob Dataset


	Variables
	Variable description
	Variable name in the dataset

	
                          Demographic measures
                        

	
                          Age of the customer
                        
	Numerical variable ranging between the ages of 19 and 101.
	
                          age
                        

	
                          Customer’s gender
                        
	Dichotomous variable, where 1 = female; 2 = male.
	
                          gender
                        

	
                          Language of customer
                        
	Categorical variable, where 1 = Germany; 2 = English; 3 = French.
	
                          language
                        

	
                          Home country
                        
	Categorical variable, whereby: 1 = Germany (de), 2 = Switzerland (ch); 3 = Austria (at); 4 = France (fr), 5 = the United States (us).
	
                          country
                        

	
                          Flight behavior measures
                        

	
                          Flight class
                        
	Categorical variable distinguishing between the following categories: 1 = First; 2 = Business; 3 = Economy.
	
                          flight_class
                        

	
                          Latest flight
                        
	Categorical variable querying when the customer last flew with Oddjob Airways. Categories are: 1 = Within the last 2 days; 2 = Within the last week; 3 = Within the last month; 4 = Within the last 3 months; 5 = Within the last 6 months; 6 = Within the last 12 months.
	
                          flight_latest
                        

	
                          Flight purpose
                        
	Dichotomous variable distinguishing between: 1 = Business; 2 = Leisure.
	
                          flight_purpose
                        

	
                          Flight type
                        
	Dummy variable, where: 1 = Domestic; 2 = International.
	
                          flight_type
                        

	
                          Number of flights
                        
	Numeric variable ranging between 1 and 457 flights per year.
	
                          nflights
                        

	
                          Traveler’s status
                        
	Categorical variable, where membership status is defined in terms of: 1 = Blue; 2 = Silver; 3 = Gold.
	
                          status
                        

	
                          Perception and satisfaction measures
                        

	
                          Recommendation
                        
	Item on whether a customer is likely to recommend the airline to a friend or colleague. This item is measured on an 11-point Likert-scale ranging from 1 very unlikely to 11 very likely.
	
                          nps
                        

	
                          Reputation
                        
	One item stating “Oddjob Airways is a reputable airline.” This item is measured on a 7-point Likert-scale ranging from 1 fully disagree to 7 fully agree.
	
                          reputation
                        

	
                          General satisfaction
                        
	3 items reflecting a customer’s overall satisfaction with the airline. All items are measured on a 7-point Likert scale ranging from 1 fully disagree to 7 fully agree .
	sat1 to sat3


	
                          Overall price/performance satisfaction
                        
	One item stating “Overall I am satisfied with the price performance ratio of Oddjob Airways.” This item is measured on a 7-point Likert-scale ranging from 1 fully disagree to 7 fully agree.
	
                          overall_sat
                        

	
                          Loyalty
                        
	5 items reflecting a customer’s loyalty to the airline. All items are measured on a 7-point Likert-scale ranging from 1 fully disagree to 7 fully agree.
	loy1 to loy5


	
                          Commitment
                        
	3 items reflecting a customer’s commitment to fly with the airline. All items are measured on a 7-point Likert-scale ranging from 1 fully disagree to 7 fully agree. The dataset also contains the variable commitment, which is the mean of com1 to com3.
	com1 to com3

and

                          commitment
                        

	
                          Traveler’s expectations
                        
	23 items reflecting a customer’s expectations with the airline: “How high are your expectations that … ” All items are measured on a continuous scale ranging from 1 very low to 100 very high.
	e1 to e23


	
                          Traveler’s satisfaction
                        
	23 items reflecting a customer’s satisfaction with Oddjob Airways regarding the features asked in the expectation items (e1-e23) on a continuous scale ranging from 1 = very unsatisfied to 100 = very satisfied.
	s1 to s23






Learn more about Oddjob Airways at www.​oddjobairways.​com. The site not only offers background on the airline but also lots of learning material relevant to this book.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figo_HTML.png]

                      Oddjob Airways
                    



5.8.1 Introduction to SPSS
SPSS
                  
                 is a computer package specializing in quantitative data analysis. It is widely used by market researchers. It is powerful, able to deal with large datasets, and relatively easy to use.
In this book, we use version 25 of IBM SPSS Statistics for Mac (which we simply refer to as SPSS). Prior versions (21 or higher) for Microsoft Windows, Mac, or Linux can also be used for almost all examples throughout the book. The differences between the versions are small enough so that all examples in the book work with all versions.
The regular SPSS package is available at a substantial fee for commercial use. However, large discounts are available for educational use. To obtain these discounts, it is best to go to your university’s IT department and enquire if you can purchase a special student license. You can also download a trial version from www.​spss.​com.
In the next sections, we will use the ► sign to indicate that you should click on something. Options, menu items or drop-down lists that you should look up in dialog boxes are printed in bold. Variable names, data files or data formats are printed in italics to differentiate them from the rest of the text.
5.8.2 Finding Your Way in SPSS
If you start up SPSS for the first time, it presents a screen similar to Fig. 5.7, unless a previous user has ticked the Don’t show this dialog in the future box. In that case, you will see a screen similar to Fig. 5.8, but without an active dataset.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig7_HTML.jpg]
Fig. 5.7The start-up screen of SPSS


[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig8_HTML.jpg]
Fig. 5.8The SPSS data editor



In the startup screen, SPSS indicates several options to create or open datasets. The options that you should use are either Recent Files, under which you can find a list with recently opened data files, or New Files. To open an unlisted file, simply choose Open another file… and click OK (alternatively, you can click Close, and then go to ► File ► Open ► Data). Then search for the directory in which you keep your files, click on Oddjob.sav, followed by Open.
SPSS uses two windows. The SPSS Statistics Data Editor contains the data and information on the variables in the dataset and the SPSS Statistics Viewer, which contains the output produced by the analyses. In the following, we will discuss these two windows separately.
Tip
SPSS uses multiple file formats. The .sav and .zsav file format contains data only. SPSS also allows you to open other file formats such as Excel (.xls and .xlsx), Stata files (.dta), and text files (such as .txt and .dat). Once these files are open, they can be conveniently saved into SPSS’s own .sav file format. If you are on SPSS’s main screen (see Fig. 5.8) simply go to File ► Open ► Data ► Files of type (select the file format) and double click on the file you wish to open.

Tip
The notation you will see in this book follows the US style. That is, commas are used to separate ten thousands (e.g., 10,000) while decimal points are used to separate whole values from fractions. If you want to change the notation to US style, go to SPSS, then ► File ► New ► Syntax and type in SET LOCALE = ‘English’. You also need to type in the last point. Now press enter and type in EXECUTE. (again, including the point) in the next line. Now run the syntax by choosing Run ► All in the syntax window. SPSS will then permanently apply the US style notation the next time you use SPSS.

5.8.3 SPSS Statistics Data Editor
In the SPSS Statistics Data Editor
                  
                 (Fig. 5.8), you will find the dataset Oddjob. sav. This dataset’s variables are included in the columns and their names are indicated at the top of each column. The cases are in the rows, which are numbered from 1 onwards.
If you click on the Variable View tab at the bottom of the screen, SPSS will show you a screen similar to Fig. 5.9. In the Variable View, SPSS provides information on the variables included in your dataset:	Name: Here you can indicate the name of the variable. It is best to provide very short names. Variable names must begin with letters (A to Z) or one of the following special characters (@, # or $). Subsequent characters can include letters (A to Z), numbers (0–9), a dot (.), and _, @, #, or $. Note that neither spaces nor other special characters (e.g., %, &,/) are allowed.

	Type: Here you can specify what your variable represents. Numeric refers to values and String refers to words. String is useful if you want to include open- ended answers, email addresses or any other type of information that cannot be adequately captured by numbers. With Dollar or Custom Currency, you can indicate that your variable represents money.

	Width and Decimals: These elements indicate the amount of space available for your variables values.

	Labels: Here you can provide a longer description of your variables (called variable labels). This can either be the definition of the variables or the original survey question.

	Values: Here you can indicate what a certain value represents (called value labels). For example, for the nominal variable gender, 1 represents females and 2 males.

	Missing: Here you can indicate one or more missing value(s). Generally, SPSS deals with missing values in two ways. If you have blanks in your variables (i.e., you haven’t entered any data for a specific observation), SPSS treats these as system-missing values
                        
                      . These are indicated in SPSS as a dot (•). Alternatively, you can specify user-defined missing values
                        
                       that are meant to signify a missing observation. By explicitly defining missing values, we can indicate why specific scores are missing (e.g., the question didn’t apply to the respondent or the respondent refused to answer). In SPSS, you should preferably specify user-defined missing values as this at least allows the true missing values to be separated from data that were not recorded (i.e., no value was entered). Under Missing, we can select among three options to indicate user-defined missing values. The first option, No missing values, is the default setting and indicates that no values are user-defined missing. The other two options, Discrete missing values and Range plus one optional discrete missing value, provide a means to express user-defined missing values. To do so, simply enter values that record that an observation is missing. Each separate value should indicate separate reasons for missing values. For example −99 may record that a respondent could not answer, and −98 that the respondent was unwilling to answer, and −97 might record “other” reasons. Thus, missing values can provide us with valuable information. More importantly, observations with user-defined missing values (just like with system-missing values) are excluded from data transformations and analyses. This is of course essential as, for example, including a user-missing value of −99 in descriptive analyses would greatly distort the results.




[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig9_HTML.jpg]
Fig. 5.9Variable view



Tip
When picking user-defined missing values, take those that would not otherwise occur in the data. For example, for a variable age, 1000 might be an acceptable value, as that response cannot occur. However, the same missing value for a variable income might lead to problems, as a respondent might have an income of 1000. If 1000 is indicated as a (user-defined) missing value, this observation would be excluded from further analysis. By convention, researchers usually choose (high) negative values to designate missing such as −99 or −999.


                	Columns and Align: These are rarely necessary, so we will skip these.

	Measure: Here you can specify the measurement level of your variable. SPSS provides you with the option to indicate whether your variable is nominal, ordinal, or whether it is interval or ratio-scaled. The combination of the last two categories is called Scale in SPSS. Note that several procedures such as creating graphs require that all measurement levels are specified correctly.

	The last Role option is not necessary for basic analysis.




              
5.8.4 SPSS Statistics Viewer
The SPSS Statistics Viewer
                  
                 is a separate window, which opens after you carry out an action in SPSS. The viewer contains the output that you may have produced. If you are used to working with software such as Microsoft Excel, where the data and output are included in a single screen, this may be a little confusing at first. Another aspect of the viewer screen is that it does not change your output once made. Unlike, for example, Microsoft Excel, changing the data after an analysis does not dynamically update the results.
The output produced in SPSS can be saved using the .spv file format that is particular to SPSS. To partially remedy this, SPSS provides the option to export the output to Microsoft Word, Excel, or PowerPoint, PDF, HTML, or text. It is also possible to export output as a picture. You can find these export options in the Statistics Viewer under File ► Export.
5.8.5 SPSS Menu Functions
In SPSS, you find a number of commands in the menu bar. These include File, ► Edit, ► View, ► Data, ► Transform, ► Analyze, and ► Graphs. In this section, we will briefly discuss these commands. The commands ► Analyze and ► Graphs will be discussed in greater detail in the example, later in this chapter. The last four commands are ► Utilities, ► Add-ons, ► Windows, and ► Help. You are unlikely to need the first three functions but the help function may come in handy if you need further guidance. Under help, you also find a set of tutorials that can show you how to use most of the commands included in SPSS.
Under ► File, you find all the commands that deal with the opening and closing of files. Under this command, you will find subcommands that you can use to open different types of files, save files, and create files. If you open a dataset, you will notice that SPSS also opens a new screen. Note that SPSS can open several datasets simultaneously. You can easily switch from dataset to dataset by just clicking on the one which you would like to activate.
Under ► Edit, you will find subcommands to copy and paste data. Moreover, you will find two options to insert cases or variables. If you have constructed a dataset but need to enter additional data, you can use this to add an additional variable and subsequently add data. Edit also contains the Find subcommand with which you can look for specific cases or observations. Finally, under ► Edit ► Options, you find a large number of options, including how SPSS formats tables, and where the default file directories are located.
Under ► View, you find several options, of which the Value Labels
                  
                 option is the most useful. Value labels are words or short sentences used to indicate what each value represents. For example, value lablels for status include blue, silver, and gold. SPSS shows value labels in the SPSS Data Editor window if you click on ► View, and then on Value Labels.
Under the ► Data command, you will find many subcommands to change or restructure your dataset. The most prominent option is the ► Sort Cases subcommand with which you can sort your data based on the values of a variable. You could, for example, sort the data based on the respondents’ age. The ► Split File subcommand is useful if we want to compare output across different groups such as flight class, purpose, or type. In addition, we can carry out separate analyses over different groups using the Split File
                  
                 command. Another very useful command is ► Data ► Select Cases, which allows you to restruct the observations that you want to analyze. Under ► Transform, we find several options to create new variables from existing variables. For example, the first subcommand is Compute Variable
                  
                . This command allows you to create a new variable from one (or more) existing variables. Also included under the ► Transform command are two subcommands to recode variables (i.e., ► Recode into Same Variables and ► Recode into Different Variables). These commands allow you to recode variable values or to summarize sets of values into one value. For example, using the Recode into Different Variables command, you could generate a new variable that takes the value 1 if age is higher than 40, and 0 else.
Under ► Analyze, you find numerous analysis procedures, several of which we will discuss in the remainder of the book. For example, under Descriptive Statistics, you can request univariate and bivariate statistics. Under Regression, SPSS provides numerous types of regression techniques.
Finally, under ► Graphs, you can chose among different options to create graphics. For example, the Chart Builder
                  
                 is an interactive tool that allows you to design basic and more complex charts. Note that in order to use the Chart Builder, all variables’ measurement levels must be correctly specified. The same holds for the Graphboard Template Chooser
                  
                , which lets you select the variables to be visualized and suggests different charts that conform to the measurement levels of the variable(s). Finally, the Legacy Dialogs command allows for a menu-driven selection of different chart types.
Some of the previous commands are also accessible as shortcut symbols in Data View screen’s menu bar. As these are very convenient, we present the most frequently used shortcuts in Table 5.6.Table 5.6Toolbar icons


	Symbol
	Action

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figg_HTML.jpg]
                          
	Open dataset

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figh_HTML.jpg]
                          
	Save the active dataset

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figi_HTML.jpg]
                          
	Recall recently used dialogs

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figj_HTML.jpg]
                          
	Undo a user action

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figk_HTML.jpg]
                          
	Find

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figl_HTML.jpg]
                          
	Split file

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figm_HTML.jpg]
                          
	Select cases

	
                            [image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fign_HTML.jpg]
                          
	Show value labels





In addition to the menu functionalities, we can run SPSS by using its command language, called SPSS syntax
                  
                . You can think of it as a programming language that SPSS uses to translate those elements on which you have clicked in the menus into commands that SPSS can understand. Syntax can be saved (as a .sps file) for later use. This is particularly useful if you conduct the same analyses over different datasets. Think, for example, of standardized marketing reports on daily, weekly, or monthly sales. Discussing the syntax in great detail is beyond the scope of this book but we offer a brief introduction in the Web appendix (⤓ Web Appendix → Downloads). Grotenhuis and Visscher (2014) provide a thorough introduction into this subject.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Figf_HTML.png]
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5.9 Data Management in SPSS
In this section, we will illustrate the use of some of the most commonly used commands for managing data in SPSS using the Oddjob.sav dataset. These include the following:

              	Split file,

	select cases,

	compute variables, and

	recode into same/different variables.




            
5.9.1 Split File
The split file
                  
                 command allows you to split the dataset on the basis of grouping variables. If the split file function is activated, all subsequent analyses will be done separately for each group of data, as defined by the grouping variable.
Tip
A very useful option, which we have adopted in this book throughout, is to show the variable names (instead of the variable labels). The variable names are typically short and the variable labels long. To make it easier to see the variables used, go to SPSS Statistics ► Preferences ► General (for Apple) or Edit ► Options ► General (for PC) and tick Display names. We show this in Fig. 5.10. Under SPSS Statistics ► Preferences ► Language (Apple) or Edit ► Options ► Language (PC) you can change the output and user interface languages.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig10_HTML.jpg]
Fig. 5.10How to display names




By clicking on ► Data ► Split File, a dialog box similar to Fig. 5.11 will open. All you need to do is to enter the variable that indicates the grouping (select Compare groups) and move the grouping variable (e.g., status) into the Groups Based on box. Note that we chose to display the variable names in the variables box at the left side of the dialog box. By right-clicking on a variable name you can switch between Display Variable Names and Display Variable Labels. Once you have specified the grouping variable and clicked on OK, SPSS will automatically carry out all subsequent analyses of each status group (i.e., blue, silver, and gold) separately. If you want to revert to analyzing the whole dataset, you need to go to ► Data ► Split File, then click on Analyze all cases, do not create groups.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig11_HTML.jpg]
Fig. 5.11Split file dialog box



It’s a common mistake to forget to turn off the split file command. Failing to do so results in all subsequent analyses being carried out for each group separately!
5.9.2 Select Cases
The select cases
                  
                 command allows us to restrict certain observations from the analyses through a pre-set condition (e.g., display the summary statistics only for those older than 40). To run the command, go to ► Data ► Select Cases and click on If condition is satisfied, followed by If. SPSS shows a screen similar to Fig. 5.12 in which you can set the conditions for restricting observations. For example, to select respondents who are older than 40, enter age>40 in the corresponding box. Next, click on Continue and OK.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig12_HTML.jpg]
Fig. 5.12Select cases dialog box



SPSS will only use the selected observations in subsequent analyses, and will omit the others (these are crossed out in the Data View screen). Remember to turn the selection off if you do not need it by going back to ► Data ► Select Cases and then click on All cases. Since we use the full dataset, please turn this selection off so that you can follow the remainder of the example.
5.9.3 Compute Variables
The compute variable
                  
                 command allows you to create a new variable from one (or more) existing variables. For example, if you want to create a composite score of some type (see Chap.​ 3), you need to calculate the average of several variables. In the following, we will use the command to compute a new index variable from the mean of the following three items related to travelers’ satisfaction: sat1, sat2, and sat3. Go to ► Transform ► Compute Variable, which will open a dialog box similar to Fig. 5.13.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig13_HTML.jpg]
Fig. 5.13Compute variables dialog box



Next, enter the name of the new variable (e.g., rating_index) in the Target Variable box on the upper left part of the screen and select Statistical from the Function group menu, followed by Mean from the Functions and Special Variables menu. SPSS will now show the corresponding function in the Numeric Expression box as MEAN(?,?). Enter sat1, sat2, sat3 in the round brackets as in Fig. 5.13 and click on OK. You have now created a new variable called rating_index that appears at the bottom of the Variable View.
5.9.4 Recode Variables
Changing or transforming the values of an existing variable according to a number of rules is a key data management activity. Numeric variables can be changed using the recode
                  
                 command, which comes in two forms. You can either overwrite an existing variable or generate a new variable, which includes the new variable coding. We recommend using the recode into different variables option. If you were to use recode into the same variables, any changes you make to the variable will result in the deletion of the original variable. Thus, if you ever want to go back to the original data, you either need to have saved a previous version, or have to enter all the data again as SPSS cannot undo these actions! The recode subcommands allow you to change the scaling of a variable. This is useful if you want to create dummies or create categories of existing variables.
In the following, we want to use the recode option to generate a new variable age_dummy, which should be 1 if a respondent is 40 or younger, and 0 else. To do so, go to ► Transform ► Recode into Different Variables, which will open a dialog box similar to Fig. 5.14.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig14_HTML.jpg]
Fig. 5.14Recode into different variables dialog box



First, move age into the Numeric Variable → Output Variable box. Next, specify the name of the variable that you want to recode (i.e., age_dummy) under Output Variable and add a label such as Dummy variable age. After clicking on Change, SPSS will draw an arrow between the original and new variables (Fig. 5.14). The next step is to tell SPSS what values need to be recoded. After clicking on Old and New Values, SPSS will open a dialog box similar to Fig. 5.15. On the left of this dialog box, you should indicate the values of the original variable that you want to recode. In our example, we used the option Range, LOWEST through value to specify that we want to recode all values of 40 or less. Select this option and enter 40 into the box below. Next, go to the right side of the menu and enter 1 under New Value and click on Add. To indicate that age_dummy should take the value 0 if age is greater than 40, select All other values and enter 0 under New Value, followed by Add. Finally, confirm your changes by clicking on Continue and OK. You have now created a new dichotomous variable (i.e., age_dummy) located at the bottom of the Variable View.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig15_HTML.jpg]
Fig. 5.15Recode options dialog box



5.10 Example
We will now examine the dataset Oddjob.sav in closer detail by following all the steps in Fig. 5.1. Cleaning the data generally requires checking for interviewer fraud, suspicious response patterns, data entry errors, outliers, and missing data. Several of these steps rely on statistics and graphs, which we discussed in the context of descriptive statistics (e.g., box plots and scatter plots). We illustrate the use of Little’s MCAR test and multiple imputation of Oddjob.sav in the Web Appendix (→ Downloads).
5.10.1 Clean Data
Since the data were cleaned earlier, we need not check for interviewer fraud or suspicious response patterns. Beside double data entries to detect and minimize errors in the process of data entry, exploratory data analysis is required to spot data entry errors that have been overlooked.
A first step in this procedure is to look at the minimum and maximum values of the relevant variables to detect values that are not plausible (i.e., fall outside the expected range of scale categories). To do so, go to ► Analyze ► Descriptive Statistics ► Descriptives, which will open a dialog box similar to Fig. 5.16. We will focus our analyses on the first ten variables (i.e., country, language, status, age, gender, nflights, flight_latest, flight_type, flight_purpose, and flight_class). Enter these variables into the Variable(s) box and click on OK. Table 5.7 shows the resulting output.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig16_HTML.jpg]
Fig. 5.16Descriptives dialog box


Table 5.7Descriptives statistics


	Descriptive Statistics

	 	N
	Minimum
	Maximum
	Mean
	Std. Deviation

	country
	1065
	1
	5
	2.00
	1.552

	language
	1065
	1
	3
	1.24
	.447

	status
	1065
	1
	3
	1.50
	.720

	age
	1065
	19
	101
	50.42
	12.275

	gender
	1065
	1
	2
	1.74
	.440

	nflights
	1065
	1
	457
	13.42
	20.226

	flight_latest
	1065
	1
	6
	3.79
	1.369

	flight_type
	1065
	1
	2
	1.48
	.500

	flight_purpose
	1065
	1
	2
	1.51
	.500

	flight_class
	1065
	1
	3
	2.80
	.435

	Valid N (listwise)
	1065
	 	 	 	 




Table 5.7 lists the minimum, maximum, mean, and standard deviation values of all the variables. Under N, we can see that all the listed variables are observed across all 1065 respondents, meaning that none of the selected variables suffer from missing observations. Among others, it appears that the age of the travelers varies between 19 and 101, while the number of flights (variable nflights) varies between 1 and 457 flights over the past 12 months. Particularly the maximum value in number of flights appears to be implausible. While this observation could represent a flight attendant, it appears more reasonable to consider this observation an outlier and eliminate it from further analyses that draw on the nflights variable.
5.10.2 Describe Data
In the next step, we describe the data in more detail, focusing on those statistics and graphs that were not part of the previous step. To do so, we make use of graphs, tables, and descriptive statistics. In Fig. 5.17, we show how you can request each of the previously discussed graphs and tables using the ► Graphs ► Legacy Dialogs menu. The figure also shows, which menu options to use to request univariate and bivariate statistics. We will not use the Legacy Dialogs option as the SPSS Chart Builder and Graphboard Template Chooser offer users more options when selecting a graph.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig17_HTML.png]
Fig. 5.17How to request graphs, tables, and statistics in SPSS



5.10.2.1 Univariate Graphs and Tables
Bar Charts
To produce a bar chart that plots the age of respondents against their country of residence, go to ► Graphs ► Chart Builder. In the dialog box that opens (Fig. 5.18), select Bar under Choose from and drag the first element into the chart builder box. Next, drag and drop age from the Variables menu to the y-axis and country to the x-axis. Clicking on OK, SPSS will produce a chart similar to Fig. 5.19.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig18_HTML.jpg]
Fig. 5.18Chart builder (bar charts)


[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig19_HTML.png]
Fig. 5.19A bar chart



Histograms
Histograms are useful for summarizing numerical variables. We will use the Graphboard Template Chooser to generate a histogram of the age variable. By going to ► Graphs ► Graphboard Template Chooser, SPSS will open a dialog box as shown in Fig. 5.20. When selecting the relevant variable age on the left side of the dialog box, SPSS will show different graph options to choose from. Select Histogram with Normal Distribution and click on OK. SPSS will produce a histogram as shown in Fig. 5.21.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig20_HTML.jpg]
Fig. 5.20Graphboard template chooser (histogram)


[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig21_HTML.png]
Fig. 5.21A histogram



Box Plot
To ask for a box plot, go to ► Graphs ► Chart Builder and select Boxplot from the Choose from list. SPSS allows you to choose among three boxplot types; select the one to the very right (1-D Boxplot) and drag this to the chart builder. Then drop age to the y-axis. When clicking on OK, SPSS will produce output similar to Fig. 5.22.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig22_HTML.png]
Fig. 5.22A box plot



Pie Charts
Pie charts are useful for displaying categorical or binary variables. We will create a pie chart for the status variable by going to ► Graphs ► Chart Builder. Select Pie/Polar from the Choose from list and drag this to the chart builder. Then drag and drop status to the x-axis. When clicking on OK, SPSS will show a pie chart. By double-clicking on the pie chart, we can open the Chart Editor
                      
                    , which allows changing the format and adding further statistics. For example, by selecting the target symbol and clicking on a slice of the chart, SPSS will display the relative frequencies (Fig. 5.23).[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig23_HTML.jpg]
Fig. 5.23Pie chart in the chart editor



Frequency Tables
We can produce a frequency table by clicking on ► Analyze ► Descriptive Statistics ► Frequencies. Move the variable country into the Variable(s) box and then click on OK. This operation will produce Table 5.8, which displays the value of each country with the corresponding absolute number of observations (i.e., Frequency), the relative values, including and excluding missing values (i.e., Percent and Valid Percent), as well as the cumulative relative values (i.e., Cumulative Percent). It shows that 65.3 % of our sample consists of travelers who reside in Germany, followed by travelers from the United States (18.3 %), Austria (10.1 %), Switzerland (6.2 %), and, finally, France (0.1 %).Table 5.8Example of a frequency table in SPSS


	country

	 	Frequency
	Percent
	Valid Percent
	Cumulative Percent

	Valid
	Germany
	695
	65.3
	65.3
	65.3

	Switzerland
	66
	6.2
	6.2
	71.5

	Austria
	108
	10.1
	10.1
	81.6

	France
	1
	.1
	.1
	81.7

	USA
	195
	18.3
	18.3
	100.0

	Total
	1065
	100.0
	100.0
	 




5.10.2.2 Univariate Statistics
Another useful way of examining your data is through the Explore option, which you can find under ► Analyze ► Descriptive Statistics ► Explore. Selecting this menu option opens a dialog box similar to that in Fig. 5.24. We will use this option to request a series of statistics for age, differentiated by gender. To do so, move age into the Dependent List box and gender into the Factor List box, which indicates the grouping variable. Under Display, select Statistics and click on OK.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig24_HTML.jpg]
Fig. 5.24Explore dialog box



SPSS will produce an output similar to Table 5.9, which includes a variety of measures of centrality and dispersion, such as the 95 % confidence interval, the 5 % trimmed mean, the variance, or the interquartile range.Table 5.9Example of a summary table using the explore option


	
                              Descriptives
                            

	 	gender
	Statistic
	Std. Error

	age
	female
	Mean
	50.81
	.761

	95 % Confidence Interval for Mean
	Lower Bound
	49.32
	 
	Upper Bound
	52.31
	 
	5 % Trimmed Mean
	50.88
	 
	Median
	51.00
	 
	Variance
	162.188
	 
	Std. Deviation
	12.735
	 
	Minimum
	22
	 
	Maximum
	78
	 
	Range
	56
	 
	Interquartile Range
	18
	 
	Skewness
	−.133
	.146

	Kurtosis
	−.591
	.290

	male
	Mean
	50.28
	.432

	95 % Confidence Interval for Mean
	Lower Bound
	49.43
	 
	Upper Bound
	51.13
	 
	5 % Trimmed Mean
	50.19
	 
	Median
	50.00
	 
	Variance
	146.684
	 
	Std. Deviation
	12.111
	 
	Minimum
	19
	 
	Maximum
	101
	 
	Range
	82
	 
	Interquartile Range
	16
	 
	Skewness
	.151
	.087

	Kurtosis
	.065
	.174





5.10.2.3 Bivariate Graphs and Tables
Scatter Plots
Scatter plots can be easily displayed in SPSS using the Chart Builder or the Graphboard Template Chooser. For example, to generate a scatter plot, go to ► Graphs ► Chart Builder and select Scatter/Dot from the Choose from list and drag the upper leftmost (simple scatter) into the chart builder box. Next, drag and drop nps to the y-axis and age to the x-axis. Clicking on OK will produce a scatter plot like in Fig. 5.25.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig25_HTML.png]
Fig. 5.25A scatter plot



Similarly, we can request a bubble plot that considers a third variable in the scatter plot. Go to Graphs ► Graphboard Template Chooser and select the variables age, nps, and status from the variable list.
Tip
To select multiple variables, simply hold the STRG key (PC) or cmd (or Command) key (Mac) and left-click on the variables you want to select..

SPSS shows several graph types to choose from, including a 3-D Area plot, 3-D Scatterplot, and a Bubble Plot (Fig. 5.26). Choose the latter and click on OK.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig26_HTML.jpg]
Fig. 5.26Graphboard template chooser (bubble plot)



The design of the bubble plot depends on the order in which you select the variables. The first variable defines the x-axis, the second variable defines the y-axis, and the third variable defines the size of the bubbles.
This will produce the bubble plot shown in Fig. 5.27. The graph shows the relationship between the respondents’ age (x-axis) and the net promoter score (y-axis) differentiated by the travelers’ status (size of the dots). Note that for illustrative purposes, the plot shown in Fig. 5.27 does not show the entire data but only a subset of 25 %, which we drew randomly using the select cases command (► Data ► Select Cases).[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig27_HTML.png]
Fig. 5.27Bubble plot for a subset of data



Cross tabulation
Cross tabulation is useful for understanding the relationship between two variables scaled on a nominal or ordinal scale. To create a crosstab, go to ► Analyze ► Descriptive Statistics ► Crosstabs. It is important that you specify which variable goes in the column and which in the rows. Choose country under Row(s) and gender under Column(s). Next, click on Cells and choose Row and Column under Percentages. Clicking on Continue and OK will produce a table similar to the one in Table 5.10.Table 5.10Example of a crosstab


	country * gender Crosstabulation

	 	gender
	Total

	female
	male

	country
	Germany
	Count
	180
	515
	695

	% within country
	25.9 %
	74.1 %
	100.0 %

	% within gender
	64.3 %
	65.6 %
	65.3 %

	Switzerland
	Count
	17
	49
	66

	% within country
	25.8 %
	74.2 %
	100.0 %

	% within gender
	6.1 %
	6.2 %
	6.2 %

	Austria
	Count
	25
	83
	108

	% within country
	23.1 %
	76.9 %
	100.0 %

	% within gender
	8.9 %
	10.6 %
	10.1 %

	France
	Count
	1
	0
	1

	% within country
	100.0 %
	0.0 %
	100.0 %

	% within gender
	0.4 %
	0.0 %
	0.1 %

	USA
	Count
	57
	138
	195

	% within country
	29.2 %
	70.8 %
	100.0 %

	% within gender
	20.4 %
	17.6 %
	18.3 %

	Total
	Count
	280
	785
	1065

	% within country
	26.3 %
	73.7 %
	100.0 %

	% within gender
	100.0 %
	100.0 %
	100.0 %





5.10.2.4 Bivariate Statistics: Correlations and Covariances
In SPSS, we can calculate bivariate correlations by going to ► Analyze ► Correlate ► Bivariate. In the dialog box that opens (Fig. 5.28), select the variables to be considered in the analysis. For example, enter s1, s2, s3, and s4 in the Variables box. When clicking on OK, SPSS will produce a correlation matrix like the one in Table 5.11.[image: ../images/210704_3_En_5_Chapter/210704_3_En_5_Fig28_HTML.jpg]
Fig. 5.28Correlate dialog box


Table 5.11Correlation matrix


	Correlations

	 	s1
	s2
	s3
	s4

	s1
	Pearson Correlation
	1
	.739**

	.619**

	.717**


	Sig. (2-tailed)
	 	.000
	.000
	.000

	N
	1038
	1037
	952
	1033

	s2
	Pearson Correlation
	.739**

	1
	.694**

	.766**


	Sig. (2-tailed)
	.000
	 	.000
	.000

	N
	1037
	1040
	952
	1034

	s3
	Pearson Correlation
	.619**

	.694**

	1
	.645**


	Sig. (2-tailed)
	.000
	.000
	 	.000

	N
	952
	952
	954
	951

	s4
	Pearson Correlation
	.717**

	.766**

	.645**

	1

	Sig. (2-tailed)
	.000
	.000
	.000
	 
	N
	1033
	1034
	951
	1035


** Correlation is significant at the 0.01 level (2-tailed).




The correlation matrix shows the correlation between each pairwise combination of three variables. For example, the correlation between s1 (“ … with Oddjob Airways you will arrive on time.”) and s2 (“ … the entire journey with Oddjob Airways will occur as booked.”) is 0.739, which indicates a strong relationship according to Cohen (1988). As indicated by the two asterisks, the correlation is significant at a 1 % level.
Alternatively, you can let SPSS display a covariance matrix. To do so, go to ► Analyze ► Correlate ► Bivariate and click on Options. Under Statistics, tick the box Cross-product deviations and covariances and run the analysis.
5.11 Cadbury and the UK Chocolate Market (Case Study)
Case Study
The UK chocolate market is expected to be £6.46 billion in 2019. Six subcategories of chocolates are used to identify the different chocolate segments: boxed chocolate, molded bars, seasonal chocolate, count lines, straight lines, and “other.”
To understand the UK chocolate market for molded chocolate bars, we have a dataset (chocolate.sav) that includes a large supermarket’s weekly sales of 100 g molded chocolate bars from January 2016 onwards. This data file can be downloaded from the book’s ⤓ Web Appendix (→ Downloads). This file contains a set of variables. Once you have opened the dataset, you will see the set of variables.
The first variable is week, indicating the week of the year and starts with Week 1 of January 2016. The last observation for 2016 ends with observation 52, but the variable continues to count onwards for 16 weeks in 2017. The next variable is sales, which indicates the weekly sales of 100 g Cadbury bars in £. Next, four price variables are included, price1-price4, which indicate the price of Cadbury, Nestlé, Guylian, and Milka in £. Next, advertising1-advertising4 indicate the amount of £ the supermarket spent on advertising each product during that week. A subsequent block of variables, pop1-pop4, indicate whether the products were promoted in the supermarket by means of point of purchase advertising. This variable is measured as yes/no. Variables promo1-promo4 indicate whether the product was put at the end of the supermarket aisle, where it is more noticeable. Lastly, temperature indicates the weekly average temperature in degrees Celsius.
You have been tasked with providing descriptive statistics for a client by means of this dataset. To help you with this task, the client has prepared a number of questions:	1.Do Cadbury’s chocolate sales vary substantially across different weeks? When are Cadbury’s sales at their highest? Please create an appropriate graph to illustrate any patterns.

 

	2.Please tabulate point-of-purchase advertising for Cadbury against point-of-purchase advertising for Nestlé. In addition, create a few more crosstabs. What are the implications of these crosstabs?

 

	3.How do Cadbury’s sales relate to the price of Cadbury? What is the strength of the relationship?

 

	4.Which descriptive statistics are appropriate for describing the usage of advertising? Which statistics are appropriate for describing point-of-purchase advertising?

 





5.12 Review Questions

              	1.Imagine you are given a dataset on car sales in different regions and are asked to calculate descriptive statistics. How would you set up the analysis procedure?

 

	2.What summary statistics could best be used to describe the change in profits over the last five years? What types of descriptive statistics work best to determine the market shares of five different types of insurance providers? Should we use just one or multiple descriptive statistics?

 

	3.What information do we need to determine if a case is an outlier? What are the benefits and drawbacks of deleting outliers?

 

	4.Download a codebook of the Household Income and Labour Dynamics in Australia (HILDA) Survey at: http://​melbourneinstitu​te.​unimelb.​edu.​au/​hilda/​for-data-users/​user-manuals. Is this codebook clear? What do you think of its structure?
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Footnotes
1Alternatively, you could also choose one of the many control system versions, including Subversion, Git, and Mecurial, which enable simple branching and project management. These systems work well with version control in centralized and in distributed environments.

 

2There are multivariate techniques that consider three, or more, variables simultaneously in order to detect outliers. See Hair et al. (2019) for an introduction, and Agarwal (2013) for a more detailed methodological discussion.

 

3For more information on missing data, see https://​www.​iriseekhout.​com


 

4The mode is another measure. However, unlike the median and mean, it is ill-defined, because it can take on multiple values. Consequently, we do not discuss the mode.

 

5A similar type of chart is the line chart
                      
                    . In a line chart, measurement points are ordered (typically by their x-axis value) and joined with straight line segments.

 

6Note that the terms n−1 in the numerator and denominator cancel each other and are therefore not shown here.

 

7The logarithm is calculated as follows: If x = y
b, then y = logb(x) where x is the original variable, b the logarithm’s base, and y the exponent. For example, log 10 of 100 is 2. Logarithms cannot be calculated for negative values (such as household debt) and for the value of zero.
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6.1 Introduction
Do men or women spend more money on the Internet? Assume that the mean amount that a sample of men spends online is $200 per year against a women sample’s mean of $250. When we compare mean values such as these, we always expect some difference. But, how can we determine if such differences are statistically significant? Establishing statistical significance requires ascertaining whether such differences are attributable to chance or not. If the difference is so large that it is unlikely to have occurred by chance, this indicates statistical significance
                
              . Whether results are statistically significant depends on several factors, including the difference, variation in the sample data, and the number of observations. In this chapter, we will introduce hypothesis testing and how this helps determine statistical significance.
6.2 Understanding Hypothesis Testing
A hypothesis is a statement about a certain condition or parameter (such as a mean or difference) that can be tested using a sample drawn from the population. A hypothesis may comprise a claim about the difference between two sample parameters (e.g., there is a difference between males’ and females’ mean spending). It can also be a test of a judgment (e.g., teenagers spend an average of four hours per day on the Internet). Data from the sample are used to obtain evidence against, or in favor of, the statement.
Hypothesis testing is performed to infer that the stated hypothesis is likely true in the population of interest (Agresti and Finlay 2014). When drawing a sample from the population, there is always some probability that we might reach the wrong conclusion due to sampling error
                
              , which is the difference between the sample and the population characteristics. To determine whether the claim is true, we start by setting an acceptable probability (called the significance level
                
              ) that we could incorrectly conclude there is an effect when, in fact, there is none. This significance level is typically set at 5 % in market research. Next, subject to the claim made in the hypothesis, we should decide on the correct type of test to perform. This involves making decisions regarding four aspects. First, we should understand the testing situation. What exactly are we testing: Are we comparing one value against a fixed value, or are we comparing groups, and, if so, how many? Second, we need to specify the nature of the samples: Is our comparison based on paired samples
                
               or independent samples
                
               (the difference is discussed later in this chapter)? Third, we should check assumptions about the distribution of our data to determine whether parametric or nonparametric tests are appropriate. Parametric tests
                
               make assumptions about the properties of the population distributions from which the data are drawn, while nonparametric tests
                
               are not based on any distributional assumptions. Fourth, we need to decide on the region where we can reject our hypothesis; that is, whether the region of rejection will be on one side or both sides of the sampling distribution.
Once these four aspects are sorted, we calculate the test statistic
                
              , which identifies whether the sample supports or rejects the claim stated in the hypothesis. Once we have calculated the test statistic, we can decide to either reject or support the hypothesis. This decision enables us to draw market research conclusions in the final step. Fig. 6.1 illustrates the six steps involved in hypothesis testing.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig1_HTML.png]
Fig. 6.1Steps involved in hypothesis testing



To illustrate the process of hypothesis testing, consider the following example: A department store chain wants to evaluate the effectiveness of three different in-store promotion campaigns that drive the sales of a specific product. These campaigns include: (1) a point of sale display, (2) a free tasting stand, and (3) in-store announcements. To help with the evaluation, the management decides to conduct a one-week experiment during which 30 stores are randomly assigned to each campaign type. This random assignment is important because randomization should equalize the effect of systematic factors not accounted for in the experimental design (see Chap.​ 4). Table 6.1 shows the sales of the three different in-store promotion campaigns. The table also contains information on the service type (personal or self-service). The marginal mean
                
               represents the means of sales within stores in the last column. Finally, the very last cell shows the grand mean
                
              , which is the overall average across all service types and campaigns.Table 6.1Sales data


	 	Sales (units)
	 
	Service type
	Point of sale display (stores 1–10)
	Free tasting stand (stores 11–20)
	In-store announcements (stores 21–30)
	Marginal mean

	Personal
	50
	55
	45
	50.00

	Personal
	52
	55
	50
	52.33

	Personal
	43
	49
	45
	45.67

	Personal
	48
	57
	46
	50.33

	Personal
	47
	55
	42
	48.00

	Self-service
	45
	49
	43
	45.67

	Self-service
	44
	48
	42
	44.67

	Self-service
	49
	54
	45
	49.33

	Self-service
	51
	54
	47
	50.67

	Self-service
	44
	44
	42
	43.33

	Marginal mean
	47.30
	52.00
	44.7
	48.00
Grand mean





We will use these data to carry out tests to compare the different in-store promotion campaigns’ mean sales separately, or in comparison to each other. We first discuss each test theoretically (including the formulas), followed by an illustration. You will realize that the formulas are not as complicated as you might have thought! These formulas contain Greek characters and we have included a table describing each Greek character in the ⤓ Web Appendix (→ Downloads).[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figa_HTML.png]
© neyro2008/Getty Images/iStock.

                      https://​www.​guide-market-research.​com/​app/​download/​13488685427/​SPSS+3rd_​Greek+Characters​.​pdf?​t=​1516714139
                    



6.3 Testing Hypotheses on One Mean
6.3.1 Formulate the Hypothesis
Hypothesis testing starts with the formulation of a null and alternative hypothesis. A null hypothesis (indicated as H0) is a statement expecting no difference or effect. Conversely, an alternative hypothesis
                  
                 (indicated as H1) is the hypothesis against which the null hypothesis is tested (Everitt and Skrondal 2010). Examples of potential null and alternative hypotheses on the campaign types are:	1.H0: The mean sales in stores that installed a point of sale display are equal to or lower than 45 units.
H1: The mean sales in stores that installed a point of sale display are higher than 45 units.

 

	2.H0: There is no difference in the mean sales of stores that installed a point of sale display and those that installed a free tasting stand (statistically, the average sales of the point of sale display = the average sales of the free tasting stand).
H1: There is a difference in the mean sales of stores that installed a point of sale display and those that installed a free tasting stand (statistically, the average sales of the point of sale display ≠ the average sales of the free tasting stand).

 





Hypothesis testing can have two outcomes: a first outcome may be that we do not reject the null hypothesis. This suggests there is no effect or no difference and that the null hypothesis can be retained. However, it would be incorrect to conclude from this that the null hypothesis is true, as it is not possible to “prove” the non-existence of a certain effect or condition. For example, one can examine any number of crows and find that they are all black, yet that would not make the statement “There are no white crows” true. Only sighting one white crow will prove its existence. A second outcome may be that we reject the null hypothesis, thus finding support for the alternative hypothesis in which some effect is expected. This outcome is, of course, desirable in most analyses, as we generally want to show that something (such as a promotion campaign) is related to a certain outcome (e.g., sales). Therefore, we frame the effect that we want to investigate as the alternative hypothesis.
Inevitably, each hypothesis test has a certain degree of uncertainty so that even if we reject a null hypothesis, we can never be totally certain that this was the correct decision. Consequently, market researchers should use terms such as “find support for the alternative hypothesis” when they discuss their findings. Terms like “prove” should never be part of hypotheses testing.
Returning to example 1, the management only considers a campaign effective if the sales it generates are higher than the 45 units normally sold (you can choose any other value, the idea is to test the sample mean against a given standard). One way of formulating the null and alternative hypotheses of this expectation is:[image: 
$${{\text{H}}_0}:\,\mu \le \,45\,$$
]




[image: 
$$\,{{\text{H}}_1}:\,\mu &gt; \,45$$
]





In words, the null hypothesis H0 states that the population mean, indicated by μ (pronounced as mu), is equal to or smaller than 45, whereas the alternative hypothesis H1 states that the population mean is larger than 45. It is important to note that the hypothesis always refers to a population parameter, in this case, the population mean, represented by μ. It is practice for Greek characters to represent population parameters and for Latin characters to indicate sample statistics (e.g., the Latin [image: 
$\bar x$
]). In this example, we state a directional hypothesis
                  
                 as the alternative hypothesis, which is expressed in a direction (higher) relative to the standard of 45 units. Since we presume that during a campaign, the product sales are higher, we posit a right-tailed hypothesis
                  
                 (as opposed to a left-tailed hypothesis
                  
                ) for the alternative hypothesis H1.
Alternatively, presume we are interested in determining whether the mean sales of the point of sale display are equal to the mean sales of the free tasting stand (example 2). This implies a non-directional hypothesis
                  
                , which can be written as:[image: 
$${H_0}:\,{\mu _1} = \,{\mu _2}$$
]




[image: 
$${H_1}:\,{\mu _1} \ne \,{\mu _2}$$
]





The difference between the two general types of hypotheses is that a directional hypothesis looks for an increase or a decrease in a parameter (such as a population mean) relative to a specific standard. A non-directional hypothesis tests for any difference in the parameter, whether positive or negative.
6.3.2 Choose the Significance Level
No type of hypothesis testing can evaluate the validity of a hypothesis with absolute certainty. In any study that involves drawing a sample from the population, there is always some probability that we will erroneously retain or reject the null hypothesis due to sampling error. In statistical testing, two types of errors can occur (Fig. 6.2):	1.a true null hypothesis is incorrectly rejected (type I
                          
                         or α error
                          
                        ), and

 

	2.a false null hypothesis is not rejected (type II
                          
                         or β error
                          
                        ).
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Fig. 6.2Type I and type II errors



In our example, a type I error occurs if we conclude that the point of sale displays increased the sales beyond 45 units, when in fact it did not increase the sales, or may have even decreased them. This situation is also referred to as false positive
                  
                . A type II error occurs if we do not reject the null hypothesis, which suggests there was no increase in sales, even though the sales increased significantly. This situation is also referred to as false negative
                  
                .
A problem with hypothesis testing is that we don’t know the true state of the null hypothesis. Fortunately, we can establish a level of confidence that a true null hypothesis will not be erroneously rejected. This is the maximum probability of a type I error that we want to allow. The Greek character α (pronounced as alpha) represents this probability and is called the significance level. In market research reports, this is indicated by phrases such as “this test result is significant at a 5 % level.” This means that the researcher allowed for a maximum chance of 5 % of mistakenly rejecting a true null hypothesis.
The selection of an α level depends on the research setting and the costs associated with a type I error. Usually, α is set to 0.05, which corresponds to a 5 % error probability. However, when researchers want to be conservative or strict in their testing, such as when conducting experiments, α is set to 0.01 (i.e., 1 %). In exploratory studies, an α of 0.10 (i.e., 10 %) is commonly used. An α-level of 0.10 means that if you carry out ten tests and reject the null hypothesis every time, your decision in favor of the alternative hypothesis was, on average, wrong once. This might not sound too high a probability, but when much is at stake (e.g., withdrawing a product because of low satisfaction ratings) then 10 % may be too high.
Why don’t we simply set α to 0.0001 % to really minimize the probability of a type I error? Setting α to such a low level would obviously make the erroneous rejection of the null hypothesis very unlikely. Unfortunately, this approach introduces another problem. The probability of a type I error is inversely related to that of a type II error, so that the smaller the risk of a type I error, the higher the risk of a type II error! However, since a type I error is considered more severe than a type II error, we control the former directly by setting α to a desired level (Lehmann 1993).
Sometimes statistical significance can be established even when differences are very small and have little or no managerial implication. Practitioners, usually refer to “significant” as being practically significant rather than statistically significant. Practical significance
                  
                 refers to differences or effects that are large enough to influence the decision-making process. It is important to note that statistical significance is required to establish practical significance. If we cannot reject that an effect is likely due to chance, such an effect is also not meaningful managerially. Whether results are practically significant depends on the management’s perception of the difference or effect and whether this warrants action. For example, a statistical difference of 10 % in sales due to packaging differences, could be practically significant if the packaging change is possible, not too costly, accepted by the retailer etc. In sum, statistical significance does not imply practical significance but practical significance does require statistical significance.
Another important concept related to this is the power of a statistical test
                  
                 (defined by 1−β, where β is the probability of a type II error). Power is the probability of rejecting a null hypothesis when it is, in fact, false. In other words, the power of a statistical test is the probability of rendering an effect significant when it is indeed significant. Researchers want the power of a test to be as high as possible, but when maximizing the power and, therefore, reducing the probability of a type II error, the occurrence of a type I error increases (Everitt and Skrondal 2010). Researchers generally view a statistical power of 0.80 (i.e., 80 %) as satisfactory, because this level is assumed to achieve a balance between acceptable type I and II errors. A test’s statistical power depends on many factors, such as the significance level, the strength of the effect, and the sample size. In Box 6.1 we discuss the statistical power concept in greater detail.
Box 6.1 Statistical power of a test
How to calculate what sample size you need? Computing the required sample size (called a power analysis
                    
                  ) can be complicated, depending on the test or procedure used. Fortunately, SPSS provides an add-on module called “Sample Power,” which can be used to carry out such analyses. In addition, the Internet offers a wide selection of downloadable applications and interactive Web programs to conduct power analyses. One particular sophisticated and easy-to-use program is G*Power 3.0 which is available at no charge from http://​www.​psycho.​uni-duesseldorf.​de/​abteilungen/​aap/​gpower3/​.
If these tools are too advanced, Cohen (1992) suggests required sample sizes for different types of tests. For example, detecting the presence of differences between two independent sample means for α = 0.05 and a power of β = 0.80 requires a sample size (n) of n = 26 for large differences, n = 64 for medium differences, and n = 393 for small differences. This demonstrates that sample size requirements increase disproportionally when the effect that needs to be detected becomes smaller.
6.3.3 Select the Appropriate Test
Selecting an appropriate statistical test is based on four aspects. First, we need to assess the testing situation: What are we comparing? Second, we need to assess the nature of the samples that are being compared: Do we have one sample with observations from the same object, firm or individual (paired), or do we have two different sets of samples (i.e., independent)? Third, we need to check the assumptions for normality to decide which type of test to use: Parametric (if we meet the test conditions) or non-parametric (if we fail to meet the test conditions)? This step may involve further analysis, such as testing the homogeneity of group variances. Fourth, we should decide on the region of rejection: Do we want to test one side or both sides of the sampling distribution? Table 6.2 summarizes these four aspects with the recommended choice of test indicated in the grey shaded boxes. In the following we will discuss each of these four aspects.Table 6.2Selecting an appropriate test


	Test #
	Testing situation
	Nature of samples
	Choice of test
	Region of rejection

	
                            What do we compare
                          
	
                            Paired vs. independent
                          
	
                            Assumptions
                          
	
                            Parametric
                          
	
                            Non-parametric
                          
	
                            One or two-sided test
                          

	1
	One group against a fixed value
	Not applicable
	Shapiro-Wilk test = normal
	One-sample t-test
	 	One or two-sided

	Shapiro-Wilk test ≠ normal
	 	Wilcoxon signed-rank test
	One or two-sided

	2
	Outcome variable across two groups
	Paired samples
	If either Levene’s test: [image: 
$\sigma _1^2 = \sigma _2^2$
] or Shapiro-Wilk test = normal
	Paired samples t-test
	 	One or two-sided

	Levene’s test: [image: 
$\sigma _1^2 \ne \sigma _2^2$
] & Shapiro-Wilk test ≠ normal
	 	Wilcoxon matched-pairs signed-rank test
	One or two-sided

	3
	Outcome variable across two groups
	Independent samples
	Levene’s test: [image: 
$\sigma _1^2 = \sigma _2^2$
]

	Independent samples
t-test
	 	One or two-sided

	Shapiro-Wilk test = normal &
Levene’s test: [image: 
$\sigma _1^2 \ne \sigma _2^2$
]

	Independent samples
t-test with Welch's correction
	 	One or two-sided

	Shapiro-Wilk test ≠ normal &
Levene’s test: [image: 
$\sigma _1^2 \ne \sigma _2^2$
]

	 	Mann-Whitney U test
	One or two-sided

	4
	Outcome variable across three or more groups
	One factor variable,
independent samples
	Shapiro-Wilk test = normal &
Levene’s test: [image: 
$\sigma _1^2 = \sigma _2^2$
]

	One-way ANOVA:
F-test
	 	Two-sided*


	Shapiro-Wilk test ≠ normal &
Levene’s test: [image: 
$\sigma _1^2 = \sigma _2^2$
]

	One-way ANOVA:
F-test
	 	Two-sided*


	Shapiro-Wilk test = normal &
Levene’s test: [image: 
$\sigma _1^2 \ne \sigma _2^2$
]

	One-way ANOVA:
F-test with Welch’s correction
	 	Two-sided*


	Shapiro-Wilk test ≠ normal &
Levene’s test: [image: 
$\sigma _1^2 \ne \sigma _2^2$
]

	 	Kruskal-Wallis rank test
	Two-sided*




* Note that although the underlying alternative hypothesis in ANOVA is two-sided, its F-statistic is based on the F-distribution, which is right-skewed with extreme values only in the right tail of the distribution.




6.3.3.1 Define the Testing Situation
When we test hypotheses, we may find ourselves in one of three situations. First, we may test if we want to compare a group to a hypothetical value (test #1 in Table 6.2). In our example, this can be a pre-determined target of 45 units to establish whether a promotion campaign has been effective or not. Second, we may want to compare the outcome variable (e.g., sales) across two groups (tests #2 or #3 in Table 6.2). Third, we may wish to compare whether the outcome variable differs between three or more levels of a categorical variable with three or more sub-groups (test #4 in Table 6.2). The factor variable is the categorical variable that we use to define the groups (e.g., three types of promotion campaigns). Each of these situations leads to different tests. When assessing the testing situation, we also need to establish the nature of the dependent variable and whether it is measured on an interval or ratio scale. This is important, because parametric tests are based on the assumption that the dependent variable is measured on an interval or ratio scale. Note that we only discuss situations when the test variable is interval or ratio-scaled (see Chap.​ 3).
6.3.3.2 Determine if Samples Are Paired or Independent
Next, we need to establish whether the samples being compared are paired or independent. The rule of thumb for determining the samples’ nature is to ask if a respondent (or object) was sampled once or multiple times. If a respondent was sampled only once, this means that the values of one sample reveal no information about the values of the other sample. If we sample the same respondent or object twice, it means that the reported values in one period may affect the values of the sample in the next period.1 Ignoring the “nested” nature of the data is the most serious threat to increases the probability of type I errors (Van Belle 2008). We therefore need to understand the nature of our samples in order to select a test that takes the dependency between observations (i.e., paired versus independent samples tests) into account. In Table 6.2, test #2 deals with paired samples, whereas tests #3 and #4 deal with independent samples.
6.3.3.3 Check Assumptions and Choose the Test
Subsequently, we need to check the distributional properties and variation of our data before deciding whether to select a parametric or a non-parametric test.
Normality test
To test whether the data are normally distributed, we conduct the Shapiro-Wilk test
                      
                     (Shapiro and Wilk 1965) that formally tests for normality. Without going into too much detail, the Shapiro-Wilk test compares the correlation between the observed sample scores (which take the covariance between the sample scores into account) with the scores expected under a standard normal distribution. Large deviations will therefore relate to p-values smaller than 0.05, suggesting that the sample scores are not normally distributed. An alternative strategy to check visually for normality, which we discuss in Box 6.2.
Equality of variances test
We can use Levene’s test
                      
                     (Levene 1960), also known as the F-test of sample variance
                      
                    , to test for the equality of the variances between two or more groups of data. The null hypothesis is that population variances across the sub-samples are the same, whereas the alternative hypothesis is that they differ. If the p-value associated with Levene’s statistic is lower than 0.05, we reject the null hypothesis, which implies that the variances are heterogeneous. Conversely, a p-value larger than 0.05 indicates homogeneous variances.
Box 6.2 Visual check for normality
You can also use plots to visually check for normality. The quantile plot
                        
                       (or Q–Q plot
                        
                       in SPSS) is a type of probability plot, which compares the quantiles of the sorted sample values with the quantiles of a standard normal distribution. Plotted data that do not follow the straight line reveal departures from normality. The quantile plot is useful to spot non-normality in the tails of the distribution. It is also possible to plot a histogram with a normal curve (discussed in Sect.​ 5.​5.​1) which is typically most useful when distribution is not quite symmetrical. Note that visual checks are subjective and should always be used in combination with more tests for normality such as the Shapiro-Wilk test.
Parametric tests
It is clear-cut that when the normality assumption is met, we should choose a parametric test. The most popular parametric test for examining one or two means is the t-test
                      
                    , which can be used for different purposes. For example, the t-test can be used to compare one mean with a given value (e.g., do males spend more than $150 a year online?). The one-sample t-test
                      
                     is an appropriate test. Alternatively, we can use a t-test to test the mean difference between two samples (e.g., do males spend more time online than females?). In this case, a two-samples t-test
                      
                     is appropriate. Independent samples t-tests
                      
                     consider two distinct groups, such as males versus females, or users versus non-users. The paired samples t-tests is used to test for differences between the same set of twice observed objects (usually respondents). When we are interested in differences between the means of more than two groups of respondents, we should use the Analysis of Variance (ANOVA).
                      
                     The ANOVA is useful when three or more means are compared and, depending on how many variables define the groups to be compared (will be discussed later in this chapter), can come in different forms. For example, we might be interested in evaluating the differences between the point of sale display, the free tasting stand, and the in-store announcements’ mean sales.
The parametric tests introduced in this chapter are very robust against normality assumption violations, especially when the data are distributed symmetrically. That is, small departures from normality usually translate into marginal differences in the p-values, particularly when using sample sizes greater than 30 (Boneau 1960). Therefore, when the Shapiro—Wilk test suggests the data are not normally distributed, we don’t have to be concerned that the parametric test results are far off (Norman, 2010), provided we have sample sizes greater than 30. The same holds for the ANOVA in cases where the sample sizes per group exceed 30. Nevertheless, if non-normality is an issue, you should use a non-parametric test that is not based on the normality assumption.
We may also have a situation in which the data are normally distributed, but the variances between two or more groups of data are unequal. This issue is generally unproblematic as long as the group-specific sample sizes are (nearly) equal. If group-size sample sizes are different, we recommend using parametric tests, such as the two-samples t-tests and the ANOVA, in combination with tests that withstand or correct the lack of equal group variances, such as Welch’s correction
                      
                    . Welch’s modified test statistic (Welch 1951) adjusts the underlying parametric tests if the variances are not homogenous in order to control for a type I error. This is particularly valuable when population variances differ and groups comprise very unequal sample sizes. In sum, when samples are normally distributed, but the equality of the variance assumption is violated (i.e., the outcome variable is not distributed equally across three or more groups), we choose a parametric test with Welch’s correction. Depending on the testing situation this can be: an independent samples t-test with Welch's correction or a one-way ANOVA F-test with Welch’s correction.
Finally, when both the normality and equality of variance assumptions are violated, non-parametric tests can be chosen directly. In the following, we briefly discuss these non-parametric tests.
Non-parametric tests
As indicated in Table 6.2, there is a non-parametric equivalent for each parametric test. This would be important if the distributions are not symmetric. For single samples, the Wilcoxon signed-rank test
                      
                     is the equivalent of one sample t-test, which is used to test the hypothesis that the population median is equal to a fixed value. For two group comparisons with independent samples, the Mann-Whitney U test
                      
                     (also called the Wilcoxon rank-sum test
                      
                    , or Wilcoxon—Mann—Whitney test
                      
                    ) is the equivalent of the independent t-test, while, for paired samples, this is the Wilcoxon matched-pairs signed-rank test
                      
                    . The Mann-Whitney U test uses the null hypothesis that the distributions of the two independent groups being considered (e.g., randomly assigned high and low performing stores) have the same shape (Mann and Whitney 1947). In contrast to an independent samples t-test, the Mann-Whitney U test does not compare the means, but the two groups’ median scores. Although we will not delve into the statistics behind the test, it is important to understand its logic.2 The Mann-Whitney U test is based on ranks and measures the differences in location (Liao 2002). The test works by first combining the separate groups into a single group. Subsequently, each outcome variable score (e.g., sales) is sorted and ranked in respect of each condition based on the values, with the lowest rank assigned to the smallest value. The ranks are then averaged based on the conditions (e.g., high versus low performing stores) and the test statistic U calculated. The test statistic represents the difference between the two rank totals. That is, if the distribution of the two groups is identical, then the sum of the ranks in one group will be the same as in the other group. The smaller the p-value (which will be discussed later in this chapter), the lower the likelihood that the two distributions’ similarities have occurred by chance; the opposite holds if otherwise.
The Kruskal-Wallis rank test
                      
                     (labelled Kruskal-Wallis H in SPSS) is the non-parametric equivalent of the ANOVA. The null hypothesis of the Kruskal-Wallis rank test is that the distribution of the test variable across group sub-samples is identical (Schuyler 2011). Given that the emphasis is on the distribution rather than on a point estimate, rejecting the null hypothesis implies that such distributions vary in their dispersion, central tendency and/or variability. According to Schuyler (2011) and Liao (2002), the following are the steps when conducting this test: First, single group categories are combined into one group with various categories. Next, objects in this variable (e.g., stores/campaigns) are sorted and ranked based on their associations with the dependent variable (e.g., sales), with the lowest rank assigned to the smallest value. Subsequently, the categorical variable is subdivided to reestablish the original single comparison groups. Finally, each group’s sum of its ranks is entered into a formula that yields the calculated test statistic. If this calculated statistic is higher than the critical value, the null hypothesis is rejected. The test statistic of the Kruskal-Wallis rank follows a χ2 distribution with k−1 degrees of freedom. In the ⤓ Web Appendix (→ Downloads), we discuss the χ2-tests.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figb_HTML.png]
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6.3.3.4 Specify the Region of Rejection
Finally, depending on the formulated hypothesis (i.e., directional versus non-directional), we should decide on whether the region of rejection is on one side (a one-tailed test
                    
                  ) or on both sides (a two-tailed test
                    
                  ) of the sampling distribution. In statistical significance testing, a one-tailed test and a two-tailed test are alternative ways of computing the statistical significance of a test statistic, depending on whether the hypothesis is expressed directionally (i.e., < or > in case of a one-tailed test) or not (i.e., ≠ in case of a two-tailed test). The word tail is used, because the extremes of distributions are often small, as in the normal distribution or bell curve shown in Fig. 6.3 later in this chapter.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig3_HTML.png]
Fig. 6.3Relationship between test value, critical value, and p-value



Even for directional hypotheses, researchers typically use two-tailed tests (Van Belle 2008). This is because two-tailed tests have strong advantages; they are stricter (and therefore generally considered more appropriate) and can also reject a hypothesis when the effect is in an unexpected direction. The use of two-tailed testing for a directional hypothesis is also valuable, as it identifies significant effects that occur in the opposite direction from the one anticipated. Imagine that you have developed an advertising campaign that you believe is an improvement on an existing campaign. You wish to maximize your ability to detect the improvement and opt for a one-tailed test. In doing so, you do not test for the possibility that the new campaign is significantly less effective than the old campaign. As discussed in various studies (e.g., Ruxton and Neuhaeuser 2010; Van Belle 2008), one-tailed tests should only be used when the opposite direction is theoretically meaningless or impossible (e.g., Field 2013; Kimmel 1957). For example, when testing if sales number of innovations are greater than zero, it does not make sense to consider negative values as negative sales cannot occur. In such a situation testing for negative outcomes is meaningless because such possibilities are ruled out beforehand. The use of two-tailed tests can seem counter to the idea of hypothesis testing, because two-tailed tests, by their very nature, do not reflect any directionality in a hypothesis. However, in many situations when we have clear expectations (e.g., sales are likely to increase), the opposite is also a possibility.
Overall, the region of rejection for the one-sample t-test and the two-samples t-test can either be one or two-tailed (however, we recommend the use of two-tailed tests). Although the alternative hypothesis in the ANOVA analysis is non-directional by nature, the underlying F-statistic—used to make inferences about group differences—is based on the F-distribution that is right-skewed. Specifically, the F-statistic is a ratio of two variances and as variances are always positive, the F-ratio is never negative. This means that although the underlying alternative hypothesis for the ANOVA analysis is two-sided, all the group differences are assumed to be in the same side of the sampling distribution. We discuss this point in more detail later in this chapter.
6.3.4 Calculate the Test Statistic
Having formulated the study’s main hypothesis, the significance level, and the type of test, we can now proceed with calculating the test statistic by using the sample data at hand. The test statistic
                  
                 is calculated by using the sample data, to assess the strength of evidence in support of the null hypothesis (Agresti and Finlay 2014). In our example, we want to compare the mean with a given standard of 45 units. Hence, we make use of a one-sample t-test
                  
                , whose test statistic is computed as follows:[image: 
$$t = \,\frac{{\bar x - \mu }}{{{s_{\bar x}}}}$$
]





Here [image: 
$\bar x$
] is the sample mean, [image: 
$\mu $
] is the hypothesized population mean, and [image: 
${s_{\bar x}}$
] the standard error (i.e., the standard deviation of the sampling distribution). Let’s first look at the formula’s numerator, which describes the difference between the sample mean [image: 
$\bar x$
] and the hypothesized population mean [image: 
$\mu $
]. If the point of sale display was highly successful, we would expect [image: 
$\bar x$
] to be higher than [image: 
$\mu {\kern 1pt} ,$
] leading to a positive difference between the two in the formula’s numerator. Alternatively, if the point of sale display was not effective, we would expect the opposite to be true. This means that the difference between the hypothesized population mean and the sample mean can go either way, implying a two-sided test. Using the data from the second column of Table 6.1, we can compute the marginal mean of the point of sales display campaign as follows:[image: 
$$\bar x = \frac{1}{n}\mathop \sum \limits_{i = 1}^n {x_i} = \frac{1}{{10}}\left( {50 + 52 + \ldots + 51 + 44} \right) = 47.30$$
]





When comparing the calculated sample mean (47.30) with the hypothesized value of 45, we obtain a difference of 2.30:[image: 
$$\bar x - \mu = 47.30 - 45 = 2.30$$
]





At first sight, it appears as if the campaign was effective as sales during the time of the campaign were higher than those that the store normally experiences. However, as discussed before, we have not yet considered the variation in the sample. This variation is accounted for by the standard error
                  
                 of [image: 
$\bar x$
] (indicated as [image: 
${s_{\bar x}}$
]), which represents the uncertainty of the sample estimate.
This sounds very abstract, so what does it mean? The sample mean is used as an estimator of the population mean; that is, we assume that the sample mean can be a substitute for the population mean. However, when drawing different samples from the same population, we are likely to obtain different sample means. The standard error tells us how much variance there probably is in the mean across different samples from the same population.
Why do we have to divide the difference [image: 
$\bar x - \mu $
] by the standard error [image: 
${s_{\bar x}}$
]? We do this because when the standard error is very low (there is a low level of variation or uncertainty in the data), the value in the test statistic’s denominator is also small, which results in a higher value for the t-test statistic. Higher t-values favor the rejection of the null hypothesis. In other words, the lower the standard error [image: 
${s_{\bar x}}$
], the greater the probability that the population represented by the sample truly differs from the hypothesized value of 45.
But how do we compute the standard error? We do so by dividing the sample standard deviation (s) by the square root of the number of observations (n), as follows:[image: 
$${s_{\bar x}} = \,\frac{s}{{\sqrt n }} = \,\frac{{\sqrt {\frac{1}{{n - 1}}\,\sum  _{i = 1}^n{{(\,{x_i} - \bar x\,)}^2}} }}{{\sqrt n }}$$
]





As we can see, a low standard deviation s decreases the standard error (which means less ambiguity when making inferences from these data). That is, less variation in the data decreases the standard error, thus favoring the rejection of the null hypothesis. Note that the standard error also depends on the sample size n. By increasing the number of observations, we have more information available, thus reducing the standard error.
If you understand this basic principle, you will have no problems understanding most other statistical tests. Let’s go back to the example and compute the standard error as follows:[image: 
$${s_{\bar x}} = \,\frac{{\sqrt {\frac{1}{{10 - 1}}\,\left[ {{{\left( {50 - 47.30} \right)}^2} + \ldots + {{\left( {44 - 47.30} \right)}^2}} \right]} }}{{\sqrt {10} }} = \,\frac{{3.199}}{{\sqrt {10} }} \approx 1.012$$
]





Thus, the result of the test statistic is:[image: 
$$t = \frac{{\bar x - \mu }}{{{s_{\bar x}}}} = \,\frac{{2.30}}{{1.012}} \approx 2.274$$
]





This test statistic applies when we compute a sample’s standard deviation. In some situations, however, we might know the population’s standard deviation, which requires the use of a different test, the z-test (see Box 6.3).
Box 6.3 The z-test
                    
                  

In the previous example, we used sample data to calculate the standard error [image: 
${s_{\bar x}}$
] . If we know the population’s standard deviation beforehand, we should use the z-test. The z-test follows a normal (instead of a t-distribution).3 The z-test is also used in situations when the sample size exceeds 30, because the t-distribution and normal distribution are similar for n > 30. As the t-test is slightly more accurate (also when the sample size is greater than 30), SPSS uses the t-test. The z-test’s statistic closely resembles the t-test and is calculated as follows:

                  [image: 
$$z = \:\frac{{\bar x - \mu }}{{{\sigma _{\bar x}}}}$$
]




                
The only minor difference is that we do not write [image: 
${s_{\bar x}}$
] but [image: 
${\sigma _{\bar x}}\:$
] in the denominator. It’s the same principle, but the Greek symbol indicates that the measure refers to a (known) population value and not to the sample. If, for example, we assumed that standard deviation in the population is 2.5, we would obtain the following test statistic:

                  [image: 
$${\sigma _{\bar x}} = \:\frac{{2.5}}{{\sqrt {10} }} = 0.791 \,\,\text {and, finally},\,\, z = \:\frac{{2.30}}{{0.791}} = 2.909\:$$
]




                
6.3.5 Make the Test Decision
Once we have calculated the test statistic, we can decide how likely it is that the claim stated in the hypothesis is correct. This is done by comparing the test statistic with the critical value that it must exceed (Option 1). Alternatively, we can calculate the actual probability of making a mistake when rejecting the null hypothesis and compare this value with the significance level (Option 2). In the following, we discuss both options.
6.3.5.1 Option 1: Compare the Test Statistic with the Critical Value
To make a test decision, we must first determine the critical value, which the test statistic must exceed for the null hypothesis to be rejected. In our case, the critical value comes from a t-distribution and depends on three parameters:	1.The significance level,

 

	2.the degrees of freedom, and

 

	3.one-tailed versus two-tailed testing.

 





We have already discussed the first point, so let’s focus on the second. The degrees of freedom
                    
                   (usually abbreviated as df) represent the amount of information available to estimate the test statistic. In general terms, an estimate’s degrees of freedom are equal to the amount of independent information used (i.e., the number of observations) minus the number of parameters estimated. Field (2013) provides a great explanation, which we adapted and present in Box 6.4.
In our example, we count n−1 or 10−1 = 9 degrees of freedom for the t-statistic to test a two-sided hypothesis of one mean. Remember that for a two-tailed test, when α is 0.05, the cumulative probability distribution is 1−α/2 or 1−0.05/2 = 0.975. We divide the significance level by two, because half of our alpha tests the statistical significance in the lower tail of the distribution (bottom 2.5 %) and half in the upper tail of the distribution (top 2.5 %). If the value of the test statistic is greater than the critical value, we can reject the H0.

We can find critical values for combinations of significance levels and degrees of freedom in the t-distribution table, shown in Table A1 in the ⤓ Web Appendix (→ Downloads). For 9 degrees of freedom and using a significance level of, for example, 5 %, the critical value of the t-statistic is 2.262. Remember that we have to look at the α = 0.05/2 = 0.025 column, because we use a two-tailed test. This means that for the probability of a type I error (i.e., falsely rejecting the null hypothesis) to be less than or equal to 5 %, the value of the test statistic must be 2.262 or greater. In our case, the test statistic (2.274) exceeds the critical value (2.262), which suggests that we should reject the null hypothesis.4 Even though the difference between the values is very small, bear in mind that hypothesis testing is binary—we either reject or don’t reject the null hypothesis. This is also the reason why a statement such as “the result is highly significant” is inappropriate.
Figure 6.3 summarizes this concept graphically. In this figure, you can see that the critical value tcritical for an α-level of 5 % with 9 degrees of freedoms equals ± 2.262 on both sides of the distribution. This is indicated by the two rejection regions left and right on the intersection of the vertical line and the curve. These two rejection areas are the upper 2.5 % and bottom 2.5 % while the remaining 95 % non-rejection region is in the middle. Since the test statistic ttest (indicated by the line saying ttest 2.274) falls in the right rejection area, we reject the null hypothesis.
Table 6.3 summarizes the decision rules for rejecting the null hypothesis for different types of t-tests, where ttest describes the test statistic and tcritical the critical value for a specific significance level α. Depending on the test’s formulation, test values may well be negative (e.g., −2.262). However, due to the symmetry of the t-distribution, only positive critical values are displayed.Table 6.3Decision rules for testing decisions


	Type of test
	Null hypothesis (H0)
	Alternative hypothesis (H1)
	Reject H0 if

	Right-tailed test
	μ ≤ value
	μ > value
	
                              [image: 
$\left| {{t_{test}}} \right| &gt; {t_{critical}}\left( \alpha \right)$
]
                            

	Left-tailed test
	μ ≥ value
	μ < value
	
                              [image: 
$\left| {{t_{test}}} \right| &gt; {t_{critical}}\left( \alpha \right)$
]
                            

	Two-tailed test
	μ = value
	μ ≠ value
	
                              [image: 
$\left| {{t_{test}}} \right| &gt; {t_{critical}}\left( {\frac{\alpha }{2}} \right)$
]
                            





Box 6.4 Degrees of freedom
Suppose you have a soccer team and 11 slots on the playing field. When the first player arrives, you have the choice of 11 positions in which you can place him or her. By allocating the player to a position, this occupies one position. When the next player arrives, you can choose from 10 positions. With every additional player who arrives, you have fewer choices where to position him or her. With the very last player, you no longer have the freedom to choose where to put him or her—there is only one spot left. Thus, there are 10 degrees of freedom. You have some degree of choice with 10 players, but for 1 player you don’t. The degrees of freedom are the number of players minus 1.
Figure 6.3 is static but using the animation on https://​homepage.​divms.​uiowa.​edu/​~mbognar/​applets/​normal.​html, you can change, for example, the rejection areas and/or toggle between one- and two-sided rejection regions.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figc_HTML.png]
© Wittayayut/Getty Images/iStock

                            https://​homepage.​divms.​uiowa.​edu/​~mbognar/​applets/​normal.​html
                          



6.3.5.2 Option 2: Compare the p-Value with the Significance Level
The above might make you remember your introductory statistics course with horror. The good news is that we do not have to bother with statistical tables when working with SPSS. SPSS automatically calculates the probability of obtaining a test statistic that is at least as extreme as the actually observed one if the null hypothesis is supported. This probability is also referred to as the p-value
                    
                   or the probability of observing a more extreme departure from the null hypothesis (Everitt and Skrondal 2010).
In the previous example, the p-value is the answer to the following question: If the population mean is not equal to 45 (i.e., therefore, the null hypothesis holds), what is the probability that random sampling could lead to a test statistic value of at least ± 2.274? This description shows that there is a relationship between the p-value and the test statistic. More precisely, these two measures are inversely related; the higher the absolute value of the test statistic, the lower the p-value and vice versa (see Fig. 6.3).
The description of the p-value is similar to the significance level α, which describes the acceptable probability of rejecting a true null hypothesis. However, the difference is that the p-value is calculated using the sample, and that α is set by the researcher before the test outcome is observed.5 The p-value is not the probability of the null hypothesis being supported! Instead, we should interpret it as evidence against the null hypothesis. The α-level is an arbitrary and subjective value that the researcher assigns to the level of risk of making a type I error; the p-value is calculated from the available data. Related to this subjectivity, there has been a revived discussion in the literature on the usefulness of p-values (e.g., Nuzzo 2014; Wasserstein and Lazar 2016) and a suitable threshold (Benjamin et al. 2017; Lakens et al. 2017).
The comparison of the p-value and the significance level allows the researcher to decide whether or not to reject the null hypothesis. Specifically, if the p-value is smaller than the significance level, we reject the null hypothesis. Thus, when examining test results, we should make use of the following decision rule—this should become second nature!6
	p-value ≤ α → reject H0


	p-value > α → do not reject H0






Note that this decision rule applies to two-tailed tests. If you apply a one-tailed test, you need to divide the p-value in half before comparing it to α, leading to the following decision rule:7
	p-value/2 ≤ α → reject H0


	p-value/2 > α → do not reject H0






In our example, the actual two-tailed p-value is 0.049 for a test statistic of ± 2.274, just below the significance level of 0.05. We can therefore reject the null hypothesis and find support for the alternative hypothesis.8

Tip
There is another way of hypothesis testing without applying a significance test. Instead of following the steps just described, we can construct a 100(1−α)% confidence interval
                      
                     for μ. The confidence interval is a range of values calculated, which includes the desired true parameter (here, the population mean μ) with a certain probability that we need to define in advance. The confidence interval has a number of critical ingredients, the estimate itself, the standard deviation of the sample, the sample size, the distribution belonging to these estimates, and the confidence level (typically 95 % but 90 % or 99 % are also common). The boundaries of the mean’s confidence interval are defined as:	Lower boundary: [image: 
$x - {t_{critical}}\left( {\frac{\alpha }{2}} \right) \cdot \:{s_{\bar x}}$
]


	Upper boundary: [image: 
$\bar x + {t_{critical}}\left( {\frac{\alpha }{2}} \right) \cdot \:{s_{\bar x}}$
]






In other words, the confidence interval is defined as: [image: 
$\left( {x - {t_{critical}}\left( {\frac{\alpha }{2}} \right) \cdot \:{s_{\bar x}};\bar x + {t_{critical}}\left( {\frac{\alpha }{2}} \right) \cdot \:{s_{\bar x}}} \right)$
]. In our case, the confidence interval looks like this:[image: 
$$\left( {47.3 - 2.262 \cdot 1.012;47.3 + 2.262 \cdot 1.012} \right) = \left( {45.01;49.59} \right)$$
]





From this, we would conclude that the true population mean, with 95 % certainty, lies in the range of 45.01 and 49.59. As we can see, the 95 % confidence interval does not include 45. Hence, we reject the null hypothesis and conclude that the population mean is not 45. Indeed, from the lower and upper boundaries, we can see that the population mean is likely larger than 45.

6.3.6 Interpret the Results
The conclusion reached by hypothesis testing must be expressed in terms of the market research problem and the relevant managerial action that should be taken. In our example, we conclude that there is evidence that the point of sale display influenced the number of sales significantly during the week it was installed.
6.4 Two-Samples t-test
6.4.1 Comparing Two Independent Samples
Testing the relationship between two independent samples is very common in market research. Some common research questions are:	Do heavy and light users’ satisfaction with a product differ?

	Do male customers spend more money online than female customers?

	Do US teenagers spend more time on Facebook than Australian teenagers?





Each of these hypotheses aim at evaluating whether two populations (e.g., heavy and light users), represented by samples, are significantly different in terms of certain key variables (e.g., satisfaction ratings).
To understand the principles of a two independent samples t-test
                  
                , let’s reconsider the previous example of a promotion campaign in a department store. Specifically, we want to test whether the population mean of the point of sale display’s sales (µ1) differs in any (positive or negative) way from that of the free tasting stand (µ2). The resulting two-sided null and alternative hypotheses are now:[image: 
$${{\text{H}}_0}:\,{\mu _1} = \,{\mu _2}$$
]




[image: 
$${{\text{H}}_1}:\,{\mu _1} \ne \,{\mu _2}$$
]





The test statistic of the two independent samples t-test—which is now distributed with n1 + n2 −2 degrees of freedom—is similar to the one-sample t-test:[image: 
$$t = \,\frac{{\left( {{{\bar x}_1} - {{\bar x}_2}} \right) - \left( {{\mu _1} - {\mu _2}} \right)}}{{{s_{{{\bar x}_1} - {{\bar x}_2}}}}},$$
]





where [image: 
${\bar x_1}$
] is the mean of the first sample (with n1 numbers of observations) and [image: 
${\bar x_2}$
] is the mean of the second sample (with n2 numbers of observations). The term [image: 
${\mu _1} - {\mu _2}$
] describes the hypothesized difference between the population means. In this case, [image: 
${\mu _1} - {\mu _2}$
] is zero, as we assume that the means are equal, but we could use any other value to hypothesize a specific difference in population means. Lastly, [image: 
${s_{{{\bar x}_1} - {{\bar x}_2}}}\,$
] describes the standard error, which comes in two forms:	If we assume that the two populations have the same variance (i.e., [image: 
$\sigma _1^2 = \sigma _2^2$
]), we compute the standard error based on the so called pooled variance estimate:[image: 
$${s_{{{\bar x}_1} - {{\bar x}_2}}} = \sqrt {\frac{{\left[ {\left( {{n_1} - 1} \right) \cdot {\text{s}}_1^2 + \left( {{n_2} - 1} \right) \cdot {\text{s}}_2^2} \right]}}{{{n_1} + {n_2} - 2}}} \,\sqrt {\frac{1}{{{{\text{n}}_1}}} + \frac{1}{{{{\text{n}}_2}}}} $$
]






	Alternatively, if we assume that the population variances differ (i.e.,[image: 
$\,\sigma _1^2 \ne \sigma _2^2$
]), we compute the standard error, using Welch's correction, as follows:[image: 
$${s_{{{\bar x}_1} - {{\bar x}_2}}} = \sqrt {\frac{{{\text{s}}_1^2}}{{{{\text{n}}_1}}} + \frac{{{\text{s}}_2^2}}{{{{\text{n}}_2}}}} $$
]










How do we determine whether the two populations have the same variance? As discussed previously, this is done using Levene’s test
                  
                , which tests the following hypotheses:[image: 
$${H_0}:\,\sigma _1^2 = \sigma _2^2$$
]




[image: 
$${H_1}:\,\sigma _1^2 \ne \sigma _2^2$$
]





The null hypothesis is that the two population variances are the same and the alternative hypothesis is that they differ. In this example, Levene’s test provides support for the assumption that the variances in the population are equal, which allows us to proceed with the pooled variance estimate. First, we estimate the variances of the first and second group as follows:[image: 
$$s_1^2 = \,\frac{1}{{{n_1} - 1}}\,\mathop \sum \limits_{i = 1}^{10} {\left( {{x_1} - {{\bar x}_1}} \right)^2} = \frac{1}{{10 - 1}}\left[ {{{\left( {50 - 47.30} \right)}^2} + \ldots + {{\left( {44 - 47.30} \right)}^2}} \right] \approx 10.233$$
]




[image: 
$$s_2^2 = \,\frac{1}{{{n_2} - 1}}\mathop \sum \limits_{i = 1}^{10} {\left( {{x_2} - {{\bar x}_2}} \right)^2} = \frac{1}{{10 - 1}}\left[ {{{\left( {55 - 52} \right)}^2} + \ldots + {{\left( {44 - 52} \right)}^2}} \right] \approx 17.556.$$
]





Using the variances as input, we can compute the standard error:

                [image: 
$${s_{{{\bar x}_1} - {{\bar x}_2}}} = \sqrt {\frac{{[(10 - 1) \cdot 10.233\, + {\text{ (}}10 - 1{\text{)}} \cdot 17.556]}}{{10 + 10 - 2}}} \cdot\sqrt {\frac{1}{{10}} + \frac{1}{{10}}} \approx 1.667$$
]




              
Inserting the estimated standard error into the test statistic results in:[image: 
$$t = \,\frac{{\left( {{{\bar x}_1} - {{\bar x}_2}} \right) - \left( {{\mu _1} - {\mu _2}} \right)}}{{{s_{{{\bar x}_1} - {{\bar x}_2}}}}} = \frac{{\left( {47.30 - 52} \right) - 0}}{{1.667}} \approx - 2.819$$
]





The test statistic follows a t-distribution with n1–n2 degrees of freedom. In our case, we have 10 + 10–2 = 18 degrees of freedom. Looking at the statistical Table A1 in the ⤓ Web Appendix (→ Downloads), we can see that the critical value of a two-sided test with a significance level of 5 % is 2.101 (note that we need to look at the column labeled α = 0.025 and the line labeled df = 18). The absolute value of −2.819 is greater than 2.101 and, thus, falls within the bottom 2.5 % of the distribution (Table 6.3). We can therefore reject the null hypothesis at a significance level of 5 % and conclude that the absolute difference between means of the point of sale display’s sales (μ1) and those of the free tasting stand (μ2) is significantly different from 0.
6.4.2 Comparing Two Paired Samples
In the previous example, we compared the mean sales of two independent samples. If the management wants to compare the difference in the units sold before and after they started the point of sale display campaign we have a paired-samples case as the sample is the same before and after. Table 6.4 shows the sales of the 10 stores before and after the point of display and in each case showing the sales in units. You can again assume that the data are normally distributed.Table 6.4Sales data (extended)


	Store
	Sales (units)

	 	Point of sale display
	No point of sale display

	1
	50
	46

	2
	53
	51

	3
	43
	40

	4
	50
	48

	5
	47
	46

	6
	45
	45

	7
	44
	42

	8
	53
	51

	9
	51
	49

	10
	44
	43

	Marginal mean
	48
	46.10





At first sight, it appears that the point of sale display generated higher sales: The marginal mean of the sales in the week during which the point of sale display was installed (48) is slightly higher than in the week when it was not (46.10). However, the question is whether this difference is statistically significant.
We cannot assume that we are comparing two independent samples, as each set of two samples originates from the same set of stores, but at different points in time and under different conditions. Hence, we should use a paired samples t-test
                  
                . In this example, we want to test whether the sales differ significantly with or without the installation of the point of sale display. We can express this by using the following hypotheses, where μd describes the population difference in sales; the null hypothesis assumes that the point of sale display made no difference, while the alternative hypothesis assumes a difference in sales:[image: 
$$\begin{array}{*{20}{c}} {{{\text{H}}_{\text{0}}}:{\mu _d} = \,0} \\ {{{\text{H}}_{\text{1}}}:{\mu _d} \ne \,0} \end{array}$$
]





To carry out this test, we define a new variable di, which captures the differences in sales between the two conditions (point of sale display—no point of sale display) in each of the stores. Thus:[image: 
$$\begin{array}{*{20}{l}} {\begin{array}{*{20}{c}} {{{\text{d}}_{\text{1}}} = \,50-46 = 4} \\ {{{\text{d}}_{\text{2}}} = \,53-51 = 2} \end{array}} \\ \ldots \\ {\begin{array}{*{20}{c}} {{{\text{d}}_{\text{9}}} = \,51-49 = 2} \\ {{{\text{d}}_{{\text{10}}}} = \,44-43 = \,1} \end{array}} \end{array}$$
]





Based on these results, we calculate the mean difference:[image: 
$$\bar d = \frac{1}{n}\mathop \sum \limits_{i = 1}^{10} {d_i} = \,\frac{1}{{10}}(4 + 2 + \cdots + 2 + 1) = 1.9$$
]





as well as the standard error of this difference:[image: 
$${s_{\bar d}} = \frac{{\sqrt {\frac{1}{{n - 1}}\,\sum _{i = 1}^{10}{{\left( {{d_i} - \bar d} \right)}^2}} }}{{\sqrt n }}$$
]




[image: 
$$ = \,\frac{{\sqrt {\frac{1}{9}[{{(4 - 1.9)}^2} + {{(2 - 1.9)}^2} + \cdots + {{(2 - 1.9)}^{2\,}} + {{(1 - 1.9)}^2}]} }}{{\sqrt {10} }} \approx 0.383$$
]





Next, we compare the mean difference [image: 
$\bar d$
] in our sample with the difference expected under the null hypothesis μd and divide this difference by the standard error [image: 
${s_{\bar d}}$
]. Thus, the test statistic is:[image: 
$$t = \,\frac{{\bar d - \,{\mu _d}}}{{{s_{\bar d}}}} = \frac{{1.9 - 0}}{{0.383}} \approx 4.960.$$
]





The test statistic follows a t-distribution with n−1 degrees of freedom, where n is the number of pairs that we compare. Recall that for a two-tailed test, when α is 0.05, we need to look at the column labeled α = 0.025. Looking at Table A1 in the ⤓ Web Appendix (→ Downloads), we can see that the critical value of a two-sided test with a significance level of 5 % is 2.262 for 9 degrees of freedom. Since the test value (4.960) is larger than the critical value, we can reject the null hypothesis and presume that the point of sale display makes a difference.
6.5 Comparing More Than Two Means: Analysis of Variance (ANOVA)
Researchers are often interested in examining differences in the means between more than two groups. For example:	Do light, medium, and heavy internet users differ in their monthly disposable income?

	Do customers across four different types of demographic segments differ in their attitude towards a certain brand?

	Is there a significant difference in hours spent on Facebook between US, UK, and Australian teenagers?





Continuing with our previous example on promotion campaigns, we might be interested in whether there are significant sales differences between the stores in which the three different types of campaigns were launched. One way to tackle this research question would be to carry out multiple pairwise comparisons of all the groups under consideration. In this example, doing so would require the following comparisons:	1.The point of sale display versus the free tasting stand,

 

	2.the point of sale display versus the in-store announcements, and

 

	3.the free tasting stand versus the in-store announcements.

 





While three comparisons are doable, you can imagine the difficulties when a greater number of groups are compared. For example, with ten groups, we would have to carry out 45 group comparisons.9

Making large numbers of comparisons induces the severe problem of α-inflation
                
              . This inflation refers to the more tests that you conduct at a certain significance level, the more likely you are to claim a significant result when this is not so (i.e., an increase or inflation in the type I error). Using a significance level of α = 0.05 and making all possible pairwise comparisons of ten groups (i.e., 45 comparisons), the increase in the overall probability of a type I error (also referred to as the familywise error rate
                
              ) is:[image: 
$${\alpha ^*} = 1 - {\left( {1 - \alpha } \right)^{45}} = 1 - {\left( {1 - 0.05} \right)^{45}} = 0.901$$
]





That is, there is a 90.1 % probability of erroneously rejecting your null hypothesis in at least some of your 45 t-tests—far greater than the 5 % for a single comparison! The problem is that you can never tell which of the comparisons’ results are wrong and which are correct.
Instead of carrying out many pairwise tests, market researchers use ANOVA, which allows a comparison of three or more groups’ averages. In ANOVA, the variable that differentiates the groups is referred to as the factor variable
                
               (don’t confuse this with the factors of factor analysis discussed in Chap.​ 8!). The values of a factor (i.e., as found in respect of the different groups under consideration) are also referred to as factor levels
                
              .
In the previous example of promotion campaigns, we considered only one factor variable with three levels, indicating the type of campaign. This is the simplest form of an ANOVA and is called a one-way ANOVA
                
              . However, ANOVA allows us to consider more than one factor variable. For example, we might be interested in adding another grouping variable (e.g., the type of service offered), thus increasing the number of treatment conditions in our experiment. ANOVA is even more flexible, because you can also integrate interval or ratio-scaled independent variables and even multiple dependent variables as well as more than one factor variable (Two-way ANOVA
                
              ).
We now know that the one-way ANOVA is used to examine the mean differences between more than two groups. In more formal terms, the objective of the one-way ANOVA is to test the null hypothesis that the population means of the groups (defined by the factor and its levels) are equal. If we compare three groups, as in the promotion campaign example, the null hypothesis is:[image: 
$${{\text{H}}_{\text{0}}}{\text{: }}{\mu _1} = {\mu _2} = {\mu _3}$$
]





This hypothesis implies that the population means of all three promotion campaigns are identical (which is the same as saying, that the campaigns have the same effect on the mean sales). The alternative hypothesis is:[image: 
$${H_1}:\,{\text{At}}\,{\text{least}}\,{\text{two}}\,{\text{of}}\,{\mu _1},{\mu _2},\,{\text{and}}\,{\mu _3}\,{\text{are}}\,{\text{unequal}}.$$
]





Before we even think of running an ANOVA, we should, of course, produce a problem formulation, which requires us to identify the dependent variable and the factor variable, as well as its levels. Once this task is done, we can dig deeper into ANOVA by following the steps described in Fig. 6.4. We next discuss each step in more detail.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig4_HTML.png]
Fig. 6.4Steps in conducting an ANOVA




              [image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figd_HTML.png]
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                      https://​www.​guide-market-research.​com/​app/​download/​13488670527/​SPSS+3rd_​Chapter+6_​Two-way+ANOVA.​pdf?​t=​1516713104
                    


            
6.5.1 Check the Assumptions
ANOVA is a parametric test that relies on the same distributional assumptions as discussed in Sect. 6.3. We may use ANOVA in situations when the dependent variable is measured on an ordinal scale and is not normally distributed, but we should then ensure that the group-specific sample sizes are similar. Thus, if possible, it is useful to collect samples of a similar size for each group. As discussed previously, ANOVA is robust to departures from normality with sample sizes greater than 30 per group, meaning that it can be performed even when the data are not normally distributed. Even though ANOVA is rather robust in this respect, violations of the assumption of the equality of variances can bias the results significantly, especially when the groups are of very unequal sample size.10 Consequently, we should always test for the equality of variances by using Levene’s test.
Finally, like any data analysis technique, the sample size must be sufficiently high to have sufficient statistical power. There is general agreement that the bare minimum sample size per group is 20. However, 30 or more observations per group are desirable. For more detail, see Box 6.1.
We already touched upon Levene’s test and you can learn more about it in ⤓ Web Appendix (→ Downloads).[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fige_HTML.png]
© virtualphoto/Getty Images/iStock

                        https://​www.​guide-market-research.​com/​app/​download/​13488668127/​SPSS+3rd_​Chapter+6_​Levene%27s+test.​pdf?​t=​1516713071
                      



6.5.2 Calculate the Test Statistic
ANOVA examines the dependent variable’s variation across groups and, based on this variation, determines whether there is reason to believe that the population means of the groups differ. Returning to our example, each store’s sales are likely to deviate from the overall sales mean, as there will always be some variation. The question is therefore whether a specific promotion campaign is likely to cause the difference between each store’s sales and the overall sales mean, or whether this is due to a natural variation in sales. To disentangle the effect of the treatment (i.e., the promotion campaign type) and the natural variation, ANOVA separates the total variation in the data (indicated by SST) into two parts:	1)the between-group variation (SSB), and

 

	2)the within-group variation (SSW).11


 





These three types of variation are estimates of the population variation. Conceptually, the relationship between the three types of variation is expressed as:[image: 
$$S{S_T} = S{S_B} + S{S_W}$$
]





However, before we get into the math, let’s see what SSB and SSW are all about.
The Between-Group Variation
                    
                   (SSB)
SSB refers to the variation in the dependent variable as expressed in the variation in the group means. In our example, it describes the variation in the mean values of sales across the three treatment conditions (i.e., point of sale display, free tasting stand, and in-store announcements) relative to the overall mean. What does SSB tell us? Imagine a situation in which all mean values across the treatment conditions are the same. In other words, regardless of which campaign we choose, the sales are the same, we cannot claim that the promotion campaigns had differing effects. This is what SSB expresses: it tells us how much variation the differences in observations that stem from different groups can explain. Since SSB is the explained variation
                    
                   (explained by the grouping of data) and thus reflects different effects, we would want it to be as high as possible. However, there is no given standard of how high SSB should be, as its magnitude depends on the scale level used (e.g., are we looking at 7-point Likert scales or income in US$?). Consequently, we can only interpret the explained variation expressed by SSB in relation to the variation that the grouping of data does not explain. This is where SSW comes into play.
The Within-Group Variation
                    
                   (SSW)
As the name already suggests, SSW describes the variation in the dependent variable within each of the groups. In our example, SSW simply represents the variation in sales in each of the three treatment conditions. The smaller the variation within the groups, the greater the probability that the grouping of data can explain all the observed variation. It is obviously the ideal for this variation to be as small as possible. If there is much variation within some or all the groups, then some extraneous factor, not accounted for in the experiment, seems to cause this variation instead of the grouping of data. For this reason, SSW is also referred to as unexplained variation
                    
                  .
Unexplained variation can occur if we fail to account for important factors in our experimental design. While some unexplained variation will always be present, regardless of how sophisticated our experimental design is and how many factors we consider. If the unexplained variation cannot be explained, it is called random noise
                    
                   or simply noise
                    
                    
                  .
Combining SSB and SSW into an Overall Picture
The comparison of SSB and SSW tells us whether the variation in the data is attributable to the grouping, which is desirable, or due to sources of variation not captured by the grouping, which is not desirable. Figure 6.5 shows this relationship across the stores featuring our three different campaign types:	Point of sale display (•),

	free tasting stand (▪), and

	in-store announcements (▲).




[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig5_HTML.png]
Fig. 6.5Scatter plot of stores with different campaigns vs. sales



We indicate the group mean of each level by dashed lines. If the group means are all the same, the three dashed lines are horizontally aligned and we then conclude that the campaigns have identical sales. Alternatively, if the dashed lines are very different, we conclude that the campaigns differ in their sales.
At the same time, we would like the variation within each of the groups to be as small as possible; that is, the vertical lines connecting the observations and the dashed lines should be short. In the most extreme case, all observations would lie on their group-specific dashed lines, implying that the grouping explains the variation in sales perfectly. This, however, hardly ever occurs.
If the vertical bars were all, say, twice as long, it would be difficult to draw any conclusions about the effects of the different campaigns. Too great a variation within the groups then swamps the variation between the groups. We can calculate the three types of variation as follows:	1.The total variation, computed by comparing each store’s sales with the overall mean [image: 
$\bar x$
], which is equal to 48 in our example:12


                          [image: 
$$S{S_T} = \mathop \sum \limits_{i = {\kern 1pt} 1}^n {\left( {{x_i} - \bar x} \right)^2} = {\left( {50 - 48} \right)^2} + {\left( {52 - 48} \right)^{2\,}} + \ldots + {\left( {47 - 48} \right)^{2\,}} + {\left( {42 - 48} \right)^{2\,}} = 584$$
]




                        

 

	2.The between-group variation, computed by comparing each group’s mean sales with the overall mean, is:

                          [image: 
$$S{S_B} = \mathop {\sum {\kern 1pt} }\limits_{j = 1}^k {n_j}{({\bar x_j} - \,\bar x)^2}$$
]




                        

 





As you can see, besides index i, as previously discussed, we also have index j to represent the group sales means. Thus, [image: 
${\bar x_j}$
] describes the mean in the j-th group and nj the number of observations in that group. The overall number of groups is denoted with k. The term nj is used as a weighting factor: Groups that have many observations should be accounted for to a higher degree relative to groups with fewer observations. Returning to our example, the between-group variation is then given by:

                  [image: 
$$S{S_B} = \,10\, \cdot {\left( {47.30 - 48} \right)^2} + 10\,\, \cdot {\left( {52 - 48} \right)^2} + 10\,\, \cdot {\left( {44.70 - 48} \right)^2} = 273.80$$
]




                  	3.The within-group variation, computed by comparing each store’s sales with its group sales mean is:

                          [image: 
$$S{S_w} = \,\mathop \sum \limits_{j = 1}^k \mathop \sum \limits_{i = 1}^{{n_j}} \left( {{x_{ij}} - {{\bar x}_j}} \right)$$
]




                        

 




                
Here, we should use two summation signs, because we want to compute the squared differences between each store’s sales and its group sales’ mean for all k groups in our set-up. In our example, this yields the following:[image: 
$$\begin{gathered} S{S_W} = \left[ {{{\left( {50 - 47.30} \right)}^2} + \ldots { + }{{\left( {44 - 47.30} \right)}^2}} \right] + \left[ {{{\left( {55 - 52} \right)}^2} + \ldots { + }{{\left( {44 - 52} \right)}^2}} \right] \hfill \\ \,\,\,\,\,\,\,\,\,\,\,\,\,\,\,\,\,\,\,\,\, + \left[ {{{\left( {45 - 44.70} \right)}^2} + \ldots { + }{{\left( {42 - 44.70} \right)}^2}} \right] = 310.20 \hfill \\ \end{gathered} $$
]





In the previous steps, we discussed the comparison of the between-group and within-group variation. The higher the between-group variation is in relation to the within-group variation, the more likely it is that the grouping of the data is responsible for the different levels in the stores’ sales instead of the natural variation in all the sales.
A suitable way to describe this relation is by forming an index with SSB in the numerator and SSW in the denominator. However, we do not use SSB and SSW directly, because they are based on summed values and the scaling of the variables used therefore influence them. Therefore, we divide the values of SSB and SSW by their degrees of freedom to obtain the true mean square values MSB (called between-group mean squares
                    
                  ) and MSW (called within-group mean squares
                    
                  ). The resulting mean square values are:[image: 
$$M{S_B} = \frac{{S{S_B}}}{{k - 1}},\,{\text{and}}\,M{S_W} = \frac{{S{S_W}}}{{n - k}}$$
]





We use these mean squares to compute the following test statistic, which we then compare with the critical value:[image: 
$$F = \frac{{M{S_B}}}{{M{S_W}}}$$
]





Turning back to our example, we calculate the test statistic as follows:[image: 
$$F = \frac{{M{S_B}}}{{M{S_W}}} = \, \frac{{{\raise0.7ex\hbox{${S{S_B}}$} \!\mathord{\left/
 {\vphantom {{S{S_B}} {k - 1}}}\right.\kern-\nulldelimiterspace}
\!\lower0.7ex\hbox{${k - 1}$}}}}{{{\raise0.7ex\hbox{${S{S_W}}$} \!\mathord{\left/
 {\vphantom {{S{S_W}} {n - k}}}\right.\kern-\nulldelimiterspace}
\!\lower0.7ex\hbox{${n - k}$}}}} = \frac{{{\raise0.7ex\hbox{${273.80}$} \!\mathord{\left/
 {\vphantom {{273.80} {3 - 1}}}\right.\kern-\nulldelimiterspace}
\!\lower0.7ex\hbox{${3 - 1}$}}}}{{{\raise0.7ex\hbox{${310.20}$} \!\mathord{\left/
 {\vphantom {{310.20} {30 - 3}}}\right.\kern-\nulldelimiterspace}
\!\lower0.7ex\hbox{${30 - 3}$}}}} \approx 11.916$$
]





6.5.3 Make the Test Decision
Making the test decision in ANOVA is like the t-tests discussed earlier, with the difference that the test statistic follows an F-distribution (as opposed to a t-distribution). Different from before, however, we don’t have to divide α by 2 when looking up the critical value, even though the underlying alternative hypothesis in ANOVA is two-sided! The reason for this is that an F-test
                  
                 statistic is the ratio of the variation explained by systematic variance (i.e., between-group mean squares) to the unsystematic variance (i.e., within-group mean squares), which is always equal to or greater than 0, but never lower than 0. For this reason, and given that no negative values occur, it makes no sense to split the significance level in half (Van Belle 2008).
Unlike the t-distribution, the F-distribution depends on two degrees of freedom: One corresponding to the between-group mean squares (k − 1) and the other referring to the within-group mean squares (n − k). The degrees of freedom of the promotion campaign example are 2 and 27; therefore, on examining Table A2 in the ⤓ Web Appendix (→ Downloads), we see a critical value of 3.354 for α = 0.05. In our example, we reject the null hypothesis, because the F-test statistic of 11.916 is greater than the critical value of 3.354. Consequently, we can conclude that at least two of the population sales means of the three types of promotion campaigns differ significantly.
At first sight, it appears that the free tasting stand is most successful, as it exhibits the highest mean sales ([image: 
${\bar x_2} = \,52$
]) compared to the point of sale display ([image: 
${\bar x_1} = \,47.30$
]) and the in-store announcements ([image: 
${\bar x_3} = \,44.70$
]). However, rejecting the null hypothesis does not mean that all the population means differ—it only means that at least two of the population means differ significantly! Market researchers often assume that all means differ significantly when interpreting ANOVA results, but this is wrong. How then do we determine which of the mean values differ significantly from the others? We deal with this problem by using post hoc tests, which is done in the next step of the analysis.
6.5.4 Carry Out Post Hoc Tests
Post hoc tests
                  
                 perform multiple comparison tests on each pair of groups and tests which of the groups differ significantly from each other. The basic idea underlying post hoc tests is to perform tests on each pair of groups and to correct the level of significance of each test. This way, the overall type I error rate across all the comparisons (i.e., the familywise error rate
                  
                ) remains constant at a certain level, such as at α = 0.05 (i.e., α-inflation is avoided).
There are several post hoc tests, the easiest of which is the Bonferroni correction
                  
                . This correction maintains the familywise error rate by calculating a new pairwise alpha that divides the statistical significance level of α by the number of comparisons made. How does this correction work? In our example, we can compare three groups pairwise: (1) Point of sale display vs. free tasting stand, (2) point of sale display vs. in-store announcements, and (3) free tasting stand vs. in-store announcements. Hence, we would use 0.05/3 ≈ 0.017 as our criterion for significance. Thus, to reject the null hypothesis that the two population means are equal, the p-value would have to be smaller than 0.017 (instead of 0.05!). The Bonferroni adjustment is a very strict way of maintaining the familywise error rate. However, there is a trade-off between controlling the familywise error rate and increasing the type II error. By reducing the type I error rate, the type II error increases. Hence the statistical power decreases, potentially causing us to miss significant effects.
The good news is that there are alternatives to the Bonferroni method. The bad news is that there are numerous types of post hoc tests—SPSS provides no less than 18! Generally, these tests detect pairs of groups whose mean values do not differ significantly (homogeneous subsets). However, all these tests are based on different assumptions and designed for different purposes, whose details are clearly beyond the scope of this book. Check out the SPSS help function for an overview and references.
The most widely used post hoc test in market research is Tukey’s honestly significant difference test
                  
                 (usually simply called Tukey’s HSD). Tukey’s HSD is a very versatile test which controls for the type I error and is conservative in nature. A less conservative alternative is the Ryan/Einot-Gabriel/Welsch Q (REGWQ)
                  
                 procedure, which also controls for the type I error rate but has a higher statistical power. These post hoc tests share two important properties:	1.they require an equal number of observations for each group (differences of a few observations are not problematic), and

 

	2.they assume that the population variances are equal.

 





Fortunately, research has provided alternative post hoc tests for situations in which these properties are not met. When sample sizes differ clearly, it is advisable to use Hochberg’s GT2
                  
                , which has good power and can control the type I error. However, when population variances differ, this test becomes unreliable. Thus, in cases where our analysis suggests that population variances differ, it is best to use the Games-Howell procedure
                  
                 because it generally seems to offer the best performance. Fig. 6.6 provides a guideline for choosing the appropriate post hoc test.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig6_HTML.png]
Fig. 6.6Guidelines for choosing the appropriate post hoc test



While post hoc tests provide a suitable way of carrying out pairwise comparisons among the groups while maintaining the familywise error rate, they do not allow making any statements regarding the strength of a factor’s effects on the dependent variable. This is something we have to evaluate in a separate analysis step, which is discussed next.
6.5.5 Measure the Strength of the Effects
We can compute the η2 (the eta squared
                  
                ) coefficient manually to determine the strength of the effect (also referred to as the effect size
                  
                ) that the factor variable exerts on the dependent variable. The eta squared is the ratio of the between-group variation (SSB) to the total variation (SST) and therefore indicates the variance accounted for by the sample data. Since η2 is equal to the coefficient of determination (R2
                  
                ), known from regression analysis (Chap.​ 7). η2 can take on values between 0 and 1. If all groups have the same mean value, and we can thus assume that the factor has no influence on the dependent variable, η2 is 0. Conversely, a high value implies that the factor exerts a strong influence on the dependent variable. In our example, η2 is:[image: 
$${\eta ^2} = \,\frac{{S{S_B}}}{{S{S_T}}} = \frac{{273.80}}{{584}} \approx 0.469$$
]





The outcome indicates that 46.9 % of the total variation in sales is explained by the promotion campaigns. The η2 is often criticized as being too high for small sample sizes of 50 or less. We can compute ω² (pronounced omega squared
                  
                ), which corresponds to the Adjusted R2
                  
                 from regression analysis (Chap.​ 7), to compensate for small sample sizes:[image: 
$${\omega ^2} = \,\frac{{S{S_B} - \left( {k - 1} \right) \cdot M{S_W}}}{{S{S_T} + M{S_W}}} = \frac{{273.80 - \left( {3 - 1} \right) \cdot 11.916}}{{584 + 11.916}} \approx 0.421$$
]





This result indicates that 42.1 % of the total variation in sales is accounted for by the promotion campaigns. Generally, you should use ω² for n ≤ 50 and η2 for n > 50.
Tip
It is difficult to provide firm rules of thumb regarding when η2 or ω² is appropriate, as this varies from research area to research area. However, since the η2 resembles Pearson’s correlation coefficient (Chap.​ 7), we follow the suggestions provided in Chap.​ 7. Thus, we can consider values below 0.30 weak, values from 0.31 to 0.49 moderate, and values of 0.50 and higher strong.

6.5.6 Interpret the Results
Just as in any other type of analysis, the final step is to interpret the results. Based on our results, we conclude that not all promotional activities have the same effect on sales. An analysis of the strength of the effects revealed that this association is moderate.
Table 6.5 provides an overview of steps involved when carrying out the following tests in SPSS: One-sample t-test, independent samples t-test, paired samples t-test, and the one-way ANOVA.Table 6.5Steps involved in carrying out one, two, or more group comparisons with SPSS


	Theory (number in brackets referring to Table 6.2)
	Action

	
                            (1) One-sample t-test
                          

	
                            Formulate the hypothesis
                          

	Formulate the study’s hypothesis:
	
                            For example:
                          

                            [image: 
${{\text{H}}_0}:{\text{ }}\mu = \# $
]
                          

                            [image: 
${{\text{H}}_1}:{\text{ }}\mu \ne \# $
]
                          

	
                            Choose the significance level
                          

	 	Usually, α is set to 0.05, but:
– if you want to be conservative, α is set to 0.01, and:
– in exploratory studies, α is set to 0.10. We choose a significance level of 0.05.

	
                            Select an appropriate test
                          

	What is the testing situation?
	Determine the fixed value again which that you are comparing.

	Is the test variable measured on an interval or ratio scale?
	Check Chap.​ 3 to determine the measurement level of the variables.

	Are the observations independent?
	Consult Chap.​ 3 to determine whether the observations are independent.

	Is the test variable normally distributed?
	
                            Check for normality
                          
Go to ► Analyze ► Descriptive Statistics ► Explore. Then add the test variable(s) to the Dependent list box. Click on Plots, uncheck Stem-and-leaf and check Normality plots with tests and click on Continue and then OK. Interpret the Tests of Normality table and check in the Tests of Normality table under Sig. of Shapiro-Wilk if p > 0.05, which suggests normality.

	Specify the type of t-test
	 
	Is the test one or two-sided?
	Determine the region of rejection, one-sided (left or right) or two-sided.

	
                            Calculate the test statistic
                          

	Specify the test variable and the fixed value
	Either normally distributed or equal group variances (one sample t-test): Go to ► Analyze ► Compare Means ► One-Sample T test. Put the test variable(s) under Test Variable(s):. Then enter under Test Value the mean value you want to compare the test variable(s) against. Note: it is possible to compare multiple test variables but no Bonferroni correction is applied and it may not be appropriate to compare multiple test variables against one test value.
Consider selecting a different confidence interval different from the default 95 % by clicking on Options and to enter the desired confidence interval (e.g. 99 or 90) under Confidence Interval percentage:.
Not normally distributed and unequal group variances (Wilcoxon signed-rank test): First you will need to compute a new variable with the fixed value you want to test for. Do this by going to ► Transform ► Compute variable and as the target variable type (for example) testval and enter the value you want to test for under Numeric Expression. Click on OK.
Then go to ► Analyze ► Nonparametric Tests ► Legacy Dialogs ► 2 Related Samples. Then add the variable you want to test for to Test Pairs: and also add the variable you just constructed (e.g. testval). Make sure only Wilcoxon is ticked and click on OK.

	
                            Interpret the results
                          

	Look at the test results
	One sample t-test: In the output tables, check in the One-Sample Test table if Sig. (2-tailed) is less than .05. For two-sided tests, you need to multiply the value under Sig. (2-tailed) by two.
Wilcoxon signed-rank test, check under Test Statistics under the row Asymp. Sig. (2-tailed) if the value is less than .05.

	What is your conclusion?
	Reject the null hypothesis that the population mean of the test variable is equal to the mean value you want to compare the test variable(s) against if the p-value is lower than 0.05.

	
                            (2) Paired samples t-test
                          

	
                            Formulate the hypothesis
                          

	Formulate the study’s hypothesis:
	
                            For example:
                          

                            [image: 
${{\text{H}}_0}:{\text{ }}{\mu _1} = {\text{ }}{\mu _2}$
]
                          

                            [image: 
${{\text{H}}_1}:{\text{ }}{\mu _1} \ne {\text{ }}{\mu _2}$
]
                          

	
                            Choose the significance level
                          

	 	Usually, α is set to 0.05, but:
– if you want to be conservative, α is set to 0.01, and:
– in exploratory studies, α is set to 0.10. We choose a significance level of 0.05.

	
                            Select an appropriate test
                          

	What is the testing situation?
	Determine the number of groups you are comparing.

	Are the test variables measured on an interval or ratio scale?
	Check Chap.​ 3 to determine the measurement level of the variables.

	Are the observations dependent?
	Next, consult Chap.​ 3 to determine whether the observations are independent.

	Are the test variables normally distributed in each of the groups?
	
                            Check for normality
                          
Go to ► Analyze ► Descriptive Statistics ► Explore. Then add the test variable(s) to the Dependent list: and under Factor List: add the variable that indicates the two groups. Then click on Plots, uncheck Stem-and-leaf and check Normality plots with tests and click on Continue and then OK. Interpret the Tests of Normality table and check in the Tests of Normality table under Sig. of Shapiro-Wilk if p > 0.05, which suggests normality.

	Specify the type of t-test
	If the data appear to be normally distributed across all groups or have equal group variances, we can proceed with the paired samples t-test. If the data are non-normally distributed and have unequal variances, we should apply the Wilcoxon matched-pairs signed-rank test.

	Is the test one or two-sided?
	Determine the region of rejection.

	
                            Calculate the test statistic
                          

	Select the paired test variables
	Normally distributed or equal group variances (Paired t-test): Go to ► Analyze ► Compare Means ► Paired-Samples T test. Put the test variables into the Paired Variable(s) box. Note: it is possible to compare multiple test variables but no Bonferroni correction is applied.
Consider selecting a different confidence interval different from the default 95 % by clicking on Options and to enter the desired confidence interval (e.g. 99 or 90) under Confidence Interval percentage.
– Not normally distributed and unequal variances (Wilcoxon matched-pairs signed-rank test): Go to ► Analyze ► Nonparametric tests ► Related Samples and click on Customize analysis. Under Fields click on Use custom field assignments first. Then add the variable you want to test to the Test Fields: box. Then click on Settings and tick Customize tests: and then Wilcoxon matched-pair signed-rank (2 samples) and click on Run.

	
                            Interpret the results
                          

	Look at the test results
	– Paired t-test: test in the Paired Samples Test table if Sig. (2-tailed) is below .05.
– Wilcoxon matched-pairs signed-rank test: in the Hypothesis Test Summary, check if the p-value under Sig. is below .05.

	What is your conclusion?
	Reject the null hypothesis that the population mean of the test variables are equal if the p-value under Sig. (2-tailed) is below 0.05.

	
                            (3) Independent samples t-test
                          

	
                            Formulate the hypothesis
                          

	Formulate the study’s hypothesis:
	
                            For example:
                          

                            [image: 
${{\text{H}}_0}:{\text{ }}{\mu _1} = {\text{ }}{\mu _2}$
]
                          

                            [image: 
${{\text{H}}_1}:\:{\mu _1} \ne \:{\mu _2}$
]
                          

	
                            Choose the significance level
                          

	 	Usually, α is set to 0.05, but:
– if you want to be conservative, α is set to 0.01, and:
– in exploratory studies, α is set to 0.10. We choose a significance level of 0.05.

	
                            Select an appropriate test
                          

	What is the testing situation?
	Determine the number of groups you are comparing.

	Are the test variables measured on an interval or ratio scale?
	Check Chap.​ 3 to determine the measurement level of the variables.

	Are the observations dependent?
	Next, consult Chap.​ 3 to determine whether the observations are independent.

	Are the test variables normally distributed in each of the groups and are the group variances the same?
	
                            Check for normality
                          
Go to ► Analyze ► Descriptive Statistics ► Explore. Then add the test variable(s) to the Dependent list:. Click on Plots, uncheck Stem-and-leaf and check Normality plots with tests and click on Continue and then OK. Interpret the Tests of Normality table and check in the Tests of Normality table under Sig. of Shapiro-Wilk if p > .05, which suggests normality.
SPSS conducts the group variances equality test automatically as part of the Paired samples t-test.

	
                            Specify the type of t-test
                          

	Is the test one or two-sided?
	Determine the region of rejection.

	
                            Calculate the test statistic
                          

	Select the test variable and the grouping variable
	Normally or non-normally distributed but equal group variances (independent samples t-test): Go to ► Analyze ► Compare Means ► Independent Samples T test. Put the test variable into the Test Variable(s) box and add the variable indicating the grouping into the Grouping Variable box. Click on Define Groups and under Use specified values enter which values indicate the two groups you want to compare. Note: it is possible to compare multiple test variables but no Bonferroni correction is applied.
Consider selecting a confidence interval different from the default 95 % by clicking on Options and to enter the desired confidence interval (e.g. 99 or 90) under Confidence Interval percentage.
Not normally distributed and unequal variances (Mann-Whitney U test): Go to ► Analyze ► Nonparametric tests ► Independent Samples. Under Objective tick Customize analysis. Under Fields, click on Use customer field assignments and move the test variable into the Test Fields box. Under Settings click on Customize tests and click on Mann-Whitney U (2-samples). Followed by Run.

	
                            Interpret the results
                          

	Look at the test results
	If the data appear to be normally or non-normally distributed with equal group variances then from the Independent Samples Test table we should read the row saying Equal variance assumed. If they come from normally distributed data but unequal variances we should use the row saying Equal variances not assumed. For both situations, check if Sig. (2-tailed) is less than 0.05. For two-sided tests, you need to multiply the value under Sig. (2-tailed) by two.
For the Mann-Whitney U test, we should check in the Hypothesis Test Summary table if Sig. (2-tailed) is less than 0.05. For two-sided tests, you need to multiply the value under Sig. (2-tailed) by two.

	What is your conclusion?
	Reject the null hypothesis that the population mean of the test variables are equal if the p-value under Sig. (2-tailed) is lower than 0.05.

	
                            (4) One-way ANOVA
                          

	
                            Formulate the hypothesis
                          

	Formulate the study’s hypothesis:
	
                            For example:
                          

                            [image: 
${{\text{H}}_0}:{\mu _1} = {\text{ }}{\mu _2} = {\text{ }}{\mu _3}$
]
                          
H1: At least two of the population means are different.

	
                            Choose the significance level
                          

	 	Usually, α is set to 0.05, but:
– if you want to be conservative, α is set to 0.01, and:
– in exploratory studies, α is set to 0.10. We choose a significance level of 0.05.

	
                            Select an appropriate test
                          

	What is the testing situation?
	Determine the number of groups you are comparing.

	Are there at least 20 observations per group?
	Check Chap.​ 5 to determine the sample size in each group.

	Is the dependent variable measured on an interval or ratio scale?
	Determine the type of test that you need to use for your analyses by checking the underlying assumptions first. Check Chap.​ 3 to determine the measurement level of the variables.

	Are the observations independent?
	Next, consult Chap.​ 3 to determine whether the observations are independent.

	Is the test variable normally distributed and are the group variances the same?
	
                            Check for normality
                          
Go to ► Analyze ► Descriptive Statistics ► Explore. Then move the test variable into the Dependent list box and under Factor List: add the variable that indicates the two groups. Click on Plots, uncheck Stem-and-leaf and check Normality plots with tests and click on Continue and then OK. Interpret the Tests of Normality table for all groups and check in the Tests of Normality table under Sig. of Shapiro-Wilk if p > 0.05, which suggests normality.

                            Check for Equality of Variances Assumption
                          
This test is included in the ANOVA analysis (in the ANOVA dialog box go to Options and tick Homogeneity of variance test and click on Continue.

	Select the type of the test
	If the assumption of normality and equality of the variance are met, proceed with the one-way ANOVA analysis. If not, conduct the Kruskal-Wallis rank test.

	
                            Calculate the test statistic
                          

	Specify the dependent variable and the factor (grouping variable)
	Normally or non-normally distributed but equal group variances (One-way ANOVA: F-test): Go to ► Analyze ► Compare Means ► One-Way ANOVA. Put the test variable into the Dependent List box and add the variable indicating the grouping into the Factor box. Click on Options and also tick Homogeneity of variance test.
Normally or non-normally distributed but equal group variances (One-way ANOVA: F-test with Welch’s correction): Go to ► Analyze ► Compare Means ► One-Way ANOVA. Put the test variable into the Dependent List box and add the variable indicating the grouping into the Factor box. Click on Options and tick Homogeneity of variance test and Welch.
Not normally distributed and unequal variances (Kruskal-Wallis rank test): Go to ► Analyze ► Nonparametric Tests ► Legacy Dialogs ► K Independent Samples. Put the test variable into the Test Variable List box. Add the factor into the Grouping Variable box after which you should click on Define Range to set the Minimum and Maximum value of the factor and click on Continue. Make sure also Kruskal-Wallis H is ticked (only). Click on OK.

	
                            Interpret the results
                          

	Look at the test results
	Compare the p-value in the ANOVA table with the significance level under Sig. The p-value should be lower than 0.05 to reject the null hypothesis.
For the One-way ANOVA: F-test with Welch’s correction, check the table Robust Tests of Equality of Means under Sig. The p-value should be lower than 0.05 to reject the null hypothesis.
For the Kruskal-Wallis rank test, check the table Test Statistics under Asymp. Sig. is lower than 0.05 to reject the null hypothesis.

	Carry out pairwise comparisons
	You can carry out post hoc tests as part of the ANOVA analysis. In the Univariate dialog box, click on Post Hoc and move the factor(s) to the Post Hoc Tests for: box. If you found evidence of equal variances, tick Tukey. If you found unequal variances, tick Games-Howell.

	Look at the strength of the effects
	In the Univariate dialog box, go to ► Options and tick Estimates of effect size. Check for the strengths of the effects under R-squared and Adjusted R-squared in the output.

	What is your conclusion?
	Based on pairwise comparisons: Check which pairs differ significantly from each other in the Paired Comparisons table. If the p-values under Sig. tied to the pairwise mean comparisons are < 0.05, reject the null hypothesis that the mean comparisons between the two groups are equal.
Based on the output from the Tests of Between Subjects Effects table, reject the null hypothesis that at least two population means are equal if the p-value is lower than 0.05 for the corrected model.





6.6 Example
Let’s now turn to the Oddjob Airways case study and apply what we discussed in this chapter. Our aim is to identify the factors that influence customers’ overall price/performance satisfaction with the airline and explore the relevant target groups for future advertising campaigns. Based on discussions with the Oddjob Airways management, answering the following three research questions will help achieve this aim:	(1)Does the overall price/performance satisfaction differ by gender?

 

	(2)Does the overall price/performance satisfaction differ according to the traveler’s status?

 





The following variables (variable names in parentheses) from the Oddjob Airways dataset (⤓ Web Appendix → Downloads) are central to this example:	overall price/performance satisfaction (overall_sat),

	respondent’s gender (gender), and

	traveler’s status (status).





6.6.1 Research Question 1
6.6.1.1 Formulate the Hypothesis
We start by formulating a non-directional hypothesis. The null hypothesis of the first research question is that the overall price/performance satisfaction means of male and female travelers are the same (H0), while the alternative hypothesis (H1) expects that the overall price/performance satisfaction means of male and female travelers differs.
6.6.1.2 Choose the Significant Level
Next, we decide to use a significance level (α) of 0.05, which means that we allow a maximum chance of 5 % of mistakenly rejecting a true null hypothesis.
6.6.1.3 Select the Appropriate Test
We move to the next step to determine the type of test, which involves assessing the testing situation, the nature of the measurements, checking the assumptions, and selecting the region of rejection. We start by defining the testing situation of our analysis, which is to compare the mean overall price/performance satisfaction scores (measured on a ratio scale) of male and female travelers. In our example, we know that the sample is a random subset of the population and we also know that they are independent. Next, we need to check if the dependent variable overall_sat is normally distributed. To do this go to ► Analyze ► Descriptive Statistics ► Explore. Then put the test variable overall_sat into the Dependent list box. Under Factor List: enter the gender variable as you want to assess normality within each of the two groups. For the ANOVA example that follows, we also need the status variable so please add this as well as it avoids having to redo the analysis later. All of this is shown in Fig. 6.7. Next, click on Plots, which will open a dialog box similar to Fig. 6.8, uncheck Stem-and-leaf, check Normality plots with tests and click on Continue and then OK.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig7_HTML.jpg]
Fig. 6.7Testing for normality


[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig8_HTML.jpg]
Fig. 6.8Normality plots with tests



Table 6.6 displays the Tests of Normality table for both gender and status. SPSS also reports both the Kolmogorov-Smirnov test (which we do not need) and the Shapiro-Wilk test with its corresponding p-values under (Sig.). The results show that the p-values of the Shapiro-Wilk test (.000) are smaller than 0.05, indicating that the normality assumption is violated for both gender groups and all tree status groups. SPSS also produces five quantile plots
                    
                   in Fig. 6.9 as discussed in Box 6.2. In every plot, the dots appear to follow the straight line reasonably well and do not clearly suggest where the normality is off.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig9_HTML.png]
Fig. 6.9Normal Q–Q plot output


Table 6.6Tests of normality


	Tests of Normality

	Gender
	Kolmogorov-Smirnova

	Shapiro-Wilk

	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	Overall, I am satisfied with the price performance ratio of Oddjob Airways.
	female
	.201
	280
	.000
	.929
	280
	.000

	male
	.167
	785
	.000
	.941
	785
	.000



a Lilliefors Significance Correction



	Tests of Normality

	 	Traveler Status
	Kolmogorov-Smirnova

	Shapiro-Wilk

	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	Overall, I am satisfied with the price performance ratio of Oddjob Airways.
	Blue
	.181
	677
	.000
	.930
	677
	.000

	Silver
	.161
	245
	.000
	.947
	245
	.000

	Gold
	.183
	143
	.000
	.941
	143
	.000



a Lilliefors Significance Correction




6.6.1.4 Calculate the Test Statistic and Make the Test Decision
As we find no support for normality, we may have to use the independent samples t-test or the Mann-Whitney U test. The decision on which to choose depends on whether the variances are equal. To do this, go to ► Analyze ► Compare Means ► Independent Samples T test, which will open a dialog box similar to Fig. 6.10.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig10_HTML.jpg]
Fig. 6.10Independent samples t-test



Put the test variable overall_sat into the Test Variable(s) box and add gender into the Grouping Variable box. Next, click on Define Groups and enter 1 next to Group 1 and 2 next to Group 2. Proceed by clicking on Continue and then OK.
Tip
To indicate different groups, you can also specify a Cut point, which is particularly useful when you want to compare two groups based on an ordinal or continuous variable. For example, if you want to compare younger vs. older members you could put all members below 30 years of age into one category and all who are 30 or above into the other category. When you indicate a cut point, observations with values less than the cut point form one group, while observations with values greater than or equal to the cut point form the other group.

SPSS will produce Tables 6.7 and 6.8. Table 6.7 shows the sample size (N) which is 280 females and 785 males. The mean (Mean) scores are also show as 4.500 and 4.2369 respectively and these mean differences, at first sight, appear different between the two groups. However, as we learned before, we have to take the variation in the data into account to test whether this difference is also present in the population. The standard deviation (Std. Deviation) gives some indication but the formal test is shown in Table 6.8. On the left of the output, we can see the test results of Levene’s test for the equality of population variances. The low F-value (F) of 0.418 suggests that we cannot reject the null hypothesis that the population variances are equal. This is also mirrored in the large p-value of 0.518, which lies far above 0.05. Because we obtained evidence that the variances are equal, we also find that the independent samples t-test is appropriate. We can thus proceed to interpret the output further.Table 6.7Group statistics


	
                              Group Statistics
                            

	 	Gender
	N
	Mean
	Std. Deviation
	Std. Error Mean

	overall_sat
	female
	280
	4.5000
	1.64611
	.09837

	male
	785
	4.2369
	1.61306
	.05757




Table 6.8Independent samples t-test


	Independent Samples Test
	 	 	 	 	 
	 	Levene's Test for Equality of Variances
	t-test for Equality of Means
	t-test for Equality of Means
	 	 
	 	F
	Sig.
	t
	df
	Sig. (2-tailed)
	Mean Difference
	Std. Error Difference
	95 % Confidence Interval of the Difference

	Lower
	Upper

	overall_sat
	Equal variances assumed
	.418
	.518
	2.330
	1063
	.020
	.26306
	.11289
	.04154
	.48457

	Equal variances not assumed
	 	 	2.308
	482.698
	.021
	.26306
	.11398
	.03909
	.48702





If both the normality and equality of the variance assumptions were not met, the Mann-Whitney U test should have been performed. This is the non-parametric counterpart of the independent samples t-test. Please see Table 6.5 for details on how to carry out this test.
6.6.1.5 Interpret the Results
Looking at the central and right part of the output in Table 6.8, we can see that SPSS carries out two tests, one based on the pooled variance estimate (upper row) and the other based on separate variance estimates using Welch's correction (lower row). Since we assume that the population variances are equal, we should interpret the upper row. When comparing the p-value under Sig. (2-tailed) with the significance level, we learn that the p-value (0.020) is smaller than the significance level (0.05). Therefore, we can reject the independent samples t-test’s null hypothesis that there is no difference in satisfaction between female and male customers and conclude that that the overall price/performance satisfaction differs significantly between female and male travelers.
6.6.2 Research Question 2
In the second research question, we examine whether customers’ membership status (i.e., status) relates to their overall price/performance satisfaction (i.e., overall_sat) with Oddjob Airways. The status variable defines three groups: Blue, Silver, and Gold. Again, we start by formulating a null hypothesis that is again non-directional in nature, expecting that the mean of the overall price/performance satisfaction is the same between the status groups, while the alternative hypothesis states that at least two status groups differ. Next, we decide to use a significance level (α) of 0.05. We have already established that a comparison of three or more groups involves a one-way ANOVA and we therefore follow the steps as indicated in Fig. 6.4.
6.6.2.1 Check the Assumptions
In checking the assumptions, we already know that the sample is a random subset of the population and we also know that other respondents’ responses do not influence those of the respondents (i.e., they are independent). Next, we check the normality but as we had already tested for normality of overall_sat for the three loyalty groups (Blue, Silver, and Gold, see Table 6.6) we know that this variable is not normally distributed. If we thus follow Table 6.2., we should either conduct a one-way ANOVA F-test when the variances are equal or a Kruskal-Wallis rank test when the variances are not equal.
To test for the equality of variances, we need to carry out an ANOVA analysis first. To do this, go to ► Analyze ► Compare Means ► One-Way ANOVA, which opens a dialog box similar to Fig. 6.11. Move the test variable overall_sat into the Dependent List box and add the variable status that indicates the three groups (Blue, Silver, and Gold) into the Factor box.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig11_HTML.jpg]
Fig. 6.11One-way ANOVA dialog box



Next, under Post Hoc (Fig. 6.12) we should specify a series of post hoc tests for multiple group comparisons that are all shown in Fig. 6.12. Since we do not yet know the result of Levene’s test, we choose Ryan/Einot-Gabriel/Welsch Q (R-E-G-W Q) and Games-Howell. Since group sizes are fairly unequal, we also select Hochberg’s GT2. Next, click on Continue to get back to the main menu.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig12_HTML.jpg]
Fig. 6.12Post hoc multiple comparisons dialog box



Go back to the main menu and click on Options. In the dialog box that opens, (Fig. 6.13), tick Descriptive and Homogeneity of variance test. Note that if you were to have support for normality (which we don’t), it is useful to tick Welch as well. Go back to the main menu by clicking on Continue and then OK.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Fig13_HTML.jpg]
Fig. 6.13One-way ANOVA options



The descriptive statistics in Table 6.9 show that the groups clearly differ in size. For example, the Blue group comprises 677 customers, whereas the Gold group comprises 143 customers. The results also indicate that the means of overall_sat differ between the three groups. For example, in the Blue group, the mean is 4.47 compared to 3.99 in the Gold group. Before evaluating the ANOVA’s results to assess whether these differences are significant however, we have to take a closer look at the results of Levene’s test as shown in Table 6.10. The Levene’s test statistic clearly suggests that the population variances are equal, as the test’s p-value (0.404) is well above 0.05. Thus, following from Table 6.2, we should use the F-test to decide whether at least one group mean differs from the others.Table 6.9Descriptive statistics


	
                              Descriptives
                            

	Overall, I am satisfied with the price performance ratio of Oddjob Airways.

	 	N
	Mean
	Std. Deviation
	Std. Error
	95 % Confidence Interval for Mean
	Minimum
	Maximum

	Lower Bound
	Upper Bound

	Blue
	677
	4.47
	1.641
	.063
	4.35
	4.60
	1
	7

	Silver
	245
	4.03
	1.560
	.100
	3.84
	4.23
	1
	7

	Gold
	143
	3.99
	1.556
	.130
	3.73
	4.24
	1
	7

	Total
	1065
	4.31
	1.625
	.050
	4.21
	4.40
	1
	7




Table 6.10Test of homogeneity of variances


	
                              Test of Homogeneity of Variances
                            

	 	 	Levene Statistic
	df1
	df2
	Sig.

	Overall, I am satisfied with the price performance ratio of Oddjob Airways.
	Based on Mean
	.907
	2
	1062
	.404

	Based on Median
	.068
	2
	1062
	.934

	Based on Median and with adjusted df
	.068
	2
	1017.925
	.934

	Based on trimmed mean
	.771
	2
	1062
	.463





6.6.2.2 Calculate the Test Statistic
SPSS will calculate the test statistic and provide a table as shown in Table 6.11. The top part of the table reports several measures of model significance and fit which we will interpret next to make the test decision.Table 6.11ANOVA table


	
                              ANOVA
                            

	Overall, I am satisfied with the price performance ratio of Oddjob Airways.

	 	Sum of Squares
	df
	Mean Square
	F
	Sig.

	Between Groups
	51.755
	2
	25.878
	9.963
	.000

	Within Groups
	2758.455
	1062
	2.597
	 	 
	Total
	2810.210
	1064
	 	 	 




6.6.2.3 Make the Test Decision
Let’s now focus on the F-test result with respect to the overall model in Table 6.11. The model has an F-value of 9.963, which yields a p-value of 0.00 (less than 0.05), suggesting that at least two of the three groups differ significantly with regard to the overall price/performance satisfaction. SPSS also indicates the between-group sum of squares (i.e., SSB), which is labelled Between Groups in Table 6.11 and the within-group sum of squares (i.e., SSW), which is labelled Within Groups. The total sum of squares (i.e., SST) is the sum of this. We will need these figures to calculate the effect size later.
6.6.2.4 Carry Out Post Hoc Tests
To evaluate whether all groups are mutually different or only two, we take a look at the post hoc test results. The Levene’s test showed that the population variances are equal. The descriptive statistics in Table 6.9 indicate that the group-specific sample sizes are clearly different. Hence, following the procedure in Fig. 6.6, we should focus on the interpretation of Hochberg’s GT2.
The results in Table 6.12 list a series of comparisons based on Hochberg’s GT2 (upper part) and the Games-Howell procedure (lower part). In the first row, you can see the comparison between the Blue group and Silver group. The difference between the means of these two groups is 0.440 units. Following this row across, we see that this difference is statistically significant (p-value = 0.001). On the contrary, further below, we can see that the difference between the Silver and Gold groups (0.047) is not significant (p-value = 0.990).Table 6.12Post hoc test results (Hochberg’s GT2 and Games Howell)


	Multiple Comparisons

	Dependent Variable: Overall, I am satisfied with the price performance ratio of Oddjob Airways.

	 	(I) Traveler Status
	(J) Traveler Status
	Mean Difference (I-J)
	Std. Error
	Sig.
	95 % Confidence Interval

	Lower Bound
	Upper Bound

	Hochberg
	Blue
	Silver
	.440*

	.120
	.001
	.15
	.73

	Gold
	.487*

	.148
	.003
	.13
	.84

	Silver
	Blue
	−.440*

	.120
	.001
	−.73
	−.15

	Gold
	.047
	.170
	.990
	−.36
	.45

	Gold
	Blue
	−.487*

	.148
	.003
	–.84
	−.13

	Silver
	−.047
	.170
	.990
	−.45
	.36

	Games-Howell
	Blue
	Silver
	.440*

	.118
	.001
	.16
	.72

	Gold
	.487*

	.145
	.003
	.15
	.83

	Silver
	Blue
	−.440*

	.118
	.001
	−.72
	−.16

	Gold
	.047
	.164
	.956
	–.34
	.43

	Gold
	Blue
	−.487*

	.145
	.003
	−.83
	−.15

	Silver
	−.047
	.164
	.956
	−.43
	.34


* The mean difference is significant at the 0.05 level.




Even though the population variances are assumed to be equal and group-specific sample sizes differ, let us take a look at the results of the Ryan/Einot-Gabriel/Welsch Q procedure for the sake of completeness. Table 6.13 organizes the means of the three groups into homogeneous subsets. Subsets that do not differ at a significance level of 0.05 are grouped together, and subsets that differ are placed in separate columns. Notice how the Blue group shows up in a separate column than the Gold and Silver groups. This indicates that the Blue group is significantly different from the other two in terms of the overall price/performance satisfaction. The Gold and Silver groups show up in the same column, indicating that they are not significantly different from each other. The lower part of Table 6.13 uses the same display to illustrate the results of Hochberg’S GT2.Table 6.13Post hoc test results (Ryan/Einot-Gabriel/Welsch Q procedure)


	Overall, I am satisfied with the price performance ratio of Oddjob Airways.

	 	Traveler Status
	N
	Subset for alpha = 0.05

	 	1
	2

	Ryan-Einot-Gabriel-Welsch Range
	Gold
	143
	3.99
	 
	Silver
	245
	4.03
	 
	Blue
	677
	 	4.47

	Sig.
	 	.807
	1.000

	Hochberga, b

	Gold
	143
	3.99
	 
	Silver
	245
	4.03
	 
	Blue
	677
	 	4.47

	Sig.
	 	.985
	1.000


Means for groups in homogeneous subsets are displayed.

a Uses Harmonic Mean Sample Size = 239.011.

b The group sizes are unequal. The harmonic mean of the group sizes is used. Type I error levels are not guaranteed.




6.6.2.5 Measure the Strength of the Effects
Finally, we want to examine the strength of the effect by computing η² and ω². However, the One-Way ANOVA analysis in SPSS does not provide these measures.13 Nevertheless we can easily compute η² and ω² manually using the information from Table 6.10. For this we need to look up SSB, SST, SSW, n and k from the output. Note also that MSW = SSW/(n-k) and that k represents the number of groups to compare while n represents the sample size.[image: 
$${\eta ^2} = \frac{{S{S_B}}}{{S{S_T}}} = \frac{{51.755}}{{2810.210}} = 0.0184$$
]




[image: 
$${\omega ^2} = \frac{{S{S_B} - \left( {k - 1} \right) \cdot M{S_W}}}{{S{S_T} + M{S_W}}} = \frac{{51.755 - \left( {3 - 1} \right) \cdot 2.560}}{{2810.210 + 2.560}} = 0.0166$$
]





The effect size η2 is 0.0184. This means that differences in the travelers’ status explain 1.841 % of the total variation in the overall price/performance satisfaction. The ω² displayed is 0.0166, which is low.
6.6.2.6 Interpret the Results
Overall, based on the outputs of the ANOVA in Table 6.11 and the post-hoc output in Tables 6.12, we conclude that:	1.Gold and Blue members, as well as Silver and Blue members, differ significantly in their mean overall price/performance satisfaction.

 

	2.There is no difference between Gold and Silver members in their mean overall price/performance satisfaction.

 

	3.Membership status explains only a minimal share of the customers’ price/performance satisfaction. Hence, other factors—presently not included in the model—explain the remaining variation in the outcome variable.

 





6.7 Customer Spending Analysis with IWD Market Research (Case Study)
Case Study

                [image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figg_HTML.png]

              
Founded in 1998, IWD Market Research Institute (https://​www.​iwd-marketresearch.​com/​index.​php) is a major German full-service provider, specialized in smartphone-supported face-to-face surveys, particularly in the retail sector. One of the company’s main fields of expertise are catchment area studies. These studies involve analyzing from which streets or districts potential customers originate, along with their demographics and spending behavior.

                [image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figh_HTML.jpg]

              
In 2017, one of UK’s major supermarket chains commissioned a study to better understand their customer base. In the course of this project, IWD surveyed the following items among 7199 customers who frequented the store during the project period (variable names in parentheses):	Could you please tell me your current postal code? (postal_code)

	How often do you shop in this store? (frequency)

	How much have you spent today? (spending)

	Do you regularly receive our leaflet at home? (leaflet)

	How did you get here today? (journey)

	May I ask you for your age? (age)

	How many people live in your household (including yourself)? (household)

	The customer’s gender (gender)





Use the data provided in IWD.sav (⤓ Web Appendix → Downloads) to answer the following research questions:	1.Is there a significant difference in spending between male and female customers?

 

	2.Does the intensity with which customers receive a leaflet variable have a significant effect on their spending? Use an appropriate test to check for significant differences in spending between each of the three categories of the leaflet variable (“Yes, regularly (weekly);” “Yes, irregularly;” “No”).

 

	3.Does the customers’ spending depend on how they got to the supermarket (journey)? Are there significant differences between the journey types?

 

	4.Extend the previous analysis by researching the impact of leaflet and journey on spending. Is there a significant interaction between the leaflet and journey variables?

 

	5.Based on your analysis results, please provide recommendations for the management team on how to align their future marketing actions.

 





6.8 Review Questions

              	1.Describe the steps involved in hypothesis testing in your own words.

 

	2.If you take a look at the following video, you will see many situations that could be tested. Please identify these and discuss what tests are needed.[image: ../images/210704_3_En_6_Chapter/210704_3_En_6_Figi_HTML.png]
© igmarx/Getty Images/iStock

                              https://​www.​youtube.​com/​watch?​v=​CJOfmHmwGO0
                            




 

	3.Explain the concept of the p-value and explain how it relates to the significance level α.

 

	4.What level of α would you choose for the following types of market research studies? Give reasons for your answers.	(a)An initial study on preferences for mobile phone colors.

 

	(b)The production quality of Rolex watches.

 

	(c)A repeat study on differences in preference for either Coca Cola or Pepsi.

 






 

	5.Write two hypotheses for each of the example studies in question 4, including the null hypothesis and alternative hypothesis.

 

	6.Describe the difference between independent and paired samples t-tests in your own words and provide two examples of each type.

 

	7.What is the difference between an independent samples t-test and an ANOVA?

 

	8.What are post hoc test and why is their application useful in ANOVA?

 




            
References
	Agresti, A., & Finlay, B. (2014). Statistical methods for the social sciences (4th ed.). London: Pearson.

	Benjamin, D. J., et al. (2018). Redefine statistical significance. Nature Human Behaviour, 2, 6–10.

	Boneau, C. A. (1960). The effects of violations of assumptions underlying the t test. Psychological Bulletin, 57(1), 49–64.Crossref

	Cohen, J. (1992). A power primer. Psychological Bulletin, 112(1), 155–159.Crossref

	Everitt, B. S., & Skrondal, A. (2010). The Cambridge dictionary of statistics (4th ed.). Cambridge: Cambridge University Press.Crossref

	Field, A. (2013). Discovering statistics using SPSS (4th ed.). London: Sage.

	Hubbard, R., & Bayarri, M. J. (2003). Confusion over measure of evidence (p’s) versus errors (α’s) in classical statistical testing. The American Statistician, 57(3), 171–178.Crossref

	Kimmel, H. D. (1957). Three criteria for the use of one-tailed tests. Psychological Bulletin, 54(4), 351–353.Crossref

	Lehmann, E. L. (1993). The Fischer, Neyman-Pearson theories of testing hypotheses: One theory or two? Journal of the American Statistical Association, 88(424), 1242–1249.Crossref

	Lakens, D., et al. (2018). Justify your alpha. Nature Human Behaviour, 2, 168–171.

	Levene, H. (1960). Robust tests for equality of variances. In I. Olkin (Ed.) Contributions to probability and statistics (pp. 278–292). Palo Alto, CA: Stanford University Press.

	Liao, T. F. (2002). Statistical group comparison. New York, NJ: Wiley-InterScience.Crossref

	Mann, H. B., & Whitney, D. R. (1947). On a test of whether one of two random variables is stochastically larger than the other. The Annals of Mathematical Statistics, 18(1), 50–60.Crossref

	Norman, G. (2010). Likert scales, levels of measurement and the “laws” of statistics. Advances in Health Sciences Education, 15(5), 625–632.Crossref

	Nuzzo, R. (2014). Scientific method: Statistical errors. Nature, 506(7487), 150–152.Crossref

	Ruxton, G. D., & Neuhaeuser, M. (2010). When should we use one-tailed hypothesis testing? Methods in Ecology and Evolution, 1(2), 114–117.Crossref

	Schuyler, W. H. (2011). Readings statistics and research (6th ed). London: Pearson.

	Shapiro, S. S., & Wilk, M. B. (1965). An analysis of variance test for normality (complete samples). Biometrika, 52(3/4), 591–611.Crossref

	Van Belle, G. (2008). Statistical rules of thumb (2nd ed.). Hoboken, N.J.: John Wiley & Sons.Crossref

	Wasserstein, R. L., & Lazar, N. A. (2016). The ASA’s statement on p-values: Context, process, and purpose. The American Statistician, 70(2), 129–133.Crossref

	Welch, B. L. (1951). On the comparison of several mean values: An alternative approach. Biometrika, 38(3/4), 330–336.Crossref


Further Readings
	Kanji, G. K. (2006). 100 statistical tests (3rd ed.). London: Sage.Crossref

	Van Belle, G. (2011). Statistical rules of thumb (2nd ed.). Hoboken, N.J.: John Wiley & Sons.



Footnotes
1In experimental studies, if respondents were paired with others (as in a matched case control sample), each person would be sampled once, but it still would be a paired sample.

 

2The exact calculation of this test is shown on https://​www.​ibm.​com/​support/​knowledgecenter/​en/​SSLVMB_​20.​0.​0/​com.​ibm.​spss.​statistics.​help/​alg_​npar_​tests_​mannwhitney.​htm


 

3The fundamental difference between the z- and t-distributions is that the t-distribution is dependent on sample size n (which the z-distribution is not). The distributions become more similar with larger values of n.

 

4To obtain the critical value, you can also use the TINV function provided in Microsoft Excel, whose general form is “TINV(α, df).” Here, α represents the desired Type I error rate and df the degrees of freedom. To carry out this computation, open a new Excel spreadsheet and type in “ = TINV(2*0.025,9).” Note that we have to specify “2*0.025” (or, directly 0.05) under α, because we are applying a two-tailed instead of a one-tailed test.

 

5Unfortunately, there is some confusion about the difference between the α and p-value. See Hubbard and Bayarri (2003) for a discussion.

 

6Note that this is convention and most textbooks discuss hypothesis testing in this way. Originally, two testing procedures were developed, one by Neyman and Pearson and another by Fisher (for more details, see Lehmann 1993). Agresti and Finlay (2014) explain the differences between the convention and the two original procedures.

 

7Note that this rule doesn't always apply such as for exact tests of probabilities.

 

8We don’t have to conduct manual calculations and tables when working with SPSS. However, we can calculate the p-value using the TDIST function in Microsoft Excel. The function has the general form “TDIST(t, df, tails)”, where t describes the test value, df the degrees of freedom, and tails specifies whether it’s a one-tailed test (tails = 1) or two-tailed test (tails = 2). Just open a new spreadsheet for our example and type in “ = TDIST(2.274,9,1)”. Likewise, there are several webpages with Java-based modules (e.g., https://​graphpad.​com/​quickcalcs/​pvalue1.​cfm) that calculate p-values and test statistic values.

 

9The number of pairwise comparisons is calculated as follows: k·(k − 1)/2, with k the number of groups to compare.

 

10In fact, these two assumptions are interrelated, since unequal group sample sizes result in a greater probability that we will violate the homogeneity assumption.

 

11SS is an abbreviation of “sum of squares,” because the variation is calculated using the squared differences between different types of values.

 

12Note that the group-specific sample size in this example is too small to draw conclusions and is only used to show the calculation of the statistics.

 

13Note that when initiating the analysis by going to ► Analyze ► General Linear Model ► Univariate, we can request these statistics under Options (Estimates of effect size).
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After reading this chapter you should understand:	The basic concept of regression analysis.

	How regression analysis works.

	The requirements and assumptions of regression analysis.

	How to specify a regression analysis model.

	How to interpret regression analysis results.

	How to predict and validate regression analysis results.

	How to conduct regression analysis with SPSS.

	How to interpret regression analysis output produced by SPSS.
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7.1 Introduction
Regression analysis is one of the most frequently used analysis techniques in market research. It allows market researchers to analyze the relationships between dependent variables
                
               and independent variables
                
              . In marketing applications, the dependent variable is the outcome we care about (e.g., sales), while we use the independent variables to achieve those outcomes (e.g., pricing or advertising). The key benefits of using regression analysis are it allows us to:	1.Calculate if one independent variable or a set of independent variables has a significant relationship with a dependent variable.

 

	2.Estimate the relative strength of different independent variables’ effects on a dependent variable.

 

	3.Make predictions.

 





Knowing what the effects of independent variables on dependent variables are, helps market researchers in many different ways. For example, this knowledge can help guide spending if we know promotional activities relate strongly to sales.
Knowing effects’ relative strength is useful for marketers, because it may help answer questions such as: Do sales depend more on the product price or on product promotions? Regression analysis also allows us to compare the effects of variables measured on different scales, such as the effect of price changes (e.g., measured in dollars) and the effect of a specific number of promotional activities.
Regression analysis can also help us make predictions. For example, if we have estimated a regression model by using data on the weekly supermarket sales of a brand of milk in dollars, the milk price (which changes with the season and supply), as well as an index of promotional activities (comprising product placement, advertising, and coupons), the results of the regression analysis could answer the question: what would happen to the sales if the prices were to increase by 5 % and the promotional activities by 10 %? Such answers help (marketing) managers make sound decisions. Furthermore, by calculating various scenarios, such as price increases of 5, 10, and 15 %, managers can evaluate marketing plans and create marketing strategies.
7.2 Understanding Regression Analysis
In the previous paragraph, we briefly discussed what regression can do and why it is a useful market research tool. We now provide a more detailed discussion. Look at Fig. 7.1: It plots a dependent (y) variable (the weekly sales of a brand of milk in dollars against an independent (x1) variable (an index of promotional activities). Regression analysis is a way of fitting a “best” line through a series of observations. With a “best” line we mean one that is fitted in such a way that it minimizes the sum of the squared differences between the observations and the line itself. It is important to know that the best line fitted by means of regression analysis is not necessarily the true line (i.e., the line that represents the population). Specifically, if we have data issues, or fail to meet the regression assumptions (discussed later), the estimated line may be biased.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig1_HTML.png]
Fig. 7.1A visual explanation of regression analysis



Before we discuss regression analysis further, we should discuss regression notation. Regression models are generally written as follows:[image: 
$$y = \alpha + {\beta _1}{x_1} + e$$
]





What does this mean? The y represents the dependent variable, which is the outcome you are trying to explain. In Fig. 7.1, we plot the dependent variable on the vertical axis. The α represents the constant
                
               (or intercept
                
              ) of the regression model, and indicates what your dependent variable would be if the independent variable were zero. In Fig. 7.1, you can see the constant is the value where the fitted straight (sloping) line crosses the y-axis, which is at 2463.963. Thus, if the index of promotional activities is zero, we expect the weekly supermarket sales of a specific milk brand to be $2464. It may not always be realistic to assume that independent variables are zero (prices are, after all, rarely zero), but the constant should always be included to ensure the regression model’s best possible fit with the data.
The independent variable is indicated by x1, while the ß1 (pronounced beta) indicates its (regression) coefficient. This coefficient represents the slope of the line, or the slope of the diagonal grey line in Fig. 7.1. A positive ß1 coefficient indicates an upward sloping regression line, while a negative ß1 coefficient indicates a downward sloping line. In our example, the line slopes upward. This makes sense, since sales tend to increase with an increase in promotional activities. In our example, we estimate the ß1 as 54.591, meaning that if we increase the promotional activities by one unit, the weekly supermarket sales of a brand of milk will go up by an average of $54.591. This ß1 value has a degree of associated uncertainty called the standard error
                
              . This standard error is assumed to be normally distributed. Using a t-test (see Chap.​ 6), we can test if the ß1 is indeed significantly different from zero.
The last element of the notation, the e, denotes the equation error
                
               (also called the residual
                
               or disturbance term
                
              ). The error is the distance between each observation and the best fitting line. To clarify what a regression error is, examine Fig. 7.1 again. The error is the difference between the regression line (which represents our regression prediction) and the actual observation (indicated by each dot). The predictions made by the “best” regression line are indicated by [image: 
$\hat y$
] (pronounced y-hat). Thus, the error of each observation is:1
[image: 
$$e = y - \hat y$$
]





In the example above, we have only one independent variable. We call this simple regression
                
              . If we include multiple independent variables, we call this multiple regression
                
              . The notation for multiple regression is like that of simple regression. If we were to have two independent variables, for example the price (x1), and an index of promotional activities (x2), our notation would be:[image: 
$$y = \alpha + {\beta _1}{x_1} + {\beta _2}{x_2} + e$$
]





We need one regression coefficient for each independent variable (i.e., ß1 and ß2). Technically the ßs indicate how a change in an independent variable influences the dependent variable if all other independent variables are held constant.2

Now that we have introduced a few regression analysis basics, it is time to discuss how to execute a regression analysis. We outline the key steps in Fig. 7.2. We first introduce the regression analysis data requirements, which will determine if regression analysis can be used. After this first step, we specify and estimate the regression model. Next, we discuss the basics, such as which independent variables to select. Thereafter, we discuss the assumptions of regression analysis, followed by how to interpret and validate the regression results. The last step is to use the regression model to, for example, make predictions.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig2_HTML.png]
Fig. 7.2Steps involved in a regression analysis



The Explained Visually webpage offers an excellent visualization of how regression analysis works.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Figa_HTML.png]
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                      http://​setosa.​io/​ev/​ordinary-least-squares-regression/​
                    



7.3 Conducting a Regression Analysis
7.3.1 Check the Regression Analysis Data Requirements
Various data requirements must be taken into consideration before we undertake a regression analysis. These include the:	Sample size,

	variables need to vary,

	scale type of the dependent variable, and

	collinearity.





We discuss each requirement in turn.
7.3.1.1 Sample Size
The first data requirement is that we need an “acceptable” sample size. “Acceptable” relates to a sample size that gives you a good chance of finding significant results if they are possible (i.e., the analysis achieves a high degree of statistical power; see Chap.​ 6). There are two ways to calculate “acceptable” sample sizes.	The first, formal, approach is a power analysis. As mentioned in Chap.​ 6 (Box 6.​2), these calculations require you to specify several parameters, such as the expected effect size and the maximum type I error you want to allow for. Generally, you should set the power to 0.80, which is an acceptable level. A power level of 0.80 means there is an 80 % probability of deciding that an effect will be significant, if it is indeed significant. Kelley and Maxwell (2003) discuss sample size requirements in far more detail. G*power—a free program available at http://​www.​gpower.​hhu.​de —is commonly used to calculate sample sizes precisely. SPSS also provides an add-on module called “Sample Power,” which can be used to carry out such analyses.

	The second approach is by using rules of thumb. These rules are not specific or precise, but are easy to apply. Green (1991); VanVoorhis and Morgan (2007) suggest that if you want to test for individual parameters’ effect (i.e., whether one coefficient is significant or not), you need a sample size of 104 + k. Thus, if you have ten independent variables, you need 104 + 10 = 114 observations. Note that this rule of thumb is best applied when you have a small number of independent variables, less than 10 and certainly less than 15. VanVoorhis and Morgan (2007) add that having at least 30 observations per variable (i.e. 30 k) allows for detecting smaller effects (an expected R2 of 0.10 or smaller) better.





7.3.1.2 Variables Need to Vary
A regression model cannot be estimated if the variables have no variation. If there is no variation in the dependent variable (i.e., it is constant), we also do not need regression, as we already know what the dependent variable’s value is! Likewise, if an independent variable has no variation, it cannot explain any variation in the dependent variable.
No variation can lead to epic failures! Consider the admission tests set by the University of Liberia: Not a single student passed the entry exams. In such situations, a regression analysis will clearly make no difference! https://​www.​independent.​co.​uk/​student/​news/​epic-fail-all-25000-students-fail-university-entrance-exam-in-liberia-8785707.​html

7.3.1.3 Scale Type of the Dependent Variable
The third data requirement is that the dependent variable needs to be interval or ratio scaled (Chap.​ 3 discusses scaling). If the data are not interval or ratio scaled, alternative types of regression should be used. You should use binary logistic regression
                    
                   if the dependent variable is binary and only takes two values (zero and one). If the dependent variable is a nominal variable with more than two levels, you should use multinomial logistic regression
                    
                  . This should, for example, be used if you want to explain why people prefer product A over B or C. We do not discuss these different methods in this chapter, but they are related to regression. For a discussion of regression methods for dependent variables measured on a nominal or ordinal scale, see Field (2013).
7.3.1.4 Collinearity
The last data requirement is that no or little collinearity should be present.3 Collinearity
                    
                   is a data issue that arises if two independent variables are highly correlated. Perfect collinearity occurs if we enter two or more independent variables containing exactly the same information, therefore yielding a correlation of 1 or −1 (i.e., they are perfectly correlated). Perfect collinearity may occur if you enter the same independent variable twice, or if one variable is a linear combination of another (e.g., one variable is a multiple of another variable, such as sales in units and sales in thousands of units). If this occurs, regression analysis cannot estimate one of the two coefficients. In practice, however, weaker forms of collinearity are common. For example, if we study what drives supermarket sales, variables such as price reductions and promotions are often used together. If this occurs very often, the variables price and promotion may be collinear, which means there is little uniqueness or new information in each of the variables. The problem with having collinearity is that it tends to regard significant parameters as insignificant. Substantial collinearity can even lead to sign changes in the regression coefficients’ estimates. When three or more variables are strongly related to each other, we call this multicollinearity
                    
                  .
Fortunately, collinearity is relatively easy to detect by calculating the variance inflation factor
                    
                   (VIF
                    
                    
                  ).4 The VIF indicates the effect on the standard error of the regression coefficient for each independent variable. Specifically, the square root of the VIF indicates you how much larger the standard error is, compared to if that variable were uncorrelated with all other independent variables in the regression model. Generally, a VIF of 10 or above indicates that (multi) collinearity is a problem (Hair et al. 2019).5 Some research suggests that VIFs far above 10—such as 20 or 40—can be acceptable if the sample size is large and the R2 (discussed later) is high (0.90 or more) (O’brien 2007). Conversely, if the sample sizes are below 200 and the R2 is low (0.25 or less), collinearity is more problematic (Mason and Perreault 1991). Consequently, in such situations, lower VIF values—such as 5—should be the maximum.
You can remedy collinearity in several ways but each of these have costs. If perfect collinearity occurs, drop one of the perfectly overlapping variables. If weaker forms of collinearity occur, you can utilize three approaches to reduce collinearity (O’brien 2007):	The first option is to use principal component or factor analysis on the collinear variables (see Chap.​ 8). By using principal component or factor analysis, you create a small number of factors that comprise most of the original variables’ information, but are uncorrelated. If you use factors, collinearity no longer an issue.

	The second option is to re-specify the regression model by removing highly correlated variables. Which variables should you remove? If you create a correlation matrix of all the independent variables entered in the regression model, you should first focus on the variables that are most strongly correlated (see Chap.​ 5 for how to create a correlation matrix). First try removing one of the two most strongly correlated variables. The one you should remove depends on your research problem—retain the most relevant variable of the two.

	The third option is not to do anything. In many cases removing collinear variables does not reduce the VIF values significantly. Even if we do, we run the risk of mis-specifying the regression model (see Box 7.1 for details). Given the trouble researchers go through to collect data and specify a regression model, it is often better to accept collinearity in all but the most extreme cases. In this case, however, we should be cautious with the interpretation of the regression coefficients because their values and significance levels may be biased.





7.3.2 Specify and Estimate the Regression Model
We need to select the variables we want to include and decide how to estimate the model to conduct a regression analysis. In the following, we will discuss each step in detail.
7.3.2.1 Model Specification
The model specification step involves choosing the variables to use. The regression model should be simple yet complete. To quote Albert Einstein: “Everything should be made as simple as possible, but not simpler!” How do we achieve this? By focusing on our ideas of what relates to the dependent variable of interest, the availability of data, client requirements, and prior regression models. For example, typical independent variables that explain the sales of a product include the price and promotions. When available, in-store advertising, competitors’ prices, and promotions are usually also included. Market researchers may, of course, choose different independent variables for other applications. Omitting important variables (see Box 7.1) has substantial implications for the regression model, so it is best to be inclusive. A few practical suggestions:	If you have many variables available in the data that overlap in terms of how they are defined— such as satisfaction with the waiter/waitress and with the speed of service—try to pick the variable that is most distinct or relevant for the client. Alternatively, you could conduct a principal component or factor analysis (see Chap.​ 8) first and use the factors as the regression analysis’s independent variables.

	If you expect to need a regression model for different circumstances, you should make sure that the independent variables are the same, which will allow you to compare the models. For example, temperature can drive the sales of some supermarket products (e.g., ice cream). In some countries, such as Singapore, the temperature is relatively constant, so including this variable is not important. In other countries, such as Germany, the temperature can fluctuate far more. If you are intent on comparing the ice cream sales in different countries, it is best to include variables that may be relevant to all the countries you want to compare (e.g., by including temperature, even if it is not very important in Singapore).

	Consider the type of advice you want to provide. If you want to make concrete recommendations regarding how to use point-of-sales promotions and free product giveaways to boost supermarket sales, both variables need to be included.

	Take the sample size rules of thumb into account. If practical issues limit the sample size to below the threshold that the rules of thumb recommend, use as few independent variables as possible. Larger sample sizes allow you more freedom to add independent variables, although they still need to be relevant.

	If you have ordinal variables, you need to construct dummy variables
                          
                        . Dummy variables indicate categories or subgroups using a 0 (absent) or 1 (present) value. Dummies can be used to understand if for example ice cream sales differ between three countries, France, Germany, and Singapore. We need only two variables to indicate the groups since if sales observations do not come from Germany (=0) or Singapore (=0), they need to be from France. Thus, we have used France as the base category. Sometimes the choice of base category is not so important but if we have a base category where a characteristic is absent (e.g., no advertising compared to three dummies that indicate three different forms of advertising) it is useful to set this as the base category (by omitting a dummy for this category). Note that we always construct one dummy fewer than the number of groups and that it is only a decision for which category to omit the dummy! We can enter dummy variables to a regression model to estimate if there are differences between categories or subgroups (such as countries or types of advertising).





Box 7.1 Omitting relevant variables
Omitting key variables from a regression model can lead to biased results. Imagine that we want to explain weekly sales by only referring to promotions. From the introduction, we know the ß of the regression model only containing promotions is estimated as 54.591. If we add the variable price (arguably a key variable), the estimated ß of promotions drops to 42.266. As can be seen, the difference between the estimated ßs in the two models (i.e., with and without price) is 12.325, suggesting that the “true” relationship between promotions and sales is weaker than in a model with only one independent variable. This example shows that omitting important independent variables leads to biases in the value of the estimated ßs. That is, if we omit a relevant variable x2 from a regression model that only includes x1, we cause a bias in the ß1 estimate. More precisely, the ß1 is likely to be inflated, which means that the estimated value is higher than it should be.
Thus, the ß1 itself is biased because we omit x2!
7.3.2.2 Model Estimation
Model estimation refers to how we estimate a regression model. The most common method of estimating regression models is ordinary least squares
                    
                   (OLS
                    
                    
                  ). OLS fits a regression line to the data that minimizes the sum of the squared distances to it. These distances are squared to stop negative distances (i.e., below the regression line) from cancelling out positive distances (i.e., above the regression line), because squared values are always positive. Moreover, by using the square, we emphasize observations that are far from the regression much more, while observations close to the regression line carry very little weight. The rule to use squared distances is an effective (but also arbitrary) way of calculating the best fit between a set of observations and a regression line (Hill et al. 2011). If we return to Fig. 7.1, we see the vertical “spikes” from each observation to the regression line. OLS estimation is aimed at minimizing the squares of these spikes.
We use the data behind Fig. 7.1—as shown in Table 7.1—to illustrate the method with which OLS regressions are calculated. This data has 30 observations, with information on the supermarket’s sales of a brand of milk (sales), the price (price), and an index of promotional activities (promotion) for weeks 1–30. This dataset is small and only used to illustrate how OLS estimates are calculated. The data can be downloaded (⤓ Web Appendix → Downloads), but are also included in Table 7.1.Table 7.1Regression data


	Week
	Sales
	Price
	Promotion

	1
	3454
	1.10
	12.04

	2
	3966
	1.08
	22.04

	3
	2952
	1.08
	22.04

	4
	3576
	1.08
	22.04

	5
	3692
	1.08
	21.42

	6
	3226
	1.08
	22.04

	7
	3776
	1.09
	47.04

	8
	14,134
	1.05
	117.04

	9
	5114
	1.10
	92.04

	10
	4022
	1.08
	62.04

	11
	4492
	1.12
	87.04

	12
	10,186
	1.02
	92.04

	13
	7010
	1.08
	61.42

	14
	4162
	1.06
	72.04

	15
	3446
	1.13
	47.04

	16
	3690
	1.05
	37.04

	17
	3742
	1.10
	12.04

	18
	7512
	1.08
	62.04

	19
	9476
	1.08
	62.04

	20
	3178
	1.08
	22.04

	21
	2920
	1.12
	2.04

	22
	8212
	1.04
	42.04

	23
	3272
	1.09
	17.04

	24
	2808
	1.11
	7.04

	25
	2648
	1.12
	2.04

	26
	3786
	1.11
	7.04

	27
	2908
	1.12
	2.04

	28
	3395
	1.08
	62.04

	29
	4106
	1.04
	82.04

	30
	8754
	1.02
	132.04





To estimate the effect of price and promotion on sales, we need to calculate the ßs, of which the estimate is noted as [image: 
$\hat \beta $
] (pronounced as beta-hat). The [image: 
$\hat \beta $
] indicates the estimated association between each independent variable (price and promotion) and the dependent variable sales. We can estimate [image: 
$\hat \beta $
] as follows:[image: 
$$\hat \beta = {({x^T}x)^{ - 1\,}}\,{x^T}y$$
]





In this equation, to solve the [image: 
$\hat \beta $
] s, we first multiply the transposed matrix indicated as xT. This matrix has three elements, a vector of 1s, which are added to estimate the intercept and two vectors of the independent variables price and promotion. Together, these form a 30 × 3 matrix. Next, we multiply this matrix with the untransposed matrix, indicated as x, consisting of the same elements (as a 3 × 30 matrix). This multiplication results in a 3 × 3 matrix of which we calculate the inverse, indicated by the power of −1 in the equation. This also results in a 3 × 3 matrix (xTx)−1. Next, we calculate xTy, which consists of the 30 × 3 matrix and the vector with the dependent variables’ observations (a 1 × 30 matrix). In applied form:[image: 
$$x = \left[ {\begin{array}{*{20}{c}} 1&amp;{1.10}&amp;{12.04} \\ 1&amp;{1.08}&amp;{22.04} \\ \vdots &amp; \vdots &amp; \vdots \\ 1&amp;{1.02}&amp;{132.04} \end{array}} \right],$$
]




[image: 
$${x^T} = \left[ {\begin{array}{*{20}{c}} 1&amp;1&amp; \ldots &amp;1 \\ {1.10}&amp;{1.08}&amp; \ldots &amp;{1.02} \\ {12.04}&amp;{22.04}&amp; \ldots &amp;{132.04} \end{array}} \right],$$
]




[image: 
$${({x^T}x)^{ - 1\,}} = \left[ {\begin{array}{*{20}{c}} {77.97}&amp;{ - 70.52}&amp;{ - 0.04} \\ { - 70.52}&amp;{63.86}&amp;{0.03} \\ { - 0.04}&amp;{0.03}&amp;{0.00} \end{array}} \right],$$
]
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[image: 
$${x^T}y = \,\left[ {\begin{array}{*{20}{c}} {147615.00} \\ {158382.64} \\ {8669899.36} \end{array}} \right],$$
]




Hence, [image: 
${({x^T}x)^{ - 1\,}} \cdot \,{x^T}y = \left[ {\begin{array}{*{20}{c}} {30304.05} \\ { - 25209.86} \\ {42.27} \end{array}} \right]$
].
This last matrix indicates the estimated [image: 
$\beta s$
] (i.e., [image: 
$\hat \beta $
]) with 30,304.05 representing the intercept, −25,209.86 representing the effect of a one-unit increase in the price on sales, and 42.27 the effect of a one-unit increase in promotions on sales.
As discussed before, each [image: 
$\hat \beta $
] also has a standard error. This standard error can be expressed in standard deviations and, as seen in the discussion in Chap.​ 5, values outside the ± 1.96 · t-value from the [image: 
$\hat \beta $
] indicate the significance of two-tailed tests. If this range includes a value of 0, the [image: 
$\hat \beta \,$
]is said to be insignificant. If it excludes 0, the [image: 
$\hat \beta $
] is said to be significant.
While OLS is an effective estimator, there are alternatives that work better in specific situations. These situations occur if we violate one of the regression assumptions. For example, if the regression errors are heteroscedastic (discussed in Sect. 7.3.3.3), we need to account for this by, for example, using Weighted Least Squares
                    
                   (WLS). We briefly discuss when WLS should be used in this chapter. If the expected mean error of the regression model is not zero, estimators such as two-staged least squares (2SLS) can be used in specific situations. There are many more estimators, but these are beyond the scope of this book. Greene (2011) discusses these and other estimation procedures in detail.
7.3.3 Test the Regression Analysis Assumptions
We have already discussed several issues that determine whether running a regression analysis is useful. We now discuss regression analysis assumptions. If a regression analysis fails to meet its assumptions, it can provide invalid results. Four regression analysis assumptions are required to provide valid results:	1.The regression model can be expressed linearly,

 

	2.The regression model’s expected mean error is zero,

 

	3.The errors’ variance is constant (homoscedasticity), and

 

	4.The errors are independent (no autocorrelation).

 





There is a fifth assumption which is optional. If we meet this assumption, we have information on how the regression parameters are distributed, which allows straightforward conclusions regarding their significance. If the regression analysis fails to meet this assumption, the regression model will still be accurate, but we cannot rely accurately on the standard errors (and t-values) to determine the regression parameters’ significance.	5.The errors need to be approximately normally distributed.

 





We next discuss these assumptions and how we can test each of them.
7.3.3.1 First Assumption: Linearity
The first assumption means that we can write the regression model as [image: 
$y = \alpha + {\beta _1}{x_1} + e.\,$
] Thus, non-linear relationships, such as [image: 
$\beta _1^2{x_1}$
], are not permissible. However, logarithmic expressions, such as log(x1), are possible as the regression model is still specified linearly. If you can write a model whose regression parameters (the ßs) are linear, you satisfy this assumption.
A separate issue is whether the relationship between the independent variable x and the dependent variable y is linear. You can check the linearity between x and y variables by plotting the independent variables against the dependent variable. Using a scatter plot, we can then assess whether there is some type of non-linear pattern. Figure 7.3 shows such a plot. The straight, sloping line indicates a linear relationship between sales and promotions. For illustration purposes, we have also added a curved upward sloping line. This dashed line corresponds to a [image: 
$x_1^2\,$
] transformation. It visually seems that the quadratic line fits the data best. If we fail to identify non-linear relationships as such, our regression line does not fit the data well, as evidenced in a low model fit (e.g., the R2, which we discuss later) and nonsignificant effects. After transforming x1 by squaring it (or using any other transformation), you still satisfy the assumption of specifying the regression model linearly, despite the non-linear relationship between x and y. We discuss details of transformations in Box 7.3 later in this chapter.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig3_HTML.png]
Fig. 7.3Different relationships between promotional activities and weekly sales



Ramsey’s RESET test
                    
                   is a specific linearity test (Ramsey 1969; Cook and Weisberg 1983). This test includes the squared values of the independent variables (i.e., [image: 
${\text{x}}_1^2)\,$
] and third powers (i.e., [image: 
$x_1^3$
]), and tests if these are significant (Baum 2006).7 While this test can detect these specific types of non-linearities, it does not indicate which variable or variables have a non-linear relationship with the dependent variable. Sometimes this test is (falsely) called a test for omitted variables, but it actually tests for non-linearities.
7.3.3.2 Second Assumption: Expected Mean Error Is Zero
The second assumption is that the expected (not the estimated!) mean error is zero. If we do not expect the sum of the errors to be zero, we obtain a biased line. That is, we have a line that consistently overestimates or underestimates the true relationship. This assumption is not testable by means of statistics, as OLS always renders a best line with a calculated mean error of exactly zero. This assumption is important, because if the error’s expected value is not zero, there is additional information in the data that has not been used in the regression model. For example, omitting important variables, as discussed in Box 7.1, or autocorrelation may cause the expected error to no longer be zero (see Sect. 7.3.3.4).
7.3.3.3 Third Assumption: Homoscedasticity
The third assumption is that the errors’ variance is constant, a situation we call homoscedasticity
                    
                  . Imagine that we want to explain various supermarkets’ weekly sales in dollars. Large stores obviously have a far larger sales spread than small supermarkets. For example, if you have average weekly sales of $50,000, you might see a sudden jump to $60,000, or a fall to $40,000. However, a very large supermarket could see sales move from an average of $5 million to $7 million. This causes the weekly sales’ error variance of large supermarkets to be much larger than that of small supermarkets. We call this non-constant variance heteroscedasticity
                    
                  . If we estimate regression models on data in which the variance is not constant, they will still result in correct βs. However, the associated standard errors are likely to be too large and may cause some βs to not be significant, although they actually are.
Figure 7.4 provides a visualization of heteroscedasticity. As the dependent variable increases, the error variance also increases. A simple scatterplot (see Chap.​ 5) with the dependent variable on the y-axis and the error plotted on the x-axis can visualize heteroscedasticity. If heteroscedasticity is an issue, the points are typically funnel shaped, displaying more (or less) variance as the independent variable increases (decreases). Note that the variance can also first go up and then down (diamond shaped) or down and then up (diabolo shaped). These funnel shapes are typical of heteroscedasticity and indicate that the error variance changes as a function of the dependent variable. If these plots reveal heteroscedasticity as an issue, we can deal with it in two different ways described next.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig4_HTML.png]
Fig. 7.4An example of heteroscedasticity



First, WLS may be used. Compared to OLS, where each observation has an equal weight (see Sect. 7.3.2.2), WLS “weights” the regression line such that observations with a smaller variance are given greater weight in determining the regression coefficients. The difficult part is to understand which variable drives the heteroscedasticity. Returning to the store sales example above, if a variable store size were available, it would address the issue that weekly sales’ error variance of large supermarkets is much larger than that of small supermarkets. This would make it a useful weighting variable. Only use WLS if there is a clear indication of heteroscedasticity and if you have a good weighting variable. Before using WLS, try adding the weight variable to the original regression model to see if heteroscedasticity is still a problem. Often heteroscedasticity arises because of omitted variables.
Second, bootstrapping
                    
                   may be used. If we expect that our regression model suffers from heteroscedasticity, bootstrapping is an alternative. Bootstrapping takes different samples from the dataset and estimates many regression models (typically 1000) from this dataset. For each sample, the regression model is calculated and these different values are weighted into bootstrapped [image: 
$\hat \beta $
] s and standard errors. These bootstrapped [image: 
$\hat \beta $
] s and standard errors give an indication of how robust the results are and if the interpretation of the OLS and bootstrapped [image: 
$\hat \beta $
] s and standard errors are the same, heteroscedasticity, is unlikely to be a major concern. Moreover, the bootstrapped [image: 
$\hat \beta $
] s and standard errors give an indication of the true values of both when heteroscedasticity is controlled for.
7.3.3.4 Fourth Assumption: No Autocorrelation
The fourth assumption is that the regression model errors are independent; that is, the error terms are uncorrelated for any two observations. Imagine that you want to explain the supermarket sales of a brand of milk by using the previous week’s sales of that milk. It is very likely that if sales increased last week, they will also increase this week. This may be due to, for example, the growing economy, an increasing appetite for milk, or other reasons that underlie the growth in supermarket sales of milk. This issue is called autocorrelation
                    
                   and means that regression errors are correlated positively (or negatively) over time. For example, the data in Table 7.1 are taken from weeks 1 to 30, which means they have a time component.
We can identify the presence of autocorrelation by using the Durbin-Watson (D-W) test
                    
                   (Durbin and Watson 1951). The D-W test assesses whether there is autocorrelation by testing the null hypothesis of no autocorrelation, which is tested for negative autocorrelation against a lower and upper bound and for positive autocorrelation against a lower and upper bound. If we reject the null hypothesis of no autocorrelation, we find support for an alternative hypothesis that there is some degree of positive or negative autocorrelation. Essentially, there are four situations, which we indicate in Fig. 7.5.	1.The errors may be positively related (called positive autocorrelation). This means that if we have observations over time, we observe that positive errors are generally followed by positive errors and negative errors by negative errors. For example, supermarket sales usually increase over certain time periods (e.g., before Christmas) and decrease during other periods (e.g., the summer holidays).

 

	2.If positive errors are commonly followed by negative errors and negative errors by positive errors, we have negative autocorrelation. Negative autocorrelation is less common than positive autocorrelation, but also occurs. If we study, for example, how much time salespeople spend on shoppers, we may see that if they spend much time on one shopper, they spend less time on the next, allowing the salesperson to stick to his/her schedule, or to simply go home on time.

 

	3.If no systematic pattern of errors occurs, we have no autocorrelation. This absence of autocorrelation is required to estimate standard (OLS) regression models.

 

	4.The D-W values may fall between the lower and upper critical value. If this occur, the test is inconclusive.

 




[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig5_HTML.png]
Fig. 7.5Durbin-Watson test values (n = 30, k = 1)



The situation that occurs depends on the interplay between the D-W test statistic (d) and the lower (dL) and upper (dU) critical value:	If the test statistic is lower than the lower critical value (d < dL), we have positive autocorrelation.

	If the test statistic is higher than 4 minus the lower critical value (d > 4−dL), we have negative autocorrelation.

	If the test statistic falls between the upper critical value and 4 minus the upper critical value (dU < d < 4−dU), we have no autocorrelation.

	If the test statistic falls between the lower and upper critical value (dL < d < dU), or it falls between 4 minus the upper critical value and 4 minus the lower critical value (4−dU < d < 4−dL), the test does not inform on the presence of autocorrelation and is undecided.





The critical values dL and dU can be found on the website accompanying this book (⤓ Web Appendix → Downloads). From this table, you can see that the lower critical value dL of a model with one independent variable and 30 observations is 1.352 and the upper critical value dU is 1.489. Figure 7.5 shows the resulting intervals. Should the D-W test indicate autocorrelation, you should use models that account for this problem, such as panel and time series models. We do not discuss these methods in this book, but Hill et al. (2011) is a useful source of further information.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Figb_HTML.png]
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7.3.3.5 Fifth (Optional) Assumption: Error Distribution
The fifth, optional, assumption is that the regression model errors are approximately normally distributed. If this is not the case, the t-values may be incorrect. However, even if the regression model errors are not normally distributed, the regression model still provides good estimates of the coefficients. Consequently, we consider this assumption an optional one. Potential reasons for regression errors being non-normally distributed include outliers
                    
                   (discussed in Chap.​ 5) and a non-linear relationship between the dependent and one or more independent variable(s) as discussed in Sect. 7.3.3.1.
There are two main ways of checking for normally distributed errors: you can use plots or carry out a formal test. Formal tests of normality include the Shapiro-Wilk tests (see Chap.​ 6), which needs to be run on the saved errors. A formal test may indicate non-normality and provide absolute standards. However, formal test results reveal little about the source of non-normality. A histogram with a normality plot may can help assess why errors are non-normally distributed (see Chap.​ 5 for details). Such plots are easily explained and interpreted and may suggest the source of non-normality (if present).
7.3.4 Interpret the Regression Results
In the previous sections, we discussed how to specify a basic regression model and how to test regression assumptions. We now discuss the regression model fit, followed by the interpretation of individual variables’ effects.
7.3.4.1 Overall Model Fit
Assessing the overall model fit starts by interpreting the F-test
                    
                  , which determines whether or not the model is significant (i.e., whether any of the independent variables has an effect on the dependent variable). The test statistic’s F-value is the result of a one-way ANOVA (see Chap.​ 6) that tests the null hypothesis that all the regression coefficients equal zero. Thus, the following null hypothesis is tested:8
[image: 
$${{\text{H}}_0}:{\text{ }}{\beta _1} = {\beta _2} = {\beta _3} = \ldots = \,0$$
]





If the regression coefficients are all equal to zero, then all the independent variables’ effect on the dependent variable is zero. In other words, there is no (zero) relationship between the dependent variable and the independent variables. If we do not reject the null hypothesis, we need to change the regression model, or, if this is not possible, report that the regression model is non-significant. If the p-value of the F-test is below 0.05 (i.e., the model is significant), does not, however, imply that all the regression coefficients are significant, or even that one of them is significant when considered in isolation. However, if the F-value is significant, it is highly likely that at least one or more regression coefficients are significant. Note that model significance is not an indicator of (close) fit, only of significance.
If we find that the F-test is significant, we can interpret the model fit by using the R2
                    
                  . The R2 (also called the coefficient of determination
                    
                    
                  ) indicates the degree to which the model, relative to the mean, explains the observed variation in the dependent variable. In Fig. 7.6, we illustrate this graphically by means of a scatter plot. The y-axis relates to the dependent variable sales (weekly sales in dollars) and the x-axis to the independent variable promotion (index of promotional activities). In the scatter plot, we see 30 observations of sales and price (note that we use a small sample size for illustration purposes). The horizontal line (at about $5000 sales per week) refers to the average sales across all 30 observations. This is also our benchmark. After all, if we were to have no regression line, our best estimate of the weekly sales would also be the average. The sum of all the squared differences between each observation and the average is the total variation or the total sum of the squares
                    
                   (SST). We indicate the total variation in only one observation on the right of the scatter plot.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig6_HTML.png]
Fig. 7.6Explanation of the R2




The straight upward sloping line (starting at the y-axis at about $2500 sales per week when there are no promotional activities) is the regression line that OLS estimates. If we want to understand what the regression model adds beyond the average (which is the benchmark for calculating the R2), we can calculate the difference between the regression line and the line indicating the average. We call this the regression sum of squares
                    
                   (SSR), as it is the variation in the data that the regression analysis explains. The final point we need to understand regarding how well a regression line fits the available data, is the unexplained sum of the squares. This is the difference between the observations (indicated by the dots) and the regression line. The squared sum of these differences refers to the regression error that we discussed previously and which is therefore denoted as the error sum of squares
                    
                   (SSE). In more formal terms, we can describe these types of variation as follows:[image: 
$$S{S_T} = S{S_R} + S{S_E}$$
]





This is the same as:[image: $$\mathop \sum \limits_{i = 1}^n \left( {{y_i} - \bar y} \right)^2 = \mathop \sum \limits_{i = 1}^n \left( {{{\hat y}_i} - \bar y} \right)^2 + \mathop \sum \limits_{i = 1}^n \left( {{y_i} - {{\hat y}_i}} \right)^2$$]





Here, n describes the number of observations, [image: 
${y_i}$
] is the value of the independent variable for observation i, [image: 
${\hat y_i}$
] is the predicted value of observation i, and [image: 
$\bar y$
] is the mean value of y. As you may see, this description is like the one-way ANOVA we discussed in Chap.​ 6. A useful regression line should explain a substantial amount of variation (have a high SSR) relative to the total variation (SST). This degree of fit is indicated by the R2 as follows:[image: 
$${{\text{R}}^2} = \frac{{{\text{S}}{{\text{S}}_{\text{R}}}}}{{{\text{S}}{{\text{S}}_{\text{T}}}}}$$
]





The R2 always lies between 0 and 1, with a higher R2 indicating a better model fit. When interpreting the R2, higher values indicate that the variation in x explains more of the variation in y. Therefore, relative to the SSR, the SSE is low.
Tip
It is difficult to provide rules of thumb regarding what R2 is appropriate, as this varies from research area to research area and on the model complexity. For example, in longitudinal studies, R2s of 0.90 and higher are common. In cross-sectional designs, values of around 0.30 are common, while values of 0.10 are normal in cross-sectional data in exploratory research. In scholarly research focusing on marketing, R2 values of 0.50, 0.30, and 0.10 can, as a rough rule of thumb, be respectively described as substantial, moderate, and weak. Similarly, the regression model's complexity influences the R2 as the statistic increases with a greater number of independent variables.

If we use the R2 to compare different regression models (but with the same dependent variable), we run into problems. If we add irrelevant variables that are slightly correlated with the dependent variable, the R2 will increase. Thus, if we only use the R2 as the basis for understanding regression model fit, we are driven towards selecting regression models with many independent variables. Selecting a model only based on the R2 is generally not a good strategy, unless we are interested in making predictions. If we are interested in determining whether independent variables have a significant relationship with a dependent variable, or when we wish to estimate the relative strength of different independent variables’ effects, we need regression models that do a good job of explaining the data (which have a low SSE), but which also have a few independent variables. It is easier to recommend that a management should change a few key variables to improve an outcome than to recommend a long list of somewhat related variables. We also do not want too many independent variables, because they are likely to complicate the insights. Consequently, it is best to rely on simple models when possible. Relevant variables should, of course, always be included. To avoid a bias towards complex models, we can use the adjusted R2
                    
                   to select regression models. The adjusted R2 only increases if the addition of another independent variable explains a substantial amount of the variance. We calculate the adjusted R2 as follows:[image: 
$$R_{{\text{adj}}}^2 = 1 - (1 - {R^2}) \cdot \frac{{{\text{n}} - 1}}{{{\text{n}} - {\text{k}} - 1}}$$
]





Here, n describes the number of observations and k the number of independent variables (not counting the constant α). This adjusted R2 is a relative measure and should be used to compare different but nested models
                    
                   with the same dependent variable. Nested means that all of a simpler model’s terms are included in a more complex model, as well as additional variables. You should pick the model with the highest adjusted R2 when comparing regression models. However, do not blindly use the adjusted R2 as a guide, but also look at each individual variable and see if it is relevant (practically) for the problem you are researching.
We cannot interpret the adjusted R2 as the percentage of explained variance as we can with the regular R2. The adjusted R2 is only a measure of how much the model explains while controlling for model complexity.
Because the adjusted R2 can only compare nested models, there are additional fit indices that can be used to compare models with the same dependent variable, but different independent variables (Treiman 2014). The Akaike information criterion (AIC) and the Bayes information criterion (BIC) are such measures of model fit. More precisely, AIC and BIC are a relative measure indicating the difference in information when a set of candidate models with different independent variables is estimated. For example, we can use these criteria to compare two models where the first regression model explains the sales by using two independent variables (e.g., price and promotions) and the second model adds one more independent variable (e.g., price, promotions, and service quality). We can also use the AIC and BIC when we explain sales by using two different sets of independent variables.
Both the AIC and BIC apply a penalty (the BIC a slightly larger one) as the number of independent variables increases with the sample size (Treiman 2014).9 Smaller values are better and, when comparing models and a rough guide is that when the more complex model’s AIC (or BIC) is 10 lower than that of another model, the former model should be given strong preference (Fabozzi et al. 2014). When the difference is less than 2, the simpler model is preferred. For values between 2 and 10, the evidence shifts towards the more complex model, although a specific cut-off point is hard to recommend. When interpreting these statistics, note that the AIC tends to point towards a more complex model than the BIC.
7.3.4.2 Effects of Individual Variables
Having established that the overall model is significant and that the R2 is satisfactory, we need to interpret the effects of the various independent variables used to explain the dependent variable. If a regression coefficient’s p-value is below 0.05, we generally say that the specific independent variable relates significantly to the dependent variable. To be precise, the null and alternative hypotheses tested for an individual parameter (e.g., β1) are:[image: 
$${H_0}:{\beta _1} = \,0$$
]




[image: 
$${H_1}:{\beta _1} \ne \,0$$
]





If a coefficient is significant (i.e., the p-value is below 0.05), we reject the null hypothesis and support the alternative hypothesis, concluding that the parameter differs significantly from zero. For example, if we estimate a regression model on the data shown in Fig. 7.1, the (unstandardized) β1 coefficient of promotional activities’ effect on sales is 54.591, with a t-value of 5.354. This t-value results in a p-value less than 0.05, indicating that the effect is significantly different from zero. If we hypothesize a direction (i.e., smaller or larger than zero) instead of significantly different from zero, we should divide the corresponding p-value by two. This is the same as applying the t-test for a directional effect, which is explained in Chap.​ 6.
The next step is to interpret the actual size of the β coefficients, which we can interpret in terms of unstandardized effects
                    
                   and standardized effects
                    
                  . The unstandardized β coefficient indicates the effect that a one-unit increase in the independent variable (on the scale used to measure the original independent variable) has on the dependent variable. This effect is therefore the partial relationship between a change in a single independent variable and the dependent variable. For example, the unstandardized β1 coefficient of promotional activities’ effect on sales (54.591) indicates that a one-unit change in (the index of) promotional activities increases sales by 54.591 units. Importantly, if we have multiple independent variables, a variable’s unstandardized coefficient is the effect of that independent variable’s increase by one unit, but keeping the other independent variables constant.
While this is a very simple example, we might run a multiple regression in which the independent variables are measured on different scales, such as in dollars, units sold, or on Likert scales. Consequently, the independent variables’ effects cannot be directly compared with one another, because their influence also depends on the type of scale used. Comparing the unstandardized β coefficients would, in any case, amount to comparing apples with oranges!
Fortunately, the standardized βs allow us to compare the relative effect of differently measured independent variables by expressing the effect in terms of standard deviation changes from the mean. More precisely, the standardized β coefficient expresses the effect that a single standard deviation change in the independent variable has on the dependent variable. The standardized βs are used to compare different independent variables’ effects. All we need to do is to find the highest absolute value, which indicates the variable that has the strongest effect on the dependent variable. The second highest absolute value indicates the second strongest effect, etc. Only consider significant βs in this respect, as insignificant βs do not (statistically) differ from zero! In practice, the standardized β is important, because it allows us to assess the effect of one variable (e.g., promotional activities), relative to other variables (e.g., prices). While the standardized βs are helpful from a practical point of view, they only allow for comparing the coefficients within and not between models! Even if you just add a single variable to your regression model, the standardized βs may change substantially.
When interpreting (standardized) β coefficients, you should always keep the effect size in mind. If a β coefficient is significant, it merely indicates an effect that differs from zero. This does not necessarily mean that the effect is managerially relevant. For example, we may find a $0.01 sales effect of spending $1 more on promotional activities that is statistically significant. Statistically, we could conclude that the effect of a $1 increase in promotional activities increases sales by an average of $0.01 (just one dollar cent). While this effect differs significantly from zero, we would probably not recommend increasing promotional activities in practice (we would lose money on the margin) as the effect size is just too small.10

There are also situations in which an effect is not constant for all observations, but depends on another variable’s values. Researchers can run a moderation analysis
                    
                  , which we discuss in Box 7.2, to estimate such effects.
Box 7.2 Moderation analysis
The discussion of individual variables’ effects assumes that there is only one effect. That is, that only one β parameter represents all observations well. This is often not true. For example, the link between sales and price has been shown to be stronger when promotional activities are higher. In other words, the effect of price (β1) is not constant, but varies with the level of promotional activities.
Moderation analysis is one way of testing if such heterogeneity is present. A moderator variable, usually denoted by m, is a variable that changes the strength (or even direction) of the relationship between the independent variable (x1) and the dependent variable (y). You only need to create a new variable that is the multiplication of x1 and m (i.e., x1·m). The regression model then takes the following form:[image: 
$$y = \alpha + {\beta _1}{x_1} + {\beta _2}m + {\beta _3}{x_1} \cdot m + e$$
]





In words, a moderator analysis requires entering the independent variable x1, the moderator variable m, and the product x1·m (commonly referred to as interaction term
                      
                    ), which represents the interaction between the independent variable and the moderator. Moderation analysis is therefore also commonly referred to as an analysis of interaction effects
                      
                    . After estimating this regression model, you can interpret the significance and sign of the β3 parameter. A significant effect suggests that	when the sign of β3 is positive, the effect β1 increases as m increases,

	when the sign of β3 is negative, the effect β1 decreases as m increases.





For further details on moderation analysis, please see David Kenny’s discussion on moderation (http://​www.​davidakenny.​net/​cm/​moderation.​htm), or the advanced discussion by Aiken and West (1991). Jeremy Dawson’s website (http://​www.​jeremydawson.​co.​uk/​slopes.​htm) offers a tool for visualizing moderation effects. An example of a moderation analysis is found in Mooi and Frambach (2009).
7.3.5 Validate the Regression Results
Having checked for the assumptions of the regression analysis and interpreted the results, we need to assess the regression model’s stability. Stability means that the results are stable over time, do not vary across different situations, and are not heavily dependent on the model specification. We can check for a regression model’s stability in several ways:	1.We can randomly split the dataset into two parts (called split-sample validation
                          
                        ) and run the regression model again on each data subset. 70 % of the randomly chosen data is often used to estimate the regression model (called estimation sample
                          
                        ) and the remaining 30 % is used for comparison purposes (called validation sample). We can only split the data if the remaining 30 % still meets the sample size rules of thumb discussed earlier. If the use of the two samples results in similar effects, we can conclude that the model is stable. Note that not all regression models need to be identical when you try to validate the results. The signs of the individual parameters should at least be consistent and significant variables should remain so, except if they are marginally significant, in which case changes are expected (e.g., p = 0.045 becomes p = 0.051)..11 Finally, note that it is mere convention to use 70 and 30 % and there is no specific reason for using these percentages.

 

	2.We can also cross-validate our findings on a new dataset and examine whether these findings are similar to the original findings. Again, similarity in the findings indicates stability and that our regression model is properly specified. Cross-validation
                          
                         does, of course, assume that we have a second dataset.

 

	3.We can add several alternative variables to the model and examine whether the original effects change. For example, if we try to explain weekly supermarket sales, we could use several additional variables, such as the breadth of the assortment or the downtown/non-downtown location in our regression model. If the basic findings we obtained earlier continue to hold even when adding these two new variables, we conclude that the effects are stable. This analysis does, of course, require us to have more variables available than those included in the original regression model. If we add variables not because we are interested in them but because we want to rule these out as alternative explanations, we call these control variables
                          
                        .

 





7.3.6 Use the Regression Model
When we have found a useful regression model that satisfies regression analysis’s assumptions, it is time to use it. Prediction is a key use of regression models. Essentially, prediction entails calculating the values of the dependent variables of new observations based on assumed values of the independent variables and the previously calculated unstandardized β coefficients. Let us illustrate this by returning to our opening example. Imagine that we are trying to predict weekly supermarket sales (in dollars) (y) and have estimated a regression model with two independent variables: price ([image: 
${x_1}$
]) and an index of promotional activities ([image: 
${x_2}$
]). The regression model is as follows:[image: 
$$y = \alpha + {\beta _1}{x_1} + {\beta _2}{x_2} + e$$
]





If we estimate this model on the previously used dataset, the estimated unstandardized coefficients using regression analysis are 30,304.054 for the intercept, −25,209.858 for price, and 42.266 for promotions. We can use these coefficients to predict sales in different situations. Imagine, for example, that we set the price at $1.10 and the promotional activities at 50. Our expectation of the weekly sales would then be:
[image: 
$$\hat y = 30,304.054 - 25,209.858 \cdot \$1.10 + 42.266 \cdot 50\ \text{promotional activities}\ = \$4686.5102\ \text{sales per week}.$$
]




We could also build several scenarios to plan for different situations by, for example, increasing the price to $1.20 and reducing the promotional activities to 40. By using regression models like this, one can, for example, automate stocking and logistical planning, or develop strategic marketing plans.
Regression can also help by providing insight into variables’ specific effects. For example, if the effect of promotions is not significant, it may tell managers that the supermarket’s sales are insensitive to promotions. Alternatively, if there is some effect, the strength and direction of promotional activities’ effect may help managers understand whether they are useful.
Table 7.2 summarizes (on the left side) the major theoretical decisions we need to make if we want to run a regression model. On the right side, these decisions are then translated into SPSS actions.Table 7.2Steps involved in carrying out a regression analysis


	Theory
	Action

	
                            Check the regression analysis data requirements
                          

	Sufficient sample size
	Run a power analysis using G*power.
Check if sample size is 104 + k, where k indicates the number of independent variables. If the expected effects are weak (the R2 is 0.10 or lower), use at least 30 ⋅ k observations per independent variable.
To check the sample size, go to ► Analyze ► Regression ► Linear ► Statistics and check Descriptives. In the output check N under Descriptive Statistics. Alternatively, after running a regression analysis, look at the intersection of df and Total in the ANOVA table. You need to add 1 to this number to get the total sample size.

	Do the dependent and independent variables show variation?
	Calculate the standard deviation of the variables by going to ► Analyze ► Regression ► Linear ► Statistics and check Descriptive. In the output check Std. Deviation under Descriptive Statistics. At the very least, the standard deviation should be greater than 0.

	Is the dependent variable interval or ratio scaled?
	See Chap.​ 3 determine the measurement level.

	Is (multi)collinearity present?
	Check the VIF. Go to ► Analyze ► Regression ► Linear ► Statistics and check Collinearity diagnostics. In the output, under Collinearity Statistics, assess if the VIFs are all below 10 (although the threshold can be higher, or lower, in some cases; see Sect. 7.3.1.4 for details). Note that SPSS also produces an additional table labelled Collinearity Diagnostics that is not needed.

	
                            Specify and estimate the regression model
                          

	Model specification
	1. Pick distinct variables
2. Try to build a robust model
3. Consider the variables that are needed to give advice
4. Consider whether the number of independent variables is in relation to the sample size
When using ordinal variables, create dummies first. Do this by going to ► Transform ► Create Dummy Variables. Move the ordinal variable to the Create Dummy Variables for box and also enter the first part of the name of the dummy under Root Names (One per Selected Variable) of the Main Effect Dummy Variables box. By default, SPSS chooses to give value labels to each category. We can change this to Use values if we have not defined value labels. Note that SPSS will automatically create dummies for all categories and we have to specify the base category.

	Estimate the regression model
	► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Independent(s). Click on OK.

	
                            Test the regression analysis assumptions
                          

	Can the regression model be specified linearly?
	Consider whether you can write the regression model as: [image: 
$y = \alpha + {\beta _1}{x_1} + {\beta _2}{x_2} + \ldots + e$
]


	Is the relationship between the independent and dependent variables linear?
	Plot the dependent variable against the independent variable using a scatterplot matrix to see if the relation (if any) appears to be linear. ► Graphs ► Chart Builder. Then click on Scatter/Dot and drag Simple Scatter to the Chart preview window. Drag the dependent variable onto the Y-axis and the first independent variable to the X-axis. Repeat for the other independent variables.
To conduct Ramsey’s RESET test first run the regression model by going to ► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Block 1 of 1 and click on Save. Then click on Unstandardized under Predicted Values, followed by Continue and OK. After this go to ► Transform ► Compute Variable. Under Target Variable, type PRED_2 and under numeric expression enter the unstandardized prediction variable PRE_1 and type **2 after this to compute the squared predicted values. Repeat this for predicted values to the power of 3 by entering PRED_3 under Target Variable. Under numeric expression enter the unstandardized prediction variable PRE_1 and type **3.
Then re-run the regression model by going to ► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Block 1 of 1. Then click on Next and enter PRED_2 and PRED_3 to the box. Under Statistics tick R squared change and click on Continue and then OK. Check under Model Summary if Sig. F Change is significant for model 2.

	Is the expected mean error of the regression model zero?
	Choice made on theoretical grounds.

	Is the error variance constant (homoscedasticity)?
	Re-run the regression model by going to ► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Block 1 of 1 and click on Save. Then go to Save and click on Unstandardized under Residuals. Then click on Continue and OK.
Plot the dependent variable against the residual by going to ► Graphs ► Chart Builder. Then click on Scatter/Dot and drag Simple Scatter to the Chart preview window. Drag the dependent variable onto the Y-axis and the saved residual onto the X-axis.
Assess if there is a clear in- or decrease in the error variance (i.e. a funnel shape).
If there is evidence of heteroscedasticity we can use bootstrapping. Re-run the regression model by going to ► Analyze ► Regression ► Linear and click on Bootstrap. Then click on Perform bootstrapping and make sure that Number of samples is set to 1,000. Click on Continue and OK. Note that this requires the SPSS bootstrapping add-on. If this is not installed, you will not see this option.
Check if the interpretation of the regression results is the same for the standard as for the bootstrapped significance (under Sig. (2-tailed)). Under the column Bias, you can see the difference with the normal ßs. The bias should be small. That is, bootstrapped parameter estimates should fall in the region of 2 ± standard errors from the coefficients of the model estimated via OLS. Compare the normal and bootstrapped model results to ensure they are similar.

	Are the errors independent (no autocorrelation)?
	First assess if there is a time component to the data (i.e., multiple observations, across time, from one respondent/object). If there is, sort the data according to the time variable and conduct the Durbin–Watson test. Compare the calculated Durbin–Watson test statistic with the critical lower and upper values. If positive or negative autocorrelation is present, panel or time-series models need to be used.
Re-run the regression model by going to ► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Block 1 of 1 and click on Statistics. Then click on Durbin-Watson under Residuals, followed by Continue and OK.
The Durbin-Watson test for first-order serial correlation should not be significant. The critical values can be found on the website accompanying this book (⤓ Web Appendix → Downloads).

	Are the errors approximately normally distributed?
	Visual inspection: Re-run the regression model by going to ► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Block 1 of 1 and click on Plots. Then click on Histogram under Standardized Residual Plots. Then click on Continue and OK. Check whether the length of the bars of the histogram follows to the normal curve.
Statistical test: Re-run the regression model by going to ► Analyze ► Regression ► Linear. Under Dependent, enter the dependent variable and add all the independent variables under Block 1 of 1 and click on Save. Then click on Unstandardized under Residuals. Then click on Continue and OK.
Calculate the Shapiro–Wilk test. ► Analyze ► Descriptive Statistics ► Explore. Add the unstandardized residual to the Dependent list and click on Plots. Tick the Normality plots with tests box and click on Continue and OK.
Check if the Shapiro-Wilk test under Sig. reports a p-value greater than 0.05.

	
                            Interpret the regression model
                          

	Consider the overall model fit
	Check the significance of the F-test and the R2 value.

	Consider the effects of the independent variables separately
	Check the (standardized) β. Also check the sign of the β. Consider the significance of each coefficient by checking the p-value und Sig..

	To compare models
	Calculate the AIC and BIC. This can only be done by setting up the regression model and instead of clicking on OK, click on Paste. Add SELECTION to the/STATISTICS subcommand (e.g./STATISTICS COEFF OUTS R ANOVA COLLIN TOL SELECTION). Select the entire code and go to ► Run ► All.
Check the AIC and BIC and ascertain if the simpler model has AIC and BIC values that are at least 2, but preferably 10, lower than that of the more complex model.

	
                            Validate the model
                          

	Are the results robust?
	Randomly select 30 % of cases (assuring minimum sample size requirements apply). To do this, go to ► Data ► Select Cases. Then click on Random sample of cases, followed by Sample. Type 30 in the box Approximately … % of all cases and click on Continue. Before clicking on OK, make sure to select Filter out unselected cases under Output. Now click on OK.
Then go to ► Data ► Select Cases and select All cases. Next, go to ► Data ► Split File. In the dialog box that opens, select the option Organize output by groups, move the filter_$ variable into the Groups Based on box, and click on OK.
Compare the model results to ensure they are similar (i.e., the coefficients of the regression run on the smaller sample are similar to the coefficients of the regression model run on the larger sample in terms of direction and significance.





7.4 Example
Let’s go back to the Oddjob Airways case study (as introduced in Chap.​ 5) and run a regression analysis on the data. Our aim is to explain commitment, which is the customer’s intention to continue the relationship. This variable is the mean of the three items com1 (“I am very committed to Oddjob Airways”), com2 (“My relationship with Oddjob Airways means a lot to me”), and com3 (“If Oddjob Airways would not exist any longer, it would be a hard loss for me”) and has already been included in the dataset (⤓ Web Appendix → Downloads).
Our task is to identify which variables relate to commitment to Oddjob Airways. Regression analysis can help us determine which variables relate significantly to commitment, while also identifying the relative strength of the different independent variables. The Oddjob Airways dataset offers several variables that may explain the commitment variable. Based on prior research and discussions with Oddjob Airway’s management, the following variables have been identified as promising candidates:	Oddjob Airways gives you a sense of safety (s9),

	The condition of Oddjob Airways’ aircraft is immaculate (s10),

	Oddjob Airways also pays attention to its service delivery’s details (s19),

	Oddjob Airways makes traveling uncomplicated (s21), and

	Oddjob Airways offers great value for money (s23).





As additional variables, we add the following three categories to the model: the respondent’s status (status), age (age), and gender (gender).
Check the Regression Analysis Data Requirements
To check whether our data meet all requirements, we need to run the regression analysis first. Before we run a regression analysis, however, we need to create dummy variables from the status variable. To do this, go to ► Transform ► Create Dummy Variables. Move the ordinal variable status into the Create Dummy Variables for box and also enter the first part of the name of the dummy as category under Root Names (One per Selected Variable) of the Main Effect Dummy Variables box (Fig. 7.7). By default, SPSS chooses to give value labels to label each category which is good since value labels have been defined as Blue, Silver, and Gold. Then click on OK.12
[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig7_HTML.jpg]
Fig. 7.7The create dummy variables dialog box



Next, we should run the regression analysis. Go to ► Analyze ► Regression ► Linear and enter the dependent variable commitment in the Dependent box and s9, s10, s19, s21, s23, category_2, category_3, age, and gender in the Independent(s) box as shown in Fig. 7.8. This will require a bit of scrolling. Note that if we were to add category_1 as well, this variable would be perfectly collinear with category_2 and category_3 since if we know an observation is not in the latter two, it must be in the former. SPSS issues no warning when it drops a variable.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig8_HTML.jpg]
Fig. 7.8The regression dialog box



Next, we need to tell SPSS that we require several options to conduct the steps as discussed earlier. First, click on Statistics and check (if it isn’t already checked) Estimates, Model fit, Descriptives, and Collinearity diagnostics (Fig. 7.9). You should also check Durbin-Watson if the data have a time component and are sorted based on this component. In these data, there is no time component so this should not be checked. Then click on Continue.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig9_HTML.jpg]
Fig. 7.9The statistics option (regression analysis)



To save the predicted values and the errors we should click on Save. Select the option Unstandardized right under Predicted Values and under Residuals (Fig. 7.10). Then click on Continue, followed by OK, which will initiate the regression analysis.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig10_HTML.jpg]
Fig. 7.10The save option (regression analysis)



Sample Size
After having run the analysis, we should first check if the sample size is sufficient for a regression analysis. To do so, we examine the Descriptive Statistics table (Table 7.3), which shows the mean, the standard deviation, and the number of observations (indicated by N). Here, we find the value 973. Green’s (1991) rule of thumb suggests that we need at least 104 + k observations, where k is the number of independent variables. Since we have nine independent variables, we satisfy this criterion. In fact, even if we apply VanVoorhis and Morgan’s (2007) more stringent criteria of 30 observations per variable, we still have a sufficient sample size. SPSS also displays a correlation matrix. However, as this matrix takes up a lot of space, we don’t display it here.Table 7.3Descriptive statistics


	Descriptive Statistics

	 	Mean
	Std. Deviation
	N

	commitment
	4.2254
	1.71537
	973

	s9
	72.63
	20.795
	973

	s10
	64.65
	21.370
	973

	s19
	57.41
	21.489
	973

	s21
	59.18
	22.535
	973

	s23
	49.37
	22.675
	973

	category_2
	.2343
	.42380
	973

	category_3
	.1377
	.34478
	973

	age
	50.58
	11.959
	973

	gender
	1.74
	.440
	973





Variables Need to Vary
To ascertain if our variables display some variation, we examine the Descriptive Statistics output from Table 7.3 again. At the very least, the standard deviation, indicated under Std. Deviation should be greater than 0. The output also shows each variable’s mean. Two variables require a bit more to interpret these. The variable status is coded using thee labels, Blue, Silver, and Gold, and from the output we can see that .2343 or 23 % of all respondents fall into category_2 (Silver) category, while .1377 or 14 % fall into category_3 (Gold). Hence, we can conclude that the reaming 63 % fall into the Blue category. Turning to the variable gender, which is coded 1 for females and 2 for males, we can conclude that as the mean is 1.74, 74 % of our observations are male.
Scale Type of the Dependent Variable
The scale of the dependent variable is interval or ratio scaled. Specifically, three 7-point Likert scales create the mean of three items that form the commitment variable. Most researchers would consider this to be interval or ratio scaled, which meets the OLS regression data assumptions.
Collinearity
To check for collinearity among the independent variables, we need to examine the regression output (Table 7.4), which shows the beta coefficients, their significances, and collinearity statistics. As we can see, the highest VIF value is 2.069, which is below 10 and also below the conservative threshold of 5. Hence, we conclude that collinearity is not at a critical level. Note that SPSS will also produce a specific table with collinearity diagnostics but this table is not necessary for an essential diagnostic of collinearity.Table 7.4Regression output


	Coefficientsa


	Model
	Unstandardized Coefficients
	Standardized Coefficients
	t
	Sig.
	Collinearity Statistics

	B
	Std. Error
	Beta
	Tolerance
	VIF

	1
	(Constant)
	1.199
	.300
	 	3.997
	.000
	 	 
	s9
	.005
	.003
	.063
	1.722
	.085
	.521
	1.919

	s10
	.001
	.003
	.008
	.224
	.823
	.498
	2.009

	s19
	.012
	.003
	.154
	4.072
	.000
	.483
	2.069

	s21
	.019
	.003
	.245
	6.821
	.000
	.532
	1.880

	s23
	.016
	.003
	.208
	6.003
	.000
	.571
	1.752

	category_2
	.183
	.112
	.045
	1.641
	.101
	.902
	1.108

	category_3
	.428
	.138
	.086
	3.105
	.002
	.897
	1.115

	age
	.010
	.004
	.072
	2.667
	.008
	.951
	1.051

	gender
	−.345
	.105
	−.089
	−3.285
	.001
	.946
	1.057


a Dependent Variable: commitment




Having now met all the described requirements for a regression analysis, our next task is to interpret the regression analysis results.
Specify and Estimate the Regression Model
We know exactly which variables to select for this model: commitment, as the dependent variable, and s9, s10, s19, s21, s23, category_2, category_3, age, and gender as the independent variables as we had specified earlier. We have already done this so there is no need to repeat this.
Test the Regression Analysis Assumptions
In the next step, we test the following assumptions relevant to regression analysis: 	Linearity,

	expected mean is zero,

	homoscedasticity,

	no autocorrelation, and

	normal error distribution.





First Assumption: Linearity
The first assumption is whether the regression model can be expressed linearly. Since no variable transformations occurred, we meet this assumption, because we can write the regression model linearly as:[image: 
$$\begin{aligned} commitment = &amp; \alpha + {\beta _1}s9 + {\beta _2}s10 + {\beta _3}s19 + {\beta _4}s21 + {\beta _5}s23 + \hfill \\ &amp; {\beta _6}category\_2 + {\beta _7}category\_3 + {\beta _8}age + {\beta _9}gender + e \end{aligned} $$
]





Separately, we also check whether the relationships between the independent and dependent variables are linear. To do this, create scatterplots of the dependent variable against all the independent variables. To do this, go to ► Graphs ► Chart Builder. Then click on Scatter/Dot and drag Simple Scatter to the Chart preview window. Drag the dependent variable commitment onto the Y-Axis and the first independent variable s9 (“Oddjob Airways gives you a sense of safety”) to the X-Axis and click on OK.
Figure 7.11 shows the resulting scatterplot. The large number of dots makes it difficult to see whether the relationship is linear and this is quite typical for large datasets. The scatterplot neither suggests nor rejects linearity clearly. Note that because commitment is computed as the mean of three variables measured on seven-point scales, we observe distinct bands. This is because the variable commitment can only take on 21 distinct values.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig11_HTML.png]
Fig. 7.11Scatterplot to examine linearity



Another means to test for nonlinear relationships between the independent and dependent variable is to run Ramsey’s RESET test. Unfortunately, the test is not readily available via SPSS’s graphical user interface but we can manually run the test using a series of commands. To conduct Ramsey’s RESET we need to square and take the third power of the predictions of the regression model we saved earlier. To do this, go to ► Transform ► Compute Variable and type PRED_2 under Target Variable. Under Numeric Expression enter the unstandardized prediction variable PRE_1 that we requested SPSS to save when running the regression analysis. Now type **2 after PRE_1 to compute the squared predicted values. After clicking on OK, SPSS will add a new variable PRED_2 to the dataset. Repeat this series of commands but enter PRED_3 under Target Variable and add **3 after PRE_1 to raise to the power of three.
Then re-run the regression model by going to ► Analyze ► Regression ► Linear Regression. Under Dependent enter the dependent variable commitment and add all the independent variables (i.e., and s9, s10, s19, s21, s23, category_2, category_3, age, and gender) under Block 1 of 1. Then click on Next and enter PRED_2 and PRED_3 to the box. Note that this block will now read Block 2 of 2. Under Statistics, tick R squared change and click on Continue and then OK.
SPSS produces a series of outputs of which only the Model Summary is relevant to us. Specifically, we need to check whether the R2 differs significantly between model 1 (the initial model) and model 2 (the model additionally containing PRED_2 and PRED_3). If we read the output in Table 7.5, we see that the change in R2 is not significant as indicated by the p-value of .800 under Sig. F Change. The results thus suggest that the relationships are linear. Bear in mind, however, that this test does not consider all forms of non-linearities.Table 7.5Model summary used for Ramsey’s RESET test


	Model Summaryc


	Model
	R
	R Square
	Adjusted R Square
	Std. Error of the Estimate
	Change Statistics

	R Square Change
	F Change
	df1
	df2
	Sig. F Change

	1
	.581a

	.338
	.332
	1.40236
	.338
	54.593
	9
	963
	.000

	2
	.582b

	.338
	.331
	1.40349
	.000
	.223
	2
	961
	.800


a Predictors: (Constant), gender, s21, age, category_3, category_2, s10, s23, s9, s19
b Predictors: (Constant), gender, s21, age, category_3, category_2, s10, s23, s9, s19, PRED_3, PRED_2
c Dependent Variable: commitment




In case the visual inspection or Ramsey’s RESET test indicate a nonlinear relationship, we can run a curve estimation to explore the concrete form of the relationship. In Box 7.3, we offer a brief introduction into curve estimation using SPSS.
Box 7.3 Curve estimation
SPSS’s curve estimation option allows running multiple regression models with a single independent variable, assuming different types of nonlinear relationships. To run this analysis, go to ► Analyze ► Regression ► Curve Estimation. In the dialog box that opens (Fig. 7.12), enter commitment into the Dependent(s) box and, for example, s9 under Independent. Under Models we can select different types of transformations to map a potential nonlinear relationship. Typical transformations include the Logarithmic, Quadratic, and Exponential. Make sure to also select Linear. Now click on OK.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig12_HTML.jpg]
Fig. 7.12Curve estimation dialog box



Figure 7.13 shows the resulting output with linear, logarithmic, quadratic, and exponential transformations. Considering the great number of data points, it is difficult to spot, which type of transformation would better represent the relationship between commitment and s9. In this case, we should compare the R2 of all significant models as an indicator of what line fits best. To do so, select Display ANOVA table option in Fig. 7.12 and pick the model with a significant F-value, which has the highest R2.13
[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig13_HTML.png]
Fig. 7.13Examples of linear, logarithmic, quadratic, and exponential relationships



Second Assumption: Expected Mean Error Is Zero
Assessing whether the regression model’s expected mean error is zero is made on theoretical grounds—there is no empirical test for this. We have a randomly drawn sample from the population and the model is similar in specification to other models explaining commitment. This makes it reasonable to assume that the regression model’s expected mean error is zero.
Third Assumption: Homoscedasticity
To consider if the errors are constant (homoscedastic) we need to re-use the errors of the regression model we saved earlier. We should then plot the dependent variable against the residual by going to ► Graphs ► Chart Builder. Then click on Scatter/Dot and drag Simple Scatter to the Chart preview window. Drag the dependent variable commitment onto the Y-axis and the unstandardized residuals variable RES_1 onto the X-axis. Click on OK. The resulting scatterplot shown in Fig. 7.14 shows no clear increase or decrease in error variance (i.e., a funnel shape). Since there is no clear evidence of heteroscedasticity, we do not need to use bootstrapping.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig14_HTML.png]
Fig. 7.14Scatterplot to assess homoscedasticity



Fourth Assumption: No Autocorrelation
If we had data with a time component, we would also perform the Durbin-Watson test to check for potential autocorrelation. This requires us to first specify a time component, which is absent in the Oddjob Airways dataset.
Fifth (Optional) Assumption: Normal Error Distribution
To check whether the errors are normally distributed, we need to re-run the regression model by going to ► Analyze ► Regression ► Linear Regression. Under Dependent, enter the dependent variable commitment and add all the independent variables (i.e., s9, s10, s19, s21, s23, category_2, category_3, age, and gender) under Block 1 of 1 (in case you ran Ramsey’s RESET test, you should press RESET first). Next, click on Plots. In the dialog box that opens, click on Histogram under Standardized Residual Plots, followed by Continue and OK. SPSS will then produce a plot as shown in Fig. 7.15, which suggest that our data are normally distributed as the bars indicating the frequency of the errors generally follow the normal curve.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig15_HTML.png]
Fig. 7.15Histogram of the errors with a standard normal curve



However, we can check this further by conducting the Shapiro–Wilk test. Do this by going to ► Analyze ► Descriptive Statistics ► Explore. Add the unstandardized residual variable RES_1 to the Dependent list box and click on Plots. Tick the Normality plots with tests box and click on Continue and OK. Then check if the Shapiro-Wilk test under Sig. reports a greater value than 0.05. We see this is the case (.083) and therefore conclude that the residual is normally distributed (Table 7.6).Table 7.6Tests of normality


	Tests of Normality

	 	Kolmogorov-Smirnova

	Shapiro-Wilk

	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	RES_1
	.026
	973
	.113
	.997
	973
	.083


a Lilliefors Significance Correction




Interpret the Regression Model
We have already conducted a regression analysis previously to test the assumptions, so there’s no need to run the analysis again. We only need to interpret Table 7.4 in detail and the two tables that precede this regression table and which we haven’t interpreted previously. These are Tables 7.7 and 7.8.Table 7.7Model summary


	Model Summaryb


	Model
	R
	R Square
	Adjusted R Square
	Std. Error of the Estimate

	1
	.581a

	.338
	.332
	1.40236


a Predictors: (Constant), gender, s21, age, category_3, category_2, s10, s23, s9, s19
b Dependent Variable: commitment



Table 7.8ANOVA table


	ANOVAa


	Model
	Sum of Squares
	df
	Mean Square
	F
	Sig.

	1
	Regression
	966.269
	9
	107.363
	54.593
	.000b


	Residual
	1893.845
	963
	1.967
	 	 
	Total
	2860.114
	972
	 	 	 

a Dependent Variable: commitment
b Predictors: (Constant), gender, s21, age, category_3, category_2, s10, s23, s9, s19




We start our interpretation of the regression model by examining the model fit. To do so, we first check if the model is significant by interpreting the F-test. The p-value under Sig. in Table 7.8 (.000) is clearly lower than 0.05, indicating that the model is significant.14 In the next step, we interpret the model’s R2, which is given in Table 7.7. The value of .338 is moderate but still satisfactory, considering that customer commitment is a rather abstract concept, which is therefore difficult to predict. The adjusted R2 is .332 but this value is only useful when comparing models with different predictors.
After assessing the overall model fit, it is time to look at the individual coefficients shown in Table 7.4. First, we look at the coefficients’ p-values (Sig.) to assess whether these are significant. We find six significant coefficients (s19, s21, s23, category_3, age, and gender), with p-values below 0.05. Note that although the constant is also significant, this is not a variable and is usually excluded from further interpretation. The significant variables require further interpretation. First look at the sign (plus or minus) of the Unstandardized Coefficients Beta column in your interpretation. For example, the more satisfied respondents are with Oddjob Airways service delivery (s19), the higher their commitment. The unstandardized B (or β) is .012, which means that when the variable s19 moves up by one unit (i.e., respondents rate it as 1 higher on average), the dependent variable commitment goes up by 0.012 units. The same logic applies to the interpretation of the other significant coefficients. The interpretation gender is slightly different as this is a dummy variable with only two categories. The negative coefficient of −.347 indicates that moving from the base category (female) to the other category (male) will decrease commitment by 0.347 units. That is, males show less commitment to Oddjob Airways than females. We find that the coefficient of category_3 (Gold) is positive (.010) and significant. Thus, we conclude that flyers in the Gold category show significantly higher levels of commitment than those in the Blue category (i.e., the reference category).
Next, we should check the Standardized Coefficients Beta column to assess which of the variables have the strongest impact on the dependent variable. This cannot be read from the unstandardized βs! Remember that the standardized β allows us to compare the relative effect of differently measured independent variables by expressing the effect in terms of standard deviation changes from the mean. To interpret the standardized βs, we should look at the highest absolute value first, which is .245 for s21 (“Oddjob Airways makes traveling uncomplicated”). This result suggests that to increase their customers’ commitment, Oddjob Airways should focus on making the travelling as uncomplicated as possible. The variable s23 (“Oddjob Airways offers great value for money”) has the second strongest impact on customer commitment. Note, that while these standardized β coefficients of age and gender also have a significant bearing on the customers’ commitment, they do not indicate much managerial importance.
In this example, we estimated one model as determined by prior research and management input. However, in other instances, we might have alternative models, which we wish to compare in terms of their fit. In Box 7.4, we describe how to do this by using the relative fit statistic AIC.
Box 7.4. Model comparison using the AIC and BIC
AIC and BIC are commonly used metrics to compare models with the same dependent variable but different sets of independent variables. Unfortunately, AIC and BIC cannot be accessed by SPSS’s graphical user interface but only via syntax, which is, however, not difficult to do. To show how to request these metrics, simply run the initial regression model as explained earlier. However, in the final step, instead of clicking OK, click on Paste. This brings up the IBM Statistics Syntax Editor in which you will see a command that starts with the word REGRESSION. Find the line that starts with/STATISTICS and add SELECTION to the end of this line. In our case the resulting code should look like this:
REGRESSION
/DESCRIPTIVES MEAN STDDEV CORR SIG N
/MISSING LISTWISE
/STATISTICS COEFF OUTS R ANOVA COLLIN TOL SELECTION
/CRITERIA = PIN(.05) POUT(.10)
/NOORIGIN
/DEPENDENT commitment
/METHOD = ENTER s9 s10 s19 s21 s23 category_2 category_3 age gender
/SAVE PRED RESID.
Then go to ► Run Statistics ► All, which will produce the output shown in Table 7.9. Under Akaike Information Criterion, we find the AIC value, which is 667.999. Similarly, under Schwarz Bayesian Criterion, we find the BIC value, which is 716.802. We could now re-run the regression model with a different set-up (e.g., omitting s9) and compare the initial model’s AIC and BIC values with those of the new model.Table 7.9Relative measures of fit


	Model Summaryb


	Model
	R
	R Square
	Adjusted R Square
	Std. Error of the Estimate
	Selection Criteria

	Akaike Information Criterion
	Amemiya Prediction Criterion
	Mallows' Prediction Criterion
	Schwarz Bayesian Criterion

	1
	.581a

	.338
	.332
	1.40236
	667.999
	.676
	10.000
	716.802


a Predictors: (Constant), gender, s21, age, category_3, category_2, s10, s23, s9, s19
b Dependent Variable: commitment




Validate the Regression Model Using SPSS
Next, we need to validate the model. Let’s first split-validate our model by randomly selecting 30 % of the cases. Note that we need to make sure that the 30 % of cases left still meet the minimum sample size requirements, else split validation should not be conducted. To do this, go to ► Data ► Select Cases, which will open a dialog box like in Fig. 7.16. Then click on Random sample of cases, followed by Sample. Type 30 in the box Approximately … % of all cases and click on Continue. Before clicking on OK, make sure to select Filter out unselected cases under Output. Now click on OK. SPSS will now produce a new variable filter_$ to the dataset, which takes the value 1 if an observation has been selected, and 0 else. When running an analysis, SPSS now only considers those observations with a value of 1. However, our aim is to compare the regression results from the 30 % of the dataset with the other 70 % of the dataset. Hence, we should go ► Data ► Select Cases and select All cases. Next, we need to tell SPSS to run separate regressions for all observations where filter_$ = 0 versus filter_$ = 1. This can easily be done by using the split file command, which we can find under ► Data ► Split File. In the dialog box that opens (Fig. 7.17), select the option Organize output by groups, move the filter_$ variable into the Groups Based on box, and click on OK.[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig16_HTML.jpg]
Fig. 7.16The select cases dialog box


[image: ../images/210704_3_En_7_Chapter/210704_3_En_7_Fig17_HTML.jpg]
Fig. 7.17The Split File dialog box



We now have two groups of data, which SPSS analyses separately when re-running the regression analysis. We do not show the model estimation results since the selection of cases is random and therefore will not match the output you obtain! Check if the results obtained from the analysis of the estimation sample (i.e., the 70 %) and validation sample (i.e., the 30 %) are similar. It is likely some effects will change but the general pattern should not change. This means that the signs of the regression coefficients should be the same in the estimation sample and validation sample. Similarly, when sorting the coefficients by size, the ordering should be identical across the samples.
As we have no second dataset available, we cannot re-run the analysis to compare results between datasets. We do, however, have access to other variables such as country. If we add this variable, we should check again if the models are similar. If they are, we can conclude that the results are stable.
7.5 Farming with AgriPro (Case Study)
Case Study
AgriPro (http://​www.​agriprowheat.​com) is a firm based in Colorado, USA, which does research on and produces genetically modified wheat seed. Every year, AgriPro conducts thousands of experiments on different varieties of wheat seeds in different USA locations. In these experiments, the agricultural and economic characteristics, regional adaptation, and yield potential of different varieties of wheat seeds are investigated. In addition, the benefits of the wheat produced, including the milling and baking quality, are examined. If a new variety of wheat seed with superior characteristics is identified, AgriPro produces and markets it throughout the USA and parts of Canada.
AgriPro’s product is sold to farmers through their distributors, known in the industry as growers. Growers buy wheat seed from AgriPro, grow wheat, harvest the seeds, and sell the seed to local farmers, who plant them in their fields. These growers also provide the farmers, who buy their seeds, with expert local knowledge about management and the environment.
AgriPro sells its products to these growers in several geographically defined markets. These markets are geographically defined, because the different local conditions (soil, weather, and local plant diseases) force AgriPro to produce different products. One of these markets, the heartland region of the USA, is an important AgriPro market, but the company has been performing below the management expectations in it. The heartland region includes the states of Ohio, Indiana, Missouri, Illinois, and Kentucky.
To help AgriPro understand more about farmers in the heartland region, it commissioned a marketing research project involving the farmers in these states. AgriPro, together with a marketing research firm, designed a survey, which included questions regarding what farmers planting wheat find important, how they obtain information on growing and planting wheat, what is important for their purchasing decision, and their loyalty to and satisfaction with the top five wheat suppliers (including AgriPro). In addition, questions were asked about how many acres of farmland the respondents farm, how much wheat they planted, how old they were, and their level of education.
This survey was mailed to 650 farmers from a commercial list that includes nearly all farmers in the heartland region. In all, 150 responses were received, resulting in a 23 % response rate. The marketing research firm also assisted AgriPro to assign variable names and labels. They did not delete any questions or observations due to nonresponse to items.
Your task is to analyze the dataset further and, based on the dataset, provide the AgriPro management with advice. This dataset is labeled Agripro.sav and is available in the ⤓ Web Appendix (→ ► Chap. 7 → Downloads). Note that the dataset contains the variable names and labels matching those in the survey. In the Web Appendix (⤓ Web Appendix → Downloads), we also include the original survey.15
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To help you with this task, AgriPro has prepared several questions that it would like to see answered:	1.What do these farmers find important when growing wheat? Please describe the variables import1 (“Wheat fulfills my rotational needs”), import2 (“I double crop soybeans”), import3 (“Planting wheat improves my corn yield”), import4 (“It helps me break disease and pest cycles”), and import5 (“It gives me summer cash flow”) and interpret.

 

	2.What drives how much wheat these farmers grow (wheat)? Agripro management is interested in whether import1, import2, import3, import4, and import5 can explain wheat. Please run this regression model and test the assumptions. Can you report on this model to AgriPro’s management? Please discuss.

 

	3.Please calculate the AIC and BIC for the model discussed in question 2. Then add the variables acre and age. Calculate the AIC and BIC again. Which model is better? Should we present the model with or without acre and age to our client?

 

	4.AgriPro expects that farmers who are more satisfied with their products devote a greater percentage of their total number of acres to wheat (wheat). Please test this assumption by using regression analysis. The client has requested that you control for the number of acres of farmland (acre), the age of the respondent (age), the quality of the seed (var3), and the availability of the seed (var4), and check the assumptions of the regression analysis. Note that a smaller sample size is available for this analysis, which means the sample size requirement cannot be met. Proceed with the analysis nevertheless. Are all the other assumptions satisfied? If not, is there anything we can do about this, or should we ignore the assumptions if they are not satisfied?

 

	5.Agripro wants you to consider which customers are most loyal to its biggest competitor Pioneer (loyal5). Use the number of acres (acre), number of acres planted with wheat (wheat), and the age of the respondent (age). What findings do we obtain? Does this regression model meet the requirements and assumptions?

 

	6.As an AgriPro’s consultant, and based on this study’s empirical findings, what marketing advice do you have for AgriPro’s marketing team? Using bullet points, provide four or five carefully thought through suggestions.

 





7.6 Review Questions

              	1.Explain what regression analysis is in your own words.

 

	2.Imagine you are asked to use regression analysis to explain the profitability of new supermarket products, such as the introduction of a new type of jam or yoghurt, during the first year of their launch. Which independent variables would you use to explain these new products’ profitability?

 

	3.Imagine you have to present the findings of a regression model to a client. The client believes that the regression model is a “black box” and that anything can be made significant. What would your reaction be?

 

	4.I do not care about the assumptions—just give me the results! Please evaluate this statement in the context of regression analysis. Do you agree?

 

	5.Are all regression assumptions equally important? Please discuss.

 

	6.Using standardized βs, we can compare effects between different variables. Can we compare apples and oranges after all? Please discuss.

 

	7.Try adding or deleting variables from the regression model in the Oddjob Airways example and use the adjusted R2, as well as AIC statistic, to assess if these models are better.
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Footnotes
1Strictly speaking, the difference between the predicted and the observed y-values is [image: 
$\hat e.$
]


 

2This only applies to the standardized βs.

 

3This is only a requirement if you are interested in the regression coefficients, which is the dominant use of regression. If you are only interested in prediction, collinearity is not important.

 

4A related measure is the tolerance
                        
                      , which is 1/VIF and calculated as 1/(1−R2).

 

5The VIF is calculated using a completely separate regression analysis. In this regression analysis, the variable for which the VIF is calculated is regarded as a dependent variable and all other independent variables are regarded as independents. The R2 that this model provides is deducted from 1 and the reciprocal value of this sum (i.e., 1/(1−R2)) is the VIF. The VIF is therefore an indication of how much the regression model explains one independent variable. If the other variables explain much of the variance (the VIF is larger than 10), collinearity is likely a problem.

 

6This term can be calculated manually, but also by using the function mmult in Microsoft Excel where [image: 
${x^T}x$
] is calculated. Once this matrix has been calculated, you can use the minverse function to arrive at [image: 
${({x^T}x)^{ - 1}}$
].

 

7The test also includes the predicted values squared and to the power of three.

 

8This hypothesis can also be read as that a model with only an intercept is sufficient.

 

9The AIC is specifically calculated as [image: 
$AIC = {\text{n}}\left[ {{\text{log}}\left( {\frac{{{\text{S}}{{\text{S}}_{\text{E}}}}}{{\text{n}}}} \right) + \:\frac{{2{\text{k}}}}{{\text{n}}}} \right]$
], where SSE is the error sum of squares, n is the number of observations and k the number of independent variables, while the BIC is calculated as [image: 
$BIC = {\text{n}}\left[ {{\text{log}}\left( {\frac{{{\text{S}}{{\text{S}}_{\text{E}}}}}{{\text{n}}}} \right) + \:\frac{{{\text{k}} \cdot {\text{log}}\left( {\text{n}} \right)}}{{\text{n}}}} \right]$
]. Note that these formulations only hold in case of normally distributed residuals with constant variance (Burnham and Anderson 2013).

 

10Cohen’s (1994) classical article “The Earth is Round (p < .05)” offers an interesting discussion on significance and effect sizes.

 

11It is possible to compare regression coefficients statistically, avoiding the need to the subjectivity of “similar.” Strictly speaking, the test for comparing coefficients is z-distributed with [image: 
${\text{z}} = \frac{{{b_1} - {b_2}}}{{\sqrt {SE_1^2 + SE_2^2} }}$
] (see Paternoster et al. 1998).

 

12Note that this only works, as shown in the lower left of Fig. 7.7, if the “Python essentials” are installed.

 

13Note that it is better to calculate if the R2 increase is significant (as for Ramsey’s RESET test) but this needs to be done manually and falls outside of the scope of this book.

 

14Note that a p-value is never exactly zero, but has values different from zero in later decimal places.

 

15We would like to thank Dr. D.I. Gilliland and AgriPro for making the data and case study available.
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8.1 Introduction
Principal component analysis (PCA)
                
               and factor analysis
                
               (also called principal factor analysis
                
               or principal axis factoring
                
              ) are two methods for identifying structure within a set of variables. Many analyses involve large numbers of variables that are difficult to interpret. Using PCA or factor analysis helps find interrelationships between variables (usually called items) to identify a smaller number of unifying variables called factors
                
              . Consider the example of a soccer club whose management wants to measure the satisfaction of the fans. The management could, for instance, measure fan satisfaction by asking how satisfied the fans are with the (1) assortment of merchandise, (2) quality of merchandise, and (3) prices of merchandise. It is likely that these three items together measure satisfaction with the merchandise. Through the application of PCA or factor analysis, we can determine whether a single factor represents the three satisfaction items well. Practically, PCA and factor analysis are applied to understand much larger sets of variables, tens or even hundreds, when just reading the variables’ descriptions does not determine an obvious or immediate number of factors.
PCA and factor analysis both explain patterns of correlations within a set of observed variables. That is, they identify sets of highly correlated variables and infer an underlying factor structure. While PCA and factor analysis are very similar in the way they arrive at a solution, they differ fundamentally in their assumptions of the variables’ nature and their treatment in the analysis. Due to these differences, the methods follow different research objectives, which dictate their areas of application. While the PCA’s objective is to reproduce a data structure, as well as possible only using a few factors, factor analysis aims to explain the variables’ correlations using factors (e.g., Hair et al. 2010; Matsunaga 2010; Mulaik 2009).1 We will discuss these differences and their implications in this chapter.
Both PCA and factor analysis can be used for exploratory or confirmatory purposes. What are exploratory and confirmatory factor analyses? Comparing the left and right panels of Fig 8.1 shows us the difference. Exploratory factor analysis
                
              , often simply referred to as EFA, does not rely on previous ideas on the factor structure we may find. That is, there may be relationships (indicated by the arrows) between each factor (indicated by ovals) and each item. While some of these relationships may be weak (indicated by the dotted arrows), others are more pronounced, suggesting that these items represent an underlying factor well. The left panel of Fig. 8.1 illustrates this point. Thus, an exploratory factor analysis reveals the number of factors and the items belonging to a specific factor. In a confirmatory factor analysis
                
              , usually simply referred to as CFA, there may only be relationships between a factor and specific items. In the right panel of Fig. 8.1, the first three items relate to factor 1, whereas the last two items relate to factor 2. Different from the exploratory factor analysis, in a confirmatory factor analysis, we have clear expectations of the factor structure (e.g., because researchers have proposed a scale that we want to adapt for our study) and we want to test for the expected structure.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig1_HTML.png]
Fig. 8.1Exploratory factor analysis (left) and confirmatory factor analysis (right)



In this chapter, we primarily deal with exploratory factor analysis, as it conveys the principles that underlie all factor analytic procedures and because the two techniques are (almost) identical from a statistical point of view. Nevertheless, we will also discuss an important aspect of confirmatory factor analysis, namely reliability analysis
                
              , which tests the consistency of a measurement scale (see Chap.​ 3). We will also briefly introduce a specific confirmatory factor analysis approach called structural equation modeling
                
               (often simply referred to as SEM). Structural equation modeling differs statistically and practically from PCA and factor analysis. It is not only used to evaluate how well observed variables relate to factors but also to analyze hypothesized relationships between factors that the researcher specifies prior to the analysis based on theory and logic.
8.2 Understanding Principal Component and Factor Analysis
8.2.1 Why Use Principal Component and Factor Analysis?
Researchers often face the problem of large questionnaires comprising many items
                  
                . For example, in a survey of a major German soccer club, the management was particularly interested in identifying and evaluating performance features that relate to soccer fans’ satisfaction (Sarstedt et al. 2014). Examples of relevant features include the stadium, the team composition and their success, the trainer, and the management. The club therefore commissioned a questionnaire comprising 99 previously identified items by means of literature databases and focus groups of fans. All the items were measured on scales ranging from 1 (“very dissatisfied”) to 7 (“very satisfied”). Table 8.1 shows an overview of some items considered in the study.Table 8.1Items in the soccer fan satisfaction study


	Satisfaction with …

	Condition of the stadium
	Public appearances of the players

	Interior design of the stadium
	Number of stars in the team

	Outer appearance of the stadium
	Interaction of players with fans

	Signposting outside the stadium
	Volume of the loudspeakers in the stadium

	Signposting inside the stadium
	Choice of music in the stadium

	Roofing inside the stadium
	Entertainment program in the stadium

	Comfort of the seats
	Stadium speaker

	Video score boards in the stadium
	Newsmagazine of the stadium

	Condition of the restrooms
	Price of annual season ticket

	Tidiness within the stadium
	Entry fees

	Size of the stadium
	Offers of reduced tickets

	View onto the playing field
	Design of the home jersey

	Number of restrooms
	Design of the away jersey

	Sponsors’ advertisements in the stadium
	Assortment of merchandise

	Location of the stadium
	Quality of merchandise

	Name of the stadium
	Prices of merchandise

	Determination and commitment of the players
	Pre-sale of tickets

	Current success regarding matches
	Online-shop

	Identification of the players with the club
	Opening times of the fan-shops

	Quality of the team composition
	Accessibility of the fan-shops

	Presence of a player with whom fans can identify
	Behavior of the sales persons in the fan shops





As you can imagine, tackling such a large set of items is problematic, because it provides quite complex data. Given the task of identifying and evaluating performance features that relate to soccer fans’ satisfaction (measured by “Overall, how satisfied are you with your soccer club”), we cannot simply compare the items on a pairwise basis. It is far more reasonable to consider the factor structure first. For example, satisfaction with the condition of the stadium (x1), outer appearance of the stadium (x2), and interior design of the stadium (x3) cover similar aspects that relate to the respondents’ satisfaction with the stadium. If a soccer fan is generally very satisfied with the stadium, he/she will most likely answer all three items positively. Conversely, if a respondent is generally dissatisfied with the stadium, he/she is most likely to be rather dissatisfied with all the performance aspects of the stadium, such as the outer appearance and interior design. Consequently, these three items are likely to be highly correlated—they cover related aspects of the respondents’ overall satisfaction with the stadium. More precisely, these items can be interpreted as manifestations of the factor capturing the “joint meaning” of the items related to it. The arrows pointing from the factor to the items in Fig. 8.1 indicate this point. In our example, the “joint meaning” of the three items could be described as satisfaction with the stadium, since the items represent somewhat different, yet related, aspects of the stadium. Likewise, there is a second factor that relates to the two items x4 and x5, which, like the first factor, shares a common meaning, namely satisfaction with the merchandise.
PCA and factor analysis are two statistical procedures that draw on item correlations in order to find a small number of factors. Having conducted the analysis, we can make use of few (uncorrelated) factors instead of many variables, thus significantly reducing the analysis’s complexity. For example, if we find six factors, we only need to consider six correlations between the factors and overall satisfaction, which means that the recommendations will rely on six factors.
8.2.2 Analysis Steps
Like any multivariate analysis method, PCA and factor analysis are subject to certain requirements, which need to be met for the analysis to be meaningful. A crucial requirement is that the variables need to exhibit a certain degree of correlation. In our example in Fig. 8.1, this is probably the case, as we expect increased correlations between x1, x2, and x3, on the one hand, and between x4 and x5 on the other. Other items, such as x1 and x4, are probably somewhat correlated, but to a lesser degree than the group of items x1, x2, and x3 and the pair x4 and x5. Several methods allow for testing whether the item correlations are sufficiently high.
Both PCA and factor analysis strive to reduce the overall item set to a smaller set of factors. More precisely, PCA extracts factors such that they account for variables’ variance, whereas factor analysis attempts to explain the correlations between the variables. Whichever approach you apply, using only a few factors instead of many items reduces its precision, because the factors cannot represent all the information included in the items. Consequently, there is a trade-off between simplicity and accuracy. In order to make the analysis as simple as possible, we want to extract only a few factors. At the same time, we do not want to lose too much information by having too few factors. This trade-off has to be addressed in any PCA and factor analysis when deciding how many factors to extract from the data.
Once the number of factors to retain from the data has been identified, we can proceed with the interpretation of the factor solution. This step requires us to produce a label for each factor that best characterizes the joint meaning of all the variables associated with it. This step is often challenging, but there are ways of facilitating the interpretation of the factor solution. Finally, we have to assess how well the factors reproduce the data. This is done by examining the solution’s goodness-of-fit, which completes the standard analysis. However, if we wish to continue using the results in further analyses, we need to calculate the factor scores. Factor scores are linear combinations of the items and can be used as variables in follow-up analyses.
Figure 8.2 illustrates the steps involved in the analysis; we will discuss these in more detail in the following sections. In doing so, our theoretical descriptions and illustrations will focus on the PCA, as this method is easier to grasp. However, most of our descriptions also apply to factor analysis.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig2_HTML.png]
Fig. 8.2Steps involved in a PCA



8.3 Principal Component Analysis
8.3.1 Check Requirements and Conduct Preliminary Analyses
Before carrying out a PCA, we have to consider several requirements, which we can test by answering the following questions:	Are the measurement scales appropriate?

	Is the sample size sufficiently large?

	Are the observations independent?

	Are the variables sufficiently correlated?





Are the measurement scales appropriate?
For a PCA, it is best to have data measured on an interval or ratio scale. In practical applications, items measured on an ordinal scale level have become common. Ordinal scales can be used if:	the scale points are equidistant, which means that the difference in the wording between scale steps is the same (see Chap.​ 3), and


	there are five or more response categories.





Is the sample size sufficiently large?
Another point of concern is the sample size. As a rule of thumb, the number of (valid) observations should be at least ten times the number of items used for analysis. This only provides a rough indication of the necessary sample size. Fortunately, researchers have conducted studies to determine minimum sample size requirements, which depend on other aspects of the study. MacCallum et al. (1999) suggest the following:	When all communalities (we will discuss this term in Sect. 8.3.2.4) are above 0.60, small sample sizes of below 100 are adequate.

	With communalities around 0.50, sample sizes between 100 and 200 are sufficient.

	When communalities are consistently low, with many or all under 0.50, a sample size between 100 and 200 is adequate if the number of factors is small and each of these is measured with six or more items.

	When communalities are consistently low and the factors numbers are high or are measured with only few items (i.e., 3 or less), 300 observations are recommended.





Are the observations independent?
We have to ensure that the observations are independent. This means that the observations need to be completely unrelated (see Chap.​ 3). If we use dependent observations, we would introduce “artificial” correlations, which are not due to an underlying factor structure, but simply to the same respondents having answered the same questions multiple times.
Are the variables sufficiently correlated?
As indicated before, PCA is based on correlations between items. Consequently, conducting a PCA only makes sense if the items correlate sufficiently. The problem is deciding what “sufficient” actually means.
An obvious step is to examine the correlation matrix (Chap.​ 5). Naturally, we want the correlations between different items to be as high as possible, but they will not always be. In our previous example, we expect high correlations between x1, x2, and x3, on the one hand, and x4 and x5 on the other. Conversely, we might expect lower correlations between, for example, x1 and x4 and between x3 and x5. Thus, not all of the correlation matrix’s elements need to have high values. The PCA depends on the relative size of the correlations. Therefore, if single correlations are very low, this is not necessarily problematic! Only when all the correlations are around zero, PCA is no longer useful. In addition, the statistical significance of each correlation coefficient helps decide whether it differs significantly from zero.
There are additional measures to determine whether the items correlate sufficiently. One is the anti-image
                    
                  . The anti-image describes the portion of an item’s variance that is independent of another item in the analysis. Obviously, we want all items to be highly correlated, so that the anti-images of an item set are as small as possible. Initially, we do not interpret the anti-image values directly, but use a measure based on the anti-image concept: The Kaiser–Meyer–Olkin (KMO)
                    
                   criterion. The KMO criterion, also called the measure of sampling adequacy (MSA),
                    
                   indicates whether the other variables in the dataset can explain the correlations between variables. Kaiser (1974), who introduced the statistic, recommends a set of nicely labeled threshold values for KMO and MSA, which Table 8.2 presents.Table 8.2Threshold values for KMO and MSA


	KMO/MSA value
	Adequacy of the correlations

	Below 0.50
	Unacceptable

	0.50–0.59
	Miserable

	0.60–0.69
	Mediocre

	0.70–0.79
	Middling

	0.80–0.89
	Meritorious

	0.90 and higher
	Marvelous





The Bartlett’s test of sphericity
                    
                   can be used to test the null hypothesis that the correlation matrix is a diagonal matrix (i.e., all non-diagonal elements are zero) in the population. Since we need high correlations for PCA, we want to reject the null hypothesis. A large test statistic value and corresponding a small p-value will favor the rejection of the hypothesis. In practical applications, it is virtually impossible not to reject this null hypothesis, as typically there are some correlations, particularly in larger sets of items. In addition, PCA is typically used with large samples, a situation, which favors the rejection of the null hypothesis. Thus, Bartlett’s test is of rather limited value for assessing whether the variables are sufficiently correlated.
To summarize, the correlation matrix with the associated significance levels provides a first insight into the correlation structures. However, the final decision of whether the data are appropriate for PCA should be primarily based on the KMO statistic. If this measure indicates sufficiently correlated variables, we can continue the analysis of the results. If not, we should try to identify items that correlate only weakly with the remaining items and remove them. In Box 8.1, we discuss how to do this.
Box 8.1 Identifying problematic items
Examining the correlation matrix and the significance levels of correlations allows identifying items that correlate only weakly with the remaining items. An even better approach is examining the variable-specific MSA values, which are interpreted like the overall KMO statistic (see Table 8.2). In fact, the KMO statistic is simply the overall mean of all variable-specific MSA values. Consequently, all the MSA values should also lie above the threshold level of 0.50. If this is not the case, consider removing this item from the analysis. An item’s communality (see Sect. 8.3.2.4) can also serve as a useful indicator of how well the factors extracted represent an item. However, communalities are mostly considered when evaluating the solution’s goodness-of-fit.
8.3.2 Extract the Factors
8.3.2.1 Principal Component Analysis vs. Factor Analysis
Factor analysis assumes that each variable’s variance can be divided into common variance (i.e., variance shared with all the other variables in the analysis) and unique variance (Fig. 8.3), the latter of which can be further broken down into specific variance (i.e., variance associated with only one specific variable) and error variance (i.e., variance due to measurement error). The method, however, can only reproduce common variance. Thereby factor analysis explicitly recognizes the presence of error. Conversely, PCA assumes that all variance is common variance, which factor extraction can fully explain (e.g., Preacher and MacCallum 2003). These differences entail different interpretations of the analysis’s outcomes. PCA asks:[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig3_HTML.png]
Fig. 8.3Principal component analysis vs. factor analysis


Which umbrella term can we use to summarize a set of variables that loads highly on a specific factor?



Conversely, factor analysis asks:What is the common reason for the strong correlations between a set of variables?



From a theoretical perspective, the assumption that there is a unique variance for which the factors cannot fully account, is generally more realistic, but simultaneously more restrictive. Although theoretically sound, this restriction can sometimes lead to complications in the analysis, which have contributed to the widespread use of PCA, especially in market research practice.
Researchers usually suggest using PCA when data reduction is the primary concern; that is, when the focus is to extract a minimum number of factors that account for a maximum proportion of the variables’ total variance. In contrast, if the primary concern is to identify latent dimensions represented in the variables, factor analysis should be applied. However, prior research has shown that both approaches arrive at essentially the same result when	more than 30 variables are used, or


	most of the variables’ communalities exceed 0.60.





With 20 or fewer variables and communalities below 0.40—which are clearly undesirable in empirical research—the differences are probably pronounced (Stevens 2009).
Apart from these conceptual differences in the variables’ nature, PCA and factor analysis differ in the aim of their analysis. Whereas the goal of factor analysis is to explain the correlations between the variables, PCA focuses on explaining the variables’ variances. That is, the PCA’s objective is to determine the linear combinations of the variables that retain as much information from the original variables as possible. Strictly speaking, PCA does not extract factors, but components
                    
                  , which are labeled as such in SPSS.
Despite these differences, which have very little relevance in many common research settings in practice, PCA and factor analysis have many points in common. For example, the methods follow very similar ways to arrive at a solution and their interpretations of statistical measures, such as KMO, eigenvalues, or factor loadings, are (almost) identical. In fact, SPSS blends these two procedures when running a PCA as the program initially applies a factor analysis but rescales the estimates such that they conform to a PCA. That way, the analysis assumes that the entire variance is common but produces (rotated) loadings (we will discuss factor rotation in Sect. 8.3.4.1), which facilitate the interpretation of the factors.
Despite the small differences of PCA and factor analysis in most research settings, researchers have strong feelings about the choice of PCA or factor analysis. Cliff (1987, p. 349) summarizes this issue well, by noting that proponents of factor analysis “insist that components analysis is at best a common factor analysis with some error added and at worst an unrecognizable hodgepodge of things from which nothing can be determined.” For further discussions on this topic, see also Velicer and Jackson (1990) and Widaman (1993).2

8.3.2.2 How Does Factor Extraction Work?
When extracting factors
                    
                  , PCA’s objective is to reproduce a data structure with only a few factors. PCA does this by generating a new set of factors as linear composites of the original variables, which reproduces the original variables’ variance as best as possible. These linear composites are called principal components
                    
                  , but, for simplicity’s sake, we refer to them as factors. More precisely, PCA computes eigenvectors
                    
                  . These eigenvectors include so called factor weights
                    
                  , which extract the maximum possible variance of all the variables, with successive factoring continuing until a significant share of the variance is explained.
Operationally, the first factor is extracted in such a way that it maximizes the variance accounted for in the variables. We can visualize this easily by examining the vector space illustrated in Fig. 8.4. In this example, we have five variables (x1−x5) represented by five vectors starting at the zero point, with each vector’s length standardized to one. To maximize the variance accounted for, the first factor F1 is fitted into this vector space in such a way that the sum of all the angles between this factor and the five variables in the vector space is minimized. We do this to interpret the angle between two vectors as correlations. For example, if the factor’s vector and a variable’s vector are congruent, the angle between these two is zero, indicating that the factor and the variable correlate perfectly. On the other hand, if the factor and the variable are uncorrelated, the angle between these two is 90°. This correlation between a (unit-scaled) factor and a variable is called the factor loading
                    
                  . Note that factor weights and factor loadings essentially express the same thing—the relationships between variables and factors—but they are based on different scales.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig4_HTML.png]
Fig. 8.4Factor extraction3




After extracting F1, a second factor (F2) is extracted, which maximizes the remaining variance accounted for. The second factor is fitted at a 90° angle into the vector space (Fig. 8.4) and is therefore uncorrelated with the first factor.4 If we extract a third factor, it will explain the maximum amount of variance for which factors 1 and 2 have hitherto not accounted. This factor will also be fitted at a 90° angle to the first two factors, making it independent from the first two factors (we don’t illustrate this third factor in Fig. 8.4, as this is a three-dimensional space). The fact that the factors are uncorrelated is an important feature, as we can use them to replace many highly correlated variables in follow-up analyses. For example, using uncorrelated factors as independent variables in a regression analysis helps solve potential collinearity
                    
                   issues (Chap.​ 7).
An important PCA feature is that it works with standardized variables (see Chap.​ 5 for an explanation of what standardized variables are). Standardizing variables has important implications for our analysis in two respects. First, we can assess each factor’s eigenvalue, which indicates how much a specific factor extracts all of the variables’ variance (see Sect. 8.3.2.3). Second, the standardization of variables allows for assessing each variable’s communality, which describes how much the factors extracted capture or reproduce each variable’s variance (see Sect. 8.3.2.4).
The Explained Visually webpage offers an excellent illustration of two- and three-dimensional factor extraction.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Figa_HTML.png]
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8.3.2.3 What Are Eigenvalues?
To understand the concept of eigenvalues
                    
                  , think of the soccer fan satisfaction study (Fig. 8.1). In this example, there are five variables. As all the variables are standardized prior to the analysis, each has a variance of 1. In a simplified way, we could say that the overall information (i.e., variance) that we want to reproduce through factor extraction is 5 units. Let’s assume that we extract the two factors presented above.
The first factor’s eigenvalue indicates how much of the total variance the factor accounts for. Each variable has a variance of 1, which means the number of variables is the total variance (i.e., 5 variables = 5 units of variance). If a factor has an eigenvalue of, let’s say 2.10, it covers the information of 2.10 variables or, put differently, accounts for 2.10/5.00 = 42 % of the overall variance (Fig. 8.5).[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig5_HTML.png]
Fig. 8.5Total variance explained by variables and factors



Extracting a second factor will allow us to explain another part of the remaining variance (i.e., 5.00 − 2.10 = 2.90 units, Fig. 8.5). However, the eigenvalue of the second factor will always be smaller than that of the first factor. Assume that the second factor has an eigenvalue of 1.30 units. The second factor then accounts for 1.30/5.00 = 26 % of the overall variance. Together, these two factors explain (2.10 + 1.30)/5.00 = 68 % of the overall variance. Every additional factor extracted increases the variance accounted for until we have extracted as many factors as there are variables. In this case, the factors account for 100 % of the overall variance, which means that the factors reproduce the complete variance.
Following the PCA approach, we assume that factor extraction can reproduce each variable’s entire variance. In other words, we assume that each variable’s variance is common; that is, the variance is shared with other variables. This differs in factor analysis, in which each variable can also have a unique variance.
For readers interested in the statistical principles, the Explained Visually webpage illustrates the concepts of eigenvalues and eigenvectors.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Figb_HTML.png]
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8.3.2.4 What Is Communality?
Whereas the eigenvalue tells us how much variance each factor accounts for, the communality
                    
                   indicates how much variance of each variable factor extraction can reproduce. There is no commonly agreed threshold for a variable’s communality, as this depends strongly on the complexity of the analysis at hand. However, generally, the extracted factors should account for at least 50 % of a variable’s variance. Thus, the communalities should be above 0.50. Every additional factor extracted will increase the explained variance, and if we extract as many factors as there are variables (in our example five), each variable’s communality would be 1.00. The factors extracted would then fully explain each variable; that is, the first factor will explain a certain amount of each variable’s variance, the second factor another part, and so on.
However, since our overall objective is to reduce the number of variables through factor extraction, we should extract only a few factors that account for a high degree of overall variance. This raises the question of how to decide on the number of factors to extract from the data, which we discuss in the following section.
8.3.3 Determine the Number of Factors
Determining the number of factors to extract from the data is a crucial and challenging step in any PCA. Several approaches offer guidance in this respect, but most researchers do not pick just one method, but use multiple ones. If different methods suggest the same number of factors, this leads to greater confidence in the results.
8.3.3.1 The Kaiser Criterion
An intuitive way to decide on the number of factors is to extract all the factors with an eigenvalue greater than 1. The reason for this is that each factor with an eigenvalue greater than 1 accounts for more variance than a single variable (remember, we are looking at standardized variables, which is why each variable’s variance is exactly 1). As the objective of PCA is to reduce the overall number of variables, each factor should of course account for more variance than a single variable can. If this occurs, then this factor is useful for reducing the set of variables. Extracting all the factors with an eigenvalue greater than 1 is frequently called the Kaiser criterion
                    
                   or latent root criterion
                    
                   and is commonly used to determine the number of factors. However, the Kaiser criterion is well known for overspecifying the number of factors; that is, the criterion suggests more factors than it should (e.g., Russell 2002; Zwick and Velicer 1986).
8.3.3.2 The Scree Plot
Another popular way to decide on the number of factors to extract is to plot each factor’s eigenvalue (y-axis) against the factor with which it is associated (x-axis). This results in a scree plot
                    
                  , which typically has a distinct break in it, thereby showing the “correct” number of factors (Cattell 1966). This distinct break is called the “
                    
                  .” Researchers typically recommend retaining all factors above this break, as they contribute most to the explanation of the variance in the dataset. Thus, we select one factor less than indicated by the elbow.
8.3.3.3 Parallel Analysis
A large body of review papers and simulation studies has produced a prescriptive consensus that Horn’s (1965) parallel analysis
                    
                   is the best method for deciding how many factors to extract (e.g., Dinno 2009; Hayton et al. 2004; Henson and Roberts 2006; Matsunga 2010; Zwick and Velicer 1986). The rationale underlying parallel analysis is that factors from real data with a valid underlying factor structure should have larger eigenvalues than those derived from randomly generated data (actually pseudorandom deviates) with the same sample size and number of variables. Parallel analysis involves several steps. First, a large number of datasets are randomly generated that have the same number of observations and variables as the original dataset. Parallel PCAs are then run on each of the datasets (hence, parallel analysis), resulting in many slightly different sets of randomly generated eigenvalues. We then compare the randomly generated eigenvalues with those from the original analysis. Only factors whose original eigenvalues are larger than the 95th percentile of the eigenvalues should be retained (Longman et al. 1989).
8.3.3.4 Expectations
When, for example, replicating a previous market research study, we might have a priori information on the number of factors we want to find. For example, if a previous study suggests that a certain item set comprises five factors, we should extract the same number of factors, even if statistical criteria, such as the scree plot, suggest a different number. Similarly, theory might suggest that a certain number of factors should be extracted from the data.
Strictly speaking, these are confirmatory approaches to PCA, which blur the distinction between these two factor analysis types. Ultimately however, we should not only rely on the data, but keep in mind that the research results should be interpretable and actionable for market research practice. Once we have decided on the number of factors to retain from the data, we can start interpreting the factor solution.
Whatever combination of approaches we use to determine the number of factors, the factors extracted should account for at least 50 % of the total variance explained (75 % or more is recommended).
8.3.4 Interpret the Factor Solution
8.3.4.1 Rotate the Factors
To interpret the solution, we have to determine which variables relate to each of the factors extracted. We do this by examining the factor loadings
                    
                  , which represent the correlations between the factors and the variables and can take values ranging from −1 to +1. A high factor loading indicates that a certain factor represents a variable well. Subsequently, we look for high absolute values, because the correlation between a variable and a factor can also be negative. Using the highest absolute factor loadings, we “assign” each variable to a certain factor and then produce a label for each factor that best characterizes the joint meaning of all the variables associated with it. This labeling is subjective, but a key PCA step. An example of a label is the respondents’ satisfaction with the stadium, which represents the items referring to its condition, outer appearance, and interior design (Fig. 8.1).
We can make use of factor rotation
                    
                   to facilitate the factors’ interpretation. We do not have to rotate the factor solution, but it will facilitate interpreting the findings, particularly if we have a reasonably large number of items (say six or more). To understand what factor rotation is all about, once again consider the factor structure described in Fig. 8.4. Here, we see that both factors relate to the variables in the set. However, the first factor appears to generally correlate more strongly with the variables, whereas the second factor only correlates weakly with the variables (to clarify, we look for small angles between the factors and variables). This implies that we “assign” all variables to the first factor without taking the second into consideration. This does not appear to be very meaningful, as we want both factors to represent certain facets of the variable set. Factor rotation can resolve this problem. By rotating the factor axes, we can create a situation in which a set of variables loads highly on only one specific factor, whereas another set loads highly on another. Figure 8.6 illustrates the factor rotation graphically.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig6_HTML.png]
Fig. 8.6Orthogonal and oblique factor rotation



On the left side of the figure, we see that both factors are orthogonally rotated 49°, meaning that a 90° angle is maintained between the factors during the rotation procedure. Consequently, the factors remain uncorrelated, which is in line with the PCA’s initial objective. By rotating the first factor from F1 to F1′, it is now strongly related to variables x1, x2, and x3, but weakly related to x4 and x5. Conversely, by rotating the second factor from F2 to F2′, it is now strongly related to x4 and x5, but weakly related to the remaining variables. The assignment of the variables is now much clearer, which facilitates the interpretation of the factors significantly.
Various orthogonal rotation
                    
                   methods exist, all of which differ with regard to their treatment of the loading structure. The varimax rotation
                    
                   is the best-known and this procedure aims at maximizing the dispersion of loadings within factors, which means a few variables will have high loadings, while the remaining variables’ loadings will be considerably smaller (Kaiser 1958)
Alternatively, we can choose between several oblique rotation
                    
                   techniques. In oblique rotation, the 90° angle between the factors is not maintained during rotation, and the resulting factors are therefore correlated. Figure 8.6 (right side) illustrates an example of an oblique factor rotation. Promax rotation
                    
                   is a commonly used oblique rotation technique. The promax rotation allows for setting an exponent (referred to as kappa) that needs to be greater than 1. Higher values make the loadings even more extreme (i.e., high loadings are amplified and weak loadings are reduced even further), which is at the cost of stronger correlations between the factors and less total variance explained (Hamilton 2013). A kappa value of 3 works well for most applications. Direct oblimin rotation
                    
                   is a popular alternative oblique rotation type, which allows specifying the maximum degree of obliqueness. This degree is the delta, which determines the level of the correlation allowed between the factors. A delta of zero (the default) ensures that the factors are—if at all—only moderately correlated, which is acceptable for most analyses. Oblique rotation is used when factors are possibly related. It is, for example, very likely that the respondents’ satisfaction with the stadium is related to their satisfaction with other aspects of the soccer club, such as the number of stars in the team or the quality of the merchandise. However, relinquishing the initial objective of extracting uncorrelated factors can diminish the factors’ interpretability. We therefore recommend using the varimax rotation to enhance the interpretability of the results. Only if the results are difficult to interpret, an oblique rotation should be applied. Among the oblique rotation methods, researchers generally recommend the promax (Gorsuch 1983) or oblimin (Kim and Mueller 1978) methods but differences between the rotation types are typically marginal (Brown 2009).
8.3.4.2 Assign the Variables to the Factors
After rotating the factors, we need to interpret them and give each factor a name, which has some descriptive value. Interpreting factors involves assigning each variable to a specific factor based on the highest absolute (!) loading. For example, if a variable has a 0.60 loading with the first factor and a 0.20 loading with the second, we would assign this variable to the first factor. Loadings may nevertheless be very similar (e.g., 0.50 for the first factor and 0.55 for the second one), making the assignment ambiguous. In such a situation, we could assign the variable to another factor, even though it does not have the highest loading on this specific factor. While this step can help increase the results’ face validity (see Chap.​ 3), we should make sure that the variable’s factor loading with the designated factor is above an acceptable level. If very few factors have been extracted, the loading should be at least 0.50, but with a high number of factors, lower loadings of above 0.30 are acceptable. Alternatively, some simply ignore a certain variable if it does not fit with the factor structure. In such a situation, we should re-run the analysis without variables that do not load highly on a specific factor. In the end, the results should be interpretable and actionable, but keep in mind that this technique is, first and foremost, exploratory!
8.3.5 Evaluate the Goodness-of-Fit of the Factor Solution
8.3.5.1 Check the Congruence of the Initial and Reproduced Correlations
While PCA focuses on explaining the variables’ variances, checking how well the method approximates the correlation matrix allows for assessing the quality of the solution (i.e., the goodness-of-fit) (Graffelman 2013). More precisely, to assess the solution’s goodness-of-fit, we can make use of the differences between the correlations in the data and those that the factors imply. These differences are also called correlation residuals
                    
                   and should be as small as possible.
In practice, we check the proportion of correlation residuals with an absolute value higher than 0.05. Even though there is no strict rule of thumb regarding the maximum proportion, a proportion of more than 50 % should raise concern. However, high residuals usually go hand in hand with an unsatisfactory KMO measure; consequently, this problem already surfaces when testing the assumptions.
8.3.5.2 Check How Much of Each Variable’s Variance Is Reproduced by Means of Factor Extraction
Another way to check the solution’s goodness-of-fit is by evaluating how much of each variable’s variance the factors reproduce (i.e., the communality). If several communalities exhibit low values, we should consider removing these variables. Considering the variable-specific MSA measures could help us make this decision (see Box 8.1). If there are more variables in the dataset, communalities usually become smaller; however, if the factor solution accounts for less than 50 % of a variable’s variance (i.e., the variable’s communality is less than 0.50), it is worthwhile reconsidering the set-up.
8.3.6 Compute the Factor Scores
After the rotation and interpretation of the factors, we can compute the factor scores
                  
                , another element of the analysis. Factor scores are linear combinations of the items and can be used as separate variables in subsequent analyses. For example, instead of using many highly correlated independent variables in a regression analysis, we can use few uncorrelated factors to overcome collinearity problems.
The simplest ways to compute factor scores for each observation is to sum all the scores of the items assigned to a factor. While easy to compute, this approach neglects the potential differences in each item’s contribution to each factor (Sarstedt et al. 2016).
Drawing on the item weights produced by the PCA is a more elaborate way of computing factor scores (Hershberger 2005). These weights indicate each item’s relative contribution to forming the factor; we simply multiply the standardized variables’ values with the weights to get the factor scores. Factor scores computed on the basis of item weights have a zero mean. This means that if a respondent has a value greater than zero for a certain factor, he/she scores above the average in terms of the characteristic that this factor describes. Conversely, if a factor score is below zero, then this respondent exhibits the characteristic below average.
Different from the PCA, a factor analysis does not produce determinate factor scores. In other words, the factor is indeterminate, which means that part of it remains an arbitrary quantity, capable of taking on an infinite range of values (e.g., Grice 2001; Steiger 1979). Thus, we have to rely on other approaches to compute factor scores. The use of these approaches is, however, not restricted to factor analysis but extends to PCA, because of the specific way SPSS (and other programs) have implemented the method. The most prominent of these approaches is the regression method
                  
                . This method takes into account (1) the correlation between the factors and variables (via the variable loadings), (2) the correlation between the variables, and (3) the correlation between the factors if oblique rotation has been used (DiStefano et al. 2009). The regression method z-standardizes each factor to zero mean and unit standard deviation.5 We can therefore interpret an observation’s score in relation to the mean and in terms of the units of standard deviation from this mean. For example, an observation’s factor score of 0.79 implies that this observation is 0.79 standard deviations above the average with regard to the corresponding factor.
Another popular approach is the Bartlett method
                  
                , which is similar to the regression method. In SPSS, the method produces factor scores with zero mean and standard deviations larger than one. Owing to the way they are estimated, the factor scores that the Bartlett method produces are considered more accurate (Hershberger 2005). However, in practical applications, both methods produce very similar results. Because of the z-standardization of the scores, which facilitates the comparison of scores across factors, we recommend using the regression method.
In Table 8.3 we summarize the main steps that need to be taken when conducting a PCA or factor analysis in SPSS.Table 8.3Steps involved in carrying out a PCA or factor analysis in SPSS


	Theory
	Action

	
                            Check assumptions and carry out preliminary analyses
                          

	Select variables that should be reduced to a set of underlying factors (PCA) or should be used to identify underlying dimensions (factor analysis)
	► Analyze ► Dimension Reduction ► Factor. Enter the variables in the Variables box.

	Are the variables interval or ratio scaled?
	Determine the measurement level of your variables (see Chap.​ 3). If ordinal variables are used, make sure that the scale steps are equidistant.

	Is the sample size sufficiently large?
	Check MacCallum et al.’s (1999) guidelines for minimum sample size requirements, dependent on the variables’ communality. For example, if all the communalities are above 0.60, small sample sizes of below 100 are adequate. With communalities around 0.50, sample sizes between 100 and 200 are sufficient. Ensure that your dataset meets these thresholds after handling missing values.

	Are the observations independent?
	Determine whether the observations are dependent or independent (see Chap.​ 3).

	Are the variables sufficiently correlated?
	► Analyze ► Dimension Reduction ► Factor ► Descriptives. Tick Coefficients, Significance levels, KMO and Bartlett’s test of sphericity, and Anti-image.
Check whether the KMO ≥ 0.50. Also consider the following measures:
– Are the correlation coefficients different from zero and significant (indicated in the lower part of the correlation matrix under Sig. (1-tailed)?)
– Is the p-value of the Bartlett’s test (indicated by Sig.) ≤ 0.05?
To identify items that are too lowly correlated, check the variable-specific MSA values (indicated in the Anti-Image Correlation table). Are the MSA values ≥ 0.50?

	
                            Extract the factors
                          

	Choose the method of factor analysis
	If the goal is to reduce the number of variables to a set of underlying factors (i.e., principal component analysis):
► Analyze ► Dimension Reduction ► Factor ► Extraction ► Principal components.
If the goal is to identify underlying dimensions (i.e., factor analysis):
► Analyze ► Dimension Reduction ► Factor ► Extraction ►Principal axis factoring

	
                            Determine the number of factors
                          
	 
	Determine the number of factors
	Kaiser criterion: Extract all factor with an eigenvalue greater than 1 (default).
Create a scree plot and select the number left of the distinctive break (elbow).
► Analyze ► Dimension Reduction ► Factor ► Extraction ► Scree plot
Run parallel analysis: Download the syntax file Parallel analysis.sps from the book’s website (⤓Web Appendix → Downloads) and open it in SPSS. Specify the number of observations under compute Ncases (line 10) and the number of variables under compute NVars (line 11). Go to ► Run ► All. Extract those factors whose original eigenvalues are greater than those indicated under Prcntyle.
Pre-specify the number of factors based on a priori information: ► Analyze ► Data Reduction ► Factor ► Extraction ► Fixed number of factors: Factors to extract
Check the Cumulative % column in the Total Variance Explained column.

	
                            Interpret the factor solution
                          
	 
	Rotate the factors
	Use the varimax procedure or, if necessary, the promax procedure with kappa set to 3: ► Analyze ► Dimension Reduction ► Factor ► Rotation.

	Assign variables to factors and interpret the factors
	Use the rotated solution to assign each variable to a certain factor based on the highest absolute loading. To facilitate interpretation, you may also assign a variable to a different factor but check that the loading lies at an acceptable level (0.50 if only few factors are extracted, 0.30 if many factors are extracted).
Find an umbrella term for clusters of items assigned to each factor.

	Compute factor scores
	Save factor scores as new variables using the regression method: ► Analyze ► Dimension Reduction ► Factor ► Scores ► Save as variables: Regression.

	
                            Evaluate the goodness-of-fit of the factor solution
                          

	Check the congruence of the initial and reproduced correlations
	Create a reproduced correlation matrix: ► Analyze ► Dimension Reduction ► Factor ► Descriptives ► Reproduced. Is the proportion of residuals greater than 0.05 ≤ 50 %?

	Check how much of each variable’s variance is reproduced by means of factor extraction
	Examine the communalities from the reproduced correlation matrix. Check if reproduced communalities (on the diagonal) are ≥ 0.50.





8.4 Confirmatory Factor Analysis and Reliability Analysis
Many researchers and practitioners acknowledge the prominent role that exploratory factor analysis plays in exploring data structures. Data can be analyzed without preconceived ideas of the number of factors or how these relate to the variables under consideration. Whereas this approach is, as its name implies, exploratory in nature, the confirmatory factor analysis allows for testing hypothesized structures underlying a set of variables.
In a confirmatory factor analysis
                
              , the researcher needs to first specify the constructs and their associations with variables, which should be based on previous measurements or theory. Instead of allowing the procedure to determine the number of factors, as is done in an exploratory factor analysis, a confirmatory factor analysis tells us how well the actual data fit the pre-specified structure. Returning to our introductory example, we could, for example, assume that the construct satisfaction with the stadium can be measured by the three items x1 (condition of the stadium), x2 (appearance of the stadium), and x3 (interior design of the stadium). Likewise, we could hypothesize that satisfaction with the merchandise can be adequately measured using the items x4 and x5. In a confirmatory factor analysis, we set up a theoretical model linking the items with the respective construct (note that in confirmatory factor analysis, researchers generally use the term construct rather than factor). This process is also called operationalization (see Chap.​ 3) and usually involves drawing a visual representation (called a path diagram
                
              ) indicating the expected relationships.
Figure 8.7 shows a path diagram—you will notice the similarity to the diagram in Fig. 8.1. Ovals represent the constructs (e.g., Y1, satisfaction with the stadium) and boxes represent the items (x1 to x5). Other elements include the relationships between the constructs and respective items (the loadings l1 to l5), the error terms (e1 to e5) that capture the extent to which a construct does not explain a specific item, and the correlations between the constructs of interest (r12).[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig7_HTML.png]
Fig. 8.7Path diagram (confirmatory factor analysis)



Having defined the individual constructs and developed the path diagram, we can estimate the model. The relationships between the constructs and items (the loadings l1 to l5) and the item correlations (not shown in Fig. 8.7) are of particular interest, as they indicate whether the construct has been reliably and validly measured.
Reliability analysis
                
               is an important element of a confirmatory factor analysis and essential when working with measurement scales. The preferred way to evaluate reliability is by taking two independent measurements (using the same subjects) and comparing these using correlations. This is also called test-retest reliability
                
               (see Chap.​ 3). However, practicalities often prevent researchers from surveying their subjects a second time.
An alternative is to estimate the split-half reliability
                
              . In the split-half reliability, scale items are divided into halves and the scores of the halves are correlated to obtain an estimate of reliability. Since all items should be consistent regarding what they indicate about the construct, the halves can be considered approximations of alternative forms of the same scale. Consequently, instead of looking at the scale’s test-retest reliability, researchers consider the scale’s equivalence, thus showing the extent to which two measures of the same general trait agree. We call this type of reliability the internal consistency reliability
                
              .
In the example of satisfaction with the stadium, we compute this scale’s split-half reliability manually by, for example, splitting up the scale into x1 on the one side and x2 and x3 on the other. We then compute the sum of x2 and x3 (or calculate the items’ average) to form a total score and correlate this score with x1. A high correlation indicates that the two subsets of items measure related aspects of the same underlying construct and, thus, suggests a high degree of internal consistency. However, with many items, there are many different ways to split the variables into two groups.
Cronbach (1951) proposed calculating the average of all possible split-half coefficients resulting from different ways of splitting the scale items. The Cronbach’s Alpha
                
               coefficient has become by far the most popular measure of internal consistency. In the example above, this would comprise calculating the average of the correlations between (1) x1 and x2 + x3, (2) x2 and x1 + x3, as well as (3) x3 and x1 + x2. The Cronbach’s Alpha coefficient generally varies from 0 to 1, whereas a generally agreed lower limit for the coefficient is 0.70. However, in exploratory studies, a value of 0.60 is acceptable, while values of 0.80 or higher are regarded as satisfactory in the more advanced stages of research (Hair et al. 2011). In Box 8.2, we provide more advice on the use of Cronbach’s Alpha. We will illustrate a reliability analysis using the standard SPSS module in the example at the end of this chapter.
Box 8.2 Things to consider when calculating Cronbach’s Alpha
When calculating Cronbach’s Alpha, ensure that all items are formulated in the same direction (positively or negatively worded). For example, in psychological measurement, it is common to use both negatively and positively worded items in a questionnaire. These need to be reversed prior to the reliability analysis. In SPSS, this can be achieved using the Recode option discussed in Chap.​ 5. Furthermore, we have to be aware of there being multiple factors in our item set. Some multi-item scales comprise subsets of items that measure different facets of a multidimensional construct. For example, soccer fan satisfaction is a multidimensional construct that includes aspects such as satisfaction with the stadium, the merchandise (as described above), the team, and the coach. Each of these factors is measured using different sets of items, whose consistency has to be evaluated separately. Calculating one Cronbach’s Alpha over 99 items would certainly be inappropriate. Cronbach’s Alpha is always calculated over the items belonging to one construct and not all items in the dataset!
8.5 Structural Equation Modeling
Whereas a confirmatory factor analysis involves testing if and how items relate to specific constructs, structural equation modeling
                
               involves the estimation of relations between these constructs. It has become one of the most important methods in social sciences, including marketing research.
There are broadly two approaches to structural equation modeling: Covariance-based structural equation modeling
                
               (e.g., Jöreskog 1971) and partial least squares structural equation modeling
                
               (e.g., Wold 1982), simply referred to as CB-SEM and PLS-SEM. Both estimation methods are based on the idea of an underlying model that allows the researcher to test relationships between multiple items and constructs.
Figure 8.8 shows an example path diagram with four constructs (represented by circles or ovals) and their respective items (represented by boxes).6 A path model incorporates two types of constructs: (1) exogenous constructs (here, satisfaction with the stadium (Y1) and satisfaction with the merchandise (Y2)) that do not depend on other constructs, and (2) endogenous constructs (here, overall satisfaction (Y3) and loyalty (Y4)) that depend on one or more exogenous (or other endogenous) constructs. The relations between the constructs (indicated with p) are called path coefficients, while the relations between the constructs and their respective items (indicated with l) are the item loadings. One can distinguish between the structural model that incorporates the relations between the constructs and the (exogenous and endogenous) measurement models that represent the relationships between the constructs and their related items. Items that measure constructs are labeled x.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig8_HTML.png]
Fig. 8.8Path diagram (structural equation modeling)



In the model in Fig. 8.8, we assume that the two exogenous constructs satisfaction with the stadium and satisfaction with the merchandise relate to the endogenous construct overall satisfaction and that overall satisfaction relates to loyalty. Depending on the research question, we could of course incorporate additional exogenous and endogenous constructs. Using empirical data, we could then test this model and, thus, evaluate the relationships between all the constructs and between each construct and its items. We could, for example, assess which of the two constructs, Y1 or Y2, relates more strongly to Y3. The result helps us when developing marketing plans to increase overall satisfaction and, ultimately, loyalty.
The evaluation of a path model analysis requires several steps that include the assessment of both measurement models and the structural model. Diamantopoulos and Siguaw (2000) and Hair et al. (2019) provide thorough descriptions of the covariance-based structural equation modeling approach and its application. Hair et al. (2017a, 2018) provide a step-by-step introduction on how to set up and test path models using partial least squares structural equation modeling.
8.6 Example
In this example, we take a closer look at some of the items from the Oddjob Airways dataset (⤓ Web Appendix → Downloads). This dataset contains eight items that relate to the customers’ experience when flying with Oddjob Airways. For each of the following items, the respondents had to rate their degree of agreement from 1 (“completely disagree”) to 100 (“completely agree”). The variable names are included below:	with Oddjob Airways you will arrive on time (s1),

	the entire journey with Oddjob Airways will occur as booked (s2),

	in case something does not work out as planned, Oddjob Airways will find a good solution (s3),

	the flight schedules of Oddjob Airways are reliable (s4),

	Oddjob Airways provides you with a very pleasant travel experience (s5),

	Oddjob Airways’s on board facilities are of high quality (s6),

	Oddjob Airways’s cabin seats are comfortable (s7), and

	Oddjob Airways offers a comfortable on-board experience (s8).





Our aim is to reduce the complexity of this item set by extracting several factors. Hence, we use these items to run a PCA.
8.6.1 Principal Component Analysis
8.6.1.1 Check Requirements and Conduct Preliminary Analyses
Before initiating the analysis, we need to check the assumptions of PCA and carry out preliminary analyses. We find that all eight variables are interval scaled from 1 (“very unsatisfied”) to 100 (“very satisfied”), therefore meeting the requirements in terms of the measurement scale.
Determining whether the variables are sufficiently correlated is part of the PCA. To initiate the analysis, go to ► Analyze ► Dimension Reduction ► Factor. In the dialog box that opens (Fig. 8.9), enter all eight variables into the Variables box.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig9_HTML.jpg]
Fig. 8.9Factor analysis dialog box



Next, click on Descriptives (Fig. 8.10) and check the boxes next to Coefficients, Significance levels, Anti-image, and KMO and Bartlett’s test of sphericity. Also make sure to select Reproduced, which requests the reproduced correlation matrix that we will use for assessing the goodness-of-fit of the factor solution. Finally, select Initial solution and Univariate descriptives in the upper part of the dialog box to display useful summary statistics of your data. All other options are of minor importance, so skip these and click Continue.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig10_HTML.jpg]
Fig. 8.10Descriptives option (factor analysis)



Now click on Extraction (Fig. 8.11) and choose Principal components in the Method drop-down menu. Under Extract, you can determine the rule for factor extraction. The default option in SPSS is the Kaiser criterion as indicated by the option Eigenvalues greater than 1. In case you have prior information regarding the number of factors to extract, select Fixed number of factors and specify the corresponding number next to Factors to extract. Finally, under Display, make sure to select Unrotated factor solution and Scree plot. Click on Continue.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig11_HTML.jpg]
Fig. 8.11Extraction option (factor analysis)



Under Rotation, you can choose between several orthogonal and oblique rotation methods. Select the Varimax procedure and click on Continue. Finally, under Options, you can decide how missing values should be handled and specify the display format of the coefficients in the component matrix. Select Exclude cases listwise to eliminate observations that have missing values in any of the variables used in any of the analyses. Avoid replacing missing values with the mean as this will diminish the variation in the data, especially if there are many missing values in your dataset. You should always check the option Sorted by size under Coefficient Display Format, as this greatly increases the clarity of the display of results. If you wish, you can suppress low loadings of say less than 0.20 by selecting the option Suppress small coefficients. Particularly when analyzing many items, this option makes the output much easier to interpret. After having specified all the options, you can initiate the analysis by clicking on Continue, followed by OK.
The descriptive statistics in Table 8.4 reveal that there are several observations with missing values in the dataset. However, with 921 valid observations, the sample size requirements are clearly met, even if the analysis produces very low communality values.Table 8.4Descriptive statistics


	Descriptive Statistics

	 	Mean
	Std. Deviation
	Analysis N

	s1
	60.36
	26.300
	921

	s2
	59.34
	25.963
	921

	s3
	55.83
	25.150
	921

	s4
	56.89
	27.808
	921

	s5
	56.48
	22.269
	921

	s6
	56.10
	22.070
	921

	s7
	51.60
	24.568
	921

	s8
	57.08
	21.286
	921





The correlation matrix in the upper part of Table 8.5 indicates that there are several pairs of highly correlated variables. The values in the diagonal are all 1.000, which is logical, as this is the correlation between a variable and itself! The off-diagonal cells correspond to the pairwise correlations. For example, the pairwise correlation between s1 and s2 is .754. The corresponding value in the lower part of Table 8.5 shows that all correlations are significant (.000). As an absolute minimum standard, we need at least one correlation in the off-diagonal cells to be significant and we clearly meet this minimum.Table 8.5Correlation matrix


	Correlation Matrix

	 	s1
	s2
	s3
	s4
	s5
	s6
	s7
	s8

	Correlation
	s1
	1.000
	.754
	.622
	.733
	.525
	.500
	.455
	.542

	s2
	.754
	1.000
	.697
	.771
	.536
	.493
	.453
	.535

	s3
	.622
	.697
	1.000
	.648
	.550
	.492
	.452
	.553

	s4
	.733
	.771
	.648
	1.000
	.484
	.436
	.367
	.487

	s5
	.525
	.536
	.550
	.484
	1.000
	.818
	.788
	.811

	s6
	.500
	.493
	.492
	.436
	.818
	1.000
	.832
	.842

	s7
	.455
	.453
	.452
	.367
	.788
	.832
	1.000
	.780

	s8
	.542
	.535
	.553
	.487
	.811
	.842
	.780
	1.000

	Sig. (1-tailed)
	s1
	 	.000
	.000
	.000
	.000
	.000
	.000
	.000

	s2
	.000
	 	.000
	.000
	.000
	.000
	.000
	.000

	s3
	.000
	.000
	 	.000
	.000
	.000
	.000
	.000

	s4
	.000
	.000
	.000
	 	.000
	.000
	.000
	.000

	s5
	.000
	.000
	.000
	.000
	 	.000
	.000
	.000

	s6
	.000
	.000
	.000
	.000
	.000
	 	.000
	.000

	s7
	.000
	.000
	.000
	.000
	.000
	.000
	 	.000

	s8
	.000
	.000
	.000
	.000
	.000
	.000
	.000
	 


The correlation matrix in Table 8.5 also shows that there are several pairs of highly correlated variables. For example, not only s1 is highly correlated with s2 (correlation = .754), but also s3 is highly correlated with s1 (correlation = .622), just like s4 (correlation = .733). As these variables’ correlations with the remaining correlations is much lower, it is likely that these four variables form one factor. As you can see from the correlation matrix, we can already identify a likely factor structure.
The results in Table 8.6 indicate a KMO value of .907, which is “marvelous” (Table 8.2). Correspondingly, all MSA values shown on the diagonal in the lower part of the Anti-image Matrices output (Table 8.7) are high. For example, s1 has an MSA value of .914. Not surprisingly the Bartlett’s test shown in Table 8.6 is significant (Sig. = .000), which means that we can reject the null hypothesis of uncorrelated variables. Summarizing these results, we conclude that the data are appropriate for PCA. Hence, we can continue with the interpretation of the PCA.Table 8.6KMO and Bartlett’s test statistics


	KMO and Bartlett's Test

	Kaiser-Meyer-Olkin Measure of Sampling Adequacy.
	.907

	Bartlett's Test of Sphericity
	Approx. Chi-Square
	6421.354

	df
	28

	Sig.
	.000




Table 8.7Anti-image matrices


	Anti-image Matrices

	 	s1
	s2
	s3
	s4
	s5
	s6
	s7
	s8

	Anti-image Covariance
	s1
	.354
	−.107
	−.029
	−.112
	−8.946E−5
	−.007
	−.011
	−.019

	s2
	−.107
	.289
	−.102
	−.122
	−.009
	−.001
	−.013
	.002

	s3
	−.029
	−.102
	.440
	−.066
	−.036
	.010
	.004
	−.036

	s4
	−.112
	−.122
	−.066
	.334
	−.016
	−.004
	.037
	−.011

	s5
	−8.946E−5
	−.009
	−.036
	−.016
	.247
	−.057
	−.068
	−.063

	s6
	−.007
	−.001
	.010
	−.004
	−.057
	.197
	−.093
	−.085

	s7
	−.011
	−.013
	.004
	.037
	−.068
	−.093
	.262
	−.040

	s8
	−.019
	.002
	−.036
	−.011
	−.063
	−.085
	−.040
	.226

	Anti-image Correlation
	s1
	.917a
	−.334
	−.072
	−.325
	.000
	−.025
	−.035
	−.068

	s2
	−.334
	.884a
	−.285
	−.393
	−.034
	−.003
	−.049
	.006

	s3
	−.072
	−.285
	.943a
	−.171
	−.111
	.034
	.011
	−.115

	s4
	−.325
	−.393
	−.171
	.883a
	−.057
	−.014
	.125
	−.039

	s5
	.000
	−.034
	−.111
	−.057
	.931a
	−.259
	−.269
	−.265

	s6
	−.025
	−.003
	.034
	−.014
	−.259
	.883a
	−.408
	−.400

	s7
	−.035
	−.049
	.011
	.125
	−.269
	−.408
	.904a
	−.164

	s8
	−.068
	.006
	−.115
	−.039
	−.265
	−.400
	−.164
	.918a

	a Measures of Sampling Adequacy(MSA)





8.6.1.2 Extract the Factors and Determine the Number of Factors
Table 8.8 lists the eigenvalues associated with each factor before extraction, after extraction, and after rotation. In the columns labeled Initial Eigenvalues, we see the results before extraction. SPSS lists all eight factors (we know that there are potentially as many factors as there are variables) in this column. Most of these factors are only of minor importance. This is reflected in each factor’s eigenvalue, which is displayed in the table’s second column. Here, we see that the first factor has an eigenvalue of 5.249. As there are eight variables in our dataset, this factor accounts for 5.249/8.00 = 65.611 % of the overall variance, as indicated in the third column. It is quite remarkable that by using only one factor instead of eight variables, we can account for over 65 % of the overall variance! The second factor has an eigenvalue of 1.328 and, thus, still covers more variance than a single variable. In contrast, factors 3–8 only marginally account for the total variance explained, as their eigenvalues are considerably smaller than 1.Table 8.8Factor extraction


	Total Variance Explained

	Component
	Initial Eigenvalues
	Extraction Sums of Squared Loadings
	Rotation Sums of Squared Loadings

	Total
	% of Variance
	Cumulative %
	Total
	% of Variance
	Cumulative %
	Total
	% of Variance
	Cumulative %

	1
	5.249
	65.611
	65.611
	5.249
	65.611
	65.611
	3.411
	42.633
	42.633

	2
	1.328
	16.604
	82.215
	1.328
	16.604
	82.215
	3.167
	39.582
	82.215

	3
	.397
	4.966
	87.181
	 	 	 	 	 	 
	4
	.263
	3.290
	90.471
	 	 	 	 	 	 
	5
	.231
	2.890
	93.361
	 	 	 	 	 	 
	6
	.196
	2.454
	95.815
	 	 	 	 	 	 
	7
	.193
	2.409
	98.224
	 	 	 	 	 	 
	8
	.142
	1.776
	100.000
	 	 	 	 	 	 

Extraction Method: Principal Component Analysis.




The second set of columns, labeled Extraction Sums of Squared Loadings, contains the factor solutions after extraction. Since we chose the Kaiser criterion as default option, SPSS extracts all factors with an eigenvalue greater than 1. As a consequence, SPSS extracts two factors, which jointly account for 82.215 % of the overall variance. The final part of the table, labeled Rotation Sums of Squared Loadings, displays the factors after rotation. The rotation typically changes the factors’ eigenvalues, but not the total variance explained. For example, before rotation, the second factor accounted for 16.604 % of the overall variance but after rotation, it accounts for 39.582 %.
Looking at the scree plot in Fig. 8.12, we find an “elbow” in the line at three factors. As the number of factors that the scree plot suggests is one factor less than the elbow indicates, we conclude that two factors are appropriate. This finding therefore supports the conclusion as the Kaiser criterion.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig12_HTML.png]
Fig. 8.12Scree plot



While the Kaiser criterion and the scree plot are helpful for determining the number of factors to extract, parallel analysis is a more robust criterion. Parallel analysis can only be run using SPSS syntax. To do so, go to the book’s ⤓ Web Appendix (→ Downloads) and download the syntax file Parallel analysis.sps (O’Connor 2000). Next, go to ► File ► Open ►Syntax, locate the syntax file on your hard drive and open it. SPSS will now show the syntax editor as in Fig. 8.13.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig13_HTML.jpg]
Fig. 8.13Syntax editor



Under compute Ncases in line 10, you need to specify the number of observations, which is 921 in our case study. Similarly, under compute NVars (line 11), specify the number of variables used in the analysis, which is 8. Next, initiate the analysis by going to ► Run ► All and SPSS will show an output similar to Fig. 8.14.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig14_HTML.png]
Fig. 8.14Parallel analysis output



The column labeled Prcntyle shows the 95th percentile for each factor’s eigenvalue resulting from the randomly generated data. Note that because of this random process, your numbers are going to look different. However, deviations typically occur at the third decimal place. We can now compare the original eigenvalues from Table 8.8 with the randomly generated eigenvalues from Fig. 8.14. We learn that the first two factors produce eigenvalues larger than the randomly generated eigenvalues. Whereas the first original Eigenvalue is clearly higher (5.249; Table 8.7) than the randomly generated one (1.185; Fig. 8.14), the difference is much less pronounced for the second factor (1.328 vs. 1.122). The third factor’s original eigenvalue (.397) is clearly lower than its randomly generated counterpart (1.076). Hence, based on the parallel analysis results, we would also opt for a two-factor solution.
8.6.1.3 Interpret the Factor Solution
We continue with the interpretation of the factors. To do so, take a look at the Rotated Component Matrix (Table 8.9), which shows the item loadings after rotation. To interpret the factors, we first “assign” each variable to a certain factor based on its maximum absolute factor loading. That is, if the highest absolute loading is negative, higher values of a particular variable relate negatively to the assigned factor. After that, we should find a label for each factor that best describes the set of variables associated with that factor. Looking at Table 8.9, we see that s1–s4 load highly on the second factor, whereas s5–s8 load on the first factor. For example, s1 has a .829 loading on the second factor, while its loading is much weaker on the first factor (.299). If you compare these results with the regular Component Matrix, you will see that prior to rotation, all items load highly on the first factor and much weaker on the second.Table 8.9Rotated component matrix


	Rotated Component Matrixa

	 	Component

	1
	2

	s6
	.903
	.272

	s7
	.902
	.208

	s8
	.856
	.352

	s5
	.852
	.347

	s4
	.198
	.885

	s2
	.282
	.871

	s1
	.299
	.829

	s3
	.340
	.759


Extraction Method: Principal Component Analysis.
Rotation Method: Varimax with Kaiser Normalization.

a Rotation converged in 3 iterations.




Having identified which variables load highly on which factor in the rotated solution, we now need to identify labels for each factor. Looking at the variable labels, we learn that the first set of variables (s1–s4) relate to reliability aspects of the journey and related processes, such as the booking. We could therefore label this factor (i.e., factor 2) reliability. The second set of variables (s5–s8) relate to different aspects of the onboard facilities and the travel experience. Hence, we could label this factor (i.e., factor 1) onboard experience. The labeling of factors is subjective and you could provide different labels.
8.6.1.4 Evaluate the Goodness-of-Fit of the Factor Solution
The last step involves assessing the analysis’s goodness-of-fit. To do so, we first look at the residuals (i.e., the differences between observed and reproduced correlations) in the reproduced correlation matrix (Table 8.10). Examining the lower part of the table, we see that there are several residuals with absolute values larger than 0.05. However, we do not have to count every single value in the matrix (this could be quite exhausting if there are over 100 variables in the dataset!). Instead, SPSS counts the proportion of residuals with high residuals, which is reported in the first part of the table. As we can see in point b beneath the table, 28.0 % of the residuals have absolute values greater than 0.05. As the percentage of increased residuals is well below 50 %, we can presume a good model fit.Table 8.10Reproduced correlations and residual matrices


	Reproduced Correlations

	 	s1
	s2
	s3
	s4
	s5
	s6
	s7
	s8

	Reproduced Correlation
	s1
	.777a
	.806
	.731
	.793
	.542
	.495
	.442
	.548

	s2
	.806
	.838a
	.757
	.827
	.542
	.491
	.435
	.548

	s3
	.731
	.757
	.691a
	.739
	.553
	.513
	.464
	.558

	s4
	.793
	.827
	.739
	.822a
	.476
	.420
	.363
	.482

	s5
	.542
	.542
	.553
	.476
	.847a
	.864
	.840
	.852

	s6
	.495
	.491
	.513
	.420
	.864
	.890a
	.871
	.869

	s7
	.442
	.435
	.464
	.363
	.840
	.871
	.856a
	.845

	s8
	.548
	.548
	.558
	.482
	.852
	.869
	.845
	.856a

	Residualb
	s1
	 	−.053
	−.109
	−.060
	−.017
	.005
	.014
	−.006

	s2
	−.053
	 	−.060
	−.056
	−.006
	.002
	.018
	−.013

	s3
	−.109
	−.060
	 	−.091
	−.003
	−.022
	−.012
	−.006

	s4
	−.060
	−.056
	−.091
	 	.008
	.016
	.004
	.005

	s5
	−.017
	−.006
	−.003
	.008
	 	−.046
	−.053
	−.040

	s6
	.005
	.002
	−.022
	.016
	−.046
	 	−.039
	−.026

	s7
	.014
	.018
	−.012
	.004
	−.053
	−.039
	 	−.065

	s8
	−.006
	−.013
	−.006
	.005
	−.040
	−.026
	−.065
	 

Extraction Method: Principal Component Analysis.

a Reproduced communalities

b Residuals are computed between observed and reproduced correlations. There are 8 (28.0 %) nonredundant residuals with absolute values greater than 0.05.




This result is supported by the variables’ communalities and the total variance explained. All communalities in Table 8.11 are very high, indicating that the factors reproduce the variables’ variance well. For example, with a value of .763, s1 has a communality value clearly above the 0.50 threshold, suggesting that the two factors account for 76.3 % of this variable’s variation. Finally, the two factors explain over 80 % of each variable’s variance (Table 8.8). Jointly these results provide support for the solution’s goodness-of-fit.Table 8.11Communalities


	Communalities

	 	Initial
	Extraction

	s1
	1.000
	.777

	s2
	1.000
	.838

	s3
	1.000
	.691

	s4
	1.000
	.822

	s5
	1.000
	.847

	s6
	1.000
	.890

	s7
	1.000
	.856

	s8
	1.000
	.856


Extraction Method: Principal Component Analysis.




In case the analysis indicates a poor goodness-of-fit, you should reconsider the set-up by eliminating items that have low communalities and MSA values.
8.6.1.5 Compute the Factor Scores
If you wish to use factor scores in subsequent analyses, you can rerun the analysis by going to ► Analyze ► Dimension Reduction ► Factor and selecting the Scores option. Since we recommend using the regression method, choose Save as variables and Regression. When clicking on Continue and OK, SPSS creates two new variables labeled FAC1_1 and FAC2_1, which include the scores of the two factors (Fig. 8.15). These are z-standardized, meaning that the newly generated variables have mean values of 0 and standard deviations of 1. This entails the factor scores are estimated in units of standard deviations from their means. For example, the first observation is about 1.911 standard deviations below average on the onboard experience factor (i.e., factor 1) and about 0.914 standard deviations above the reliability factor (i.e., factor 2). In contrast, the second observation is clearly above average in terms of onboard experience (1.684) and reliability (1.297). Using these variables as input we could, for example, evaluate whether male and female customers differ significantly with regard to their satisfaction with the airline’s reliability, and the onboard experience.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig15_HTML.jpg]
Fig. 8.15SPSS data view window



SPSS can only calculate factor scores if it has information on all the variables included in the analysis. If SPSS does not have all the information, it only shows a “.” (dot) in the data view window, indicating a system-missing value.
8.6.2 Reliability Analysis
To illustrate its usage, let’s carry out a reliability analysis of the first factor onboard experience by calculating Cronbach’s Alpha as a function of variables s5 to s8. To run the reliability analysis, click on ► Analyze ► Scale ► Reliability Analysis. Next, enter variables s5, s6, s7, and s8 into the Items box (again, you may have to right-click on the items and select Display Variable Names to show the names instead of the variable labels) and type in the scale’s name (e.g., satisfaction with the onboard experience). Make sure that Alpha is selected in the Model drop-down list (Fig. 8.16).[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig16_HTML.jpg]
Fig. 8.16Reliability analysis dialog box



Next, click on Statistics and choose Scale if item deleted (Fig 8.17). You can also request several descriptive statistics for each item (including correlations) and the entire scale. However, for the sake of simplicity, we will work with the default settings. Click on Continue, followed by OK.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Fig17_HTML.jpg]
Fig. 8.17Statistics option (reliability analysis)



The results in Table 8.12 show that the scale exhibits a high degree of internal consistency reliability. With a value of .944, the Cronbach’s Alpha coefficient lies well above the commonly suggested threshold of .70. This result is not surprising, since we are simply testing a scale previously established using item correlations. Keep in mind that we should carry out a reliability analysis to test a scale using a different sample—this example is only for illustration purposes! The rightmost column of Table 8.13 indicates what the Cronbach’s Alpha would be if we deleted the item indicated in that row. When we compare each of the values with the overall Cronbach’s Alpha value, we can see that any change in the scale’s set-up would reduce the Cronbach’s Alpha value. For example, by removing s5 from the scale, the Cronbach’s Alpha of the new scale comprising only s6, s7, and s8 would be reduced to .928. In the column labeled Corrected Item-Total Correlation of Table 8.13, SPSS indicates the correlation between the item and the scale that is composed of other items. This information is useful for determining whether reverse-coded items were also identified as such. Reverse-coded items should have a minus sign.Table 8.12Reliability statistics


	Reliability Statistics

	Cronbach's Alpha
	No of Items

	.944
	4




Table 8.13Item-total statistics


	Item-Total Statistics

	 	Scale Mean if Item Deleted
	Scale Variance if Item Deleted
	Corrected Item-Total Correlation
	Cronbach's Alpha if Item Deleted

	s5
	165.53
	4084.951
	.861
	.928

	s6
	165.91
	4045.200
	.896
	.917

	s7
	170.42
	3859.797
	.852
	.933

	s8
	164.96
	4215.151
	.861
	.929





8.7 Customer Satisfaction at Haver & Boecker (Case Study)
Case Study

                [image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Figc_HTML.jpg]
© Haver & Boecker OHG


              
Haver & Boecker (http://​www.​haverboecker.​com) is one of the world’s leading and most renowned machine producers in the fields of mineral processing, as well as the storing, conveying, packing, and loading of bulk material. The family-owned group operates through its global network of facilities, with manufacturing units, among others, in Germany, the UK, Belgium, US, Canada, Brazil, China, and India.
The company’s relationships with its customers are usually long-term oriented and complex. Since the company’s philosophy is to help customers and business partners solve their challenges or problems, they often customize their products and services to meet the buyers’ needs. Therefore, the customer is not a passive buyer, but an active partner. Given this background, the customers’ satisfaction plays an important role in establishing, developing, and maintaining successful customer relationships.[image: ../images/210704_3_En_8_Chapter/210704_3_En_8_Figd_HTML.jpg]
© Haver & Boecker OHG



Early on, the company’s management realized the importance of customer satisfaction and decided to commission a market research project in order to identify marketing activities that can positively contribute to the business’s overall success. Based on a thorough literature review, as well as interviews with experts, the company developed a short survey to explore their customers’ satisfaction with specific performance features and their overall satisfaction. All the items were measured on seven-point scales, with higher scores denoting higher levels of satisfaction. A standardized survey was mailed to customers in 12 countries worldwide, which resulted in 281 fully completed questionnaires. The following items (names in parentheses) were listed in the survey:	Reliability of the machines and systems. (s1)

	Life-time of the machines and systems. (s2)

	Functionality and user-friendliness operation of the machines and systems. (s3)

	Appearance of the machines and systems. (s4)

	Accuracy of the machines and systems. (s5)

	Timely availability of the after-sales service. (s6)

	Local availability of the after-sales service. (s7)

	Fast processing of complaints. (s8)

	Composition of quotations. (s9)

	Transparency of quotations. (s10)

	Fixed product prize for the machines and systems. (s11)

	Cost/performance ratio of the machines and systems. (s12)

	Overall, how satisfied are you with the supplier? (overall)





Your task is to analyze the dataset to provide the management of Haver & Boecker with advice for effective customer satisfaction management. The dataset is labeled Haver and Boecker.sav (⤓ Web Appendix → Downloads).	1.Using regression analysis, locate those variables that best explain the customers’ overall satisfaction (overall). Evaluate the model fit and assess the impact of each variable on the dependent variable. Remember to consider collinearity diagnostics.

 

	2.Determine the factors that characterize the respondents using factor analysis. Use items s1–s12 for this. Run a PCA with varimax rotation to help interpretation. Consider the following aspects:	(a)Are all assumptions for carrying out a PCA met? Are the data are sufficiently correlated?

 

	(b)How many factors would you extract? Base your decision on the Kaiser criterion, the scree plot, and parallel analysis. Do these three methods suggest the same number of factors?

 

	(c)Find suitable labels for the extracted factors.

 

	(d)Evaluate the factor solution’s goodness-of-fit.

 






 

	3.Use the factor scores and regress the customers’ overall satisfaction (overall) on these. Evaluate the strength of the model and compare it with the initial regression. What should Haver & Boecker’s management do to increase their customers’ satisfaction?

 

	4.Calculate the Cronbach’s Alpha over items s1–s5 and interpret the results.

 





For further information on the dataset and the study, see Festge and Schwaiger (2007), as well as Sarstedt et al. (2009).
8.8 Review Questions

              	1.What is factor analysis? Try to explain what factor analysis is in your own words.

 

	2.What is the difference between exploratory factor analysis and confirmatory factor analysis?

 

	3.What is the difference between PCA and factor analysis?

 

	4.Describe the terms communality, eigenvalue, and factor loading. How do these concepts relate to one another?

 

	5.Describe the Kaiser criterion, the scree plot, and parallel analysis to determine the number of factors. What are there similarities and differences between these methods?

 

	6.What is the purpose of a varimax rotation? Does a rotation alter eigenvalues or factor loadings?

 

	7.Re-run the Oddjob Airways case study by carrying out a factor analysis and compare the results to the PCA analysis described in Sect. 8.6. Are there any differences?

 

	8.What is reliability analysis and why is it important?

 

	9.Explain the basic principle of structural equation modeling.
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Footnotes
1Other methods for carrying out factor analyses include, for example, unweighted least squares, generalized least squares, or maximum likelihood but these are statistically complex.

 

2Related discussions have been raised in structural equation modeling, where researchers have heatedly discussed the strengths and limitations of factor-based and component-based approaches (e.g. Sarstedt et al. 2016a; Hair et al. 2017b).

 

3Note that Fig. 8.3 describes a special case, as the five variables are scaled down into a two-dimensional space. In this set-up, it would be possible for the two factors to explain all five items. However, in real-life, the five items span a five-dimensional vector space.

 

4Note that this changes when oblique rotation is used. We will discuss factor rotation later in this chapter.

 

5Note that this is only the case in PCA. When using factor analysis, the standard deviations are different from one (DiStefano et al. 2009).

 

6Note that we omitted the error terms for clarity.
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Learning Objectives
After reading this chapter you should understand:	The basic concepts of cluster analysis.

	How basic cluster algorithms work.

	How to compute simple clustering results manually.

	The different types of clustering procedures.

	The SPSS clustering outputs.
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9.1 Introduction
Market segmentation
                
               is one of the most fundamental marketing activities. To successfully match products and services to customer needs, companies have to divide markets into groups (segments) of consumers, customers, and clients with similar needs and wants. Firms can then target each of these segments by positioning themselves in a unique segment (e.g., Ferrari in the high-end sports car market). Market segmentation “is essential for marketing success: the most successful firms segment their markets carefully” (Lilien and Rangaswamy 2004, p. 61) and “tools such as segmentation [ … ] have the largest impact on marketing decisions” (Roberts et al. 2014, p. 127). While market researchers often form market segments based on practical grounds, industry practice and wisdom, cluster analysis uses data to form segments, making segmentation less dependent on subjectivity.
9.2 Understanding Cluster Analysis
Cluster analysis
                
               is a method for segmentation and identifies homogenous groups of objects (or cases, observations) called clusters
                
              . These objects can be individual customers, groups of customers, companies, or entire countries. Objects in a certain cluster should be as similar as possible to each other, but as distinct as possible from objects in other clusters.
Let’s try to gain a basic understanding of cluster analysis by looking at a simple example. Imagine that you are interested in segmenting customers A to G in order to better target them through, for example, pricing strategies.
The first step is to decide on the characteristics that you will use to segment your customers A to G. In other words, you have to decide which clustering variables
                
               will be included in the analysis. For example, you may want to segment a market based on customers’ price consciousness (x) and brand loyalty (y). These two variables can be measured on a scale from 0 to 100 with higher values denoting a higher degree of price consciousness and brand loyalty. Table 9.1 and the scatter plot in Fig. 9.1 show the values of seven customers (referred to as objects).[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig1_HTML.png]
Fig. 9.1Scatter plot


Table 9.1Data


	Customer
	A
	B
	C
	D
	E
	F
	G

	x
	33
	82
	66
	30
	79
	50
	10

	y
	95
	94
	80
	67
	60
	33
	17





The aim of cluster analysis is to identify groups of objects (here, customers) that are very similar regarding their price consciousness and brand loyalty, and assign them to clusters. After having decided on the clustering variables (here, price consciousness and brand loyalty), we need to decide on the clustering procedure to form our groups of objects. This step is crucial for the analysis, as different procedures require different decisions prior to analysis. There are many different approaches and little guidance on which one to use. We will discuss the most popular approaches in market research, including:	hierarchical methods,

	partitioning methods (especially k-means), and

	two-step clustering.





While the basic aim of these procedures is the same, namely grouping similar objects into clusters, they take different routes, which we will discuss in this chapter. An important consideration before starting the grouping is to determine how similarity should be measured. Most methods calculate measures of (dis)similarity by estimating the distance between pairs of objects. Objects with smaller distances between one another are considered more similar, whereas objects with larger distances are considered more dissimilar. The decision on how many clusters should be derived from the data is a fundamental issue in the application of cluster analysis. This question is explored in the next step of the analysis. In most instances, we do not know the exact number of clusters and then we face a trade-off. On the one hand, we want as few clusters as possible to make the clusters easy to understand and actionable. On the other hand, having many clusters allows us to identify subtle differences between objects.
Megabus is a hugely successful bus line in the US. They completely rethought the nature of their customers and concentrated on three specific segments of the market: College kids, women travelling in groups, and active seniors. To meet these customer segments’ needs, Megabus reimagined the entire driving experience by developing double-decker buses with glass roofs and big windows, and equipped with fast WiFi. Megabus’s success of segmenting and targeting efforts has led to practitioners talk about the “Megabus Effect”—how one company has shaped an entire industry.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Figa_HTML.png]
© Stagecoach Group plc.

                      https://​www.​youtube.​com/​watch?​v=​mnrblwymSEo
                    



In the final step, we need to interpret the clustering solution by defining and labeling the obtained clusters. We can do this by comparing the mean values of the clustering variables across the different clusters, or by identifying explanatory variables to profile the clusters. Ultimately, managers should be able to identify customers in each cluster on the basis of easily measurable variables. This final step also requires us to assess the clustering solution’s stability and validity. Figure 9.2 illustrates the steps associated with a cluster analysis; we will discuss these steps in more detail in the following sections.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig2_HTML.png]
Fig. 9.2Steps involved in a cluster analysis



9.3 Conducting a Cluster Analysis
9.3.1 Select the Clustering Variables
At the beginning of the clustering process, we have to select appropriate variables for clustering. Even though this choice is critical, it is rarely treated as such. Instead, a mixture of intuition and data availability guide most analyses in marketing practice. However, faulty assumptions may lead to improper market segmentation and, consequently, to deficient marketing strategies. Thus, great care should be taken when selecting the clustering variables! There are several types of clustering variables, as shown in Fig. 9.3. Sociodemographic variables define clusters based on people’s demographic (e.g., age, ethnicity, and gender), geographic (e.g., residence in terms of country, state, and city), and socioeconomic (e.g., education, income, and social class) characteristics. Psychometric variables capture unobservable character traits such as people’s personalities or lifestyles. Finally, behavioral clustering variables typically consider different facets of consumer behavior, such as the way people purchase, use, and dispose of products. Other behavioral clustering variables capture specific benefits which different groups of consumers look for in a product.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig3_HTML.png]
Fig. 9.3Types of clustering variables



The types of variables used for cluster analysis provide different solutions and, thereby, influence targeting strategies. Over the last decades, attention has shifted from more traditional sociodemographic clustering variables towards behavioral and psychometric variables. The latter generally provide better guidance for decisions on marketing instruments’ effective specification. Generally, clusters based on psychometric variables are more homogenous and these consumers respond more consistently to marketing actions (e.g., Wedel and Kamakura 2000). However, consumers in these clusters are frequently hard to identify as such variables are not easily measured. Conversely, clusters determined by sociodemographic variables are easy to identify but are also more heterogeneous, which complicates targeting efforts. Consequently, researchers frequently combine different variables such as lifestyle characteristics and demographic variables, benefiting from each one’s strengths.
In some cases, the choice of clustering variables is apparent because of the task at hand. For example, a managerial problem regarding corporate communications will have a fairly well defined set of clustering variables, including contenders such as awareness, attitudes, perceptions, and media habits. However, this is not always the case and researchers have to choose from a set of candidate variables. But how do we make this decision? To facilitate the choice of clustering variables, we should consider the following guiding questions:	Do the variables differentiate sufficiently between the clusters?

	Is the relation between the sample size and the number of clustering variables reasonable?

	Are the clustering variables highly correlated?

	Are the data underlying the clustering variables of high quality?





Do the variables differentiate sufficiently between the clusters?
It is important to select those clustering variables that provide a clear-cut differentiation between the objects.1 More precisely, criterion validity
                    
                   is of special interest; that is, the extent to which the “independent” clustering variables are associated with one or more criterion variables not included in the analysis. Such criterion variables generally relate to an aspect of behavior, such as purchase intention or willingness-to-pay. Given this relationship, there should be significant differences between the criterion variable(s) across the clusters (e.g., consumers in one cluster exhibit a significantly higher willingness-to-pay than those in other clusters). These associations may or may not be causal, but it is essential that the clustering variables distinguish significantly between the variable(s) of interest.
Is the relation between the sample size and the number of clustering variables reasonable?
When choosing clustering variables, the sample size is important. From a statistical perspective, every additional variable requires an over-proportional increase in observations to ensure valid results. Unfortunately, there is no generally accepted guideline regarding minimum sample sizes or the relationship between the objects and the number of clustering variables used. Recent rules-of-thumb are as follows:	In the simplest case where clusters are of equal size, Qiu and Joe (2009) recommend a sample size at least ten times the number of clustering variables multiplied by the number of clusters.

	Dolnicar et al. (2014) recommend using a sample size of 70 times the number of clustering variables.

	Dolnicar et al. (2016) find that increasing the sample size from 10 to 30 times the number of clustering variables substantially improves the clustering solution. This improvement levels off subsequently, but is still noticeable up to a sample size of approximately 100 times the number of clustering variables.





These rules-of-thumb are approximate as the required sample size depends on many factors, such as survey data characteristics (e.g., nonresponse, sampling error, response styles), relative cluster sizes, and the degree to which the clusters overlap (Dolnicar et al. 2016). Qiu and Joe (2009) suggest a minimum sample size of 10 times the number of clustering variables. Keep in mind that no matter how many variables are used and no matter how small the sample size, cluster analysis will almost always provide a result. At the same time, increasing the sample size has decreasing marginal returns on the quality of results. In addition, we need to be able to find clusters that are managerially relevant as the cluster sizes need to be substantial to ensure that the targeted marketing programs are profitable.
Are the clustering variables highly correlated?
If there is strong correlation between the variables, they are not sufficiently unique to identify distinct market segments. If highly correlated variables—0.90 and over—are used for cluster analysis, the specific aspects that these variables cover will be overrepresented in the clustering solution. For example, if we were to add another variable called brand preference to our analysis, it would almost cover the same aspect as brand loyalty. The concept of being attached to a brand would therefore be overrepresented in the analysis, because the clustering procedure does not conceptually differentiate between the clustering variables. Researchers frequently handle such correlation problems by applying cluster analysis to the observations’ factor scores, derived from a principal component or factor analysis. However, this factor-cluster segmentation
                    
                   approach is subject to several limitations, which we discuss in Box 9.1.
Box 9.1 Issues with factor-cluster segmentation
Dolnicar and Grün (Dolnicar and Grün 2009) identify several problems of the factor-cluster segmentation approach (see Chap.​ 8 for a discussion of principal component and factor analysis and related terminology):	1.The data are pre-processed and the clusters are identified on the basis of transformed values, not on the original information, which leads to different results.

 

	2.In factor analysis, the factor solution does not explain all the variance; information is thus discarded before the clusters have been identified or constructed.

 

	3.Eliminating variables with low loadings on all the extracted factors means that, potentially, the most important pieces of information for the identification of niche clusters are discarded, making it impossible to ever identify such groups.

 

	4.The interpretations of clusters based on the original variables become questionable, given that these clusters were constructed by using factor scores.

 





Several studies have shown that the factor-cluster segmentation reduces the success of finding useable clusters significantly.2 Consequently, you should reduce the number of items in the questionnaire’s pre-testing phase, retaining a reasonable number of relevant, non-overlapping questions that you believe differentiate the clusters well. However, if you have doubts about the data structure, factor-clustering segmentation may still be a better option than discarding items.
Are the data underlying the clustering variables of high quality?
Ultimately, the choice of clustering variables always depends on contextual influences, such as the data availability or the resources to acquire additional data. Market researchers often overlook that the choice of clustering variables is closely connected to data quality. Only those variables that ensure that high quality data can be used should be included in the analysis (Dolnicar and Lazarevski 2009). Following our discussions in Chaps.​ 3–5, data are of high quality if the questions …	… have a strong theoretical basis,

	… are not contaminated by respondent fatigue or response styles, and

	… reflect the current market situation (i.e., they are recent).





The requirements of other functions in the organization often play a major role in the choice of clustering variables. Consequently, we have to be aware that the choice of clustering variables should lead to segments acceptable to the different functions in the organization.
9.3.2 Select the Clustering Procedure
By choosing a specific clustering procedure, we determine how clusters should be formed. This forming of clusters always involves optimizing some kind of criterion, such as minimizing the within-cluster variance (i.e., the clustering variables’ overall variance of the objects in a specific cluster), or maximizing the distance between the clusters. The procedure could also address the question of how to determine the (dis)similarity between objects in a newly formed cluster and the remaining objects in the dataset.
There are many different clustering procedures and also many ways of classifying these (e.g., overlapping versus non-overlapping, unimodal versus multimodal, exhaustive versus non-exhaustive). Wedel and Kamakura (2000), Dolnicar (2003), and Kaufman and Rousseeuw (2005) offer reviews of clustering techniques. A practical distinction is the differentiation between hierarchical and partitioning methods (especially k-means), which we will discuss in the next sections.
9.3.2.1 Hierarchical Clustering Methods
Understanding Hierarchical Clustering Methods
Hierarchical clustering methods
                      
                     are characterized by the tree-like structure established in the course of the analysis. Most hierarchical methods fall into a category called agglomerative clustering
                      
                    . In this category, clusters are consecutively formed from objects. Agglomerative clustering starts with each object representing an individual cluster. The objects are then sequentially merged to form clusters of multiple objects, starting with the two most similar objects. Similarity is typically defined in terms of the distance between objects. That is, objects with smaller distances between one another are considered more similar, whereas objects with larger distances are considered more dissimilar. After the merger of the first two most similar (i.e., closest) objects, the agglomerative clustering procedure continues by merging another pair of objects or adding another object to an already existing cluster. This procedure continues until all the objects have been merged into one big cluster. As such, agglomerative clustering establishes a hierarchy of objects from the bottom (where each object represents a distinct cluster) to the top (where all objects form one big cluster). The left-hand side of Fig. 9.4 shows how agglomerative clustering merges objects (represented by circles) step-by-step with other objects or clusters (represented by ovals).[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig4_HTML.png]
Fig. 9.4Agglomerative and divisive clustering



Hierarchical clustering can also be interpreted as a top-down process, where all objects are initially merged into a single cluster, which the algorithm then gradually splits up into smaller clusters. This approach to hierarchical clustering is called divisive clustering
                      
                    . The right-hand side of Fig. 9.4 illustrates the divisive clustering concept. As we can see, in both agglomerative and divisive clustering, a cluster on a higher level of the hierarchy always encompasses all clusters from a lower level. This means that if an object is assigned to a certain cluster, there is no possibility of reassigning this object to another cluster (hence, the name hierarchical clustering). This is an important distinction between hierarchical and partitioning methods, such as k-means, which we will explore later in this chapter.
Divisive procedures are rarely used in market research and not implemented in statistical software programs such as SPSS as they are computationally very intensive for all but small datasets.3 We therefore focus on (agglomerative) hierarchical clustering.
Linkage algorithms
When using agglomerative hierarchical clustering, you need to specify a linkage algorithm.
                      
                     Linkage algorithms define the distance from a newly formed cluster to a certain object, or to other clusters in the solution. The most popular linkage algorithms include the following:	Single linkage
                            
                           (nearest neighbor
                            
                           in SPSS): The distance between two clusters corresponds to the shortest distance between any two members in the two clusters.

	Complete linkage
                            
                           (furthest neighbor
                            
                           in SPSS): The oppositional approach to single linkage assumes that the distance between two clusters is based on the longest distance between any two members in the two clusters.

	Average linkage
                            
                           (between-groups linkage
                            
                           in SPSS): The distance between two clusters is defined as the average distance between all pairs of the two clusters’ members.

	Centroid linkage
                            
                          : In this approach, the geometric center (centroid) of each cluster is computed first. This is done by computing the clustering variables’ average values of all the objects in a certain cluster. The distance between the two clusters equals the distance between the two centroids.

	Ward’s linkage
                            
                          : This approach differs from the previous ones in that it does not combine the two closest or most similar objects successively. Instead, Ward’s linkage combines those objects whose merger increases the overall within-cluster variance (i.e., the homogeneity of clusters) to the smallest possible degree. The approach is generally used in combination with (squared) Euclidean distances, but can be used in combination with any other (dis)similarity measure.





Figs. 9.5, 9.6, 9.7, 9.8 and 9.9 illustrate these linkage algorithms for two clusters, which are represented by white circles surrounding a set of objects.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig5_HTML.png]
Fig. 9.5Single linkage


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig6_HTML.png]
Fig. 9.6Complete linkage


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig7_HTML.png]
Fig. 9.7Average linkage


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig8_HTML.png]
Fig. 9.8Centroid linkage


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig9_HTML.png]
Fig. 9.9Ward’s linkage



Each of these linkage algorithms can yield different results when used on the same dataset, as each has specific properties:	The single linkage algorithm is based on minimum distances; it tends to form one large cluster with the other clusters containing only one or a few objects each. We can make use of this chaining effect
                            
                           to detect outliers
                            
                          , as these will be merged with the remaining objects—usually at very large distances—in the last steps of the analysis. Single linkage is considered the most versatile algorithm.

	The complete linkage method is strongly affected by outliers, as it is based on maximum distances. Clusters produced by this method are likely to be compact and tightly clustered.

	The average linkage and centroid linkage algorithms tend to produce clusters with low within-cluster variance and with similar sizes. The average linkage is affected by outliers, but less than the complete linkage method.

	Ward’s linkage yields clusters of similar size with a similar degree of tightness. Prior research has shown that the approach generally performs very well. However, outliers and highly correlated variables have a strong impact on the results.





To better understand how the linkage algorithms work, let’s manually examine some calculation steps using single linkage as an example. Let's start by looking at the distance matrix in Table 9.2, which shows the distances between objects A-G from our initial example. In this distance matrix, the non-diagonal elements express the distances between pairs of objects based on the Euclidean distance—we will discuss this distance measure in the following section. The diagonal elements of the matrix represent the distance from each object to itself, which is, of course, 0. In our example, the distance matrix is an 8 × 8 table with the lines and rows representing the objects under consideration (see Table 9.1). As the distance between objects B and C (in this case, 21.260 units; printed in bold in Table 9.2) is the same as between C and B, the distance matrix is symmetrical. Furthermore, since the distance between an object and itself is 0, you only need to look at either the lower or upper non-diagonal elements.Table 9.2Euclidean distance matrix


	Objects
	A
	B
	C
	D
	E
	F
	G

	
                                A
                              
	0
	 
	
                                B
                              
	49.010
	0
	 
	
                                C
                              
	36.249
	
                                21.260
                              
	0
	 
	
                                D
                              
	28.160
	58.592
	38.275
	0
	 
	
                                E
                              
	57.801
	34.132
	23.854
	40.497
	0
	 
	
                                F
                              
	64.288
	68.884
	49.649
	39.446
	39.623
	0
	 
	
                                G
                              
	81.320
	105.418
	84.291
	53.852
	81.302
	43.081
	0


Note: Smallest distance is printed in bold.




In the very first step, the two objects exhibiting the smallest distance in the matrix are merged. Since the smallest distance occurs between B and C (d(B,C) = 21.260), we merge these two objects in the first step of the analysis.
Agglomerative clustering procedures always merge those objects with the smallest distance, regardless of the linkage algorithm used (e.g., single or complete linkage).
In the next step, we form a new distance matrix by considering the single linkage decision rule as discussed above. Using this linkage algorithm, we need to compute the distance from the newly formed cluster [B,C] (clusters are indicated by squared brackets) to all the other objects. For example, with regard to the distance from the cluster [B,C] to object A, we need to check whether A is closer to object B or to object C. That is, we look for the minimum value in d(A,B) and d(A,C) from Table 9.2. As d(A,C) = 36.249 is smaller than d(A,B) = 49.010, the distance from A to the newly formed cluster is equal to d(A,C); that is, 36.249. We also compute the distances from cluster [B,C] to all the other objects (i.e., D, E, F, G). For example, the distance between [B,C] and D is the minimum of d(B,D) = 58.592 and d(C,D) = 38.275 (Table 9.2). Finally, there are several distances, such as d(D,E) and d(E,F), which are not affected by the merger of B and C. These distances are simply copied into the new distance matrix. This yields the new distance matrix shown in Table 9.3.Table 9.3Distance matrix after first clustering step (single linkage)


	Objects
	A
	B, C
	D
	E
	F
	G

	
                                A
                              
	0
	 	 	 	 	 
	
                                B, C
                              
	36.249
	0
	 	 	 	 
	
                                D
                              
	28.160
	38.275
	0
	 	 	 
	
                                E
                              
	57.801
	
                                23.854
                              
	40.497
	0
	 	 
	
                                F
                              
	64.288
	49.649
	39.446
	39.623
	0
	 
	
                                G
                              
	81.320
	84.291
	53.852
	81.302
	43.081
	0


Note: Smallest distance is printed in bold.




Continuing the clustering procedure, we simply repeat the last step by merging the objects in the new distance matrix that exhibit the smallest distance and calculate the distance from this new cluster to all the other objects. In our case, the smallest distance (23.854, printed in bold in Table 9.3) occurs between the newly formed cluster [B, C] and object E. The result of this step is described in Table 9.4.Table 9.4Distance matrix after second clustering step (single linkage)


	Objects
	A
	B, C, E
	D
	F
	G

	
                                A
                              
	0
	 	 	 	 
	
                                B, C, E
                              
	36.249
	0
	 	 	 
	
                                D
                              
	
                                28.160
                              
	38.275
	0
	 	 
	
                                F
                              
	64.288
	39.623
	39.446
	0
	 
	
                                G
                              
	81.320
	81.302
	53.852
	43.081
	0


Note: Smallest distance is printed in bold.




Try to calculate the remaining steps yourself and compare your solution with the distance matrices in the following Tables 9.5, 9.6 and 9.7.Table 9.5Distance matrix after third clustering step (single linkage)


	Objects
	A, D
	B, C, E
	F
	G

	
                                A, D
                              
	0
	 	 	 
	
                                B, C, E
                              
	
                                36.249
                              
	0
	 	 
	
                                F
                              
	39.446
	39.623
	0
	 
	
                                G
                              
	53.852
	81.302
	43.081
	0


Note: Smallest distance is printed in bold.



Table 9.6Distance matrix after fourth clustering step (single linkage)


	Objects
	A, B, C, D, E
	F
	G

	
                                A, B, C, D, E
                              
	0
	 	 
	
                                F
                              
	
                                39.446
                              
	0
	 
	
                                G
                              
	53.852
	43.081
	0


Note: Smallest distance is printed in bold.



Table 9.7Distance matrix after fifth clustering step (single linkage)


	Objects
	A, B, C, D, E, F
	G

	
                                A, B, C, D, E, F
                              
	0
	 
	
                                G
                              
	43.081
	0





By following the single linkage procedure, the last steps involve the merger of cluster [A,B,C,D,E,F] and object G at a distance of 43.081. Do you get the same results? As you can see, conducting a basic cluster analysis manually is not that hard at all—not if there are only a few objects.
9.3.2.2 Partitioning Methods: k-means
Partitioning clustering methods
                    
                   are another important group of procedures. As with hierarchical clustering, there is a wide array of different algorithms; of these, k-means is the most popular for market research.
Understanding k-means Clustering
The k-means
                      
                     method follows an entirely different concept than the hierarchical methods discussed above. The initialization of the analysis is one crucial difference. Unlike with hierarchical clustering, we need to specify the number of clusters to extract from the data prior to the analysis. Using this information as input, k-means starts by randomly assigning all objects to the clusters. In the next step, k-means successively reassigns the objects to other clusters with the aim of minimizing the within-cluster variation. This within-cluster variation is equal to the squared distance of each observation to the center of the associated cluster (i.e., the centroid). If the reallocation of an object to another cluster decreases the within-cluster variation, this object is reassigned to that cluster.
Since cluster affiliations can change in the course of the clustering process (i.e., an object can move to another cluster in the course of the analysis), k-means does not build a hierarchy as hierarchical clustering does (Fig. 9.4). Therefore, k-means belongs to the group of non-hierarchical clustering methods
                      
                    .
For a better understanding of the approach, let’s take a look at how it works in practice. Figs. 9.10, 9.11, 9.12 and 9.13 illustrate the four steps of the k-means clustering process—research has produced several variants of the original algorithm, which we briefly discuss in Box 9.2.	Step 1: The researcher needs to specify the number of clusters that k-means should retain from the data. Using this number as the input, the algorithm selects a center for each cluster. In our example, two cluster centers are randomly initiated, which CC1 (first cluster) and CC2 (second cluster) represent in Fig. 9.10.

	Step 2: Euclidean distances are computed from the cluster centers to every object. Each object is then assigned to the cluster center with the shortest distance to it. In our example (Fig. 9.11), objects A, B, and C are assigned to the first cluster, whereas objects D, E, F, and G are assigned to the second. We now have our initial partitioning of the objects into two clusters.

	Step 3: Based on the initial partition in step 2, each cluster’s geometric center (i.e., its centroid) is computed. This is done by computing the mean values of the objects contained in the cluster (e.g., A, B, C in the first cluster) in terms of each of the variables (price consciousness and brand loyalty). As we can see in Fig. 9.12, both clusters’ centers now shift to new positions (CC1’ in the first and CC2’ in the second cluster; the inverted comma indicates that the cluster center has changed).

	Step 4: The distances are computed from each object to the newly located cluster centers and the objects are again assigned to a certain cluster on the basis of their minimum distance to other cluster centers (CC1’ and CC2’). Since the cluster centers’ position changed with respect to the initial situation, this could lead to a different cluster solution. This is also true of our example, because object E is now—unlike in the initial partition—closer to the first cluster center (CC1’) than to the second (CC2’). Consequently, this object is now assigned to the first cluster (Fig. 9.13).




[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig10_HTML.png]
Fig. 9.10k-means procedure (step 1: placing random cluster centers)


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig11_HTML.png]
Fig. 9.11k-means procedure (step 2: assigning objects to the closest cluster center)


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig12_HTML.png]
Fig. 9.12k-means procedure (step 3: re-computing cluster centers)


[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig13_HTML.png]
Fig. 9.13k-means procedure (step 4: reassigning objects to the closest cluster center)



The k-means procedure is now repeated until a predetermined number of iterations are reached, or convergence is achieved (i.e., there is no change in the cluster affiliations).
Tip
Naftali Harris’s website offers a nice visualization of k-means clustering:

                      https://​www.​naftaliharris.​com/​blog/​visualizing-k-means-clustering/​
                    

Three aspects are worth noting in terms of using k-means:	k-means is implicitly based on pairwise Euclidean distances, because the sum of the squared distances from the centroid is equal to the sum of the pairwise squared Euclidean distances divided by the number of objects. Hence, SPSS does not allow for selecting a distance measure—as in hierarchical clustering—but uses Euclidean distances. Therefore, the method should only be used with metric and, in case of equidistant scales, ordinal variables.

	Results produced by k-means depend on the starting partition. That is, k-means produce different results, depending on the starting partition chosen by the researcher or initiated by the software. In SPSS, the initialization depends on the ordering of the objects. As a result, k-means may converge in a local optimum
                            
                          , which means that the solution is only optimal compared to similar solutions, but not globally. Therefore, you should run k-means multiple with objects sorted in different random orders to verify the stability of a given solution.

	k-means is less computationally demanding than hierarchical clustering techniques. The method is therefore generally preferred for sample sizes above 500, and particularly for big data
                            
                           applications.

	Running k-means requires specifying the number of clusters to retain prior to running the analysis. We discuss this issue in the next section.





Box 9.2 Variants of the original k-means method
k-medians
                        
                       is a popular variant of k-means, which essentially follows the same logic and procedure. However, instead of using the cluster mean as a reference point for the calculation of the within cluster variance, k-medians minimizes the absolute deviations from the cluster medians, which equals the city-block distance. Thus, k-medians does not optimize the squared deviations from the mean as in k-means, but absolute distances. Thereby k-median avoids the possible effect of extreme values on the cluster solution. Other variants use other cluster centers (e.g., k-medoids
                        
                      ; Kaufman and Rousseeuw 2005; Park and Jun 2009), or optimize the initialization process (e.g., k-means++;
                        
                       Arthur and Vassilvitskii 2007). However, neither of these variants is menu-accessible in SPSS.
9.3.2.3 Two-Step Cluster Analysis
Chiu et al.’s (2001) two-step cluster analysis
                    
                   is an alternative to k-means for very large datasets. As its name implies, the method follows a two-stage approach.
In the first stage, the method merges all objects into sub-clusters. To do so, the method successively screens all objects to decide whether an object is merged with an existing cluster or establishes a new sub-cluster. Thereby two-step clustering establishes a cluster feature tree
                    
                   with roots and leaves (Fig. 9.14). Each of potentially eight roots consists of a maximum number of eight leaves. Each leave has a maximum number of eight sub-clusters. Hence, two-step clustering allows for a maximum number of 8 · 8 · 8 = 512 sub-clusters. Sub-clusters in one leave are similar to each other, as defined by the distance measure, whereas sub-clusters in different leaves are distinct. By establishing a cluster feature tree, two-step cluster analysis reduces computing time, which is an issue for very large datasets. In the second stage, two-step cluster analysis uses a modified hierarchical agglomerative clustering procedure to merge the sub-clusters.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig14_HTML.png]
Fig. 9.14Cluster feature tree



One crucial advantage of the two-step cluster analysis is that it can handle categorical and continuous variables simultaneously. Hierarchical clustering and k-means are clearly limited in this regard as these methods require continuous variables (k-means) or variables measured on either a categorical, ordinal, or continuous scale (hierarchical clustering). Furthermore, two-step clustering allows for automatically selecting the number of clusters based on statistical criteria. The procedure also indicates each variable’s importance for the construction of a specific cluster. Finally, two-step cluster analysis also offers an overall goodness-of-fit measure called silhouette measure of cohesion and sepearation. It is essentially based on the average distances between the objects and can vary between −1 and +1. A value of less than 0.20 indicates a poor solution quality, a value between 0.20 and 0.50 a fair solution, whereas values higher than 0.50 indicate a good solution. These desirable features make the somewhat less popular two-step clustering a good alternative to the traditional methods.
9.3.3 Select a Measure of Similarity or Dissimilarity
In the previous section, we discussed different linkage algorithms used in agglomerative hierarchical clustering, the k-means procedure as well as two-step clutering. All these clustering procedures rely on measures that express the (dis)similarity between pairs of objects. In the following section, we introduce different measures for metric, ordinal, nominal, and binary variables.
9.3.3.1 Metric and Ordinal Variables
Distance Measures
A straightforward way to assess two objects’ proximity is by drawing a straight line between them. For example, on examining the scatter plot in Fig. 9.1, we can easily see that the length of the line connecting observations B and C is much shorter than the line connecting B and G. This type of distance is called Euclidean distance
                      
                     or straight line distance
                      
                    ; it is the most commonly used type for analyzing metric variables and, if the scales are equidistant (Chap.​ 3), ordinal variables. Researchers also often use the squared Euclidean distance
                      
                    .
In order to use a clustering procedure, we need to express these distances mathematically. Using the data from Table 9.1, we can compute the Euclidean distance between customer B and customer C (generally referred to as d(B,C)) by using variables x and y with the following formula:[image: 
$${d_{Euclidean}}(B,C) = \sqrt {{{({x_B} - {x_C})}^2} + {{({y_B} - {y_C})}^2}} $$
]





As can be seen, the Euclidean distance is the square root of the sum of the squared differences in the variables’ values. Using the data from Table 9.1, we obtain the following:[image: 
$${d_{Euclidean}}\left( {B,C} \right) = \sqrt {{{\left( {82 - 66} \right)}^2} + {{\left( {94 - 80} \right)}^2} = } \sqrt {452} \approx 21.260$$
]





This distance corresponds to the length of the line that connects objects B and C. In this case, we only used two variables, but we can easily add more under the root sign in the formula. However, each additional variable will add a dimension (e.g., with six clustering variables, we have to deal with six dimensions), making it difficult to represent the solution graphically. Similarly, we can compute the distance between customer B and G, which yields the following:[image: 
$${d_{Euclidean}}\left( {B,G} \right) = \sqrt {{{\left( {82 - 10} \right)}^2} + {{\left( {94 - 17} \right)}^2} = } \sqrt {11,113} \approx 105.418$$
]





We should also compute the distance between all other pairs of objects and summarize them in a distance matrix. Table 9.2 shows the Euclidean distance matrix for objects A-G.
There are also alternative distance measures: The city-block distance
                      
                     uses the sum of the variables’ absolute differences. This distance measure is referred to as the Manhattan metric
                      
                     as it is akin to the walking distance between two points in a city like New York’s Manhattan district, where the distance equals the number of blocks in the directions North-South and East-West. Using the city-block distance to compute the distance between customers B and C (or C and B) yields the following:[image: 
$${d_{City - block}}(B,C) = \left| {{x_B} - {x_C}} \right| + \left| {{y_B} - {y_C}} \right| = \left| {82 - 66} \right| + \left| {94 - 80} \right| = 30$$
]





The resulting distance matrix is shown in Table 9.8.Table 9.8City-block distance matrix


	Objects
	A
	B
	C
	D
	E
	F
	G

	A
	0
	 
	B
	50
	0
	 
	C
	48
	30
	0
	 
	D
	31
	79
	49
	0
	 
	E
	81
	37
	33
	56
	0
	 
	F
	79
	93
	63
	54
	56
	0
	 
	G
	101
	149
	119
	70
	112
	56
	0





Lastly, when working with metric (or ordinal) data, researchers frequently use the Chebychev distance
                      
                    , which is the maximum of the absolute difference in the clustering variables’ values. For customers B and C, this is calculated as:[image: 
$${d_{Chebychev}}\left( {B,C} \right) = max\left( {\left| {{x_B} - {x_C}} \right|,\left| {{y_B} - {y_C}} \right|} \right) = max\left( {\left| {82 - 66} \right|,\left| {94 - 80} \right|} \right) = 16$$
]





Figure 9.15 illustrates the interrelation between these three distance measures regarding two objects (here: B and G) from our example.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig15_HTML.png]
Fig. 9.15Distance measures



Tip
Different distance measures typically lead to different cluster solutions. Thus, it is advisable to use several measures, check for the stability of results, and compare them with theoretical or known patterns.

Association Measures
The (dis)similarity between objects can also be expressed using association measures
                      
                     (e.g., correlations). For example, suppose a respondent rated price consciousness 2 and brand loyalty 3, a second respondent indicated 5 and 6, whereas a third rated these variables 3 and 3. Euclidean and city-block distances would indicate that the first respondent is more similar to the third than to the second. Nevertheless, one could convincingly argue that the first respondent’s ratings are more similar to the second’s, as both rate brand loyalty higher than price consciousness. This can be accounted for by computing the correlation between two vectors of values as a measure of similarity (i.e., high correlation coefficients indicate a high degree of similarity). Consequently, similarity is no longer defined as the difference between the answer categories, but as the similarity of the answering profiles.
Tip
Whether you use one of the distance measures or correlations depends on whether you think the relative magnitude of the variables within an object (which favors correlation) matters more than the relative magnitude of each variable across the objects (which favors distance). Some researchers recommended using correlations when applying clustering procedures that are particularly susceptible to outliers, such as complete linkage, average linkage, or centroid linkage. Furthermore, correlations implicitly standardize the data, as differences in the scale categories do not have a strong bearing on the interpretation of the response patterns. Nevertheless, distance measures are most commonly used for their intuitive interpretation. Distance measures best represent the concept of proximity, which is fundamental to cluster analysis. Correlations, although having widespread application in other techniques, represent patterns rather than proximity.

Standardizing the Data
In many analysis tasks, the variables under consideration are measured in different units with hugely different variance. This would be the case if we extended our set of clustering variables by adding another metric variable representing the customers’ gross annual income. Since the absolute variation of the income variable would be much higher than the variation of the remaining two variables (remember, x and y are measured on a scale from 0 to 100), this would significantly change our analysis results. We can resolve this problem by standardizing the data prior to the analysis (Chap.​ 5).
Different standardization methods are available, such as z-standardization
                      
                    , which rescales each variable to a mean of 0 and a standard deviation of 1 (see Chap.​ 5). In cluster analysis, however, range standardization
                      
                     (e.g., to a range of 0 to 1) typically works better (Milligan and Cooper 1988).
9.3.3.2 Binary and Nominal Variables
Whereas the distance measures presented thus far can be used for variables measured on a metric and, in general, on an ordinal scale, applying them to binary and nominal variables is problematic. When nominal variables are involved, you should instead select a similarity measure expressing the degree to which the variables’ values share the same category. These matching coefficients
                    
                   can take different forms, but rely on the same allocation scheme as shown in Table 9.9. In this crosstab, cell a is the number of characteristics present in both objects A and B, whereas cell d describes the number of characteristics absent in both objects. Cells b and c describe the number of characteristics present in one, but not the other, object.Table 9.9Allocation scheme for matching coefficients


	 	Second object

	Presence of a characteristics (1)
	Absence of a characteristic (0)

	First object
	Presence of a characteristic (1)
	a
	b

	Absence of a characteristic (0)
	c
	d





The allocation scheme in Table 9.9 applies to binary variables (i.e., nominal variables with two categories). For nominal variables with more than two categories, you need to convert the categorical variable into a set of binary variables in order to use matching coefficients. For example, a variable with three categories needs to be transformed into three binary variables, one for each category (see the following example).
Based on the allocation scheme in Table 9.9, we can compute different matching coefficients, such as the simple matching (SM) coefficient
                    
                  :[image: 
$$SM = \frac{{a + d}}{{a + b + c + d}}$$
]





This coefficient takes both the joint presence and the joint absence of a characteristic (as indicated by cells a and d in Table 9.9) into account. This feature makes the simple matching coefficient particularly useful for symmetric variables where the joint presence and absence of a characteristic carry an equal degree of information. For example, the binary variable gender has the possible states “male” and “female.” Both are equally valuable and carry the same weight when the simple matching coefficient is computed. However, when the outcomes of a binary variable are not equally important (i.e., the variable is asymmetric), the simple matching coefficient proves problematic. An example of an asymmetric variable is the presence, or absence, of a relatively rare attribute, such as customer complaints. While you say that two customers who complained have something in common, you cannot say that customers who did not complain have something in common. The most important outcome is usually coded as 1 (present) and the other is coded as 0 (absent). The agreement of two 1s (i.e., a positive match) is more significant than the agreement of two 0s (i.e., a negative match). Similarly, the simple matching coefficient proves problematic when used on nominal variables with many categories. In this case, objects may appear very similar, because they have many negative matches rather than positive matches.
Given this issue, researchers have proposed several other matching coefficients, such as the Jaccard coefficient (JC)
                    
                   and the Russell and Rao coefficient
                    
                  , which (partially) omit the d cell from the calculation. Like the simple matching coefficient, these coefficients range from 0 to 1 with higher values indicating a greater degree of similarity.4 They are defined as follows:[image: 
$$\begin{aligned} JC\, &amp;= \,\frac{a}{{a\, + \,b\, + c}} \hfill\\ \, \\ RR\, &amp;= \,\frac{a}{{a + b\, + \,c\, + \,d}} \hfill \\ \end{aligned} $$
]





To provide an example that compares the three coefficients, consider the following three variables:	gender: male, female

	customer: yes, no

	country of residence: GER, UK, USA





We first transform the measurement data into binary data by recoding the original three variables into seven binary variables (i.e., two for gender and customer; three for country of residence). Table 9.10 shows a binary data matrix for three objects A, B, and C. Object A is a male customer from Germany; object B is a male non-customer from the United States; object C is a female non-customer, also from the United States.Table 9.10Recoded measurement data


	Object
	
                              Gender
                            
(binary)
	
                              Customer
                            
(binary)
	
                              Country of residence
                            
(binary)

	 	Male
	Female
	Yes
	No
	GER
	UK
	USA

	A
	1
	0
	1
	0
	1
	0
	0

	B
	1
	0
	0
	1
	0
	0
	1

	C
	0
	1
	0
	1
	0
	0
	1




Using the allocation scheme from Table 9.9 to compare objects A and B yields the following results for the cells: a = 1, b = 2, c = 2, and d = 2. This means that the two objects have only one shared characteristic (a = 1), but two characteristics, which are absent from both objects (d = 2). Using this information, we can now compute the three coefficients described earlier:

                  [image: 
$$SM(A,B) = \frac{{1 + 2}}{{1 + 2 + 2 + 2}} = 0.571,$$
]




                

[image: 
$JC(A,B) = \frac{1}{{1 + 2 + 2}} = 0.2$
], and[image: 
$$RR(A,B) = \frac{1}{{1 + 2 + 2 + 2}} = 0.143$$
]





As we can see, the simple matching coefficient suggests that objects A and B are reasonably similar. Conversely, the Jaccard coefficient, and particularly the Russel Rao coefficient, suggests that they are not.
Try computing the distances between the other object pairs. Your computation should yield the following: SM(A,C) = 0.143, SM(B,C) = 0.714, JC(A,C) = 0, JC(B,C) = 0.5, RR(A,C) = 0, and RR(B,C) = 0.286.
9.3.3.3 Mixed Variables
Most datasets contain variables that are measured on multiple scales. For example, a market research questionnaire may require the respondent’s gender, income category, and age. We therefore have to consider variables measured on a nominal, ordinal, and metric scale. How can we simultaneously incorporate these variables into an analysis?
Often research use the distance measures discussed in the context of metric (and ordinal) data. Even though this approach may slightly change the results compared to using matching coefficients, it should not be rejected. Cluster analysis is mostly an exploratory technique whose results only provide guidance for making decisions but are no substitute for decision-making.
An alternative is to dichotomize all the variables and apply the matching coefficients discussed above. For metric variables, this involves specifying categories (e.g., low, medium, and high age) and converting these into sets of binary variables. In most cases, the specification of categories is somewhat arbitrary. Furthermore, this procedure leads to a severe loss in precision, as we disregard more detailed information on each object. For example, we lose precise information on each respondent’s age when scaling this variable down into age categories. Given such issues, you should avoid combining metric and nominal variables in a single cluster analysis.
Another way to handle variables measured on different scale levels is to use the two-step cluster analysis (see Sect. 9.3.2.3). This method uses a distance measure that draws on probability distributions. Specifically, this distance defines the distance between two objects in terms of the decrease of the likelihood value when merging them.
9.3.4 Decide on the Number of Clusters
An important question we haven’t yet addressed is how to decide on the number of clusters. A misspecified number of clusters results in under- or oversegmentation, which easily leads to inaccurate management decisions on, for example, customer targeting, product positioning, or determining the optimal marketing mix (Becker et al. 2015).
We can select the number of clusters pragmatically, choosing a grouping that “works” for our analysis, but sometimes we want to select the “best” solution that the data suggest. However, different clustering methods require different approaches to decide on the number of clusters. Hence, we discuss hierarchical and portioning methods separately.
9.3.4.1 Hierarchical Methods
To guide the decision of how many clusters to extract from the data, we can draw on the distances at which the objects were combined. More precisely, we can seek a solution in which an additional combination of clusters or objects would occur at a greatly increased distance. This raises the issue of what a great distance is.
We can seek an answer by plotting the distance level at which the mergers of objects and clusters occur by using a dendrogram
                    
                  . Figure 9.16 shows the dendrogram for our example as produced by SPSS. We read the dendrogram from the left to the right. The horizontal lines indicate the distances at which the objects were merged. Note that in SPSS, these distances do not correspond to the actual merging distances as computed in Tables 9.2, 9.3, 9.4, 9.5 and 9.7. Instead, SPSS rescales the distances to a range of 0–25 (i.e., the last merging step to a one-cluster solution takes place at a rescaled distance of 25). The rescaling on the x-axis facilitates the decision on how many clusters to extract from the data. Specifically, to decide on the number of clusters, we cut the dendrogram vertically in the area where no merger has occurred for a long distance. In our example, this is done when moving from a four-cluster solution, which occurs at a rescaled distance of 8, to a three-cluster solution, which occurs at a distance of 18. This result suggests a four-cluster solution [A,D], [B,C,E], [F], and [G], but this conclusion is not clear-cut. In fact, the dendrogram often does not provide a clear indication, because it is generally difficult to identify where the cut should be made. This is particularly true of large sample sizes when the dendrogram becomes unwieldy.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig16_HTML.png]
Fig. 9.16Dendrogram



As an alternative to the dendrogram, we can also contrast the distances against the number of clusters to produce a scree plot
                    
                  , similar to the one used to decide on the number of factors in factor analysis (Chap.​ 8). Specifically, we can plot the number of clusters on the x-axis (starting with the one-cluster solution at the very left) against the distance at which objects or clusters are merged on the y-axis. Using this plot, we then search for the distinctive break (elbow
                    
                  ), which indicates the number of clusters to retain. Note that—unlike in factor analysis—we do not pick the solution with one cluster less than indicated by the elbow. Furthermore, the distances typically sharply increase when switching from a two-cluster solution to a one-cluster solution. However, this break should not be viewed as a reliable indicator for the decision regarding the number of segments.
Research has produced several other criteria for determining the number of clusters in a dataset. One of the most prominent criteria is Calinski and Harabasz’s (1974) variance ratio criterion (VRC)
                    
                  . For a solution with n objects and k clusters, the VRC is defined as:[image: 
$$VR{C_k} = (S{S_B}/(K - 1))/(S{S_W}/(n - K)),$$
]





where SSB is the sum of the squares between the clusters and SSW is the sum of the squares within the clusters. The criterion should seem familiar, as it is equivalent to the F-value of a one-way ANOVA (Chap.​ 6). To determine the appropriate number of clusters, you should choose the number that maximizes the VRC. However, as the VRC usually decreases with a greater number of clusters, you should compute the difference in the VRC values ωk of each cluster solution, using the following formula:[image: 
$${\omega _k} = (VR{C_{k + 1}} - VR{C_k}) - (VR{C_k} - VR{C_{k - 1}}).$$
]





The number of clusters k that minimizes the value in ωk indicates the best cluster solution. Prior research has shown that the VRC reliably identifies the correct number of clusters across a broad range of constellations (Miligan and Cooper 1985). However, owing to the term VRC k
−1, which is not defined for a one-cluster solution, the minimum number of clusters that can be selected is three, which is a disadvantage when using the ωk statistic.
To compute the VRC, we need to run a series of ANOVAs using the clustering variables as dependent variables and the cluster affiliation as the factor variable. The VRC for a certain number of clusters k results from summing all the F-value across the different ANOVAs. Note that the computation of the VRC values is more straightforward when running k-means clustering as SPSS allows running ANOVAs on the clustering variables as part of this clustering procedure.
Overall, the above criteria can often only provide rough guidance regarding the number of clusters that should be selected–you should also take practical considerations into account. Occasionally, you might have a priori knowledge, or a theory on which you can base your choice. However, first and foremost, you should ensure that your results are interpretable and meaningful. Not only must the number of clusters be small enough to ensure manageability, but each segment should also be large enough to warrant strategic attention.
9.3.4.2 Partitioning Methods
When running partitioning methods, such as k-means, you have to pre-specify the number of clusters to retain from the data. There are varying ways of guiding this decision:	Compute the VRC (see discussion in the context of hierarchical clustering) for an alternating number of clusters and select the solution that maximizes the VRC or minimizes ωk. For example, compute the VRC for a three- to five-cluster solution and select the number of clusters that minimizes ωk.

	Run a hierarchical procedure to determine the number of clusters by using the dendrogram and run k-means afterwards.5 This approach also enables you to find starting values for the initial cluster centers to handle a second problem, which relates to the procedure’s sensitivity to the initial classification (we will follow this approach in the example application).

	Rely on prior information, such as earlier research findings.





9.3.4.3 Two-step Clustering
One crucial advantage of two-step clustering is that the method allows for automatically selecting the number of clusters based on statistical criteria. In doing so, two-step clustering follows a two-stage approach (Bacher et al. 2004).
In the first stage, the method determines a maximum number of clusters based on Akaike’s Information Criterion
                    
                   (AIC; Akaike 1973) or the Bayes Information Criterion
                    
                   (BIC; Schwarz 1978), depending on the researcher’s specification. These criteria add different terms to the log likelihood value resulting from the analysis, which penalize the complexity of the solution as expressed by the number of clusters—solutions with a more clusters entail a stronger penalty term. In SPSS, the maximum number of clusters is determined by the ratio between AIC (or BIC) for a solution with k clusters and a one-cluster solution. The solution for which this ratio is smaller than a certain threshold assumed by the program is the maximum number of clusters.
In the second stage, two-step clustering computes the ratio of distances between different cluster solutions using the AIC (or BIC) values as input. The resulting ratio determines the final number of clusters to extract.
9.3.5 Validate and Interpret the Clustering Solution
Before interpreting the cluster solution, we need to assess the stability of the results. Stability means that the cluster membership of individuals does not change, or only changes a little when different clustering methods are used to cluster the objects. Thus, when different methods produce similar results, we claim stability.
The aim of any cluster analysis is to differentiate well between the objects. The identified clusters should therefore differ substantially from each other and the members of different clusters should respond differently to different marketing-mix elements and programs.
Lastly, we need to profile the cluster solution by using observable variables. Profiling
                  
                 ensures that we can easily assign new objects to clusters based on observable traits. For example, we could identify clusters based on loyalty to a product, but in order to use these different clusters, their membership should be identifiable according to tangible variables, such as income, location, or family size, in order to be actionable.
The key to successful segmentation is to critically revisit the results of different cluster analysis set-ups (e.g., by using different algorithms on the same data) in terms of managerial relevance. The following criteria help identify a clustering solution (Kotler and Keller 2015; Tonks 2009).	Substantial: The clusters are large and sufficiently profitable to serve.

	Reliable: Only clusters that are stable over time can provide the necessary basis for a successful marketing strategy. If clusters change their composition quickly, or their members’ behavior, targeting strategies are not likely to succeed. Therefore, a certain degree of stability is necessary to ensure that marketing strategies can be implemented and produce adequate results. Reliability can be evaluated by critically revisiting and replicating the clustering results at a later date.

	Accessible: The clusters can be effectively reached and served.

	Actionable: Effective programs can be formulated to attract and serve the clusters.

	Parsimonious: To be managerially meaningful, only a small set of substantial clusters should be identified.

	Familiar: To ensure management acceptance, the cluster composition should be easy to relate to.

	Relevant: Clusters should be relevant in respect of the company’s competencies and objectives.





9.3.5.1 Stability
Stability is evaluated by using different clustering procedures on the same data and considering the differences that occur. For example, you may first run a hierarchical clustering procedure, followed by k-means clustering to check whether the cluster affiliations of the objects change. Alternatively, running a hierarchical clustering procedure, you can use different distance measures and evaluate their effect on the stability of the results. However, note that it is common for results to change even when your solution is adequate. As a rule of thumb, if more than 20 % of the cluster affiliations change from one technique to the other, you should reconsider the analysis and use, for example, a different set of clustering variables, or reconsider the number of clusters. Note, however, that this percentage is likely to increase with the number of clusters used.
When the data matrix exhibits identical values (referred to as ties
                    
                  ), the ordering of the objects in the dataset can influence the results of the hierarchical clustering procedure. For example, when computing the distance matrix based on the city-block distance for the data from Table 9.1, object pairs (D,E), (E,F), and (F,G) have the same distance of 56 units. Ties can prove problematic when they occur for the minimum distance in a distance matrix, as the decision about which objects to merge then becomes ambiguous (i.e., should we merge objects D and E, E and F, or F and G if 56 was the smallest distance in the matrix?). To handle this problem, Van Der Kloot et al. (2005) recommend re-running the analysis with a different input order of the data. The downside of this approach is that the labels of a cluster may change from one analysis to the next. This issue is referred to as label switching
                    
                  . For example, in the first analysis, cluster 1 may correspond to cluster 2 in the second analysis. Ties are, however, more the exception than the rule in practical applications—especially when using (squared) Euclidean distances—and generally don't have a pronounced impact on the results. However, if changing the order of the objects also drastically changes the cluster compositions (e.g., in terms of cluster sizes), you should reconsider the set-up of the analysis and, for example, re-run it with different clustering variables.
9.3.5.2 Differentiation of the Data
To examine whether the final partition differentiates the data well, we need to examine the cluster centroids. This step is highly important, as the analysis sheds light on whether the clusters are truly distinct. Only if objects across two (or more) clusters exhibit significantly different means in the clustering variables (or any other relevant variable) can they be distinguished from each other. This can be easily ascertained by comparing the means of the clustering variables across the clusters with independent t-tests or ANOVA (see Chap.​ 6).
Furthermore, we need to assess the solution’s criterion validity
                    
                   (see Chap.​ 4). We do this by focusing on the criterion variables that have a theoretical relationship with the clustering variables, but were not included in the analysis. In market research, criterion variables are usually managerial outcomes, such as the sales per person, or willingness-to-pay. If these criterion variables differ significantly, we can conclude that the clusters are distinct groups with criterion validity.
9.3.5.3 Profiling
As indicated at the beginning of the chapter, cluster analysis usually builds on unobservable clustering variables. This creates an important problem when working with the final solution: How can we decide to which cluster a new object should be assigned if its unobservable characteristics, such as personality traits, personal values, or lifestyles, are unknown? We could survey these attributes and make a decision based on the clustering variables. However, this is costly and researchers therefore usually try to identify observable variables (e.g., demographics) that best mirror the partition of the objects. More precisely, these observable variables should partition the data into similar groups as the clustering variables do. Using these observable variables, it is then easy to assign a new object (whose cluster membership is unknown) to a certain cluster. For example, assume that we used a set of questions to assess the respondents’ values and learned that a certain cluster contains respondents who appreciate self-fulfillment, enjoyment of life, and a sense of accomplishment, whereas this is not the case in another cluster. If we were able to identify explanatory variables, such as gender or age, which distinguish these clusters adequately, then we could assign a new person to a specific cluster on the basis of these observable variables whose value traits may still be unknown.
9.3.5.4 Interpret the Clustering Solution
The interpretation of the solution requires characterizing each cluster by using the criterion or other variables (in most cases, demographics). This characterization should focus on criterion variables that convey why the cluster solution is relevant. For example, you could highlight that customers in one cluster have a lower willingness to pay and are satisfied with lower service levels, whereas customers in another cluster are willing to pay more for a superior service. By using this information, we can also try to find a meaningful name or label for each cluster; that is, one that adequately reflects the objects in the cluster. This is usually a challenging task, especially when unobservable variables are involved.
Table 9.11 summarizes the steps involved in a hierarchical, k-means, and two-step clustering using SPSS.Table 9.11Steps involved in carrying out a cluster analysis in SPSS


	Theory
	Action

	
                              Research problem
                            

	Identification of homogenous groups of objects in a population

	Select clustering variables to form segments
	Select relevant variables that potentially exhibit high degrees of criterion validity with regard to a specific managerial objective.

	
                              Requirements
                            

	Sufficient sample size
	Make sure that the relationship between the objects and the clustering variables is reasonable. Ten times the number of clustering variables is the bare minimum, but 30 to 70 times is recommended. Ensure that the sample size is large enough to guarantee substantial segments.

	Low levels of collinearity among the variables
	► Analyze ► Correlate ► Bivariate
In case of highly correlated variables (correlation coefficients > 0.90), delete one variable of the offending pair.

	
                              Specification
                            

	Choose the clustering procedure
	If there is a limited number of objects in your dataset or you do not know the number of clusters:
► Analyze ► Classify ► Hierarchical Cluster

	If there are many observations (> 500) in your dataset and you have a priori knowledge regarding the number of clusters:
► Analyze ► Classify ► K-Means Cluster

	If there are many observations in your dataset and the clustering variables are measured on different scale levels:
► Analyze ► Classify ► Two-Step Cluster

	Choose clustering algorithm
(only hierarchical clustering)
	► Analyze ► Classify ► Hierarchical Cluster ► Method ► Cluster Method
Use Ward’s method if equally sized clusters are expected and no outliers are present. Preferably use single linkage, also to detect outliers.

	Select a measure of (dis)similarity
	
                              Hierarchical methods:
                            
► Analyze ► Classify ► Hierarchical Cluster ► Method ► Measure
Depending on the scale level, select the measure;
convert variables with multiple categories into a set of binary variables and use matching coefficients; standardize variables if necessary (on a range of 0 to 1).

	
                              k-means clustering:
                            
Uses Euclidean distances per default.

	
                              Two-step clustering:
                            
► Analyze ► Classify ► Two-Step Cluster ► Distance Measure
Use Euclidean distances when all variables are continuous; for mixed variables, you have to use the log-likelihood.

	Deciding on the number of clusters
	
                              Hierarchical clustering:
                            
Examine the dendrogram:
► Analyze ► Classify ► Hierarchical Cluster ► Plots ►Dendrogram
Draw a scree plot: Double-click on the Agglomeration Schedule in the output window, highlight all coefficients in the column and right-click the mouse button. In the menu that opens up, select Create Graph ► Line

Compute the VRC using an ANOVA:
► Analyze ► Compare Means ► One-Way ANOVA
Move the cluster membership variable in the Factor box and the clustering variables in the Dependent List box;
Compute VRC for each segment solution and compare values.
Include practical considerations in your decision.

	
                              k-means:
                            
Run a hierarchical cluster analysis and decide on the number of segments based on a dendrogram or scree plot; use this information to run k-means with k clusters.
Compute the VRC using an ANOVA:
► Analyze ► Classify ► K-Means Cluster ► Options ►ANOVA table;
Compute VRC for each segment solution and compare values.
Include practical considerations in your decision.

	
                              Two-step clustering:
                            
Specify the maximum number of clusters:
► Analyze ► Classify ► Two-Step Cluster ►Number of Clusters
Run separate analyses using the AIC and BIC as clustering criteria:
► Analyze ► Classify ► Two-Step Cluster ► Clustering Criterion
Examine the model summary output.
Include practical considerations in your decision.

	
                              Validating and interpreting the cluster solution
                            

	Stability
	Re-run the analysis using different clustering procedures, algorithms or distance measures.

	Change the order of objects in the dataset.

	Differentiation of the data
	Compare the cluster centroids across the different clusters for significant differences.
If possible, assess the solution’s criterion validity.

	Profiling
	Identify observable variables (e.g., demographics) that best mirror the partition of the objects based on the clustering variables.

	Interpreting of the cluster solution
	Identify names or labels for each cluster and characterize each cluster using observable variables.





While companies develop their own market segments, they frequently use standardized segments, based on established buying trends, habits, and customers’ needs to position their products in different markets. The PRIZM
                    
                   lifestyle by Nielsen is one of the most popular segmentation databases. It combines demographic, consumer behavior, and geographic data to help marketers identify, understand, and reach their customers and prospective customers. PRIZM defines every US household in terms of more than 60 distinct segments to help marketers discern these consumers’ likes, dislikes, lifestyles, and purchase behaviors.
An example is the segment labeled “Connected Bohemians,” which Nielsen characterizes as a “collection of mobile urbanites, Connected Bohemians represent the nation's most liberal lifestyles. Its residents are a progressive mix of tech savvy, young singles, couples, and families ranging from students to professionals. In their funky row houses and apartments, Bohemian Mixers are the early adopters who are quick to check out the latest movie, nightclub, laptop, and microbrew.” Members of this segment are between 25 and 44 years old, have a midscale income, own a hybrid vehicle, eat at Starbucks, and go skiing/snowboarding. (www.​MyBestSegments.​com).
9.4 Example
Let’s go back to the Oddjob Airways case study and run a cluster analysis on the data. Our aim is to identify a manageable number of segments that differentiates the customer base well. To do so, we first select a set of clustering variables, taking the sample size and potential collinearity issues into account. Next, we apply hierarchical clustering based on the squared Euclidean distances, using the Ward’s linkage algorithm. This analysis will help us determine a suitable number of segments and a starting partition, which we will then use as the input for k-means clustering.
9.4.1 Hierarchical Cluster Analysis
9.4.1.1 Select the Clustering Variables
The Oddjob Airways dataset (↓ Web Appendix → Downloads) offers several variables for segmenting its customer base. Our analysis draws on the following set of variables, which we consider promising for identifying distinct segments based on customers’ expectations regarding the airline’s service quality (variable names in parentheses):	With Oddjob Airways you will arrive on time (e1),

	Oddjob Airways provides you with a very pleasant travel experience (e5),

	Oddjob Airways gives you a sense of safety (e9),

	Oddjob Airways makes traveling uncomplicated (e21), and

	Oddjob Airways provides you with interesting on-board entertainment, service, and information sources (e22).





With five clustering variables, our analysis meets even the most conservative rule-of-thumb regarding minimum sample size requirements. Specifically, according to Dolnicar et al. (2016), the cluster analysis should draw on 100 times the number of clustering variables to optimize cluster recovery. As our sample size of 1065 is clearly higher than 5 · 100 = 500, we can proceed with the analysis. Note, however, that the actual sample size used in the analysis may be substantially lower when using casewise deletion. This also applies to our analysis, which draws on 969 objects (i.e., after casewise deletion) as we can see in Table 9.16.
To begin with, we examine the variable correlations by clicking on ► Analyze ► Correlate ► Bivariate. Next, enter the variables e1, e5, e9, e21, and e22 into the Variables box (Fig. 9.17). Click on OK and SPSS will display the results (Table 9.12).[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig17_HTML.jpg]
Fig. 9.17Bivariate correlations dialog box


Table 9.12Bivariate correlations output


	Correlations

	e1
	e5
	e9
	e21
	e22

	e1
	Pearson Correlation
	1
	.515**

	.533**

	.613**

	.370**


	Sig. (2-tailed)
	 	.000
	.000
	.000
	.000

	N
	1038
	1026
	1023
	1018
	997

	e5
	Pearson Correlation
	.515**

	1
	.525**

	.574**

	.530**


	Sig. (2-tailed)
	.000
	 	.000
	.000
	.000

	N
	1026
	1041
	1023
	1017
	998

	e9
	Pearson Correlation
	.533**

	.525**

	1
	.522**

	.417**


	Sig. (2-tailed)
	.000
	.000
	 	.000
	.000

	N
	1023
	1023
	1036
	1016
	996

	e21
	Pearson Correlation
	.613**

	.574**

	.522**

	1
	.425**


	Sig. (2-tailed)
	.000
	.000
	.000
	 	.000

	N
	1018
	1017
	1016
	1028
	989

	e22
	Pearson Correlation
	.370**

	.530**

	.417**

	.425**

	1

	Sig. (2-tailed)
	.000
	.000
	.000
	.000
	 
	N
	997
	998
	996
	989
	1012


** Correlation is significant at the 0.01 level (2-tailed).




The results show that collinearity is not at a critical level. The variables e1 and e21 show the highest correlation of 0.613, which is clearly lower than the 0.90 threshold. We can therefore proceed with the analysis, using all five clustering variables.
9.4.1.2 Select the Clustering Procedure and a Measure of Similarity or Dissimilarity
To initiate hierarchical clustering, go to ► Analyze ► Classify ► Hierarchical Cluster, which opens a dialog box similar to Fig. 9.18.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig18_HTML.jpg]
Fig. 9.18Hierarchical cluster analysis dialog box



Move the variables e1, e5, e9, e21, and e22 into the Variable(s) box. The Statistics option gives us the opportunity to request the distance matrix (labeled proximity matrix in this case) and the agglomeration schedule, which provides information on the objects being combined at each stage of the clustering process. Furthermore, we can specify the number or range of clusters to retain from the data. As we do not yet know how many clusters to retain, just check the box Agglomeration schedule
                    
                   and continue.
Under Plots, check the box Dendrogram to graphically display the distances at which objects and clusters are joined. SPSS also offers the option to display an Icicle diagram
                    
                   (All clusters), which is yet another graph for displaying clustering solutions. Its name stems from the analogy to rows of icicles hanging from the eaves of a house. The diagram is read from the bottom to the top; the columns correspond to the objects being clustered, and the rows represent the number of clusters. Given the great number of objects, we do not request the icicle diagram in our example.
The option Method allows us to specify the cluster method, the distance measure, and the type of standardization of values. Because of its versatility and general performance, we choose the Ward’s method and Squared Euclidean distance as distance measure. Even though all the variables used in our analysis are measured on a scale from 0 to 100, we standardize the data to account for differences in the variables’ variances. To do so, go to the Transform Values drop-down menu and select Range 0 to 1.
Finally, the Save option enables us to save cluster memberships for a single solution or a range of solutions. Saved variables can then be used in subsequent analyses to explore differences between groups. As a start, we will skip this option, so continue and click on OK in the main menu.
9.4.1.3 Decide on the Number of Clusters
First, we take a closer look at the agglomeration schedule (Table 9.13), which displays the objects or clusters combined at each stage (columns Cluster 1 and Cluster 2) and the distances at which this merger takes place (column Coefficients). Given the great number of objects, we limit the display of the agglomeration schedule to the merger stages 200 to 210. The table shows that in stage 200, objects 133 and 684 are merged at a distance of 0.046. From here onward, the resulting cluster is labeled as indicated by the first object involved in this merger, which is object 133. The last column on the very right tells you in which stage of the algorithm this cluster will appear next. In this case, this happens in in stage 350, where this object is merged with object 409 at a distance of 0.359 (not shown).Table 9.13Agglomeration schedule (partial screenshot)


	
                              Agglomeration Schedule
                            

	Cluster Combined
	 	Stage Cluster First Appears
	 
	Stage
	Cluster 1
	Cluster 2
	Coefficients
	Cluster 1
	Cluster 2
	Next Stage

	…
	…
	…
	…
	…
	…
	…

	200
	133
	684
	.046
	0
	119
	350

	201
	330
	478
	.047
	91
	0
	429

	202
	723
	881
	.048
	0
	0
	391

	203
	536
	835
	.049
	0
	0
	319

	204
	250
	712
	.050
	0
	0
	257

	205
	624
	631
	.051
	0
	0
	363

	206
	370
	505
	.052
	0
	0
	427

	207
	67
	112
	.053
	0
	0
	370

	208
	444
	853
	.054
	0
	83
	362

	209
	48
	767
	.055
	0
	0
	325

	210
	563
	572
	.057
	0
	112
	385

	…
	…
	…
	…
	…
	…
	…





Next, we use the agglomeration schedule to determine the number of segments to retain from the data. To do so, we generate a scree plot by plotting the distances (Coefficients column in Table 9.13) against the number of clusters. The distinct break (elbow) indicates the solution regarding where an additional combination of two objects or clusters would occur at a greatly increased distance. Thus, the number of clusters prior to this merger is the most probable solution. SPSS does not automatically provide this plot. To generate a scree plot we have to double-click the Agglomeration Schedule in the output window. Next, highlight all coefficients in the column and right-click the mouse button. In the menu that opens up, select Create Graph ► Line (Fig. 9.19). SPSS will add a line chart to the output, which represents the scree plot.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig19_HTML.png]
Fig. 9.19Generating a scree plot



The scree plot in Fig. 9.20 shows that there is no clear elbow indicating a suitable number of clusters to retain. This result is quite common for datasets with several hundred objects.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig20_HTML.png]
Fig. 9.20Scree plot



Next, we should take a look at the dendrogram. We don’t display the dendrogram here because of the size of the dataset. Reading the dendrogram from left to right, we find that the vast majority of objects are merged at very small distances. The dendrogram also shows that the step from a three-cluster solution to a two-cluster solution occurs at a greatly increased distance. Hence, we assume a three-cluster solution and continue with the analysis.
9.4.1.4 Validate and Interpret the Clustering Solution
To get a first impression of the size and nature of the three clusters, let’s re-run the hierarchical cluster analysis, but this time, we pre-specify the number of segments. To do so, go back to ► Analyze ► Classify ► Hierarchical Cluster and select the Save option. In the dialog box that opens, select Single solution and enter 3 next to Number of clusters. Click on Continue followed by OK. When running the analysis, SPSS generates the same output but also adds one additional variable to your dataset (CLU3_1), which reflect each object’s cluster membership. SPSS automatically places CLU in front, followed by a 3 to identify the total number of clusters. The variable's values (1, 2, and 3) identify each object’s cluster membership.
To learn about the size of the clusters, go to ► Analyze ► Descriptive Statistics ► Frequencies and enter CLU3_1 into the Variable(s) box. When clicking on OK, SPSS will open an output similar to Table 9.14.Table 9.14Frequencies


	CLU3_1

	 	Frequency
	Percent
	Valid Percent
	Cumulative Percent

	Valid
	1
	516
	48.5
	53.3
	53.3

	2
	238
	22.3
	24.6
	77.8

	3
	215
	20.2
	22.2
	100.0

	Total
	969
	91.0
	100.0
	 
	Missing
	System
	96
	9.0
	 	 
	Total
	1065
	100.0
	 	 




The output in Table 9.14 shows that the cluster analysis assigned 969 objects to the three segments; 96 objects were not assigned to any segment due to missing values. The first cluster is the largest among the three clusters with 516 objects, which translates into a relative cluster size of 53.3 %. Clusters 2 and 3 are smaller and similar in size with 238 and 215 objects, respectively.
Next, we would like to compute the centroids of our clustering variables. To do so, split up the dataset using the Split File command (► Data ► Split File) (see Chap.​ 5). Choose CLU3_1 as the grouping variable and select the option Compare groups. Next, go to ► Analyze ► Descriptive Statistics ► Descriptives (see Chap.​ 5) and request the mean, minimum, and maximum, as well as the standard deviations for the clustering variables e1, e5, e9, e21, and e22. Table 9.15 shows the resulting output. The first column in the table indicates the cluster number with the first element (labeled with a dot) representing the group of missing values. However, we focus our analysis of the results on the first three groups and particularly the clustering variables’ mean values.Table 9.15Descriptive statistics


	Descriptive Statistics

	CLU3_1
	N
	Minimum
	Maximum
	Mean
	Std. Deviation

	.
	e1
	69
	2
	100
	79.09
	23.522

	e5
	72
	1
	100
	70.65
	26.768

	e9
	67
	43
	100
	81.99
	18.709

	e21
	59
	1
	100
	71.47
	27.555

	e22
	43
	2
	100
	61.35
	23.931

	Valid N (listwise)
	0
	 	 	 	 
	1
	e1
	516
	69
	100
	95.13
	7.202

	e5
	516
	25
	100
	86.98
	14.519

	e9
	516
	28
	100
	94.38
	10.035

	e21
	516
	50
	100
	89.89
	11.507

	e22
	516
	50
	100
	87.61
	12.195

	Valid N (listwise)
	516
	 	 	 	 
	2
	e1
	238
	53
	100
	92.58
	9.165

	e5
	238
	5
	100
	76.65
	20.048

	e9
	238
	19
	100
	89.77
	15.189

	e21
	238
	1
	100
	83.37
	17.343

	e22
	238
	1
	75
	47.16
	15.865

	Valid N (listwise)
	238
	 	 	 	 
	3
	e1
	215
	1
	100
	59.42
	21.327

	e5
	215
	1
	100
	58.28
	19.658

	e9
	215
	1
	100
	71.63
	20.414

	e21
	215
	1
	100
	56.73
	19.303

	e22
	215
	2
	100
	58.03
	20.175

	Valid N (listwise)
	215
	 	 	 	 




Comparing the variable means across the three clusters, we find that respondents in the first cluster have extremely high expectations regarding all five performance features, as evidenced in average values of around 90 and higher. Respondents in the second cluster strongly emphasize punctuality (e1), while comfort (e5) and, particularly, entertainment aspects (e22) are less important. Finally, respondents in the third cluster do not express high expectations in general, except in terms of security (e9). Based on these results, we could label the first cluster “the demanding traveler,” the second cluster “on-time is enough,” and the third cluster “no thrills.” We could further check whether these differences in means are significant by using a one-way ANOVA as described in Chap.​ 6.
In a further step, we can try to profile the clusters using sociodemographic variables. Specifically, we use crosstabs (see Chap.​ 5) to contrast our clustering with the variable flight_purpose, which indicates whether the respondents primarily fly for business purposes (flight_purpose = 1) or private purposes (flight_purpose = 2). Before doing so, we need to turn off the Split File command by going to ► Data ► Split File and clicking on Analyze all cases, do not create groups, followed by OK. Next, click on ► Analyze ► Descriptive Statistics ► Crosstabs. In the dialog box that opens, enter CLU3_1 into the Row(s) box and flight_purpose into the Column(s) box. Also click on Statistics and select Chi-square and Contingency coefficient and click on Continue followed by OK. The results in Table 9.16 show that the first cluster primarily consists of leisure travelers, whereas the majority of respondents in the second and third cluster are business travelers. With a p-value of 0.003, the [image: 
${\chi ^2}$
]-test statistic indicates a significant relationship between these two variables. However, the strength of the variables’ association is rather small, as indicated by the Contingency Coefficient of 0.108.Table 9.16Crosstab


	
                              CLU3_1 * flight_purpose Crosstabulation
                            

	Count

	flight_purpose
	 
	1
	2
	Total

	CLU3_1
	1
	232
	284
	516

	2
	137
	101
	238

	3
	114
	101
	215

	Total
	483
	486
	969


	
                              Chi-Square Tests
                            

	Value
	df
	Asymptotic Significance (2-sided)

	Pearson Chi-Square
	11.463a

	2
	.003

	Likelihood Ratio
	11.493
	2
	.003

	Linear-by-Linear Association
	6.432
	1
	.011

	N of Valid Cases
	969
	 	 
	
a 0 cells (0.0%) have expected count less than 5. The minimum expected count is 107.17.


	
                              Symmetric Measures
                            

	Value
	Approximate Significance

	Nominal by Nominal
	Contingency Coefficient
	.108
	.003

	N of Valid Cases
	969
	 



The Oddjob Airways dataset offers various other variables such as age, gender, or status, which could be used to further profile the cluster solution. However, instead of testing these variables’ efficacy step-by-step, we proceed and assess the solution’s stability by running an alternative clustering procedure on the data. Specifically, we apply k-means clustering, using the cluster centers produced by the Ward’s linkage analysis as input for the starting partition, instead of letting k-means choose the centers.
To do so, we need to do some data management in SPSS, as the cluster centers have to be supplied in a specific format. Specifically, we need to aggregate the data first (briefly introduced in Chap.​ 5). By going to ► Data ► Aggregate, SPSS opens a dialog box similar to Fig. 9.21. Proceed by entering CLU3_1 into the Break Variable(s) box as well as e1, e5, e9, e21, and e22 into the Aggregated Variables box. When using the default settings, SPSS computes the variables’ mean values along the lines of the break variable, which correspond to the cluster centers that we need for the k-means clustering. SPSS indicates this circumstance by the postifix _mean, added to each aggregate variable’s name. For k-means to process the cluster centers, we need to delete the postfix _mean using the Name & Label. Finally, we do not want to add the aggregated variables to the active dataset, but rather need to create a new dataset comprising only the aggregated variables. Hence, select Create a new dataset containing only the aggregated variables and specify a dataset label such as aggregate (Fig. 9.21). When clicking on OK, SPSS creates and opens a new dataset labeled aggregate.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig21_HTML.jpg]
Fig. 9.21Aggregate data dialog box



The new dataset is almost in the right format—but we still need to change the break variable’s name from CLU3_1 to cluster_. SPSS will issue a warning but this can be safely ignored. Furthermore, we need to delete the first object, which includes the cluster centers of the missing values. The final dataset should have the form shown in Fig. 9.22.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig22_HTML.jpg]
Fig. 9.22Aggregated data file



Everything is now set for the k-means cluster analysis. To run the analysis, select the original dataset Oddjob.sav and go to ► Analyze ► Classify ► K-Means Cluster. In the dialog box that opens (Fig. 9.23), first move the five clustering variables into the Variables box. To use the cluster centers from our previous analysis, check the box Read initial and click on Open dataset. You can now choose the dataset labeled aggregate. In the Number of Clusters box, specify 3, which corresponds to the result of the hierarchical cluster analysis. Next, click on Save and check the box Cluster Membership in order to create a new variable indicating each object’s cluster membership as produced by k-means clustering. Under Options, you can request several statistics and specify how missing values should be treated. Ensure to request the Initial cluster centers as well as the ANOVA table. Now start the analysis.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig23_HTML.jpg]
Fig. 9.23k-means cluster analysis dialog box



The k-means procedure generates Tables 9.17 and 9.18, which show the initial and final cluster centers. As we can see, there is a high degree of agreement between the initial cluster centers produced by the Ward’s linkage and the final cluster centers produced by k-means clustering. While some cluster centers changed (also indicated in the Iteration History output, not shown here), the clusters’ nature, as expressed by the cluster labels “the demanding traveler,” “on-time is enough,” and “no thrills,” remains intact.Table 9.17Initial cluster centers


	
                              Initial Cluster Centers
                            

	Cluster

	1
	2
	3

	e1
	95
	93
	59

	e5
	87
	77
	58

	e9
	94
	90
	72

	e21
	90
	83
	57

	e22
	88
	47
	58


Input from FILE Subcommand



Table 9.18Final cluster centers


	
                              Final Cluster Centers
                            

	Cluster

	1
	2
	3

	e1
	95
	90
	59

	e5
	92
	74
	55

	e9
	96
	90
	67

	e21
	92
	81
	54

	e22
	91
	55
	54





To further check for the solution’s stability, we next explore the overlap in the two cluster solutions, by contrasting the objects’ cluster affiliations using crosstabs. To do so, go to ► Analyze ► Descriptive Statistics ► Crosstabs and select CLU3_1 under Row(s) and QCL_1 under Column(s). The latter variable represents the objects’ cluster affiliations as produced by the k-means clustering. After clicking on OK, SPSS will produce an output similar to Table 9.19.Table 9.19Comparison of clustering results


	CLU3_1 * QCL_1 Crosstabulation

	Count

	QCL_1

	Total
	1
	2
	3

	CLU3_1
	1
	410
	100
	6
	516

	2
	14
	213
	11
	238

	3
	10
	36
	169
	215

	Total
	434
	349
	186
	969





The results show that there is a strong degree of overlap between the two cluster analyses. For example, 410 objects that fall into the first cluster in the Ward’s linkage analysis also fall into this cluster in the k-means clustering. At the same time, however, 100 objects now appear in the second k-means cluster. This divergence is considerably lower in the second and third cluster. Overall, the two analyses have an overlap of (410 + 213 + 169)/969 = 81.73 %, which is very satisfactory as less than 20 % of all objects appear in a different cluster when using k-means.
In contrast to hierarchical clustering, the k-means outputs provide us with an ANOVA of the cluster centers (Table 9.20). Since all the values in the final column Sig. are below 0.05, we can conclude that all the clustering variables’ means differ significantly across at least two of the three segments.Table 9.20ANOVA output


	
                              ANOVA
                            

	Cluster
	Error
	 	 
	Mean Square
	df
	Mean Square
	df
	F
	Sig.

	e1
	91964.042
	2
	170.733
	966
	538.643
	.000

	e5
	94966.114
	2
	230.012
	966
	412.875
	.000

	e9
	58156.159
	2
	164.349
	966
	353.857
	.000

	e21
	96081.135
	2
	202.743
	966
	473.905
	.000

	e22
	158600.747
	2
	227.709
	966
	696.508
	.000


The F tests should be used only for descriptive purposes because the clusters have been chosen to maximize the differences among cases in different clusters. The observed significance levels are not corrected for this and thus cannot be interpreted as tests of the hypothesis that the cluster means are equal.




Since we used the prior analysis results from hierarchical clustering as an input for the k-means procedure, the problem of selecting the correct number of segments is not problematic in this example. Complementing our prior analyses, we now compute the VRC for different numbers of clusters based on the k-means results. Specifically, we want use the VRC values to compute the ωk statistics for a three-, four-, and five-cluster solution. Since determining a suitable number clusters using the ωk statistic involves comparing the VRC values of solutions with one segment less than k and with one cluster more than k, we need to run k-means for a two- to six-cluster solution. To do so, go back to ► Analyze ► Classify ► K-Means Cluster. As we seek to run k-means with different numbers of clusters, we cannot use the initial cluster centers from the Ward’s linkage clustering. Hence, uncheck the box next to Read initial. Next, set the Number of Clusters to 2, run the analysis, and save the F-values for variables e1, e5, e9, e21, and e22 from the ANOVA table, which correspond to the VRC values. Repeat these steps for a three-, four-, five- and six-cluster solution, each time saving the F-values. Table 9.21 summarizes the F-values from the ANOVA tables.Table 9.21F-values for different numbers of clusters


	
                              Number of clusters
                              k
                            

	F-values
	2
	3
	4
	5
	6

	
                              e1
                            
	448.182
	555.639
	425.992
	391.870
	474.269

	
                              e5
                            
	830.757
	458.807
	306.988
	272.402
	290.935

	
                              e9
                            
	456.818
	373.290
	264.142
	237.495
	186.223

	
                              e21
                            
	734.041
	490.399
	453.413
	479.337
	312.860

	
                              e22
                            
	578.393
	581.981
	707.882
	548.408
	446.994

	Total
	
                              3,048.191
                            
	
                              2,460.116
                            
	
                              2,158.417
                            
	
                              1,929.512
                            
	
                              1,711.281
                            





To compute the ωk statistic, we enter the F-values—which again, correspond to the VRC values—from Table 9.21 into the following formula:[image: 
$${\omega _k} = (VR{C_{k + 1}} - VR{C_k}) - (VR{C_k} - VR{C_{k{\text{ - }}1}}).$$
]





For example, for a three-cluster solution, we compute[image: 
$${\omega _3} = \left( {2,158.417 - 2,460.116} \right) - \left( {2,460.116 - 3,048.191} \right) = 286.376$$
]





Similarly, we can compute ωk for four and five clusters resulting in ω4= 72.794 and ω5= 10.674, respectively. Comparing the values, we find that the minimum ωk results for a five-cluster solution. However, looking into the cluster sizes of a five-cluster solution, shows that one cluster contains only 15 objects, which calls the relevance of this cluster into question. Similarly, when using a four-cluster solution, one cluster contains only 60 objects. Hence, it appears more reasonable to retain the three-cluster solution.
This analysis concludes our cluster analysis. However, we could further explore the solution’s stability by running other linkage algorithms, such as centroid or complete linkage, on the data. Relatedly, we could use different (dis)similarity measures and assess their impact on the results. So go ahead and explore these options yourself!
9.4.2 Two-Step Clustering
In the last step of the analysis, we run two-step clustering on the data. As two-step clustering allows handling segmentation variables measured on different scale levels, we extend the prior set and now also consider gender as an additional (categorical) segmentation variable. To initiate the analysis, go to ► Analyze ► Classify ► Two-Step Cluster. A new dialog box opens, similar to that shown in Fig. 9.24. First, move gender into the Categorical Variables box and e1, e5, e9, e21, and e22 into the Continuous Variables box.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig24_HTML.jpg]
Fig. 9.24Two-step cluster analysis dialog box



Under Distance Measure we can choose between two options. While Log-likelihood can be used for categorical and continuous variables, the Euclidean distance requires variables measured on a continuous scale. Since our analysis contains both categorical and continuous variables, we have to use the Log-likelihood distance measure.
Under Number of Clusters, we can specify a fixed number or a maximum number of clusters to retain from the data. One of two-step clustering’s major advantages is that it allows the automatic selection of the number of clusters on the grounds of information criteria. In line with our previous analyses, we specify a maximum number of 5 clusters. Under Clustering Criterion, select Schwarz’s Bayesian Criterion (BIC) but to test the stability of the solution, we will re-run the analysis using Akaike’s Information Criterion (AIC).
Under Options, we can select options related to outlier treatment, memory allocation, and variable standardization. Variables that are already standardized have to be assigned as such, but since this is not the case in our analysis, we can simply proceed.
Finally, under Output, we can specify additional variables for describing the resulting clusters. Select Create cluster membership variable and click on Continue followed by OK.
SPSS produces a very simple output, as shown in Fig. 9.25. The upper part of the output describes the algorithm applied, the number of variables used (labeled input features) and the final number of clusters retained from the data. In our case, the number of clusters is chosen according to BIC, which indicates a three-segment solution (the same holds when using AIC instead of BIC).[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig25_HTML.png]
Fig. 9.25Two-step cluster analysis output



The lower part of the output (Fig. 9.25) indicates the quality of the cluster solution. The silhouette measure of cohesion and separation
                  
                 reaches a value of less than 0.50, indicating a fair cluster quality. We proceed with the analysis by double-clicking on the output. This will open up the model viewer (Fig. 9.26), an evaluation tool that graphically presents the structure of the revealed clusters.[image: ../images/210704_3_En_9_Chapter/210704_3_En_9_Fig26_HTML.jpg]
Fig. 9.26Additional options in the model viewer



The model viewer provides us with two windows: The main view, which initially shows a model summary (left-hand side), and an auxiliary view, which initially features the cluster sizes (right-hand side). At the bottom of each window (next to View), you can request different information on each of the clusters. To further analyze the clusters, select Clusters in the main view and Predictor Importance in the auxiliary view (Fig. 9.26).
On the left of Fig 9.26, we can now see a description of the three clusters, including their (relative) sizes. We find that the first cluster contains 40.2 % of the objects, the second cluster 33.5 % of the objects, and the third cluster contains 26.2 % of the objects. Further below, the output shows the distribution of the gender variable in each cluster. Moving the mouse over the boxes showing the clustering variable labels, SPSS shows their mean values as well as their relative importance in terms of predicting each object’s membership per cluster. Darker shades (i.e., higher values in feature importance) denote the variable’s greater importance for the clustering solution. Comparing the results, we learn that gender is by far the most important variable for each of the clusters, followed by e5 (“Oddjob Airways provides you with a very pleasant travel experience”), e21 (“Oddjob Airways makes traveling uncomplicated”), e9 (“Oddjob Airways gives you a sense of safety”), e22 (“Oddjob Airways provides you with interesting on-board entertainment, service, and information sources”), and e1 (“with Oddjob Airways you will arrive on time”).6 Clicking on one of the boxes will show a graph with the frequency distribution of each cluster.
The auxiliary view on the right-hand side shows an overview of the variables’ overall importance for predicting the clustering solution (i.e., across all clusters). The model viewer provides us with additional options for visualizing the results or comparing clustering solutions. It is worthwhile to simply play around with the different self-explanatory options. So go ahead and explore the model viewer’s features yourself!
9.5 Oh, James! (Case Study)
Case Study
The James Bond movie series is one of the success stories of filmmaking. The movies are the longest continually running and the third-highest-grossing film series to date, which started in 1962 with Dr. No, starring Sean Connery as James Bond. As of 2018, there have been 24 movies with six actors having played James Bond. Interested in the factors that contributed to this running success, you decide to investigate the different James Bond movies’ characteristics. Specifically, you want to find out whether the movies can be grouped into clusters, which differ in their box-office revenues. To do so, you draw on Internet Movie Database (www.​imdb.​com) and collect data on all 24 movies based on the following variables (variable names in parentheses):	Title. (title)

	Actor playing James Bond. (actor)

	Year of publication. (year)

	Budget in USD, adjusted for inflation. (budget)

	Box-office revenues in the USA, adjusted for inflation. (gross_usa)

	Box-office revenues worldwide, adjusted for inflation. (gross_worldwide)

	Runtime in minutes. (runtime)

	Native country of the villain actor. (villain_country)

	Native country of the bondgirl. (bondgirl_country)

	Haircolor of the bondgirl. (bondgirl_hair)





Use the dataset James Bond.sav (↓ Web Appendix → Downloads) to run a cluster analysis—despite potential objections regarding the sample size. Answer the following questions:	1.Which clustering variables would you choose in light of the study objective, their levels of measurement, and correlations?

 

	2.Given the levels of measurement, which clustering method would you prefer? Carry out a cluster analysis using this procedure.

 

	3.Interpret and profile the obtained clusters by examining cluster centroids. Compare the differences across clusters on the box-office revenue variables.

 

	4.Use a different clustering method to test the stability of your results.

 





9.6 Review Questions

              	1.In your own words, explain the objective and basic concept of cluster analysis.

 

	2.What are the differences between hierarchical and partitioning methods? When do we use hierarchical or partitioning methods?

 

	3.Repeat the manual calculations of the hierarchical clustering procedure from the beginning of the chapter, but use complete linkage as the clustering method. Compare the results with those of the single linkage method.

 

	4.Explain the different options to decide on the number of clusters to extract from the data. Should you rather on statistical measures or rather on practical reasoning?

 

	5.Run the two-step clustering analysis on the Oddjob Airways data again (Oddjob.sav, ↓ Web Appendix → Downloads) but with a prespecified number of four and five clusters. Compare your results with the original three-cluster solution.

 

	6.Which clustering variables could be used to segment:	The market for smartphones?

	The market for chocolate?

	The market for car insurances?
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Footnotes
1Tonks (2009) provides a discussion of segment design and the choice of clustering variables in consumer markets.

 

2See Arabie and Hubert (1994), Sheppard (1996), and Dolnicar and Grün (2009).

 

3Whereas agglomerative methods have the large task of checking N·(N–1)/2 possible first combinations of observations (note that N represents the number of observations in the dataset), divisive methods have the almost impossible task of checking 2(
N
-1)–1 combinations.

 

4There are many other matching coefficients, with exotic names such as Yule’s Q
                        
                      , Kulczynski
                        
                      , or Ochiai
                        
                      , which are also menu-accessible in SPSS. As most applications of cluster analysis rely on metric or ordinal data, we will not discuss these. See Wedel and Kamakura (2000) for more information on alternative matching coefficients.

 

5See Punji and Stewart (1983) for additional information on this sequential approach.

 

6The strong emphasis of gender in determining the solution supports prior research, which found that two-step clustering puts greater emphasis on categorical variables in the results computation (Bacher et al. 2004).
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Learning Objectives
After reading this chapter, you should understand:	Why communicating the results is a crucial element of every market research study.

	The elements that should be included in a written research report and how to structure these elements.

	How to communicate the findings in an oral presentation.

	The ethical issues concerning communicating the report findings to the client.
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10.1 Introduction
Communicating results is key to any market research project. This includes giving clear answers to the investigated research questions and recommending a course of action, where appropriate. The importance of communicating marketing research results should not be underestimated. Even if the research has been carefully conducted, the recipients will find it difficult to understand the implications of the results and to appreciate the study’s quality if you spend too little time and energy on communicating these. Clear communication may also set the stage for follow-up research. If you communicate the findings effectively, the clients, who may know little about market research and may even be unfamiliar with the specific market research project, will understand them. Hence, the communication must be relevant for the addressed audience and provide a clear picture of the project.
Market researchers usually present their findings in the form of an oral presentation and written report. This report is the written evidence of the research effort and includes the details. Identifying the addressed audience is critical for both these points, as this determines how you can best communicate the findings. In this chapter, we discuss guidelines on how to effectively communicate research findings orally and in writing. We first discuss written reports before listing the basics of oral presentations. We also provide hints on how to acquire research follow-up. At the end of the chapter, we briefly review the ethical issues related to market research.
10.2 Identify the Audience
When providing reports (and presentations), you should keep the audience’s characteristics and needs in mind and should tailor the report to their objectives. Imagine you are dealing with the marketing department of a company planning to launch a new product and needing to learn more about the potential customers’ buying behavior. The knowledge and level of interest in the study might differ greatly within the department. While the managers, who commissioned the study, are generally familiar with its objective and design, others, who might be unaware of the background (e.g., the marketing director or the sales staff), must be informed about the research to allow them to understand the research findings. When preparing the report, you should consider the following questions:	Who will read the report?

	Why will they read the report?

	Which parts of the report are of specific interest to them?

	What do they already know about the study?

	What information will be new to them?

	What is the most important point for them to know after they have read the report?

	What can be done with the research findings?





These questions help you determine the level of detail that should be included in your report. Furthermore, they reveal information that requires specific focus during the project. Remember, a successful report meets its audience’s needs! However, not everything that you consider appropriate for your audience is appropriate. Nothing is worse than suggesting an idea that the audience finds unpalatable (e.g., saying that a specific senior management behavior or attitude is a major obstacle to success), or proposing a course of action that has been attempted before. Informal talks with the client are therefore vital before you present the results—never present findings formally without discussing them with the client first!
Further, you need to ask clients about their expectations and the recommendations they think will be made early in the project. Why would clients spend $100,000 if you merely give them the answers they expect to get? Such discussions may help exceed clients’ expectations in a way that is useful to them.
10.3 Guidelines for Written Reports
You should always keep the people addressed in the report in mind. Decision makers are generally unfamiliar with statistical details but would like to know how the findings can help them make decisions. You should therefore avoid research jargon and state the key insights clearly without omitting important facts. There are several major rules to consider when writing a report (Armstrong 2010; Churchill and Iacobucci 2015):	1.The report must be complete; that is, it must contain all information that the reader needs in order to understand the research. Technical or ambiguous terms, as well as abbreviations and symbols, should be clearly defined and illustrated. Although you know what terms like heteroscedasticity or eigenvalue mean, the report reader probably won’t! In addition, the report must provide enough detail to enable the reader to verify and replicate the findings if necessary. Bear in mind that the staff turnover in many organizations is high and that reports should therefore be stand-alone to allow those with little knowledge of the background to read and understand them.

 

	2.The report must be accurate. The readers will base their assessment of the entire research project’s quality on the presented report. Consequently, the report must be well written. For example, grammar and spelling must be correct, no slang should be used, tables must be labeled correctly, and page numbers should be included. If there are small errors, the reader may believe they are due to your lack of care and generalize about your analysis! Therefore, proofread (using a professional proofreader) to eliminate obvious errors. Lastly, objectivity is an important attribute of any report. This means that any subjective conclusions should be clearly stated as such.

 

	3.The report must be clear and language simple and concise:	Use short sentences.

	Use simple and unambiguous words.

	Use concrete examples to illustrate aspects of the research (e.g., unexpected findings). These can also be helpful if the audience has strong beliefs that are not consistent with your recommendation. Such recommendations are otherwise almost certainly not implemented as the client does not believe them.

	Use the active voice to make the report easy to read and to help understanding.

	Avoid negative words.

	Use business language.

	Avoid exclamation marks and do not use caps unnecessarily. Avoid the use of bold or italics for more than just a few words.






 

	4.Follow the KISS principle
                        
                      : Keep it short and simple! This principle requires the report to be concise. And since it needs to be action-driven, the reader must immediately understand its purpose and the results, so start off with these. You should present the results clearly and simply. Important details can be shown in the appendix or appendices of the report, which should also not be overloaded with irrelevant material. In addition, keep in mind that each section’s first sentences are the most important ones: They should summarize the main idea you want to convey in this section.

 

	5.The report must be structured logically. This applies to the general structure of the report (see Table 10.1) and to the line of argumentation in each section. Make sure you avoid style elements that may distract the reader:	Avoid cross-references. Having to search elsewhere for important results is disruptive. For example, do not put important tables in the appendix.

	Use footnotes instead of endnotes and as few as possible.

	The structure should not be too detailed. As a rule of thumb, you should avoid using more than four levels.

	A new level must include at least two sections. For example, if there is a ► Sect. 3.1.1, there must also be a Sect. 3.1.2.






 




Table 10.1Suggested structure for a written research report


	
                          Title Page
                        

	
                          Executive Summary
                        

	
                          Table of Contents
                        

	
                          1. Introduction
                        

	1.1 Problem definition

	1.2 Research objectives

	1.3 Research questions and/or hypothesesa


	
                          2. Methodology
                        

	2.1 Population, sampling method, and sample description

	2.2 Quantitative and qualitative methods used for data analysis

	
                          3. Results
                        

	
                          4. Conclusions and Recommendations
                        

	
                          5. Limitations
                        

	
                          6. Appendix
                        



a In practice, the word hypotheses may be replaced by research question(s) or proposition(s)




10.4 Structure of the Written Report
When preparing a written report, a clear structure helps readers to quickly and easily find those elements that interest them. Although all reports differ, we include a suggested structure for a research report in Table 10.1.
10.4.1 Title Page
The title page should state the title of the report, the name of the client who commissioned the report, the organization or researcher submitting it, and the date of release. The heading should clearly state the nature and scope of the report. It may simply describe the research (e.g., “Survey of Mobile Phone Usage”) or may outline the objectives of the study in the form of an action title (e.g., “How to Increase the Adoption of Wearable Technologies”).
10.4.2 Executive Summary
The executive summary should appear first and is essential, because it is often the only section that executives read. This summary helps set the expectations of those who read more. Hence, this section must be short to allow busy executives to read it and should give them the essence (findings and recommendations) of the research. As a rule of thumb, the executive summary should not exceed 150 words. It should contain key findings and recommendations, and help the reader understand the full study. The executive summary also requires more structure. A common way of giving structure is to tell a story. Begin with a description of the problem, thereafter introducing the issues that make this difficult or complicated and describing how these give rise to a number of questions. Finally, lead the reader through your line of reasoning to the answer:	Situation: Background information.

	Difficulty or complication: A short window of opportunity; a change from the previously stable situation; lack of performance due to unknown causes (i. e., the reason for your research study).

	Question: The scope and goal of your research study.

	Answer: Your findings and conclusions (and if the client requires this, also your recommendations).





10.4.3 Table of Contents
The table of contents helps the reader locate specific aspects of the report. The table of contents should correspond to the main report headings. It should also include lists of tables and figures with page references.
10.4.4 Introduction
This section should explain the project context to the reader. Questions to be answered include:	Why was the study undertaken?

	What were the objectives and which key questions are answered?

	Is the study related to other studies and, if so, which findings did they produce?

	How is the report structured?





Besides introducing the background and purpose of the research, the introduction should briefly explain how the objectives and key questions are addressed. You should briefly mention the hypotheses or propositions tested during the research and how the research was approached (e.g. cluster analysis). You should ensure that critical terms are defined. For example, aviation terms such as CASM (cost per available seat mile) require explanation. As a rule, the following three questions on the research should be answered in the introduction, but should be neither too detailed nor too technical:	What was done?

	How was it done?

	Why was it done?





Keep in mind that the introduction should set the stage for the body of the report and the presentation of the results, but no more than this. You should only provide a detailed description of how you collected and analyzed the data in the next section of the report. Lastly, you should provide a brief summary of how the report is organized at the end of the introduction.
10.4.5 Methodology
In this section, you should describe the research procedure and the different (statistical) methods used to analyze the data. These must be presented precisely and coherently, allowing the reader to understand the analyses’ process and basic principles. Always keep your audience in mind! If the audience is familiar with research methodology, you can describe the procedures in detail and skip the basics. If the client has little knowledge of research methodology, you should introduce the methods briefly. If you have an audience of whom some have a little and others more knowledge, you might want to move the basics to an appendix.
If not already stated in the previous section, you should define whether the study is exploratory, descriptive, or causal by nature and whether the results are based on primary or secondary data. If primary data are used, their source should be specified (e.g., observation or questionnaire). If a questionnaire was used, you should state whether it was administered by means of face-to-face interviews, telephone interviews, or through web or mail surveys. Also explain why you chose this specific method.
The reader should also know the demographic or other relevant characteristics of the targeted survey population. This includes the geographical area, age group, and gender. While it is usually sufficient to describe the population in a few sentences, the sampling method needs more explanation: How was the sample selected? Which sampling frames were chosen (e.g., random, systematic, stratified)? In addition, information on the sample size, response rate, and sample characteristics are essential, as this indicates the results’ reliability and validity.
You should include a copy of the actual instruments used, such as the questionnaire or the interview guide, the data collection protocol, and the detailed statistical analyses of the results, in the appendix, or present them separately. Although these are important to fully understand the characteristics of the research project, including them in the main text would make reading the report more difficult.
10.4.6 Results
In this section, you need to present the findings and describe how they relate to a possible solution to the research problem and how they influence the recommendations. There are several ways of presenting the results logically. You could, for instance, use the different research objectives as a guideline to structure this section and then analyze them one by one.
Another way is to first summarize the overall findings and then analyze them in relevant subgroups, such as the type of customer or geographical regions. Alternatively, you can classify the findings according to the data type or the research method if several were used. For example, you could first present the conclusions of the secondary data collection and then those derived from an analysis of the questionnaire.
Use tables and graphs when presenting statistical data, as they make the report and the data more interesting. Tables and graphs also structure information, thus facilitating understanding. Graphs often allow the researcher to visually present complex data, which might not be possible when only using tables. However, as the following sections will show, graphs can also be misleading, as they may be adjusted to favor a specific viewpoint.
Results are often presented in Excel or Word format. Fortunately, SPSS has built-in capabilities to export its results to Excel or Word. To do so, simply right click on a table or figure in the SPSS Statistics Viewer and select Export. SPSS then gives you the option to export in several formats of which Excel 2007 and higher (*.xlsx), Word/RTF (*.doc), and None (graphics only) are the most useful.
10.4.6.1 Window Dressing with Graphs
While graphs have the advantage that they can present complex information in a way that is easily understandable, they can be used to mislead the reader. Experience with generating and interpreting graphs will help you spot this. In this section, we show examples of how graphs can mislead. By shortening the x-axis in Fig. 10.1 (i. e., removing the years 2007–2011), it suggests a growth in the units sold (Fig. 10.2).[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig1_HTML.png]
Fig. 10.1What year does the curve start? (I)


[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig2_HTML.png]
Fig. 10.2What year does the curve start? (II)



Likewise, we can modify the scale range (Fig. 10.2 vs. Fig. 10.3). Specifically, reducing the y-axis to a range from 68 to 100 units with 4-unit increments, suggests faster growth (Fig. 10.3). Another example is the “floating” y-axis (Fig. 10.1 vs. Fig. 10.4), which increases the scale range along the y-axis from 0 to 210 with 30-unit increments, thus making the drop in the number of units sold over the period 2009 to 2012 less visually pronounced.[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig3_HTML.png]
Fig. 10.3Shortening the y-axis


[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig4_HTML.png]
Fig. 10.4The “floating” y-axis



Data are often presented by means of three-dimensional figures, such as in Fig. 10.5
[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig5_HTML.png]
Fig. 10.5Doubling the edge length quadruples the area

. While these can be visually appealing, they are also subject to window-dressing. In this example, the lengths of all the edges were doubled to correspond to the 100 % increase in turnover. However, the resulting area is not twice but four times as large as the original image, thus presenting a false picture of the increase. These are just some common examples; Huff’s (1993) classic text offers more on this topic.
Tables are generally less susceptible to manipulation, as they contain data in numbers. As a rule of thumb, each table or graph in the report should be numbered sequentially and have a meaningful title so that it can be understood without reading the text. This is called a self-contained table
                    
                   or self-contained figure
                    
                  . Some rules of thumb:	Put data to be compared in columns, not rows.

	Round data off to whole percentages, thousands or millions for sales, and two or three digits for academic purposes.

	Highlight data to reinforce conclusions (e.g., making the key numbers bold).

	Clearly state the units of measurement.





The following TED-Ed talk offers insights on how to spot misleading graphs.[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Figa_HTML.png]
© Enis Aksoy/Getty Images/iStock

                          https://​ed.​ted.​com/​lessons/​how-to-spot-a-misleading-graph-lea-gaslowitz
                        



10.4.6.2 Presenting Statistical Data
In this section, we describe various ideas that you can use to convey statistical results in a reader-friendly manner. In the results section, it is common to start presenting the descriptive statistics first. This comprises text that is visually supported by graphs, to offer information and context to those readers with the required background. Graphs offer two major advantages: first, they organize and simplify complex and dense information, which is especially useful with large data samples (Tufte 2001); second, graphs can summarize dense information efficiently. There are, of course, many kinds of graphs and each type has its advantages and disadvantages. The sample size and the nature of your data may constrain the choice of graphs. Sometimes your client may even have specific requirements. Here are some tips to help you with the presentation of your data:
Summarize your results efficiently
Graphs, like bar charts and especially dot charts, offer a useful way of summarizing descriptive data most efficiently; that is, by using less space. Bar charts are generally useful where the objective is to depict how the outcome variable varies across two or more grouping variables. Figure.10.6 uses the Oddjob.sav dataset to illustrate this point by plotting the average net promoter score over the respondents’ gender and status. Note that, in a complete presentation, it is important to include a title and subtitle, to label the y-axis and the x-axis, and to list the source of the data below the figure.[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig6_HTML.png]
Fig. 10.6Bar chart presentation



Combine several plots
SPSS offers many more graphs many of which we discussed in Chap.​ 5. While this chapter will not review the graphs offered in SPSS, it is worth mentioning that the Chart Builder allows combining coefficients from different analyses in a single plot. Figure.10.7 offers an example and depicts the mean net promoter score (bar charts) and the customers’ expectation regarding value for money (line chart) along the seven different points of the overall satisfaction scale. The inclusion of 95 % confidence intervals in the graph—indicated by the vertical lines at the end of each bar—show significant differences in the customers’ recommendation intention along the different satisfaction levels. This is because the vertical lines of bars do not overlap for most of the pairs. This matter could be unclear if the confidence intervals are not included and may lead to misinterpretation by knowledgeable readers, who assume that such differences are statistically not significant.[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig7_HTML.png]
Fig. 10.7Combination of different estimations and charts



Make concise and clear (regression) tables
Research projects often require running several analyses on the same set of data by using slightly different settings in the data analysis technique. For example, researchers generally run a regression analysis on multiple models, which differ with regard to the number of independent variables or the type of dependent variable. When multiple models are estimated, these are usually presented in adjacent columns to make comparisons easier. In regression tables, each column represents the results of one regression analysis. The rows indicate each independent variable’s influence on the dependent variable by means of the (standardized or unstandardized) regression coefficient estimates. To create a clear table, include the:	1.Model Title: The first step in any table is to label each model that you are presenting. The label should be self-explanatory (e.g., “Regression results of commitment to Oddjob Airways on different predictors”). For academic purposes, a model number (e.g., Model 1, Model 2, etc.) or a title that best represents the model (e.g., Baseline model; Extended model, etc.) is sometimes used. This is particularly useful when writing up the results as you can then refer to and compare the estimates of the different models in the text. The choice of model name depends on the audience and the formatting guidelines.

 

	2.Independent variables: In a (regression) table, the rows refer to the independent variables in the model. Give the variables a straightforward name to make it easier for the reader to understand. Make sure that these variable names are identical to those used in other tables and graphs (if any).

 

	3.Coefficient estimates: Depending on your audience, the (regression) table needs to specify whether standardized or unstandardized coefficient estimates are being presented. This can be included as a subtitle and explained above the table.

 

	4.Significance level: Putting asterisks (*) behind the estimated regression coefficients is a common way of presenting the coefficients’ significance levels. Usually, one asterisk indicates a significance level of 0.10, two asterisks a significance level of 0.05, and three asterisks a significance level of 0.01. Depending on the audience, researchers sometimes present only effects with a significance level of 0.05. Whatever strategy you choose, make sure you add a note below your table indicating the level of significance that the asterisks represent.

 

	5.Standard error or t values: In addition to the significance levels, you need to present the corresponding t value or standard error of the coefficient estimate, which is usually placed in brackets below the coefficient estimates. Both presentation methods are accepted and the choice depends on your audience and the formatting criteria.

 

	6.Sample size and degrees of freedom: For a complete presentation, you should also include the sample size and the models’ degrees of freedom after the model estimation. These statistics are respectively indicated as N and df in Table 10.2. Reporting these statistics can reveal differences in the sample sizes of the different estimated models, which can be due to missing values in specific independent variables. If this happens, a comparison of the different models may make little sense, given that the models are based on different sample sizes with different characteristics. It is therefore important to understand what causes the large sample size differences between the models before taking any further action or drawing conclusions.

 

	7.Model fit: Finally, depending on the type of estimated model, statistics indicating the model significance, such as the R
2, and the relative model fit, such as the AIC or BIC statistics, should be part of the table. In Table 10.2 we have included the R
2, the Adjusted R
2, and the BIC to indicate the model fit.

 




Table 10.2Regression results of commitment to Oddjob Airlines on different predictors


	 	Model 1
	Model 2
	Model 3

	Number of flights
	−0.011***

(0.003)
	−0.009***

(0.003)
	−0.008***

(0.003)

	Age
	 	0.023***

(0.004)
	0.023***

(0.004)

	Gender
	 	 	−0.308**

(0.119)

	Constant
	4.308***

(0.063)
	3.124***

(0.229)
	3.669***

(0.306)

	
                                R
                                2
                              
	0.016
	0.041
	0.047

	Adjusted R
2

	0.015
	0.039
	0.044

	BIC
	1174.958
	1154.163
	1154.450

	
                                N
                              
	1065
	1065
	1065

	df
	1063
	1062
	1061


Notes: Dependent variable: commitment; unstandardized coefficients; standard errors in brackets; * p < 0.05, ** p < 0.01, *** p < 0.001




Typing the output tables for such multiple analyses by hand is time-consuming and often leads to errors.
Table 10.2 shows an example of a regression table, which comprises three models that add several variables, at a time, containing some of the key elements of the table that we mentioned earlier. These are: the model title, indicated as Model 1, Model 2 and Model 3. Next, the independent variables, with the corresponding coefficients, standard errors (in brackets), and significance levels are listed in the first column. For example, in Model 1, the first row presents the unstandardized coefficient for nfligts (−0.011), together with the pertaining standard errors (e.g., (0.003)), and significance level (***). Next, the table shows the R
2, the Adjusted R
2, and BIC values along with the sample size (N). The caption at the bottom of the table indicates the dependent variable, the display of standard errors, the type of coefficients (i. e., unstandardized), and a description of the significance levels.
10.4.7 Conclusion and Recommendations
Having presented the findings, the next step is to summarize the most relevant points and interpret them in the light of the research objectives. You should write the conclusions in such a way that they present information that is relevant for managerial decision-making. Keep in mind that, for the client, the quality of the marketing research depends heavily on how well decision makers can use the information! The research must provide the client with clear benefits, which could lead to further research assignments.
Researchers are increasingly asked to go beyond stating facts and to provide recommendations or to advise. Whereas conclusions based solely on the research should be unbiased and impersonal, specific recommendations are based on a personal and (at least partially) subjective opinion on how the results can be most favorably used in the client’s interest. You should therefore make sure that recommendations are recognizable as such. During the negotiations prior to the start of a project, the client needs to determine the extent to which the research report should include recommendations. This will also depend on the researcher’s expertise in the area. Researchers may provide logical recommendations based on the findings, but these might be unrealistic or impossible for the client to implement due to issues such as insufficient budgets, predetermined methods, or specific policies, regulations, and politics. Make sure that you or another member of your research team is familiar with the overall context, including the regulatory and legal issues, to avoid such issues. Furthermore, before making recommendations, review them with the client to determine whether these are acceptable and actionable (see Box 10.1 for an example).
Box 10.1 Bad recommendations
A candy company wishes to know how it can increase its sales and has commissioned a research organization to gain insights into its different customer segments. The researchers found that teenagers are the most important target for the given brand and suggest that vending machines in schools would increase the company’s revenue. Although this might boost sales, the recommendation does not help the company if vending machines are not allowed in schools. And even if they were allowed, they might lead to negative media reports.
10.4.8 Limitations
Finally, you should explain the extent to which the findings can be generalized. All research studies have limitations due to time, budget, and other constraints. Furthermore, errors might have occurred during the data collection. Not mentioning potential weaknesses (e.g., the use of a convenience sample, or a small sample size) for whatever reason reduces the research’s credibility. Not disclosing important facts also violates common codes of industry conduct, such as those drafted by ESOMAR. Taking all these factors into regard, the research results should always be discussed objectively and in a balanced way. You should neither overly belittle the importance and validity of the research, nor try to conceal sources of errors and, hence, potentially mislead managers. Finally, some modesty is in order as, in hindsight, many reports have been proved inaccurate or even wrong. Few, for example, predicted the global financial crisis, the Trump presidency, or Brexit.
10.4.9 Appendix
All material not directly required for an understanding of the project, but still related to the study, should be included in the appendix or appendices. This includes questionnaires, interview guides, detailed data analyses, and other types of data or material.
10.5 Guidelines for Oral Presentations
Most clients want an oral presentation to accompany the written report. One could deliver such a presentation in the form of an interim report during the research, or at the end to explain the findings to the management and other staff. Members of the client staff often present the research findings to the management and do not ask the market research company to do so. Satisfaction with the delivered report may increase if a member of the client staff, such as an internal market researcher or business analyst, delivers the presentation, because the client feels they know and accept the content.
If asked to deliver an oral presentation, you should keep the principles of a written report in mind. It is especially important to identify and understand your audience, and to prepare the presentation thoroughly. A professional and interesting presentation might increase interest in the written report! Furthermore, since the oral presentation allows for interaction, interesting points can be highlighted and discussed in more detail. However, if you are not well prepared for the presentation, nor understand your audience’s expectations, needs, and wants, you could face an unpleasant situation. You should always keep the following golden rule in mind: Never deliver a presentation you wouldn’t want to sit through!
10.6 Visual Aids in Oral Presentations
It is useful to provide the audience with a written summary or a handout so that they do not have to take notes, but can focus on the presentation. If focus group interviews were conducted, for example, you could show excerpts from the recordings to provide concrete examples in support of a finding. The saying “a picture says more than a thousand words” is also true of the oral presentation. Visual aids
                
              , such as overhead transparencies, flip charts, or computer slide shows (e.g., PowerPoint or Prezi at www.​prezi.​com) not only help emphasize important points, but also facilitate the communication of difficult ideas. In the following, we summarize some suggestions (Armstrong 2010).
Use of visual aids

                	Use a simple master slide and avoid fancy animations.

	Use a sufficiently large font size (as a rule of thumb, 16pt. or higher and never less than 12pt.) so that everyone attending the presentation can read the slides.

	Use high contrasts for text. Use black and white. Do not write on illustrations or wallpapers.

	Use contrasting colors to emphasize specific points, but not too many.

	Use simple graphs, diagrams or short sentences rather than tables.




              
Arranging visual aids

                	Do not have too much information on one slide (generally, one key issue per slide). Never put a block of text on a page.

	Organize the material so that the different modes reinforce one another. For example, you do not want people running ahead of you, so either explain each point as you discuss it on a slide, or use many simple slides.

	Use a small number of slides compared to the time available for the presentation. The focus should be on the presenter and not on the slides. Having more slides than minutes available is not a good idea. Good presenters often use between 3 and 5 minutes to discuss a slide.

	Prepare (color) handouts for all members of the audience.

	If you intend to use media elements in your presentation, make sure that the equipment supports them (e.g., that the sound equipment is working, or that your video formats are supported).




              
10.7 Structure of the Oral Presentation
Be aware that an oral presentation cannot cover the same amount of information as a written report. You must be selective and structure the presentation content clearly and logically. There are two ways of creating a presentation:	1.A common way of starting your presentation is by structuring the introduction in the classic narrative pattern of story-telling (situation → difficulty or complication → question → answer) introduced earlier in the context of written reports. Limit the introduction to what the audience can accept. Nothing could be worse than triggering resistance of what you are presenting right from the start of your oral presentation. Next, move on to the main part of your presentation. Based on a brief description of your major findings, capture the audience’s attention by presenting answers to the logical questions that arise from the project, such as: “How were these results achieved?” or “How did we reach this conclusion?”

 

	2.An alternative is to follow the Minto principle
                        
                      , according to which presentations have a pyramid structure
                        
                      , starting with the conclusion. This raises question in the audience’s mind that has to be subsequently answered. Figure 10.8 illustrates this concept by using the example of a mobile phone study, which found that a novel smartphone should be introduced in white.

 




[image: ../images/210704_3_En_10_Chapter/210704_3_En_10_Fig8_HTML.png]
Fig. 10.8Pyramid structure for presentations



You begin by introducing the result of the study (i. e., the smartphone should be introduced in white) and then work your way down. Begin by explaining that a comprehensive market analysis was carried out, after which you discuss the elements of the analysis (i. e., focus group interviews, lead user interviews, and a customer survey). Finally, present the results of each element of the analysis (e.g., that lead users perceived black as too conservative, silver as too cheap, while white was perceived as modern). Once at the bottom of the pyramid, it is time to pause and to provide a summary, before moving from the first key line, which you have just presented, to the next key line, and so on. This process forces you to only provide the information relevant to the question under consideration. Moving from top to bottom and then bottom to top, helps you answer the questions: “Why so?” and “So what?,” while being both exhaustive and mutually exclusive regarding the results and the concepts you have presented. Ensure you never provide findings that do not lead to specific conclusions and do not offer conclusions not based on findings. Ultimately, this pyramid approach helps the audience grasp the line of reasoning better. This technique is also frequently called the Minto principle or Minto pyramid after its creator Barbara Minto (2009).
10.8 Follow-Up
Having delivered the written report and oral presentation, two tasks remain: First, you may need to help the client implement the findings. This includes answering questions that may arise from the written report and oral presentation, helping select a product, advertising agency, marketing actions, etc., or incorporate information from the report into the firm’s marketing information system or decision support system (see Chap.​ 3). This provides an opportunity to discuss other research projects. For example, you might agree on repeating the study after one year to see whether the marketing actions were effective. Second, you need to evaluate the market research project internally and with the client. Only (critical) feedback can disclose potential problems that may have occurred and, thus, provide the necessary grounds for improving your work. Using uniform questionnaires for the evaluation of different projects helps comparing the feedback from different projects conducted simultaneously or at different points in time. However, some market research companies do not want to be involved in implementation.
10.9 Ethics in Research Reports
Ethics
                
               is an important topic in marketing research, because research interacts with human beings at several stages (e.g., during data collection and the communication of the findings). There are two “problematic” relations that can ultimately lead to ethical dilemmas. First, ethical issues arise when the researcher’s interests conflict with those of the participants. For instance, the researcher’s interest is to gather as much information as possible from the respondents, but they often require their answers to be treated confidentially and to remain anonymous. Second, in addition to researchers’ legal and professional responsibilities towards their respondents, they also have reporting responsibilities. For example, the European Society for Opinion and Marketing Research (ESOMAR) and the International Chamber of Commerce have established a code, which sets minimum standards of ethical, which rests on three fundamental principles (ESOMAR 2016, p. 7):	1.
                      When collecting personal data from data subjects for the purpose of research, researchers must be transparent about the information they plan to collect, the purpose for which it will be collected, with whom it might be shared and in what form.
                    

 

	2.
                      Researchers must ensure that personal data used in research is thoroughly protected from unauthorised access and not disclosed without the consent of the data subject.
                    

 

	3.
                      Researchers must always behave ethically and not do anything that might harm a data subject or damage the reputation of market, opinion and social research.
                    

 





In practice, researchers face an ethical dilemma. They are paid by the client and may feel forced to deliver “good” results. In this sense, they might be tempted to interpret results in a way that fits the client’s perspective or the client’s presumed interests. For instance, researchers might ignore data because they would reveal an inconvenient truth (e.g., the client’s brand has low awareness, or customers do not like the product design).
Remember that researchers should never mislead the audience! For instance, it would be ethically questionable to modify the scales of a graph so that the results look more impressive, as shown in Figs. 10.1, 10.2, 10.3 and 10.4. Furthermore, researchers have a duty to treat information and research results confidentially, to store data securely, and to use data only for the research purpose agreed upon. Above all, you should keep in mind that marketing research is based on trust. Thus, when writing the report, you should respect the profession’s ethical standards in order to maintain this trust.
10.10 Review Questions

              	1.What are the basic elements of any written research report?

 

	2.Revisit the case study on Oddjob Airways in Chap.​ 7 and prepare an outline for a written research report.

 

	3.Consider the following situations. Do you think they confront the market researcher with ethical issues?	(a)The client asks the researcher for a list of respondents to allow him/her to target selling activities at them.

 

	(b)The client asks the researcher not to disclose part of the research to his organization.

 

	(c)The client asks the researcher to present other recommendations.

 

	(d)The client asks the researcher to re-consider the analysis, because the findings seem implausible to him/her.

 

	(e)The client wishes to know the name of a particular customer who was very negative about the quality of service provided.
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Glossary


                α
                error:
              
                  occurs when erroneously rejecting a true null hypothesis. Also referred to as
                  type I error
                  .
                




                α
                -inflation:
              results when multiple tests are conducted simultaneously on the same data. The result is that you are more likely to claim a significant result when this is not so (i.e., an increase or inflation in the type I error).



Acquiescence:describes the tendency of respondents from different cultures to agree with statements (e.g., as formulated in a Likert scale item) regardless of their content.




                Adjusted
                R
                2
                :
              is a measure of goodness-of-fit that takes the number of independent variables and the sample size into account. The statistic is useful for comparing regression models with different numbers of independent variables, sample sizes, or both.



Agglomerative clustering:is a type of hierarchical clustering method in which clusters are consecutively formed from objects. It starts with each object representing an individual cluster. The objects are then sequentially merged to form clusters of multiple objects, starting with the two most similar.



Aggregation:is a type of scale transformation in which variables measured at a lower level are taken to a higher level.



Akaike Information Criterion (AIC):is a relative measure of goodness-of-fit, which can be used to compare regression models with different independent variables and/or number of observations. Compared to an alternative model setup, smaller AIC values indicate a better fit. The criterion is also used in the two-step cluster analysis to determine on the number of clusters.



Alternative hypothesis:is the hypothesis against which the null hypothesis is tested.



American Marketing Association (AMA):is the world’s leading association for marketing professionals.



Analysis of Variance (ANOVA):is a multivariate data analysis technique that allows testing whether the means of (typically) three or more groups differ significantly on one (one-way ANOVA) or two (two-way ANOVA) metric dependent variable(s). There are numerous extensions to more dependent variables and to differently scaled independent variables.



Anti-image:is a measure used in principal component and factor analysis to determine whether the items correlate sufficiently. The anti-image describes the portion of an item’s variance that is independent of another item in the analysis.



Armstrong and Overton procedure:is used to assess the degree of non-response bias. This procedure calls for comparing the first 50 % respondents with the last 50 % with regard to key demographic variables. The concept behind this procedure is that later respondents more closely match the characteristics of non-respondents.



Autocorrelation:occurs when the residuals from a regression analysis are correlated.



Average linkage:is a linkage algorithm in hierarchical clustering methods in which the distance between two clusters is defined as the average distance between all pairs of objects in the two clusters.




                β
                error:
              
                  occurs when erroneously accepting a false null hypothesis. Also referred to as
                  type II error
                  .
                



Back-translation:is a translation method used in survey research in which a survey is being translated and then back-translated into the original language by another person.



Balanced scale:describes a scale with an equal number of positive and negative scale categories.



Bar chart:is a graphical representation of a single categorical variable indicating each category’s frequency of occurrence. Bar charts are primarily useful for describing nominal and ordinal variables.



Bartlett method:is a procedure to generate factor scores in principal component analysis. The resulting factor scores have a zero mean and a standard deviation larger than one.



Bartlett’s test of sphericity:is used in the context of principal component analysis and factor analysis to assess whether the variables are sufficiently correlated.



Bayes Information Criterion (BIC):is a relative measure of goodness-of-fit, which can be used to compare regression models with different independent variables and/or number of observations. Compared to an alternative model setup, smaller BIC values indicate a better fit. The criterion is also used in the two-step cluster analysis to determine on the number of clusters.



Big data:refers to very large datasets, generally a mix of quantitative and qualitative data in very large volumes.



Binary logistic regression:is a type of regression method used when the dependent variable is binary and only takes two values.



Bivariate statistics:describes statistics that express the empirical relationship between two variables. Covariance and correlation are key measures that indicate (linear) associations between two variables.



Bonferroni correction:
                  is a post hoc test typically used in an ANOVA that maintains the familywise error rate by calculating a new pairwise alpha that divides the statistical significance level
                  α
                  by the number of comparisons made. See also
                  familywise error rate
                  and
                  α-inflation
                  .
                



Bootstrapping:is a resampling technique that draws a large number of subsamples from the original data (with replacement) and estimates parameters for each subsample. It is used to determine standard errors of coefficients to assess their statistical significance without relying on distributional assumptions.



Box plot:
                  shows the distribution of a (typically continuous) variable. It consists of elements expressing the dispersion of the data. Also referred to as
                  box-and-whisker plot
                  .
                



Case:
                  is an object such as a customer, a company, or a country in statistical analysis. Also referred to as
                  observation
                  .
                



Causal research:is used to understand the relationships between two or more variables. Causal research explains how variables relate.



Census:is a procedure of systematically acquiring and recording information about all the members of a given population.



Centroid linkage:is a linkage algorithm in hierarchical clustering methods in which the distance between two clusters is defined as the distance between their geometric centers (centroids).



Chaining effect:is a solution pattern typically observed when using a single linkage algorithm in cluster analysis.



Chebychev distance:is a distance measure used in cluster analysis that uses the maximum of the absolute difference in the clustering variables’ values.



City-block distance:
                  is a distance measure used in cluster analysis that uses the sum of the variables’ absolute differences. Also referred to as
                  Manhattan metric
                  .
                



Closed-ended questions:is a type of question format in which respondents have a certain number of response categories from which to choose.



Cluster analysis:is a class of methods that groups a set of objects with the goal of obtaining high similarity within the formed groups and high dissimilarity between groups.



Clustering variables:are variables used in cluster analysis.



Clusters:are groups of objects with similar characteristics.



Codebook:contains essential details of a data file, such as variable names and summary statistics.




                Coefficient of determination (
                R
                2
                ):
              is a measure used in regression analysis to express the dependent variable’s amount of variance that the independent variables explain.



Collinearity:arises when two variables are highly correlated.



Communality:describes the amount of a variable’s variance that the extracted factors in a principal component and factor analysis reproduce.



Complete linkage:is a linkage algorithm in hierarchical clustering methods in which the distance between two clusters corresponds to the longest distance between any two members in the two clusters.



Components:are extracted in the course of a principal component analysis. They are also commonly referred to as factors.



Confidence interval:provides the lower and upper limit of values within which a population parameter will fall with a certain probability (e.g., 95 %).



Confirmatory factor analysis:is a special form of factor analysis used to test whether the measures of a construct are consistent with a researcher's understanding of that construct.



Constant:is a characteristic of an object whose value does not change.



Constant sum scale:is a type of scale that requires respondents to allocate a certain total number of points (typically 100) to a number of alternatives.



Construct:
                  measures a concept that is abstract, complex, and cannot be directly observed. Also referred to as
                  latent variable
                  .
                



Construct scores:are composite scores that calculate a value for each construct of each observation. Construct scores are often computed by taking the mean of all the items associated with the construct.



Construct validity:is the degree of correspondence between a measure at the conceptual level and its empirical manifestation. Researchers often use this as an umbrella term for content, criterion, discriminant, face, and nomological validity.



Content validity:refers to the extent to which a measure represents all facets of a given construct.



Control variables:are included into (typically regression) analyses in order to rule these out as alternative explanations.



Correlation:is a measure of how strongly two variables relate to each other. Correlation is a scaled version of the covariance.



Correlation residuals:are the differences between the original item correlations and the reproduced item correlations in a principal component and factor analysis.



Covariance:is a measure of how strongly two variables relate to each other.



Covariance-based structural equation modeling (CB-SEM):is an approach to structural equation modeling used to test relationships between multiple items and constructs.



Criterion validity:measures how well one measure predicts the outcome of another measure when both are measured at the same time.



Cronbach’s Alpha:is a measure of internal consistency reliability. Cronbach’s Alpha generally varies between 0 and 1 with greater values indicating higher degrees of reliability.



Crosstabs:are tables in a matrix format that show the frequency distribution of nominal or ordinal variables.



Cross validation:entails comparing the results of an analysis with those obtained when using a new dataset.



Customer relationship management (CRM):refers to a system of databases and software used to track and predict customer behavior.



Data entry errors:is a mistake in transcribing data during data entry. Erroneous values that fall outside a variable’s standard range can easily be identified by means of descriptive statistics (minimum, maximum, and range).



Degrees of freedom (df):represents the amount of information available to estimate a test statistic. Generally, an estimate’s degrees of freedom are equal to the amount of independent information used (i.e., the number of observations) minus the number of parameters estimated.



Dendrogram:visualizes the results of a cluster analysis. Horizontal lines in a dendrogram indicate the distances at which the objects have been merged.



Dependence of observations:is the degree to which observations are related.



Dependent variables:are the concepts a researcher wants to understand, explain, or predict.



Descriptive research:is used to detail certain phenomena, characteristics, or functions. Descriptive research often builds on previous exploratory research.



Directional hypothesis:looks for an increase or a decrease in a parameter (such as a population mean) relative to a specific standard. Directional hypothesis can either be right-tailed or left-tailed.



Direct oblimin rotation:is a popular oblique type of rotation, which allows specifying the maximum degree of obliqueness.



Discriminant validity:ensures that a measure is empirically unique and represents phenomena of interest that other measures in a model do not capture.



Distance matrix:expresses the distances between pairs of objects.



Divisive clustering:is a type of hierarchical clustering method in which all objects are initially merged into a single cluster, which the algorithm then gradually splits up.



Double-barreled questions:are survey questions to which respondents can agree with one part but not with the other. Also refers to survey questions that cannot be answered without accepting an assumption.



Dummy variables:are binary variables that indicate whether a certain trait is present or not.



Durbin-Watson test:is a test for autocorrelation used in regression analysis.



Effect size:is a statistical measure to determine the strength of the effect (e.g., in an ANOVA).



Eigenvalue:indicates the amount of variance reproduced by a specific component or factor.



Eigenvectors:are the results of a principal component analysis and include the factor weights.



Equidistance:is indicated when the (psychological) distances between a scale’s categories are identical.



Equidistant scale:
                  see
                  Equidistance
                  .
                



Error:is the difference between the regression line (which represents the regression prediction) and the actual observation.



Error sum of squares:quantifies the difference between the observations and the regression line.



ESOMAR:is the world organization for market, consumer, and societal research.



Estimation sample:is the sample used to run a statistical analysis.




                Eta-squared (
                η
                2
                ):
              
                  is a statistic used in an ANOVA to describe the ratio of the between-group variation to the total variation, thereby indicating the variance accounted for by the factor variable(s).
                  η
                  
                    2
                  
                  is identical to the
                  R
                  2
                  , the coefficient of determination in regression analysis. It can take on values between 0 and 1 whereas a high value implies that the factor exerts a strong influence on the dependent variable.
                



Ethics:are a system of morals and principles, which defines a research organization’s obligations, for example, with regard to the findings they release being an accurate portrayal of the survey data.



Ethnography:is a type of qualitative research in which the researcher interacts with consumers over a period to observe and question them.



Euclidean distance:
                  is a distance measure commonly used in cluster analysis. It is the square root of the sum of the squared differences in the variables’ values. Also referred to as
                  straight line distance
                  .
                



Experimental design:describes which treatment variables to administer and how these relate to dependent variables. Prominent experimental designs include the one-shot case study, the before-after design, the before-after design with a control group, and the Solomon four-group design.



Experiments:are study designs commonly used in causal research in which a researcher controls for a potential cause and observes corresponding changes in hypothesized effects via treatment variables.



Explained variation:is the degree of variation that a factor variable in an ANOVA explains. It is similar to the Coefficient of Determination used for regression analysis.



Exploratory factor analysis:is a type of factor analysis that derives factors from a set of correlated indicator variables without the researcher having to prespecify a factor structure.



Exploratory research:is conducted when the researcher has little or no information about a particular problem or opportunity. It is used to refine research questions, discover new relationships, patterns, themes, and ideas or to inform measurement development.



External secondary data:are compiled outside a company for a variety of purposes. Sources of secondary data include, for example, governments, trade associations, market research firms, consulting firms, (literature) databases, and social networks.



External validity:is the extent to which the study results can be generalized to real-world settings.



Extreme response styles:occur when respondents systematically select the endpoints of a response scale.



Face-to-face interview:
                  See
                  Personal interview
                



Face validity:is the extent to which a test is subjectively viewed as covering the concept it purports to measure.



Factor analysis:
                  is a statistical procedure that uses the correlation patterns among a set of indicator variables to derive factors that represent most of the original variables’ variance. Also referred to as
                  Principal axis factoring
                  .
                



Factor-cluster segmentation:is the process of running a cluster analysis on factor scores derived from a principal component or factor analysis to handle collinear variables.



Factor level:the values of a factor variable that differentiates the groups in an ANOVA.



Factor loading:is the correlation between a (unit-scaled) factor and a variable.



Factor rotation:is a technique used to facilitate the interpretation of solutions in principal component and factor analysis.



Factor scores:are composite scores that calculate a value for each factor of each observation.



Factor variable:is a categorical variable used to define the groups (e.g., three types of promotion campaigns) in an ANOVA.



Factor weights:express the relationships between variables and factors.



Factors:are (1) independent variables in an ANOVA, and (2) the resulting variables of a principal component and factor analysis that summarize the information from a set of indicator variables.



Familywise error rate:
                  is the probability of making one or more false discoveries or type I errors when performing multiple hypotheses tests. See also
                  α-inflation
                  .
                



Field experiments:are experiments in which the manipulation of a treatment variable occurs in a natural setting, thereby emphasizing the external validity, but potentially compromising internal validity.



Field service firms:are companies that focus on conducting surveys, determining samples, sample sizes, and collecting data. Some of these firms also translate surveys, or provide addresses and contact details.



Focus groups:is a method of data collection in which six to ten participants discuss a defined topic under the leadership of a moderator.



Forced-choice scale:is an answer scale that omits a neutral category, thereby forcing the respondents to make a positive or negative assessment.



Formative construct:is a type of measurement in which the indicators form the construct.



Free-choice scale:is an answer scale that includes a neutral choice category. Respondents are therefore not forced to make a positive or negative assessment.



Frequency table:is a table that displays the absolute, relative, and cumulative frequencies of one or more variables.




                F
                -test:
              a test statistic used in an ANOVA and regression analysis to test the overall model’s significance.




                F
                -test of sample variance:
              
                  see
                  Levene’s
                  test.
                



Full service providers:are large market research companies, such as The Nielsen Company, Kantar, or GfK, that offer syndicated and customized services.



Grand mean:is the overall average across all levels of a factor variable or other variables that split the dataset into groups.



Heteroskedasticity:refers to a situation in regression analysis in which the variance of the residuals is not constant.



Hierarchical clustering methods:develop a tree-like structure of objects in the course of the clustering process, which can be top-down (divisive clustering) or bottom-up (agglomerative clustering).



Histogram:is a graph that shows how frequently categories derived from a continuous variable occur.



Homoscedasticity:refers to a situation in regression analysis in which the variance of the residuals is constant.



Hypotheses:are claims made about effects or relationships in a population.



Inconsistent answers:are a respondent’s contradictory answer patterns.



Independent samples:occur if observations are sampled only once.



Independent samples t-test:
                  a test using the
                  t
                  -statistic that establishes whether two means collected from independent samples differ significantly.
                



Independent variables:are variables that explain or predict a dependent variable.



In-depth interview:is a qualitative conversation with participants on a specific topic. This interview type is typically used in exploratory research as it allows one-to-one probing to foster interaction between the interviewer and the respondent.



Index:consists of a set of variables that defines the meaning of the resulting composite.



Index construction:is the procedure of combining several items to form an index.



Interaction effect:refers to how the effect of one variable on another variable is influenced by a third variable.



Interaction term:is an auxiliary variable entered into the regression model to account for the interaction of the moderator variable and an independent variable.



Intercept:is the expected mean value of the dependent variable in a regression analysis, when the independent variables are zero. Also referred to as a constant.



Internal consistency reliability:is a form of reliability used to judge the consistency of results across items in the same test. It determines whether the items measuring a construct are highly correlated. The most prominent measure of internal consistency reliability is Cronbach’s Alpha.



Internal secondary data:are data that companies compile for various reporting and analysis purposes.



Internal validity:is the extent to which causal claims can be made in respect of the study results.



Interquartile range:is the difference between the third and first quartile.



Inter-rater reliability:is the degree of agreement between raters expressed by the amount of consensus in their judgment.



Interviewer fraud:is an issue in data collection resulting from interviewers making up data or even falsifying entire surveys.



Item non-response:occurs when people do not provide answers to certain questions, for example, because they refuse to answer, or forgot to answer.



Items:
                  represent measurable characteristics in conceptual models and statistical analysis. Also referred to as
                  indicators
                  .
                



Kaiser criterion:
                  is a statistic used in principal component and factor analysis to determine the number of factors to extract from the data. According to this criterion, researchers should extract all factors with an eigenvalue greater than one. Also referred to as
                  latent root criterion
                  .
                



Kaiser–Meyer–Olkin criterion:
                  is an index used to assess the adequacy of the data for a principal component and factor analysis. High values indicate that the data are sufficiently correlated. Also referred to as
                  measure of sampling adequacy
                  (
                  MSA
                  ).
                



KISS principle:the abbreviation of “Keep it short and simple!” and implies that any research report should be as concise as possible.



Kruskal-Wallis rank test:is the non-parametric equivalent of the ANOVA. The null hypothesis of the test is that the distribution of the test variable across all groups is identical.




                k
                -means:
              is a group of clustering methods that starts with an initial partitioning of all the objects into a prespecified number of clusters and then gradually re-allocates objects in order to minimize the overall within-cluster variation.




                k
                -means++:
              
                  is a variant of the
                  k
                  -means method that uses an improved initialization process.
                




                k
                -medians:
              
                  is a popular variant of
                  k
                  -means that aims at minimizing the absolute deviations from the cluster medians.
                




                k
                -medoids:
              
                  is a variant of
                  k
                  -means that uses other cluster centers rather than the mean or median.
                



Lab experiments:are performed in controlled environments (usually in a company or academic lab) to isolate the effects of one or more treatment variables on an outcome.



Label switching:a situation in which the labels of clusters change from one analysis to the other.



Laddering:is an interviewing technique where the interviewer pushes a seemingly simple response to a question in order to find subconscious motives. It is typically used in the means-end approach.



Latent concepts:represent broad ideas or thoughts about certain phenomena that researchers have established and want to measure in their research.



Latent root criterion:
                  See
                  Kaiser criterion
                  .
                



Latent variable:
                  measures a concept that is abstract, complex, and cannot be directly observed by (multiple) items. Also referred to as
                  construct
                  .
                



Left-tailed hypothesis:is a directional hypothesis expressed in a direction (lower) relative to a standard.



Levene’s test:
                  tests the equality of the variances between two or more groups of data. Also referred to as
                  F-test of sample variance
                  .
                



Likert scale:is a type of answering scale in which respondents have to indicate their degree of agreement to a statement. The degree of agreement is usually set by the scale endpoints, which range from strongly disagree to strongly agree.



Limited service providers:are market research companies that specialize in one or more services.



Line chart:
                  is a type of chart in which measurement points are ordered (typically according to their
                  x
                  -axis value) and joined with straight-line segments.
                



Linkage algorithm:defines the distance from a newly formed cluster to a certain object, or to other clusters in the solution.



Listwise deletion:entails deleting cases with one or more missing value(s) in any of the variables used in an analysis.



Little’s MCAR test:is a test to analyze the patterns of missing data by comparing the observed data with the pattern expected if the data were missing completely at random.



Local optimum:is an optimal solution when compared with similar solutions, but not a global optimum.



Log transformation:is a type of scale transformation commonly used to handle skewed data.



Mail surveys:are paper-based surveys sent to respondents via regular mail.



Manhattan metric:
                  See
                  City-block distance
                  .
                



Manipulation checks:a type of analysis in experiments to check whether the experimental treatment was effective.



Mann-Whitney U test:
                  is the non-parametric equivalent of the independent samples
                  t
                  -test used to assess whether two sample means are equal or not.
                



Marginal mean:represents the mean value of one category in respect of each of the other types of categories.



Market segmentation:is the segmenting of markets into groups (segments) of objects (e.g., consumers) with similar characteristics (e.g., needs and wants).



Market segments:are groups of objects with similar characteristics.



Matching coefficients:are similarity measures that express the degree to which the clustering variables’ values fall into the same category.



Mean:
                  is the most common method of defining a typical value of a list of numbers. It is equal to the sum of a variable’s values divided by the number of observations. Also referred to as
                  arithmetic mean
                  or simply
                  average
                  .
                



Means-end approach:a method used to identify the ends consumers aim to satisfy and the means (consumption) they use to do so.



Measurement scaling:refers to (1) the level at which a variable is measured (nominal, ordinal, interval or ratio scale), and (2) the general act of using a set of variables to measure a construct.



Measure of sampling adequacy (MSA):
                  See
                  Kaiser–Meyer–Olkin criterion
                



Measures of centrality:
                  are statistical indices of a typical or average value of a list of numbers. There are two main types of measures of centrality, the
                  median
                  and the
                  mean
                  .
                



Measures of dispersion:
                  provide researchers with information about the variability of the data (i.e., how far the values are spread out). There are four main types of measures of dispersion: the
                  range, interquartile range, variance
                  , and
                  standard deviation
                  .
                



Median:is a value that separates the lowest 50 % of values from the highest 50 % of values.



Middle response styles:a systematic way of responding to survey items that describes respondents’ tendency to choose the mid points of a response scale.



Minto principle:a guideline for presentations that starts with the conclusion, raising questions in the audience’s mind about the way this conclusion was reached. The presenter subsequently explains the steps involved in the analysis.



Missing at random (MAR):is a missing values pattern in which the probability that data points are missing varies from respondent to respondent.



Missing completely at random (MCAR):is a missing values pattern in which the probability that data points are missing is unrelated to any other measured variable and to the variable with the missing values.



Missing data:occur when entire observations are missing (survey non-response), or respondents have not answered all the items (item non-response).



Mixed mode:is the act of combining different ways of administering surveys.



Moderation analysis:involves assessing whether the effect of an independent variable on a dependent variable depends on the values of a third variable, referred to as a moderator variable.



(Multi)collinearity:is a data issue that arises in regression analysis when two or more independent variables are highly correlated.



Multi-item construct:is a measurement of an abstract concept that uses several items.



Multinomial logistic regression:is a type of regression analysis used when the dependent variable is nominal and takes more than two values.



Multiple imputation:is a simulation-based statistical technique that replaces missing observations with a set of possible values (as opposed to a single value), representing the uncertainty about the missing data’s true value.



Multiple regression:is a type of regression analysis that includes multiple independent variables.



Mystery shopping:is a type of observational study in which a trained researcher visits a store or restaurant and consumes their products/services.



Nested models:are simpler versions of a complex model.



Net Promoter Score (NPS):
                  is a measure of customer loyalty that uses the single question:
                  “How likely are you to recommend our company/product/service to a friend or colleague?
                  ”
                



Noise:
                  is a synonym for unexplained variation that cannot be explained. Also referred to as
                  random noise
                  .
                



Nomological validity:is the degree to which a construct behaves as it should in a system of related constructs.



Non-directional hypothesis:tests for any difference in the parameter, whether positive or negative.



Non-hierarchical clustering methods:
                  see
                  Partitioning methods
                  .
                



Nonparametric tests:are statistical tests for hypothesis testing that do not assume a specific distribution of the data (typically a normal distribution).



Non-probability sampling:is a sampling technique that does not give every individual in the population an equal chance of being included in the sample. The resulting sample is typically not representative of the population.



Non-random missing:is a missing values pattern in which the probability that data points are missing depends on the variable and on other unobserved factors.



Null and alternative hypothesis:
                  the null hypothesis (indicated as H
                  0
                  ) is a statement expecting no difference or no effect. The alternative hypothesis (indicated as H
                  1
                  ) is the hypothesis against which the null hypothesis is tested.
                



Oblique rotation:is a technique used to facilitate the interpretation of the factor solution in which the independence of a factor to all other factors is not maintained.



Observation:
                  is an object, such as a customer, a company, or a country, in statistical analysis. Also referred to as
                  case
                  .
                



Observational studies:are procedures for gathering data in which the researcher observes people’s behavior in a certain context. Observational studies are normally used to understand what people are doing rather than why they are doing it.




                Omega-squared (
                ω
                ²):
              
                  is a statistic used in an ANOVA to describe the ratio of the between-group variation to the total variation, thereby indicating the variance accounted for by the data. It is commonly used for sample sizes of 50 or less and corresponds to the Adjusted
                  R
                  2
                  of regression analysis. Omega-squared is also used to indicate effect sizes of individual variables in regression analysis.
                




                One-sample
                t
                -test:
              is a parametric test used to compare one mean with a given value.



One-tailed tests:are a class of statistical tests frequently used when the hypothesis is expressed directionally (i.e., < or >). The region of rejection is on one side of the sampling distribution.



One-way ANOVA:is a type of ANOVA that involves a single metric dependent variable and one factor variable with three (or more) levels.



Open-ended questions:
                  are a type of question format that provides little or no structure for respondents’ answers. Generally, the researcher asks a question and the respondent writes down his or her answer in a box. Also referred to as
                  verbatim items
                  .
                



Operationalization:is the process of defining a set of variables to measure a construct. The process defines latent concepts and allows them to be measured empirically.



Ordinary least squares (OLS):is the estimation approach commonly used in regression analysis and involves minimizing the squared deviations from the observations to the regression line (i.e., the residuals).



Orthogonal rotation:is a technique used to facilitate the interpretation of a factor solution in which a factor’s independence is maintained from all other factors. The correlation between the factors is determined as zero.



Outliers:are observations that differ substantially from other observations in respect of one or more characteristics.



Paired samples:are samples that include multiple observations from the same object (e.g., firm or individual).



Paired samples t-test:is a statistical procedure used to determine whether there is a significant mean difference between observations measured at two points in time.



Parallel analysis:is a statistic used in principal component and factor analysis to determine the number of factors to extract from the data. According to this criterion, researchers should extract all factors whose eigenvalues are larger than those derived from randomly generated data with the same sample size and number of variables.



Parametric test:are statistical tests that assume a specific data distribution (typically normal).



Partial least squares structural equation modeling (PLS-SEM):is a method to estimate structural equation models. The goal is to maximize the explained variance of the dependent latent variables.



Partitioning methods:
                  is a group of clustering procedures that does not establish a tree-like structure of objects and clusters, but exchanges objects between clusters to optimize a certain goal criterion. The most popular type of partitioning method is
                  k
                  -means.
                



Path diagram:is a visual representation of expected relationships tested in a structural equation modeling analysis.



Personal interviews:
                  is an interview technique that involves face-to-face contact between the interviewer and the respondent. Also referred to as
                  face-to-face interviews
                  .
                



Pie chart:displays the relative frequencies of a variable’s values.



Population:is a group of objects (e.g., consumers, companies, or products) that a researcher wants to assess.



Post hoc tests:are a group of tests used for paired comparisons in an ANOVA. Post hoc tests maintain the familywise error rate (i.e., they prevent excessive type I error).



Power analysis:is a procedure used to estimate the power of a statistical test.



Power of a (statistical) test:
                  represents the probability of rejecting a null hypothesis when it is in fact false. In other words, the power of a statistical test is the probability of rendering an effect significant when it is indeed significant. The power is defined by 1−
                  β
                  , where
                  β
                  is the probability of a type II error.
                



Practical significance:refers to whether differences or effects are large enough to influence decision-making processes.



Predictive validity:is the extent to which an instrument predicts the outcome of another variable, measured at a later point in time.



Primary data:are data gathered for a specific research project.



Principal axis factoring:
                  See
                  Factor analysis.
                



Principal component analysis:is a statistical procedure that uses correlation patterns among a set of indicator variables to derive factors that represent most of the original variables’ variance. Different from factor analysis, the procedure uses all the variance in the variables as input.



Principal components:are linear composites of original variables that reproduce the original variables’ variance as well as possible.



Principal factor analysis:
                  See
                  Factor analysis.
                



Probability sampling:is a sampling technique that gives every individual in the population an equal chance, different from zero, of being included in the sample.



Profiling:is a step in market segmentation that identifies observable variables (e.g., demographics) that characterize the segments.



Projective technique:is a special type of testing procedure, usually used as part of in-depth interviews. This technique provides the participants with a stimulus (e.g., pictures, words) and then gauges their responses (e.g., through sentence completion).



Promax rotation:is a popular oblique rotation method used in principal component and factor analysis.




                p
                -value:
              is the probability of erroneously rejecting a true null hypothesis in a given statistical test.



Pyramid structure for presentations:
                  See
                  Minto principle
                  .
                



Qualitative data:are audio, pictorial, or textual information that researchers use to answer research questions.



Qualitative research:
                  is primarily used to gain an understanding of
                  why
                  certain things happen. It can be used in an exploratory context by defining problems in more detail, or by developing hypotheses to be tested in subsequent research.
                



Quantile plot:is a graphical method for comparing two (typically normal) distributions by plotting their quantiles against each other.



Quantitative data:are data to which numbers are assigned to represent specific characteristics.



Quartimax rotation:is a variant of the oblimin rotation.




                R
                2
                :
              
                  See
                  Coefficient of determination
                  .
                



Ramsey’s RESET test:is a test for linearity used in regression analysis.



Random noise:is a synonym for unexplained variation that cannot be explained in an analysis such as in a regression or ANOVA.



Range:is the difference between the highest and the lowest value in a variable measured, at least, on an ordinal scale.



Range standardization:is a type of scale transformation in which the values of a scale are standardized to a specific range that the researcher has set.



Rank order scale:is an ordinal scale that asks respondents to rank a set of objects or characteristics in terms of, for example, importance, preference, or similarity.



Reflective constructs:is a type of measurement in which the indicators are considered manifestations of the underlying construct.



Regression method:is a procedure to generate factor scores in principal component analysis. The resulting factor scores have a zero mean and unit standard deviation.



Regression sum of squares:quantifies the difference between the regression line and the line indicating the average. It represents the variation in the data that the regression analysis explains.



Reliability:is the degree to which a measure is free from random error.



Reliability analysis:
                  is an element of a confirmatory factor analysis and essential when working with measurement scales. See
                  Reliability
                  .
                



Research design:describes the general approach to answering a research question related to a marketing opportunity or problem. There are three broad types of research design: exploratory research, descriptive research, and causal research.



Residual:
                  is the unexplained variance in a regression model. Also referred to as
                  disturbance term
                  .
                



Reverse-scaled items:are items whose statement (if a Likert scale is used), or word pair (if a semantic differential scale is used) is reversed when compared to the other items in the set.



Right-tailed hypothesis:is a directional hypothesis expressed in a direction (higher) relative to a standard.



Russell and Rao coefficient:is a similarity coefficient used in cluster analysis.



Sample size:is the number of observations drawn from a population.



Sampling:is the process through which objects are selected from a population.



Sampling error:occurs when the sample and population structure differ on relevant characteristics.



Scale development:
                  is the process of defining a set of variables to measure a construct and which follows an iterative process with several steps and feedback loops. Also referred to as
                  operationalization
                  , or, in the case of an index,
                  index construction
                  .
                



Scale transformation:is the act of changing a variable’s values to ensure comparability with other variables, or to make the data suitable for analysis.



Scanner data:are collected at the checkout of a supermarket where details about each product sold are entered into a database.



Scatter plot:is a graph that represents the relationship between two variables, thus portraying the joint values of each observation in a two-dimensional graph



Scree plot:is a graph used in principal component and factor analysis that plots the number of factors against the eigenvalues, sometimes resulting in a distinct break (elbow) that indicates the number of factors to extract. Following the same principle, the scree plot is also used in hierarchical cluster analysis to plot the number of clusters against the distances at which objects were merged.



Secondary data:are data that have already been gathered, often for a different research purpose and some time ago. Secondary data comprise internal secondary data, external secondary data, or a mix of both.



Segment specialists:are companies that concentrate on specific market segments, such as a particular industry or type of customer.



Self-contained figure:is a graph in a market research report that should be numbered sequentially and have a meaningful title so that it can be understood without reading the text.



Self-contained table:is a table in a market research report that should be numbered sequentially and have a meaningful title so that it can be understood without reading the text.



Semantic differential scales:is a type of answering scale that comprises opposing pairs of words, normally adjectives (e.g., young/old, masculine/feminine) constituting the endpoints of the scale. Respondents then indicate how well one of the word in each pair describes how he or she feels about the object to be rated (e.g., a company or brand).



Sentence completion:is a type of projective technique that provides respondents with beginnings of sentences that they have to complete in ways that are meaningful to them.



Shapiro-Wilk test:is a test for normality (i.e., whether the data are normally distributed).



Significance level:is the probability that an effect is incorrectly assumed when there is in fact none. The researcher sets the significance level prior to the analysis.



Silhouette measure of cohesion and separation:is an overall goodness-of-fit measure in two-step clustering.



Simple matching coefficient:is a similarity coefficient used in cluster analysis.



Simple regression:is the simplest type of regression analysis with one dependent and one independent variable.



Single-item constructs:is a measurement of a concept that uses only one item.



Single linkage:is a linkage algorithm in hierarchical clustering methods in which the distance between two clusters corresponds to the shortest distance between any two members in the two clusters.



Skewed data:occur if a variable is asymmetrically distributed. A positive skew (also called right-skewed) occurs when many observations are concentrated on the left side of the distribution, producing a long right tail (the opposite is called negative skew or left-skewed).



Social desirability bias:occurs when respondents provide socially desirable answers (e.g., by reporting higher or lower incomes than are actually true), or take a position that they believe society favors (e.g., not smoking or drinking).



Social media analytics:are methods for analyzing social networking data and comprise text mining, social network analysis, and trend analysis.



Social networking data:reflect how people would like others to perceive them and, thus, indicate consumers’ intentions. Product or company-related social networking data are of specific interest to market researchers.



Specialized service firms:are market research companies that focus on particular products, markets, or market research techniques.



Split-half reliability:is a type of reliability assessment in which scale items are divided into halves and the scores of the halves are correlated.



Split-sample validation:involves splitting the dataset into two samples, running the analysis on both samples, and comparing the results.



SPSS:Computer package specializing in quantitative data analysis.



Standard deviation:describes the sample distribution values’ variability from the mean. It is the square root of the variance.



Standard error:is the sampling distribution of a statistic’s standard deviation, mostly from the mean.



Standardized effects:express the relative effects of differently measured independent variables in a regression analysis by expressing them in terms of standard deviation changes from the mean.



Standardizing variables:have been rescaled (typically to a zero mean and unit standard deviation) to facilitate comparisons between differently scaled variables.



Statistical significance:occurs when an effect is so large that it is unlikely to have occurred by chance. Statistical significance depends on several factors, including the size of the effect, the variation in the sample data, and the number of observations.



Straight line distance:
                  See
                  Euclidean distance
                  .
                



Straight-lining:occurs when a respondent marks the same response in almost all the items.



Structural equation modeling:is a multivariate data analysis technique used to measure relationships between constructs, as well as between constructs and their associated indicators.



Survey non-response:occurs when entire responses are missing. Survey non-response rates are usually 75 %–95 %.



Surveys:are often used for gathering primary data. Designing surveys involves a six-step process: 1. Determine the survey goal; 2. determine the type of questionnaire required and the administration method; 3. decide on the questions and 4. the scale; 5. design the questionnaire; and 6. pretest and administer the questionnaire.



Suspicious response patterns:are issues in response styles in respect of straight-lining and inconsistent answers that a researcher needs to address in the analysis.



Syndicated data:are data sold to multiple clients, allowing them to compare key measures with those of the rest of the market.



Telephone interviews:allow researchers to collect data quickly and facilitate open-ended responses, although not as well as personal interviews.



Test markets:are a type of field experiment that evaluates a new product or promotional campaign under real market conditions.



Test-retest reliability:
                  is a type of reliability assessment in which the researcher obtains repeated measurement of the same respondent or group of respondents, using the same instrument and under similar conditions. Also referred to as
                  stability of the measurement
                  .
                



Test statistic:is calculated from the sample data to assess the strength of the evidence in support of the null hypothesis.



Tolerance:is a measure to detect collinearity defined as 1/VIF, where VIF is the variance inflation factor.



Total sum of squares:quantifies the difference between the observations and the line indicating the average.



Transforming data:is an optional step in workflow of data, involving variable respecification and scale transformation.



Treatments:are elements in an experiment that are used to manipulate the participants by subjecting them to different situations. A simple form of treatment could be an advertisement with and without humor.




                t
                -test:
              
                  is the most popular type of parametric test for comparing a mean with a given standard and for comparing the means of independent samples (independent samples
                  t
                  -test), or the means of paired samples (paired samples
                  t
                  -test).
                



Tukey’s honestly significant difference test:
                  is a popular post hoc test used in an ANOVA that controls for type I errors, but is limited in terms of statistical power. Often simply referred to as
                  Tukey’s method
                  .
                



Two-sample t-test:is the most popular type of parametric test for comparing the means of independent or paired samples.



Two-tailed tests:
                  are a class of statistical tests frequently used when the hypothesis is not expressed directionally (i.e.,
                  ≠
                  ). The region of rejection is on two sides of the sampling distribution.
                



Two-way ANOVA:is a type of ANOVA that involves a single metric dependent variable and two factor variables with three (or more) levels.



Type I error:
                  occurs when erroneously rejecting a true null hypothesis. Also referred to as
                  α
                  error.
                



Type II error:
                  occurs when erroneously accepting a false null hypothesis. Also referred to as
                  β error
                  .
                



Unbalanced scale:describes a scale with an unequal number of positive and negative scale categories.



Unexplained variation:is the degree of variation that a factor variable in an ANOVA cannot explain. It can occur if extraneous factors, not accounted for in the analysis, cause variation instead of the factor variable.



Unit of analysis:is the level at which a variable is measured. Typical measurement levels include that of the respondents, customers, stores, companies, or countries.



Univariate statistics:are statistics that describe the centrality and dispersion of a single variable.



Unstandardized effects:express the absolute effects that a one-unit increase in the independent variables have on the dependent variable in a regression analysis.



Validation sample:is a random subsample of the original dataset used for validation testing.



Validity:is the degree to which a researcher measures what (s)he wants to measure. It is the degree to which a measure is free from systematic error.



Variable:represents a measurable characteristic whose value can change.



Variable respecification:involves transforming data to create new variables, or to modify existing ones.



Variance:a measure of dispersion computed by the sum of the squared differences of each value and a variable’s mean, divided by the sample size minus 1.



Variance inflation factor (VIF):quantifies the degree of collinearity between the independent variables in a regression analysis.



Variance ratio criterion:is a statistic used in cluster analysis to determine the number of clusters. The criterion compares the within- and between-cluster variation of different numbers of clusters.



Varimax rotation:is the most popular orthogonal rotation method used in principal component and factor analysis.



Verbatim items:
                  See
                  Open-ended questions
                  .
                



Visual aids:include overhead transparencies, flip charts, or slides (e.g., PowerPoint or Prezi) that help emphasize important points and facilitate the communication of difficult ideas in a presentation of market research results.



Visual analogue scale:is a type of answering scale in which respondents use levers that allow scaling on a continuum. This scale does not provide response categories.



Ward’s linkage:is a linkage algorithm in hierarchical clustering methods that combines those objects whose merger increases the overall within-cluster variance by the smallest possible degree.



Web surveys:
                  are less expensive to administer and can be fast in terms of data collection, because they can be set up very quickly. Also referred to as
                  computer-assisted web interviews
                  (
                  CAWI
                  ).
                



Weighted average linkage:is a variant of the average linkage algorithm used in cluster analysis that weights the distances according to the number of objects in the cluster.



Weighted Least Squares:is a variant of a standard regression analysis, which is used to account for violated regression assumptions such as heteroskedastic regression errors. It “weights” the regression line such that observations with a smaller variance are given greater weight in determining the regression coefficients.



Welch correction:is a statistical test used in an ANOVA to assess the significance of the overall model when the group variances differ significantly and the groups differ in size.



Wilcoxon matched-pairs signed-rank test:
                  is the non-parametric equivalent of the paired samples
                  t
                  -test.
                



Wilcoxon signed-rank test:
                  is the non-parametric equivalent of the independent samples
                  t
                  -test.
                



Workflow:is a strategy to keep track of the entering, cleaning, describing, and transforming of data.




                z
                -standardization:
              is a type of scale transformation in which the values of a scale are standardized to a zero mean and unit standard deviation.




                z
                -test:
              is any statistical test for which the distribution of the test statistic under the null hypothesis can be approximated by a normal distribution.




Index

Symbol

α error

α-inflation

β error

χ2-test

3-D scatter plot

5 % trimmed mean


A

Acquiescence

Adaptive questioning

Adjusted R2

Agglomeration schedule

Agglomerative clustering

Aggregating data

Aggregation

Akaike’s Information Criterion (AIC)

Alternative hypothesis

American Customer Satisfaction Index (ACSI)

American Marketing Association (AMA)

Analysis of Variance (ANOVA)

Anti-image

Arithmetic mean

Armstrong and Overton procedure

Association measures (cluster analysis)

Autocorrelation

Average

Average linkage


B

Back-translation

Balanced scale

Bar chart

Bartlett method (factor scores)

Bartlett’s test of sphericity

Bayes Information Criterion (BIC)

Before measurement effect

Before-after design

Before-after design with a control group

Best-worst scaling

Between-group mean squares

Between-group Variation

Between-groups linkage

Big data

Binary logistic regression

Bivariate descriptives

Bivariate graphs

Bivariate statistics

Bivariate tables

Bonferroni correction

Bootstrapping

Box plot

Box-and-whisker plot

Bubble plot


C

Case

Causal research

Causality

Census

Centroid linkage

Chaining effect

Chart Builder (SPSS)

Chart Editor (SPSS)

Chebychev distance

City-block distance

Closed-ended questions

Cluster analysis

Cluster feature tree

Cluster sampling

Clustering variables

Clusters

Codebook

Coefficient of determination
SeeSee R2

Collinearity

Communality

Company records (data source)

Complete linkage

Components

Composite measure

Compute Variable (SPSS)

Computer-assisted personal interviews (CAPI)

Computer-assisted self-interviews (CASI)

Computer-assisted telephone interviews (CATI)

Computer-assisted web interviews (CAWI)

Confidence interval

Confirmatory factor analysis

Constant

Constant (regression analysis)

Constant sum scale

Construct score

Construct validity

Constructs

Consulting firms (data source)

Content validity

Contingency coefficient

Contingency tables

Control variables

Convenience sampling

Conversion rate

Correlation

Correlation residuals

Covariance

Covariance-based structural equation modeling (CB-SEM)

Cramer’s V

Criterion validity

Cronbach’s Alpha

Cross-validation

Crosstabs

Culture-specific response styles

Customer Relationship Management (CRM)


D

Data entry errors

Degrees of freedom

Dendrogram

Dependent variables (regression analysis)

Descriptive research

Direct oblimin rotation

Directional hypothesis

Discriminant validity

Disturbance term

Divisive clustering

Don’t know option

Double-barreled questions

Dummies

Dummy variables

Durbin-Watson test


E

Effect size

Eigenvalues

Eigenvectors

Elbow (scree plot)

Enterprise Resource Planning (ERP) systems

Equidistance

Equidistant scale

Error (regression analysis)

Error sum of squares

ESOMAR

Estimation sample

Eta squared

Ethics

Ethnography

Euclidean distance

Existing research studies (data source)

Experimental design

Experimental research

Experiments

Expert validity

Explained variation

Exploratory factor analysis

Exploratory research

External secondary data

External validity

Extraneous variables

Extreme response styles

Extreme values (box plot)

Eyetracking


F

F-test

F-test of sample variance

Face validity

Face-to-face interviews

Factor analysis

Factor extraction

Factor levels

Factor loadings

Factor rotation

Factor scores

Factor variable

Factor weights

Factor-cluster segmentation

Factors

False negative

False positive

Familywise error rate

Field experiments

Field service firms

Focus groups

Forced-choice scale

Formative constructs

Free-choice scale

Frequency table

Full factorial design

Full service providers

Funnel approach (questionnaire design)

Furthest neighbor

Fused market research


G

Games-Howell procedure

GfK Spex Retail

Global representativeness (sampling)

Governments (data source)

Grand mean

Graphboard Template Chooser (SPSS)


H

Heteroskedasticity

Hierarchical clustering methods

Histogram

Hochberg’s GT2

Homoscedasticity

Hybrid market research

Hypotheses


I

Icicle diagram

In-depth interviews

Inconsistent answers

Independent observations

Independent samples

Independent samples t-tests

Independent variables (regression analysis)

Index

Index construction

Indicators

Inter-rater reliability

Interaction effect

Interaction term

Intercept

Internal consistency reliability

Internal secondary data

Internal validity

Internet data

Interquartile range

Interval scale

Interviewer bias

Interviewer fraud

Item content

Item non-response

Item wording

Items


J

Jaccard coefficient (JC)

Judgmental sampling


K

k-means

k-means++

k-medians

k-medoids

Kaiser criterion

Kaiser–Meyer–Olkin (KMO) criterion

Kendall’s tau

KISS principle

Kruskal-Wallis rank test

Kulczynski (cluster analysis)


L

Lab experiments

Label switching

Laddering

Latent concepts

Latent root criterion

Latent variable

Left-skewed data

Left-tailed hypothesis

Levels of measurement

Levene’s test

Likert scale

Limited service providers

Line chart

Linkage algorithms

Listwise deletion

Literature databases (data source)

Little’s MCAR test

Local optimum

Log transformation


M

Mail surveys

Mall intercepts

Manhattan metric

Manipulation checks

Mann-Whitney U test

Marginal mean

Market research firms (data source)

Market segmentation

Marketing opportunities

Marketing symptoms

Matching coefficients

MaxDiff scale

Mean

Means-end approach

Measure of sampling adequacy (MSA)

Measurement error

Measurement scaling

Measures of central tendency

Measures of centrality

Measures of dispersion

Median

Middle response styles

Minto principle

Misresponse rates

Missing completely at random (MCAR)

Missing data

Missing not at random (MNAR)

Missing at random (MAR)

Mixed methodology

Mixed mode

Mobile phone surveys

Moderation analysis

Multi-item constructs

Multi-item scale

Multicollinearity

Multinomial logistic regression

Multiple imputation

Multiple regression

Mystery shopping


N

Nearest neighbor (cluster analysis)

Negative skew

Nested models

Net Promoter Score (NPS)

Noise

Nominal scale

Nomological validity

Non-directional hypothesis

Non-hierarchical clustering methods

Non-probability sampling

Nonparametric tests


O

oblique rotation

Observation

Observational studies

Ochiai (cluster analysis)

OLS
SeeSee Ordinary least squares

Omega squared

One-sample t-test

One-shot case study

One-tailed test

One-way ANOVA

Open-ended questions

Operationalization

Ordinal scale

Ordinary least squares (OLS)

orthogonal rotation

Outliers


P

p-value

Page requests

Paired samples t-test

Parallel analysis

Parametric tests

Partial least squares structural equation modeling (PLS-SEM)

Partitioning clustering methods

Path diagram

Pearson’s correlation coefficient

Personal interviews

Phi

Pie chart

Population

Positive skew

Post hoc tests

Power of a statistical test

Power analysis

Practical significance

Practice effects

Predictive validity

Pretest

Primary data

Principal axis factoring

Principal component analysis (PCA)

Principal components

Principal factor analysis

PRIZM

Probability sampling

Profiling (cluster analysis)

Projective techniques

Promax rotation

Pyramid structure


Q

Q-Q plot

Qualitative data

Qualitative research

Quantile plot

Quantitative data

Quantitative research

Quartiles

Questionnaire design

Question order

Quota sampling


R


                  R
                  2
                

Ramsey’s RESET test

Random error

Random noise

Randomization (experiments)

Range

Range standardization

Rank order scales

Ratio scale

Recode (SPSS)

Recoding

Reflective constructs

Regression method (factor scores)

Regression sum of squares

Reliability

Reliability analysis

Representative sample

Research design

Research problem

Residual

Respondent bias

Response categories (design)

Response categories (labeling)

Response categories (number)

Response rates

Reverse-scaled items

Right-skewed data

Right-tailed hypothesis

Russell and Rao coefficient

Ryan/Einot-Gabriel/Welsch Q (REGWQ)


S

Sales reports (data source)

Sample size

Sampling

Sampling error

Sampling frame

Scale development

Scale properties

Scale transformation

Scale types

Scanner data

Scatter plot

Scree plot

Screeners

Screening questions

Search engines

Secondary data

Segment specialists

Select cases (SPSS)

Self-contained figure

Self-contained table

Self-selection (experiments)

Semantic differential scales

Sentence completion

Sessions

Shapiro-Wilk test

Shelf tests

Significance level

Silhouette measure of cohesion and separation

Simple matching (SM) coefficient

Simple random sampling

Simple regression

Single linkage

Single-item constructs

Skewed data

Snowball sampling

Social desirability bias

Social media analytics

Social network analysis

Social networking data

Solomon four-group design

Spearman’s correlation coefficient

Specialized service firms

Specific representativeness (sampling)

Split File (SPSS)

split-half reliability

Split-sample validation

SPSS

SPSS Statistics Data Editor

SPSS Statistics Viewer

SPSS syntax

Spurious correlation

Squared Euclidean distance

Stability of the measurement

Standard deviation

Standard error (regression analysis)

Standardized effects

Standardizing variables

Statistical significance

Straight line distance

Straight-lining

Strata (sampling)

Stratified sampling

Structural equation modeling

Survey format

Survey layout

Survey non-response

Surveys

Suspicious response patterns

Syndicated data

System-missing values (SPSS)

Systematic error

Systematic sampling


T

t-test

Telephone interviews

Test markets

Test statistic

test-retest reliability

Test-retest reliability

Testing effect

Text mining

Ties

Tolerance

Total sum of the squares

Tracking cookie

Trade associations (data source)

Transforming data

Treatments

Trend analysis

Tukey’s honestly significant difference test

Two-samples t-test (t-test )

Two-step cluster analysis

Two-tailed test

Two-way ANOVA

Type I error

Type II error

Types of research problems


U

Unbalanced scale

Unexplained variation

Unit of analysis

unit non-response

Univariate descriptives

Univariate graphs

Univariate statistics

Univariate tables

Unstandardized effects

User-defined missing values (SPSS)


V

Vague quantifiers

Validity

Value Labels (SPSS)

Variable

Variable coding

Variable names

Variable respecification

Variance

Variance inflation factor (VIF)

Variance ratio criterion (VRC)

varimax rotation

Verbatim items

VIF
SeeSee variance inflation factor

Visual aids

Visual analogue scale


W

Ward’s linkage

Web surveys

Weighted Least Squares

Welch’s correction

Whisker (box plot)

Wilcoxon matched-pairs signed-rank test

Wilcoxon–Mann–Whitney test

Wilcoxon rank-sum test

Wilcoxon signed-rank test

Within-group mean squares

Within-group variation

Workflow of data


Y

Yule’s Q (cluster analysis)


Z

z-scores

z-standardization

z-test
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@ Oddjob.sav [DataSet1] - IBM SPSS Statistics Data Editor

e B Aol

Name Type Width  Decimals Label Values Missing  Columns Align Measure Role
1 country Numeric 8 0 Home country  |{1, Germany... None 8 Right & Nominal |\ Input
2 language Numeric vs 0 Language {1, German}... None 8 Right &5 Nominal | ™ Input
3 status Numeric 8 0 Traveler Status {1, Blue)... | None 10 Right &b Nominal |\ Input
4 age Numeric 8 0 Age None None 10 Right & scale j\. Input
5 gender Numeric 9 0 Gender {1, female}...  None 10 Right & Nominal N Input
6 nflights Numeric 8 0 How many flig... | None None 8 Right & sale | Input
7 flight_latest |Numeric 8 [ When was your... {1, within th...| None 8 Right ol ordinal |\ nput
8 flight_type | Numeric 8 0 What type was ... {1, Domesti... | None 8 Right & Nominal "\. Input
9 flight_purp... | Numeric 8 0 What was the ... {1, Business...| None 8 Right & Nominal | nput
10 flight_class | Numeric 8 0 Which class did... {1, First}... | None 8 Right ol ordinal | tnput
1 nps Numeric 8 0 How likely is it ...| {1, very unli... | None 8 Right & sale | input
12 reputation | Numeric 8 0 Oddjob Airway... {1, Fully dis... |None 8 Right ol ordinal |\ mput
13 satl Numeric 8 0 In general, I a... |1, Fully dis... None 8 Right ol ordinal e Input
14 sat2 Numeric 8 0 Oddjob Airway... {1, Fully dis... |None 8 Right ol Ordinal j\. Input
15 sat3 Numeric 8 0 Oddjob Airway... {1, Fully dis... |None 8 Right ol ordinal | input
16 overall_sat | Numeric 8 0 Overall, 1amss... {1, Fully dis...  None 8 Right ol ordinal [ tnput
17 loyl Numeric 8 0 1 say positive t... |{1, Fully dis... None 8 Right ol ordinal '\ Input
18 loy2 Numeric 8 0 | recommend O...| {1, Fully dis... |None 8 Right ol Ordinal |\ tnput
19 loy3 Numeric 8 0 I encourage fri... {1, Fully dis... None Right ol ordinal | Input
20 loy4 Numeric 0 I consider Oddj... {1, Fully dis... |None 8 Right il ordinal | tnput

— loys Numeric 8 0 intend to stay... {1, Fully dis... None 8 Right ol ordinal |\ input

IBM SPSS Statistics Processor is ready Unicode:ON
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(XX ) Parallel analysis_Oddjob.sps - IBM SPSS Statistics Syntax Editor

ISHE W e~ BLA N PO 0O & 2b H
| 5 00 MW T e o

Encoding: UTF-8
Parallel Analysis
The original test is described in: Horn, J. L. (1965). A Rationale and Test for the Number of Factors in Factor Analy
This syntax is taken from O'Connor (2000) SPSS and SAS Programs for Determining the Number of components Us
Behavior Research Methods, Instruments, & Computers, 32 (3), 396-402
set set rr!xloops=9000 length=none printback=none width=80.
. matrix.
matrix. COMMENT: Enter the number of observations (Ncases) and number of variables (Nvars) here. The number of datase
compute Ncases = 921.
compute Ndatsets = 1000.
compute compute percent = 95.
compute compute evals = make(nvars,ndatsets,-9999).
compute compute nml = 1/ (ncases-1).
loop #nds = 1 to ndatsets.
compute 17 J|compute x = sqrt(2 * (In(uniform(ncases,nvars)) * -1) ) &*
compute 18 5 c0s(6.283185 * uniform(ncases,nvars) ).
loop 19 vev = nml * (sscp(x) - ((tlcsum(x)*csum(x))/ncases)).
20 d=i di t(diagvev))).
compute 21 compute evals(,#nds) = eval(d * vev * d).
compute 22 end loop.
compute 23 compute num = rnd((percent*ndatsets)/100).
compute 24 compute results = { t(1:nvars), t(1:nvars), t(1:nvars) }.
25 loop #root = 1 to nvars.
end loop. 26 ranks = rnkorder(eval ).
compute 27 loop #col = 1 to ndatsets.
compute 28 do if (ranks(1,#col) = num).
29 3) = J#col).
loop 30 break.
compute 31 end if.
loop 32 end loop.
doif 33 end loop.
0:d 34 compute results(;,2) = rsum(evals) / ndatsets.
compute 35 compute specifs = {ncases; nvars; ndatsets; percent}.
break. 36 8 print specifs /title="Specifications for this Run:"
end if 37 /rlabels="Ncases" "Nvars" "Ndatsets" "Percent".
- 38 print results /title="Random Data Eigenvalues"
end loop. 39 g /clabels="Root" "Means" "Prcntyle".
end loop. i .
compute

| [IBM SPSS Statistics Processor is ready| [Unicode:ON/In 10 Col 21|
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Part 4. Following questions are related to demographic characteristics. Please answer that corresponds you.
4.1.3. What type of city do you live in?
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